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Welcome to ArcMap 1
• Visualizing information

• Working geographically

• Showing relationships

• Solving problems

• Creating and updating data

• Presenting results

• Developing mapping applications

• Tips on learning ArcMap

Welcome to ArcMap�, the premier ESRI® software for desktop geographic
information systems (GIS) and mapping. ArcMap gives you the power to:

� Visualize. In no time you�ll be working with your data geographically:
seeing patterns you couldn�t see before, revealing hidden trends and
distributions, and gaining new insights.

� Create. It�s easy to create maps to convey your message. ArcMap
provides all the tools you need to put your data on a map and display it
in an effective manner.

� Solve. Working geographically lets you answer questions such as �Where
is...?�, �How much...?�, and �What if...?�. Understanding these
relationships will help you make better decisions.

� Present. Showing the results of your work is easy. You can make great-
looking publication-quality maps and create interactive displays that link
charts, tables, drawings, photographs, and other elements to your data.
You�ll find that communicating geographically is a powerful way to
inform and motivate others.

� Develop. The ArcMap customization environment lets you tailor the
interface to suit your needs or the needs of your organization, build new
tools to automate your work, and develop standalone applications based
on ArcMap mapping components.

The next few pages show you some of the things you can do with ArcMap.
As you start making your own maps, you�ll discover even more.

ch1.p65 12/01/2000, 10:28 AM3



4 USING ARCMAP

Visualizing information
Sometimes just looking at a map will tell you what you want to know. Maps not only tell you where things are, but also what�s special
about them. This population map shows you where people live in the United States. From it, you can easily see where the major
metropolitan areas are located.

Do you live in a populated area? Areas drawn with dark blue have a lower population density than areas drawn with
yellow and brown.

ch1.p65 12/01/2000, 10:28 AM4



WELCOME TO ARCMAP 5

Working geographically
Maps are not static displays; they�re interactive. You can browse a map�taking a closer look at a particular area�and point at features
to find out more about them.

Get a regional perspective by zooming in. Want to know more about a
particular area? Just point at it.

ch1.p65 12/01/2000, 10:29 AM5



6 USING ARCMAP

Showing relationships
You can show relationships between features by opening tables and creating charts, then adding these elements to the map.

Charts and tables complement the map because they quickly summarize information that would otherwise take more
time to understand.
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WELCOME TO ARCMAP 7

Solving problems
You can search a map for features that meet particular criteria�for instance, find features by name, proximity, or characteristic.

Finding forest habitats within 100 meters of roads aids in assessing environmental impact.

ch1.p65 12/01/2000, 10:29 AM7



8 USING ARCMAP

Creating and updating data
You can keep your data current with the latest information from the field. ArcMap has integrated editing tools to help you update data
or create new data.

As a city grows, so too does its parcel database. ArcMap lets you edit both the geometry and attributes of features.
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WELCOME TO ARCMAP 9

Presenting results
You can create high-quality maps and present them to others. Embed maps in reports, publish them on the Web, export them to standard
formats, or print them out to hang on the wall.

ch1.p65 12/01/2000, 10:30 AM9



10 USING ARCMAP

Developing mapping applications
You can develop custom mapping applications. Customize the out-of-the-box capabilities of ArcMap using the built-in Visual Basic®

for Applications (VBA) programming environment or your favorite programming language. With ArcMap, you can customize the
interface to suit your needs, write macros to automate work, or use ArcMap components to embed mapping capabilities into other
software you create.

Automate your work with macros.

ch1.p65 12/01/2000, 10:30 AM10



WELCOME TO ARCMAP 11

Tips on learning ArcMap
If you�re new to GIS and mapping, remember that you don�t have
to learn everything about ArcMap to get immediate results. Begin
learning ArcMap by reading Chapter 2, �Quick-start tutorial�.
This chapter shows you how quickly and easily you can make a
map and gain insights into the steps you�ll use to create your
own. ArcMap comes with the data used in the tutorial, so you can
follow along step by step at your computer. You can also read the
tutorial without using your computer.

If you prefer to jump right in and experiment on your own, take a
look at some of the maps distributed with ArcMap. Try browsing
a map, changing symbols, and adding your own data.

When you�re ready to build your own maps, you�ll find that
ArcMap comes with useful data you can use directly or as
basemap data for your own data. If you don�t find what you need,
more data is available from ESRI, from other organizations, and
from the Internet. ArcMap also comes with lots of predefined
symbols, North arrows, and scale bars to make building maps
easier.

Finding answers to questions

Like most people, your goal is to complete your tasks while
investing a minimum amount of time and effort on learning how
to use software. You want intuitive, easy-to-use software that
gives you immediate results without having to read pages of
documentation. However, when you do have a question, you want
the answer quickly so you can complete your task. That�s what
this book is all about�getting you the answers you need when
you need them.

This book describes the mapping tasks�from basic to
advanced�that you�ll perform with ArcMap. Although you can
read this book from start to finish, you�ll likely use it more as a
reference. When you want to know how to do a particular task,
such as saving a map, just look it up in the table of contents or

index. What you�ll find is a concise, step-by-step description of
how to complete the task. Some chapters also include detailed
information that you can read if you want to learn more about the
concepts behind the tasks. You may also refer to the glossary in
this book if you come across any unfamiliar GIS terms or need to
refresh your memory.

Getting help on your computer

In addition to this book, the ArcMap online Help system is a
valuable resource for learning how to use the software. To learn
how to use Help, see �Getting help� in Chapter 3 of this book.

Learning about ArcMap extensions

ArcMap extensions are add-on programs that provide specialized
GIS functionality. Extensions that come with ArcMap are covered
in this book.

Contacting ESRI

If you need to contact ESRI for technical support, see the product
registration and support card you received with ArcMap or refer
to �Getting technical support� in the online Help system�s
�Getting more help� section.

You can also visit ESRI on the Web at www.esri.com for more
information on ArcMap and ArcInfo�.

ESRI education solutions

ESRI provides educational opportunities related to geographic
information science, GIS applications, and technology. You can
choose among instructor-led courses, Web-based courses, and
self-study workbooks to find education solutions that fit your
learning style and pocketbook. For more information, visit
www.esri.com/education on the Web.

ch1.p65 12/01/2000, 10:30 AM11
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Quick-start tutorial 2
• Exercise 1: Exploring your data

• Exercise 2: Working with
geographic features

• Exercise 3: Working with tables

• Exercise 4: Editing features

• Exercise 5: Working with map
elements

The best way to learn ArcMap is to try it yourself. This tutorial guides you
through some basic ArcMap skills as you create and print a set of maps for a
county that is planning to expand its airport.

Residents of the county have identified several issues they are concerned
about. These include noise affecting schools and houses near the airport and
increased traffic along major roads. In this tutorial, you�ll first create and
print a map showing schools near the airport. Then you�ll place this map�
along with two other maps that show land use surrounding the airport and
population density for the county�on a wall-sized poster for display.

In the tutorial, you�ll learn how to:

� Display map features.

� Add data to your map.

� Edit geographic data.

� Work with data tables.

� Query and select geographic features.

� Create a summary chart.

� Lay out and print a map.

There are five exercises. Each exercise takes between 30 and 45 minutes to
complete. You can work through the entire tutorial or complete each lesson
one at a time.

ch2.p65 12/01/2000, 2:21 PM13



14 USING ARCMAP

Exercise 1: Exploring your data

In this exercise, you�ll create a map showing locations of
schools near the airport along with a noise contour to see
which schools may be affected by noise from the airport.
The noise contour is based on the 65 Community Noise
Equivalency Level (CNEL), which indicates areas
experiencing more than 65 decibels of noise, averaged over
a 24-hour period. In many cases, buildings within the
65 CNEL will need soundproofing or other mitigation
measures.

The exercises in this chapter use the tutorial data
distributed with ArcMap. The default install location of the
data is C:\ArcGIS\ArcTutor\Map. The exercises require
that you have write access to this data. If you don�t, you�ll
need to copy the data to a location that you do have write
access to.

Starting ArcMap

ArcMap lets you explore your geographic data and create
maps for display.

1. Click the Start button on the Windows taskbar.

2. Point to Programs.

3. Point to ArcGIS.

4. Click ArcMap.

Opening an existing map document

The first time you start ArcMap, the Startup dialog box
appears. The Startup dialog box offers you several options
for starting your ArcMap session. For this exercise, you
want to open an existing map document.

1. Double-click Browse for maps.

1

2

3

4

1

ch2.p65 12/01/2000, 2:21 PM14



QUICK-START TUTORIAL 15

2. In the dialog box, click the Look in dropdown arrow,
and navigate to the Map folder on the local drive where
you installed the tutorial data (the default installation
path is C:\ArcGIS\ArcTutor\Map).

3. Double-click airport.mxd. ArcMap opens the map.

ArcMap stores a map as a map document so you can
redisplay it, modify it, or share it with other ArcMap users.
The map document doesn�t store the actual data, but rather
references the data stored on disk along with information
about how it should be displayed. The map document also
stores other information about the map such as its size and
the map elements it includes (title, scale bar, and so on).

To the left of the ArcMap display window is the table of
contents, showing you which geographic layers are
available to display. To the right is the map display area.

This particular map contains the following layers in a data
frame called Schools:

schools locations of elementary, middle,
high, and private schools

runways location of airport runways

arterials major roads

cnel65 the noise contour

airport_area the proposed airport expansion
zone

county the county boundary

The map currently displays the arterials, noise contour,
airport area, and county boundary. Their boxes are checked
in the table of contents.

Table of contents Map display area

2

3
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16 USING ARCMAP

Moving around the map

The Tools toolbar lets you move around the map and query
the features on the map. Place your pointer over each icon
(without clicking) to see a description of each.

1. Using the Zoom In tool, draw a box around the noise
contour to zoom in. Place the pointer on the upper-left
part of the contour, press the mouse button, and hold it
down while dragging to the lower-right. You�ll see the
box drawn on the screen. When you release the mouse
button, ArcMap zooms in to the area
defined by the box.

2. If necessary, use the Pan tool (the hand) on the Tools
toolbar to reposition the map so the noise contour is in
the center of the display area (hold the mouse button
down while dragging in the direction you want to move
the features, then release the button).

Displaying a layer

The table of contents lets you turn layers on and off in the
display. To display a layer, check the box next to its name.
To turn it off, uncheck it. Display the schools and runways
by checking their boxes in the table of contents. For more
information, see Chapter 5, �Managing layers�.

ch2.p65 12/01/2000, 2:22 PM16



QUICK-START TUTORIAL 17

Changing the display symbol

ArcMap lets you change the colors and symbols you use to
display features. You�ll change the symbols for schools
from a dot to a standard symbol used for schools on many
maps.

1. Click the dot symbol in the table of contents to display
the Symbol Selector window.

2. Scroll down until you find the School 1 symbol. Click it.

3. Click OK. The schools are drawn with the new symbol.

You can also open the symbol dialog by right-clicking the
layer name, choosing Properties from the menu that
appears, and clicking the Symbology tab. To simply change
the color of a symbol, right-click the symbol in the table of
contents to display the color palette. For more information
on changing display symbols, see Chapter 6, �Symbolizing
your data�.

1

2

3
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18 USING ARCMAP

Identifying a feature

There is one school that may be within the noise contour
around the airport.

1. Using the Zoom In tool, draw a box around the school to
zoom in.

You can see that the school is indeed within the noise
contour.

2. Click the Identify tool on the Tools toolbar.

3. Move the mouse pointer over the school and click. The
name of the school (Northwestern Prep) is listed in the
Identify Results window. Notice that only the features in
the topmost layer are identified. You can also identify
features in other layers by choosing the specific layers
you want to identify by clicking the Layers dropdown
arrow in the dialog box.

Close the Identify Results window.

3

1

2
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QUICK-START TUTORIAL 19

4. Click the Back button on the Tools toolbar to return to
your previous view.

Adding graphics

You can add text and other graphics to your display using
the Draw toolbar at the bottom of the ArcMap window.

1. Click the New Text button. The pointer changes to a
crosshair with a T.

2. Move the mouse pointer near the school you identified
and click.

3. In the text box that appears, type �Northwestern Prep�
and press Enter.

A blue dotted line surrounds the text, indicating it is
currently selected. You can drag the text to a new
position by clicking and holding down the mouse button
while dragging the text and then releasing the button.

4. When you�re finished positioning the text near the
school, click outside the text box to unselect it.

For more information on working with text, see Chapter 7,
�Labeling maps with text and graphics�.

4

1

3
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20 USING ARCMAP

Laying out a map

ArcMap lets you work in data view or layout view. Data
view focuses on a single data frame. Use data view when
exploring or editing your data. Layout view shows you how
the map page looks. Use layout view when composing and
printing a map for display. You can also explore and edit
your data in layout view if you want. All the tools and
options available in data view are also available in layout
view.

You can change the size and orientation of the page in
layout view. In this case, you�ll create a 16-by-12 inch map
with a landscape orientation.

1. Click the View menu and click Layout view. The Layout
toolbar appears, and the display changes to show the
page layout with rulers along the side.

2. Right-click anywhere on the layout background and
click Page Setup. You can also access Page Setup from
the File menu.

3. Make sure the Same as Printer box is not checked�
otherwise, the page size will default to be the same as
your printer. (If your printer does not print larger sizes,
you can scale the map down when you print it, as you�ll
see later in this exercise.)

4. Check Scale map elements proportionally to changes in
page size. That way, the data will be rescaled to fit the
page.

5. Set the Map Size Page Orientation to Landscape.

6. Set the page width to 16 and the height to 12 inches
(just click in each box and type over the existing
values).

Layout toolbar

ch2.p65 12/01/2000, 2:24 PM20



QUICK-START TUTORIAL 21

Zooming in on the page

The Layout toolbar controls your view of the scale and
position of the whole map (as opposed to the data layers on
the map). By default, the map size is set so you can see all
of it. But at this scale it�s hard to see the school name.

1. Click Zoom to 100% on the Layout toolbar. The page is
displayed at the actual printed size so you can see the
detail.

2. Click the Pan button on the Layout toolbar and drag the
map to the lower left so you can see the name of the
school.

7. Click OK. The page display and rulers change to reflect
the new size and orientation.

3

6

5

74 1

2
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22 USING ARCMAP

3. Click the Zoom Whole Page button on the Layout
toolbar to see the entire page again.

Inserting map elements

ArcMap makes it easy to add titles, legends, North arrows,
and scale bars to your map.

1. Click Insert on the Main menu and click Title. In the
box that appears, type the title for your map, �Schools
and Noise Contour�, and press Enter.

3
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QUICK-START TUTORIAL 23

2. On the Draw toolbar at the bottom of the window, click
the Text Size dropdown arrow and click 36 to change
the title to 36 points.

3. Click on the title and drag it so it�s centered at the top of
the map.

The Draw toolbar lets you add and change the format
(font, size, color, and so on) of text and graphic
elements�such as boxes, callout lines, or circles�on
your map.

4. Click Insert and click Legend.

The Legend Wizard appears.

5. Click Next several times to step through the wizard
accepting the default legend parameters. Click Finish
when done.

3
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24 USING ARCMAP

By default, ArcMap scales the legend to the page and
includes all the layers that are currently displayed. You
can modify the legend by right-clicking it and choosing
Properties from the menu that appears. For now, just use
the default legend.

6. Click and drag the legend to the lower-left corner of the
map.

7. Click Insert and click North Arrow. The North Arrow
Selector window appears.

8. Click ESRI North 1 and click OK. Click and drag the
North arrow so it is to the right of the legend.
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QUICK-START TUTORIAL 25

9. Now insert a scale bar from the Insert menu. Click Scale
Line 1 in the Scale Bar Selector window and click OK.

10.Click and drag the scale bar under the legend and North
arrow.

11.Click the legend to select it, then click the scale bar
while holding down the Shift key to select it as well.

12.Click Drawing on the Draw toolbar, point to Align, and
click Align Left from the menu that appears. The scale
bar is now aligned with the left side of the legend.
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Printing a map

At this point, your first map is finished. If you have a
printer connected to your computer, you can print the map.

1. Click File and click Print.

2. If the map (which is 16 by 12 inches) is larger than your
printer paper, click Scale map to fit printer paper.

3. Click Setup.

4. Click Landscape on the Printer Setup panel.

5. Click OK to close the Page Setup window.

3
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6. Click OK on the Print window to print your map.

Saving a map

Save your map in the folder with the tutorial data. First,
though, specify that ArcMap use the full pathname of the
location of the data on your system (the airport map was
created using relative pathnames so ArcMap would find
and display the data after the ArcTutor\Map folder was
copied to your system).

1. Click File and click Map Properties.

2. Click Data Source Options on the Properties dialog box.

3. Click Store full path names and click OK.

4. Click OK on the Map Properties dialog box.

Now save a copy of your map. You�ll use this copy in the
subsequent exercises.

1. Click File and click Save As.

2. In the File name box, type airport_ex.

3. Click Save.

You can continue on with the tutorial or stop and complete
it at a later time.

2
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Exercise 2: Working with geographic features

In this exercise, you�ll map the amount of each land use
type within the noise contour. You�ll add data to your map,
draw features based on an attribute, select specific features,
and summarize them in a chart.

If necessary, start ArcMap, navigate to the folder where
you saved the map from Exercise 1 (airport_ex), and open
the map.

Changing the page layout

First, you�ll create the map layout by changing the page
size and orientation.

1. Make sure you�re in layout view (click the View menu
and click Layout View).

2. Click File and click Page Setup.

3. Click the Standard Page Sizes dropdown arrow and
click E. That sets the width and height to a standard E-
size page.

4. Click Portrait on the Map Size panel.

5. Uncheck Scale map elements proportionally to changes
in page size (this way, the existing map of schools will
remain the same size, rather than being scaled up to fit
the page).

3
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6. Click OK. The page size changes, and the existing map
is displayed in the lower-left corner.

7. Click the Select Graphics button on the Tools toolbar.

8. Click and drag a box around the elements to select them.

9. Click and drag the group of elements to the upper
portion of the page.

For more information on page layout, see Chapter 8,
�Laying out and printing maps�.

7
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Creating a new data frame

A data frame is a way of grouping a set of layers you want
to display together. Now you�ll add a new data frame to
show land use.

1. Click Insert and click Data Frame.

The frame appears on the layout and is listed in the table
of contents.

2. Right-click New Data Frame in the table of contents and
click Properties.

3. Click the General tab, highlight the existing text in the
Name text box, and type Land Use.

4. Click the Units dropdown arrows and set the Map and
Display units to feet.

3

4
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5. Click the Size and Position tab.

6. Set the X position to 15 and the Y position to 15 by
typing in the text boxes. This sets how far the lower-left
corner of the data frame is, in inches, from the lower-
left corner of the page. (You can specify X,Y position
for another location on the data frame by clicking the
appropriate box on the diagram.)

You can specify the position of any object on the page�
the data frame itself, text, legends, and so on�either by
selecting and dragging them or by setting the X and Y
position explicitly.

7. Click OK. The data frame is repositioned.

The data frame is highlighted with a blue square, and its
name is bold in the table of contents, indicating it is the
frame you�re currently working with.

8. Hold down the Shift key and click the top data frame on
the page so both frames are selected.

9. Click Drawing on the Draw toolbar, point to Distribute,
and click Make Same Size.

5
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Both data frames are now the same size.

 Adding a data layer

You�ll map land use based on a code for each land parcel.
First, add the parcels layer to the data frame.

1. Click the Land Use data frame on the page, so that only
it is selected.

2. Click the Add Data button on the Standard toolbar.

3. Navigate to the Map folder on the local drive where you
installed the tutorial data (the default installation path is
C:\ArcGIS\ArcTutor\Map).

4. Double-click the airport geodatabase, airport.mdb.

5. Click the parcels layer and click Add.

The data layer is added to the table of contents and
displays in the layout (the parcels may be a different
color on your map).

1

Add Data
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All the data used in this tutorial is stored in a geodatabase.
ArcMap also lets you work with ArcInfo coverages,
shapefiles, image files, and many other data formats. For
more about geodatabases and other data formats, see Using
ArcCatalog.

Copying a layer

You�ll want to display the noise contour and airport area
with the parcels. You can copy them from the Schools data
frame. First, though, switch back to data view.

1. Click the View menu and click Data View. Now you�re
looking at only the area covered by the parcels, rather
than at the entire map.

2. Right-click the airport_area layer under the Schools data
frame and click Copy.

3. Right-click the Land Use data frame name and click
Paste Layer(s).

4. Copy the cnel65 layer the same way.
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Displaying features by category

By default, all the parcels are drawn using the same symbol
when you add them. You can also draw them based on an
attribute (in this case, type of land use).

1. Right-click parcels in the table of contents and click
Properties.

2. Click the Symbology tab. All parcels are currently
drawn using the same symbol (the same solid fill color).

3. Click Categories in the Show box. Unique values is
automatically highlighted.

4. Click the Value Field dropdown arrow and click
LAND_USE as the field to use to shade the parcels.

5. Click Add All Values. A unique color is assigned to each
land use type.

6. Click OK. The parcels are now drawn based on their
land use type.

3 4
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Using a style

ArcMap uses a random set of symbols to draw the land use
types (although you can change the color scheme). You can
change an individual color by double-clicking it and
specifying a new color in the Symbol Selector, or you can
specify a style to use predefined colors and symbols (a
style is a set of symbols stored in ArcMap, often specific to
an application or industry). ArcMap provides some
standard styles. You can also create your own. You�ll use a
land use style created for this tutorial.

1. Right-click parcels in the table of contents and click
Properties.

2. Click the Symbology tab.

3. Under Categories in the Show window, click Match to
symbols in a style.

4. Click the Browse button and navigate to the Map folder
on the local drive where you installed the tutorial data
(the default installation path is
C:\ArcGIS\ArcTutor\Map). Click the land_use style and
click Open.

5. Click Match Symbols.

6. Click OK. The parcels will now be drawn using colors
defined in the style.

For more information on symbolizing and displaying
features, see Chapter 6, �Symbolizing your data�.

3 4
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Selecting features geographically

To find out how much of each land use is within the noise
contour, select only those parcels within the contour.

1. Click Selection and click Select By Location.

The Select By Location dialog box guides you through
creating a geographic query.

2. In the first box, click the dropdown arrow and click
select features from.

3. In the second box, check parcels as the layer to select
features from.

4. Click the dropdown arrow for the third box and click
intersect. This will select those features in parcels that
intersect the features of cnel65.

5. In the last box, click the dropdown arrow and click
cnel65 as the layer to select by.

6. Click Apply. The selected parcels are outlined in a thick
line.

7. Close the Selection window. Notice that any parcel even
partially inside the contour is included.

For more on selection, see Chapter 13, �Querying maps�.

6
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Exporting a layer

To find out how many parcels and how much land area of
each land use type are within the noise contour, you�ll
create a new feature class and run statistics on its data
table.

1. Right-click parcels in the table of contents, point to
Data, then click Export Data.

2. In the Export Data dialog box, click the Export
dropdown arrow and click Selected features (to export
only the selected parcels).

3. Save the selected features in the airport geodatabase as a
feature class called parcels_sel. Type the path as shown
below, substituting the install location of the tutorial
data on your system. (The default installation path for
the geodatabase is
C:\ArcGIS\ArcTutor\Map\airport.mdb.)

4. Click OK. ArcMap exports the parcels to a new feature
class in the airport geodatabase.

5. Click Yes when prompted to add the exported data as a
new layer on the map. The new layer contains only the
selected parcels.

6. Right-click the original parcels layer, point to Selection,
then click Clear Selected Features.

2
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7. The new layer is displayed on top of the other layers. To
see the noise contour and airport area, click parcels_sel
in the table of contents and drag it down until the bar is
above parcels. Then, release the mouse button.

Creating summary statistics

ArcMap includes tools for statistical analysis. You�ll create
a table to summarize the number of parcels of each land
use type within the noise contour and the total area of each
type.

1. In the table of contents, right-click the parcels_sel layer
and click Open Attribute Table.

2. Right-click the LAND_USE field header and click
Summarize.
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3. Make sure the field to summarize is LAND_USE.

4. Click the plus sign next to Shape_Area to expand it.
Check Sum to summarize the area by land use type.

5. Create the output table in the airport geodatabase and
name it lu_frequency.

6. Click OK. ArcMap creates a new table with a record for
each land use type showing the number of parcels of
that type and the total land area (in square feet).

7. Click Yes when prompted to add the resulting table to
the map.

Opening a table

You may have noticed that when the table is added to the
map, the table of contents switches from the Display tab to
the Source tab (at the bottom of the table of contents). The
Source tab shows the location of all data in the table of
contents; this is useful when editing data in ArcMap
because it shows you which layers are in the same
workspace. (When you edit in ArcMap, you edit an entire
workspace; that is, all the layers in the workspace are
available for editing.) The Source tab also lists all tables.
Tables don�t show up when the Display tab is selected since
a table is not a geographic feature that gets displayed on the
map.

1. Right-click lu_frequency in the table of contents and
click Open. You can see the number of parcels and the
total area (in square feet) of each land use type.

2. Close the table window.
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Making a graph

Next you�ll create a column graph showing the number of
parcels of each land use type.

1. Click the Tools menu, point to Graphs, and click Create.
The Graph Wizard appears.

2. On the Graph Wizard dialog box, click the Column
graph and click Next.

3. Click lu_frequency as the table containing the data to
graph.

4. Make sure that Use selected set of features or records is
not checked.

5. Check the field Cnt_LAND_USE as the field to graph.

6. Click Graph data series using records and click Next.

7. Type in Land Use in Noise Contour as the title.

8. Check Label X Axis With and click LAND_USE as the
labeling field.

9. Uncheck Show Legend.

10.Check Show Graph on Layout and click Finish.

The graph appears on the layout. You can see that most of
the parcels are residential.
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W

11.Click the Select Graphics button on the Tools toolbar.

12.Click and drag the graph to the left of the parcel map.

13.With the graph still selected, hold down the Shift key
and click the land use map so both are selected.

14.Click the Drawing dropdown arrow on the Draw
toolbar, point to Align, and click Align Bottom to line
up the graph and map.

You can stop here or continue on with the next exercise.
Save your work by clicking Save on the File menu.
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Exercise 3: Working with tables

In this exercise, you�ll map population density for the
county. A population density map shows where people are
concentrated. First, you�ll add population data for each
census tract. Then you�ll calculate population density for
each tract and map it.

If necessary, start ArcMap, navigate to the folder where
you saved the map from Exercise 2 (airport_ex), and open
the map.

Creating a new data frame

As with the land use map, you�ll start by creating a new
data frame to display the data.

1. Switch to Layout view, if necessary (click View and
click Layout View).

2. Click Insert and click Data Frame.

3. In the table of contents, right-click New Data Frame 2
and click Properties.

4. Click the General tab and type Population Density in the
Name text box.

5. Click the Units dropdown arrows and set the Map and
Display units to feet.

6. Click the Size and Position tab.

4
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7. Set the X position to 9 and the Y position to 2.5.

8. Click OK.

9. Hold down the Shift key and click the middle data frame
(Land Use) on the page so both frames are selected.

10.Click Drawing on the Draw toolbar, point to Distribute,
and click Make Same Size.

The data frames are now the same size.

11.Click the Population Density data frame on the page so
it is the only one selected.

Adding data from ArcCatalog

You�ll add the layers you need by dragging them from
ArcCatalog�.

1. Start ArcCatalog by clicking the ArcCatalog button on
the Standard toolbar in ArcMap. Position the
ArcCatalog and ArcMap windows so ArcMap is visible
behind the ArcCatalog window.

ArcCatalog

7
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2. In ArcCatalog, navigate to the Map folder on the local
drive where you installed the tutorial data (the default
installation path is C:\ArcGIS\ArcTutor\Map).

3. Click the plus sign next to the Map folder to list the
contents.

4. Click the airport geodatabase icon to display the
contents in the right-hand panel.

5. In the right-hand panel, click arterials.

6. Hold down the Ctrl key and click tracts and airport_area
to select them as well. The layers are highlighted as you
select them.

7. Point to arterials, hold down the left mouse button, and
drag the pointer over the ArcMap layout view
(anywhere is fine).

8. Release the mouse button. All three layers are added to
the new data frame.

7
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9. Close ArcCatalog.

10.Right-click tracts in the ArcMap table of contents and
click Zoom To Layer. The map redraws to show all the
tracts and centers them in the data frame.

Adding tabular data

You also need to add the table containing the population
data to your data frame.

1. In ArcMap, click the Add Data button.

2. Navigate to the Map folder on the local drive where you
installed the tutorial data (the default installation path is
C:\ArcGIS\ArcTutor\Map) and double-click the airport
geodatabase.

3. Click tract_pop (the icon looks like a table).

4. Click Add. The table is added to the Population density
data frame in the table of contents. ArcMap activates the
Source tab so you can access the table.

Joining tables

The next step is to join the table containing the population
data to the census tract data table. You�ll do this using the
census tract ID as the common field.

1. Right-click tracts in the table of contents and click Open
Attribute Table to see the existing attributes including
the census tract ID.

1
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Now right-click tract_pop and click Open. The table
contains the TRACT_ID field and the population of
each tract.

Close the tables before proceeding with the join.

2. Right-click tracts in the table of contents again, point to
Joins and Relates, and click Join.

3. Click the dropdown arrow in the first text box and click
Join attributes from a table.

3
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4. Click the dropdown arrow in the next text box, scroll
down, and click TRACT_ID as the field in the layer to
base the join on.

5. Click the dropdown arrow in the next text box and click
tract_pop as the table to join to the layer.

6. In the next text box, click TRACT_ID as the field in the
table to base the join on.

7. Click OK to join the table to the layer.
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8. Right-click tracts and click Open Attribute Table. The
population value has been added to each tract.

Adding a field to an attribute table

In order to map population density, you�ll need to add a
new field to the tracts layer. You�ll use this field to store
the population density of each tract.

1. Click the Options button at the bottom of the attributes
of tracts window and click Add Field.

If a message appears indicating the table is in use by
another user, make sure you closed ArcCatalog.

2. In the Add Field dialog box, Type POP_DEN as the
field name.

3. Click the Type dropdown arrow and click Long Integer.

4. Click OK.

You should see the new field added to the attribute
table.
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The first part of the formula is entered for you
tracts.POP_DEN = . The full formula will look like this:

tracts.POP_DEN = [tracts_pop.POPULATION] /
([tracts.Shape_Area] / 27878400).

Dividing the area by 27,878,400 converts the area of
each tract, stored in square feet, to square miles. You
can type the formula right into the box or use the
buttons on the dialog. In this exercise, you�ll use both.

4. Click tract_pop.POPULATION in the Fields list.

5. Click the division symbol.

6. Type a space and a left parenthesis from the keyboard.

7. Click tracts.Shape_Area from the field list.

8. Click the division symbol.

9. Type a space and type 27878400.

10.Type a space and a right parenthesis from the keyboard.

11.Click OK.

Calculating attribute values

You�ll calculate the population density for each tract by
dividing the population by the area of each tract; this will
give you the number of people per square mile. To do this,
you�ll use the editing functions of ArcMap to edit the
census tract attributes (in Exercise 4 you�ll edit the
geometry of a feature).

1. Click the Editor Toolbar button on the Standard toolbar.
The Editor toolbar appears.

2. Click Editor and click Start Editing.

3. Right-click tracts.POP_DEN and click Calculate Values.
The Field Calculator appears.
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When the dialog box closes, you can see the population
density values for each tract in people per square mile in
the table.

12.Click the Editor menu on the Editor toolbar and click
Stop Editing.

13.Click Yes when prompted to save your edits.

14.Close the Editor toolbar and close the attribute table.

For more information on adding and calculating attributes,
see Chapter 10, �Working with tables�.

Classifying features by quantity

You can now map the tracts based on their population
density values to see where people are concentrated in
relation to the airport and to major roads.

1. Right-click tracts in the table of contents and click
Properties.

2. Click the Symbology tab. All tracts are currently drawn
using the same symbol (the same solid fill color).
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3. Click Quantities in the Show box. Graduated colors is
automatically highlighted.

4. Click the Value dropdown arrow and click
tracts.POP_DEN as the field to use to shade the tracts.

5. Click the Color Ramp dropdown arrow and click the
blue color ramp.

ArcMap chooses a classification scheme and the number of
classes for you. You can modify these by clicking the
Classify button in the Layer Properties dialog box. For
now, just use the default classification.

6. Click OK.

7. Click the Display tab at the bottom of the table of
contents.

8. Click arterials in the table of contents and drag it to the
top. Click airport_area and drag it so it is just below
arterials. Now these layers draw on top of the tracts.

43

5

9. Switch to data view to get a closer look at the tracts.
Click View and click Data View.

For more on classifying and displaying data, see Chapter 6,
�Symbolizing your data�.

You�ve now completed Exercise 3. You can continue on
with the next exercise or continue at a later time. Be sure to
save your map (click the File menu and click Save).
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Exercise 4: Editing features

You can use ArcMap to edit your data as well as create
maps. In this exercise you�ll extend the airport road to
create a new loop road joining up with an existing arterial
road. This exercise is a very brief introduction to editing,
which is covered in much more detail in Editing in
ArcMap.

If necessary, start ArcMap, navigate to the folder where
you saved the map from Exercise 3 (airport_ex), and open
the map.

Exporting data

You�ll be working with the schools data frame. First, make
a copy of the arterials data. That way, in case you need to,
you can start over again with the original data.

1. Switch to Data view (click the View menu and click
Data view).

2. Right-click the Schools data frame in the table of
contents and click Activate.

3. Right-click arterials, point to Data, and click Export Data.

4. Click the Export dropdown arrow and click All features.

5. Click Use the same Coordinate System as this layer�s
source data.

6. Save the new feature class as arterials_new in the airport
geodatabase (the default installation path is
C:\ArcGIS\ArcTutor\Map\airport.mdb).
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7. Click OK to export the data.

8. Click Yes when prompted to add the layer to the map.

Using Export makes a copy of the data itself. If you�d
chosen Copy from the menu, you�d be copying the layer,
which is only a pointer to the underlying data and
information about how the data is displayed.

Creating a new feature

You edit features in ArcMap using the Editor toolbar. All
the layers in a workspace are available for editing within
the same editing session. You specify which layer (the
�target�) new features will be added to.

1. Click the Zoom In button on the Tools toolbar and zoom
in to the area around the existing road and the road
you�re adding.

2. Turn off the cnel65 and airport_area layers by
unchecking the boxes next to them in the table of
contents so you can more easily see the existing roads.

2

Zoom in to
this area.
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2. Check the boxes for Edge and End for arterials_new.
This specifies that the new line you draw in the
arterials_new dataset will snap to existing lines (edges)
and endpoints of existing lines.

3. Close the Snapping Environment dialog box.

Digitizing a feature

1. Click the Target dropdown arrow and click
arterials_new : arterials_new as the feature class you
want to create new features in.

2. Click the Sketch tool on the Editor toolbar.

3. The pointer changes to a crosshair with a circle. Move
the mouse pointer over the end of the existing road�the
circle snaps to the end.

3. Click the Editor Toolbar button to display the Editor
toolbar.

4. Click the Editor menu and click Start Editing.

Setting snapping

Snapping lets you specify that new features connect to or
align with existing features.

1. Click Editor and click Snapping.

3
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4. Click to start the new road.

5. Move the mouse pointer back over the existing road and
right-click to display the context menu.

6. Click Parallel.

7. Move the mouse pointer in the direction you want the
new road to go (up and to the right). Right-click and
click Length.
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8. Type 900 (feet) and press Enter. ArcMap places a vertex
at the correct location.

9. Right-click again and click Tangent Curve.

10.Click the dropdown arrow in the upper box and click
Arc Length. Click in the box to the right and enter a
length of 400 (feet). In the lower box, click the
dropdown arrow and click Delta Angle. Click in the box
to the right and type 90 (degrees). Click the button next
to Right, if necessary. Then press Enter.

ArcMap draws the curve.
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11.Move the mouse pointer so it snaps to the existing road,
but don�t click the mouse. You want the next segment of
the new road to be parallel to the existing road.

12.Right-click and click Parallel. The line is constrained to
be parallel to the existing road.

13.To finish the road, move the mouse pointer over the
road you want the new road to intersect and make sure
the circle snaps to it. Double-click the left mouse button
to end the line.
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2

1

The new road is highlighted in a thick blue line.

Adding attributes to new features

You can also add the name of the new road.

1. Click the Attributes button on the Editor toolbar.

2. Click next to NAME on the list of attributes, type
AIRPORT DR, and press Enter.

3. Close the Attributes window.

4. Click the Editor menu and click Stop Editing. Click Yes
when prompted to save your edits.

5. Close the Editor toolbar.

ch2.p65 12/02/2000, 3:06 PM57



58 USING ARCMAP

6. Right-click arterials_new in the table of contents and
click Label Features. The road you added is labeled with
its name.

7. Turn the cnel65 and airport_area layers back on by
checking their boxes in the table of contents.

8. Switch to Layout view (click the View menu and click
Layout view). You can see that the road has been added
to your map.

9. You zoomed in for editing (when you switched to data
view), so type 1:28,000 in the Scale text box on the
Standard toolbar and press Enter to set the map scale.

Use the Pan tool on the Tools toolbar to place the noise
contour in the center of the map.

You can continue on with the final exercise or stop here. If
you stop, be sure to save your work so far (click the File
menu and click Save).
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Exercise 5: Working with map elements

In this exercise, you�ll add additional map elements to
complete your poster and print it.

If necessary, start ArcMap, navigate to the folder where
you saved the map from Exercise 4 (airport_ex), and open
the map.

Adding a background, titles, legends, and scale
bars

1. Switch to Layout view, if necessary (click View and
click Layout view).

2. Click the land use data frame on the page so it�s
highlighted. In the table of contents, uncheck the
parcels_sel layer so it�s not displayed (that way the map
will show the land use types within the noise contour).

4. Click the Frame tab. Click the Background dropdown
arrow and click Sand. Click OK.

3. Right-click the data frame and click Properties.

2

4
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8. Drag the title onto the land use data frame, as shown
below.

9. Click Insert and click Legend.

The Legend Wizard appears.

10.Click Next several times to step through the wizard
accepting the default legend parameters. Click Finish
when you�re done.

5. Click Insert and click Title.

6. Type �Land Use within Noise Contour� in the text box
and press Enter.

7. Click the Text Size dropdown arrow on the Draw
toolbar. Click 36 to make the title 36 point.

6

8
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11.Drag the legend to the lower-left corner of the data
frame, as shown below. Make it smaller by clicking the
upper-right handle and dragging it down and to the left.

12.Click Insert and click Scale Bar.

13.Click Scale Line 1 and click OK. Drag the scale bar
under the legend and make it smaller.

14.Now do the same for the Population Density data frame.
First click to select it. Set the background to Sand, make
the title read �Population Density�, and add a legend
and scale bar. Place the legend in the upper-left corner
of the data frame and place the scale bar in the lower-
left corner.

15.Click the Schools data frame to select it and set the
background to Olive.

16.You only need one North arrow since all maps are
oriented in the same direction. Click the North arrow in
the Schools data frame and enlarge it by dragging the
upper-right handle. Then drag the North arrow to the
lower-right corner of the page.

W

ch2.p65 12/02/2000, 3:09 PM61



62 USING ARCMAP

17.Click the Text tool on the Draw toolbar and click at the
top of the page. Type �Proposed Airport Expansion� as
the title and press Enter. Set the size to 72 point and
make the title bold by clicking the Bold button. Position
the title at the top and center of the page.

Adding drop shadows

You can add drop shadows to most of the graphic elements
on the layout page. Add a drop shadow to each data frame.

1. Click on the Population Density data frame to activate
it.

2. Right-click the Population Density data frame and click
Properties.

3. Click the Frame tab.

4. Click the Drop Shadow dropdown arrow and click Gray
30%.

5. Type 50 for the X Offset and -50 for the Y Offset.

6. Click OK.

4

5 6
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7. Repeat the steps above to add drop shadows to the
Schools and Land Use data frames. When finished, your
map should look like this:

Adding a neatline

1. Click Insert and click Neatline.

2. Click Place inside margins.

3. Type in a gap of 36 points. This places the neatline
about one-half inch inside the margin of the page.

4. Click the Border dropdown arrow and click a border
size of 3.0 points.

5. Click OK. Your map should look like this.

4

2

3

5
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Printing a map

Your map is finished. You can print it if you have a printer
connected to your computer. If your printer doesn�t print
the full size (34 by 44 inches), you can scale the map down
to fit your printer.

1. Click the File menu and click Print.

2. If the map is larger than the printer paper, click Scale
map to fit printer paper. (Tile map to printer paper will
print the map at full scale on separate sheets of paper so
you can paste them together to display the full map.)

3. Click Setup.

4. Click Portrait on the Printer Setup panel.

4

2

3
5. Click OK on the Page Setup dialog box, then click OK

on the Print dialog.

For more information on adding graphics to your map, see
Chapter 7, �Labeling maps with text and graphics�. For
more on map layout and composition, see Chapter 8,
�Laying out and printing maps�.

In this chapter, you�ve been introduced to many of the
basic ArcMap tasks you�ll often use. The rest of this book
provides more detail on these tasks and shows you many
more tasks you can perform using ArcMap.
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A map is the fundamental component you work with in ArcMap. Maps help
you visualize geographic data by showing you where things are, telling you
what they are, and helping you understand why they are that way.

Maps serve a variety of purposes. Some maps are interactive and meant to be
browsed online, while others are formatted for printing or embedding in
another application such as a word processor. Every map can have a unique
look�including both its graphic layout and interface�tailored to those who
will ultimately use the map.

Maps are documents stored on disk and managed with ArcCatalog. Through
ArcCatalog, you can find the map you want to work with and open it in
ArcMap. Once your map is open, you might browse its contents, edit the
geographic data it contains, or prepare it for printing by arranging map
elements, such as titles, North arrows, legends, and scale bars, around the
data in a visually pleasing manner. When you�re through working with the
map, you can save the document.

Whether you�re building a map or just looking at one, you can make it show
exactly what you want. For instance, you can choose what geographic data
you want to see, focus on a particular geographic area and display it at a
specific scale, and query features to find out about them and explore their
relationship to other features. When you�re finished, you can give the map to
someone else to look at.
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You display geographic information on a map as layers, where each layer represents a particular type of feature such as streams, lakes,
highways, political boundaries, or wildlife habitats. A layer doesn�t store the actual geographic data; instead, it references the data
contained in coverages, shapefiles, geodatabases, images, grids, and so on. Referencing data in this way allows the layers on a map to
automatically reflect the most up-to-date information in your GIS database.

The table of contents lists all the layers on the map and shows what the features in each layer represent. The check box next to each
layer indicates whether it is currently turned on or off, that is, whether it is currently drawn on the map or not. The order of layers within
the table of contents is also important; the layers at the top draw on top of those below them. Thus, you�ll put the layers that form the
background of your map, such as the ocean, at the bottom of the table of contents.

Layers, data frames, and the table of contents

Table of contents

A layer displays geographic
features and defines how it’s

drawn on the map.

Click here to add a layer to the map.

The Cities layer draws on
top of all other layers.
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Layers in the table of contents can be further organized into data frames. A data frame simply groups, in a separate frame, the layers
that you want to display together. You always get a data frame when you create a map; it�s listed at the top of the table of contents as
�Layers�, but you can change the name to something more meaningful if you like. For many of the maps you make, you won�t need to
think much more about data frames; you�ll just add layers to your map and, depending on how you order them in the table of contents,
some layers will draw on top of others. You will want to think more about data frames�and adding additional ones�when you want to
compare layers side by side or create insets and overviews that highlight a particular location or attribute, as shown in the map below.

When a map has more than one data frame, one of them is the active data frame. The active data frame is the one you�re currently
working with. For example, when you add a new layer to a map, it is added to the active data frame. You can always tell which data
frame is active because it�s highlighted on the map and its name is shown in bold text in the table of contents. Of course, if a map has
only one data frame, it�s always the active one.

The active data frame is
highlighted with bold text.

Use additional data frames to
display layers in separate

frames on the map.
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Starting ArcMap
Starting ArcMap is the first step
to exploring your data. However,
before you can start, ArcMap
must be installed on your
computer or network. If you
don�t know whether it�s installed
yet, check with your system
administrator or install it yourself
using the installation guide.

Once the software is installed,
you can access ArcMap from the
Start button on the Windows
taskbar. Each ArcMap session
can display one map at a time.
You can work with several maps
by starting additional ArcMap
sessions.

After you first start ArcMap, you
can decide whether or not you
want to see the splash screen and
Startup dialog box. If you don�t
want to see these, you can easily
turn them off.

Tip

Starting ArcMap by open-
ing an existing map
Double-clicking a map in
ArcCatalog or the Windows
Explorer will launch ArcMap and
display the map.

Starting ArcMap from the
Start menu

1. Click the Start button on the
Windows taskbar.

2. Point to Programs.

3. Point to ArcGIS.

4. Click ArcMap.

Starting ArcMap from
ArcCatalog

1. Click the Launch ArcMap
button.

1

2

3

4

1
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Turning on the splash
screen

1. Click the Tools menu and
click Options.

2. Click the Application tab.

3. Check Show splash screen.

4. Click OK.

Turning on the Startup
dialog box

1. Click the Tools menu and
click Options.

2. Click the Application tab.

3. Check Show startup dialog.

4. Click OK.

3

3

4

4
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The ArcMap window

Browse a map with
the Tools toolbar.

Frequently used commands, such as Open, Save,
Print, Undo, and Add Layers, are on the Standard
toolbar.

Use these buttons to quickly switch
between data view and layout view.

 The table of contents
lists the layers on the

map. To see more of the
map, drag the table of

contents off.

Add map elements with
the Draw toolbar.
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Opening a map
To work on a map, you open it in
ArcMap. If you know its location
on disk, you can navigate to it
with ArcCatalog and open it in
ArcMap. If you already have
ArcMap running, you can open it
directly within that session.

If you�re not sure where your
map is located, use ArcCatalog to
find it by browsing for it in the
folders in your database. Because
ArcCatalog lets you preview a
map before you open it, you�ll
always open the right one.

A map doesn�t store the spatial
data displayed on it. Instead, it
stores references to the location
of these data sources�for
example, geodatabases, cover-
ages, shapefiles, and rasters�on
disk. Thus, when you open a
map, ArcMap checks the links to
the data. If it can�t find some
data�for instance, if the source
data for a layer has been deleted
or renamed, or a network drive is
not accessible�ArcMap lets you
locate it. If the data is currently
unavailable, you can ignore the
broken link and display the map
without the layer. The layer will
still be part of the map and listed
in the table of contents; it simply
won�t display.

Opening a map from
ArcCatalog

1. Start ArcCatalog if it isn’t
already running.

2. In ArcCatalog, navigate to the
folder that contains your map.

3. Click the Thumbnails button
to get a look at the maps the
folder contains.

4. Double-click the map to open
it in ArcMap.

4

Opening a map from
ArcMap

1. Click the Open button on the
Standard toolbar.

2. Click the Look in dropdown
arrow and navigate to the
folder that contains the map.

3. Click the map you want to
open.

4. Click Open.

2

3

3

4

1

2
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Opening a recently
opened map

1. Click the File menu on the
Standard toolbar.

2. Click a map from the list of
recently opened maps.

Tip

Working on one map at a
time
You can only work on one map at a
time in an ArcMap session.
ArcMap will close any open map
before opening another one.

Tip

Why does the interface
change when I open a
map?
Every map can have its own
interface. Anytime you change a
map�s interface�for example,
move a button, add a button to a
toolbar, or create your own
toolbar�you can save the change
to the map. Not only can you make
a map look the way you want, you
can also tailor the interface to
work the way you want.

Tip

Running multiple ArcMap
sessions
Double-clicking a map in
ArcCatalog will always open that
map in its own ArcMap session.
You can also double-click a map in
Windows Explorer to open it.

Opening a map from the
Startup dialog box

1. Start ArcMap.

2. Click to open an existing
map.

3. Click OK.

4. In the dialog box that ap-
pears, click the Look in
dropdown arrow and navigate
to the folder that contains the
map.

5. Click the map you want to
open.

6. Click Open.

See Also

For more information on creating
maps, see Chapter 4, �Creating
maps�.

3

2

5

6

2

4
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Using the table of
contents
Every map has a table of
contents. The table of contents
shows you what layers the map
contains and also how the map
presents the geographic features
in those layers.

Some maps display all the layers
in one data frame. Others, such
as those with insets and over-
views, will have more than one
data frame. The table of contents
shows how the layers are
organized into data frames.

When viewing a map, you�ll use
the table of contents primarily to
turn layers on and off. As you
begin building your own maps,
you�ll find that the table of
contents is the focal point for
many tasks, such as adding and
deleting layers and determining
how to draw layers.

You can choose to display the
table of contents with either the
Display or Source tab. Use the
Source tab while editing to see
how your data is organized into
workspaces.

Showing the table of
contents

1. Click the View menu on the
Standard toolbar.

2. Click Table Of Contents.

Turning a layer on or off

1. In the table of contents,
check the box next to the
layer’s name.

The layer should appear on
your map. If you can’t see the
layer, it may be hidden by
another layer or display only
at a particular scale.

Tip

Need to see more of your
map?
You can drag the table of contents
off the ArcMap window.

1

2

1
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Showing a layer’s legend

1. Click the plus or minus sign
to the left of the layer name in
the table of contents to show
or hide its legend.

Showing the contents of
a data frame

1. Click the plus or minus sign
to the left of the data frame in
the table of contents to show
or hide the list of layers it
contains.

Tip

Drawing layers
Double-click a layer in the table of
contents to see its properties. From
there you can change how you
draw the layer.

Tip

Changing colors
You can quickly change the color
of a particular feature by right-
clicking on the color in the table of
contents.

1

1

Tip

Why isn’t my layer draw-
ing?
The layer may have a visible scale
range set. If you see a gray scale
bar underneath the layer�s check
box in the table of contents, it�s not
drawing because it�s outside of a
visible scale range. You�ll need to
zoom in or out to see it.

If you see a red exclamation point,
the link to the layer�s data source
is broken. Right-click the layer,
point to Data, and click Set Data
Source to fix the link.
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Looking at a map
in data view and
layout view
ArcMap provides two different
ways to view a map: data view
and layout view. Each view lets
you look at and interact with the
map in a specific way.

When you want to browse the
geographic data on your map,
choose data view. Data view is an
all-purpose view for exploring,
displaying, and querying the data
on your map. This view hides all
the map elements on the layout�
such as titles, North arrows, and
scale bars�and lets you focus on
the data in a single data frame,
for instance, to do editing or
analysis.

When you�re preparing your map
to hang on the wall, put in a
report, or publish on the Web,
you�ll want to work with it in
layout view. Layout view is for
laying out your map. In layout
view, you�ll see a virtual page
upon which you can place and
arrange map elements. In layout
view, you can do almost every-
thing you can in data view, plus
design your map.

Switching to layout view

1. Click the View menu on the
Standard toolbar.

2. Click Layout View.

The ArcMap window displays
the entire map.

Switching to data view

1. Click the View menu on the
Standard toolbar.

2. Click Data View.

The ArcMap window displays
the active data frame.

21

21

You can also use these buttons to quickly switch
between the data and layout view.
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Moving around the
map
As you work with a map, you can
easily change how you view the
data it contains. When you�re just
browsing a map, you might want
to pan and zoom around the data
to investigate different areas and
features. When you�re creating a
map to hang on the wall,
displaying data at a specific scale
may be important.

Most of the tools for navigating
your data are found on the Tools
toolbar.

Zooming in or out

1. Click the Zoom In or Zoom
Out button on the Tools
toolbar.

2. Move the mouse pointer over
the map display and click
once to zoom around a point.
Alternatively, click and drag a
rectangle defining the area
you want to zoom in or out
on.

See Also

For information on panning and
zooming the entire map page in
layout view, see Chapter 8,
�Laying out and printing maps�.

Panning

1. Click the Pan button on the
Tools toolbar.

2. Move the mouse pointer over
the map display and click and
drag the pointer.

Tip

Panning using the scroll
bars
In data view, you can also pan the
map by dragging the scroll bars.

1
Use these buttons to zoom
in or out a fixed amount.

1
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Zooming to the full extent
of the data

1. Click the Full Extent button
on the Tools toolbar.

Moving back or forward
one display

1. Click the Back or Forward
Extent buttons on the Tools
toolbar.

Tip

Panning and zooming in
maps with more than one
data frame
If your map has more than one
data frame, panning and zooming
will occur in the active data frame.
In layout view, clicking a data
frame will activate it.

1

1
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Zooming to a specific
scale

1. Type the desired scale on the
Standard toolbar.

Zooming to the extent of
a layer

1. Right-click the layers you
want to zoom to.

2. Click Zoom To Layer.

1

2

1

Tip

Why doesn’t a layer draw
when I zoom in or out?
The layer probably has a Visible
Scale Range set that prevents the
layer from displaying on the map
at certain scales. You can clear the
scale range by right-clicking on
the layer in the table of contents,
pointing to Visible Scale Range,
and clicking Clear Scale Range.

Tip

Selecting layers in the
table of contents
Click a layer to select it. Hold
down the Shift or Ctrl key to select
multiple layers.
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Setting bookmarks
A spatial bookmark identifies a
particular geographic location
that you want to save and refer to
later. For example, you might
create a spatial bookmark that
identifies a study area. That way,
as you pan and zoom around your
map, you can easily return to the
study area by accessing the
bookmark. You can also use
spatial bookmarks to highlight
areas on your map you want
others to see.

You can create a spatial book-
mark at any time.  As a shortcut,
you can also create bookmarks
when you find and identify map
features. Spatial bookmarks,
however, can only be defined on
spatial data; they can�t be defined
on an area of the page in layout
view.

Each data frame on your map
maintains its own list of book-
marks. In layout view, the list
reflects the bookmarks of the
active data frame.

Creating a spatial
bookmark

1. Pan and zoom the map to the
area for which you want to
create a bookmark.

2. Click the View menu, point to
Bookmarks, and click Create.

3. Type a name for the book-
mark.

4. Click OK.

Using a spatial bookmark

1. Click the View menu, point to
Bookmarks, and click the
name of the bookmark you
want to use.

The bookmarked display
appears.

3

1

2

4

1
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Creating a spatial
bookmark from the
Identify Results dialog box

1. Click the Identify button on
the Tools toolbar.

2. Click the mouse pointer over
the map feature to identify.

3. Right-click the identified
feature in the Identify Results
dialog box.

4. Click Set Bookmark.

The bookmark is named after
the feature.

Creating a spatial
bookmark from the Find
dialog box

1. Click the Find button on the
Tools toolbar.

2. Fill in the dialog box to find
the features you want.

3. Right-click the Value in the
Find Results list.

4. Click Set Bookmark.

The bookmark is named after
the feature.

3

1

4

1

3
4

2
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Removing a spatial
bookmark

1. Click the View menu, point to
Bookmarks, and click
Manage.

2. Click a bookmark.

3. Click Remove.

Tip

Removing more than one
bookmark at a time
Hold down the Shift key to select
more than one bookmark and click
Remove.

2

3

1
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Opening magnifier
and overview
windows
When you don�t want to adjust
your map display, yet you want to
see things a bit differently�see
more detail or get an overview of
an area�open another window.
ArcMap provides two additional
ways to explore the spatial data
on your map through an overview
and a magnifier window.

The magnifier window works like
a magnifying glass: as you pass
the window over the data, you
see a magnified view of the
location under the window.
Moving the window around does
not affect the current map
display.

The overview window shows you
the full extent of the data. A small
box in the overview window
represents the currently displayed
area on the map. You can move
this box around to pan the map
and also shrink or enlarge it to
zoom in or out.

Both windows operate only in
data view.

Opening an overview
window to pan and zoom
the map

1. Click the Window menu and
click Overview.

You must be viewing the map
in data view to display an
overview window.

2. Drag, shrink, or expand the
box in the overview window
to change the map display in
the active data frame.

Opening a magnifier
window and setting the
view

1. Click the Window menu and
click Magnifier.

You must be viewing the map
in data view to display a
magnifier window.

2. When the magnifier window
appears, drag it over the data
to see a magnified view.

3. Right-click the title bar and
click Snapshot to lock the
view.

1

2

3

1

2

ch3.p65 12/02/2000, 2:50 PM82



ARCMAP BASICS 83

Exploring data on a
map
Sometimes just looking at a map
isn�t enough. You need to query
data to solve problems. ArcMap
lets you explore the data on the
map and get the information you
need.

You can point at features to find
out what they are, find features
that have a particular characteris-
tic or attribute, examine all the
attributes of a particular layer,
and measure distances on the
map. Map Tips also provide a
quick way to browse map
features. Like ToolTips for
toolbar buttons, Map Tips pop up
as you pause the mouse pointer
over a feature.

See Also

For powerful ways to explore your
data, see Chapter 13, �Querying
maps�.

Identifying features by
pointing at them

1. Click the Identify button on
the Tools toolbar.

2. Click the mouse pointer over
the map feature you want to
identify.

The features in all visible
layers under the pointer will
be identified.

Displaying Map Tips

1. In the table of contents, right-
click the layer for which you
want to display Map Tips and
click Properties.

2. Click the Display tab and
check Show Map Tips.

3. Click the Fields tab.

4. Click the Primary display field
dropdown arrow and click the
attribute field you want to
display as the Map Tip.

5. Click OK.

6. Move the mouse pointer over
a feature to see the Map Tip.

Tip

I can’t see the Map Tips
If you can�t see Map Tips even
after you�ve enabled them, make
sure that the layer is turned on and
the features in the layer are not
being hidden by features in
overlapping layers.

1

2

2

2

3

4 5
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Viewing a layer’s
attribute table

1. In the table of contents, right-
click the layer for which you
want to display the attribute
table.

2. Click Open Attribute Table.

Finding features with
particular attributes

1. Click the Find button on the
Tools toolbar.

2. Type the string you want to
find in the Find text box.

3. Click the In layers dropdown
arrow and click the layer you
want to search.

4. Uncheck Find features that
are similar to or contain the
search string if the string
must match exactly.

5. Search for the string in all
fields, in a specific field, or in
the primary display field.

6. Click Find.

6

Tip

The primary display field
The primary display field is the
field that contains the name or
identifying characteristic of the
feature. For example, on a map of
the world, you might set the
primary display field to the field
that contains the country names.
The primary display field is set
through layer properties.

See Also

For more information on working
with attribute tables, see
Chapter 10, �Working with tables�.

1

2

1

2
3
4

5
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Measuring distance

1. Click the Measure button on
the Tools toolbar.

2. Use the mouse pointer to
draw a line representing the
distance you want to mea-
sure. The line can have more
than one line segment.

3. Double-click to end the line.

Tip

Do you want to measure
distance in kilometers,
miles, meters, or feet?
Each data frame can display
distance measurements using
whatever units you need. Set the
distance units on the General tab
of the data frame properties sheet.

1

2 3

The measurement displays here on the status bar.
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2

1

Getting help
A quick way to learn what
ArcMap can do is to get help
about the buttons and menu
commands you see on the
interface. After clicking the
What�s This? button, you can
click an item in the window to
display a popup description of it.

You can also get help in some
dialog boxes. When you click the
What�s This? button in the upper-
right corner and click an item in
the dialog box, a description of
the item pops up.

Much of the information in this
book is available in the online
Help system. The Help topics are
organized around the main tasks
you want to complete as well as
the concepts behind the tasks.

You can look up general Help
topics in the Help Contents. You
can search the Index for specific
tasks and issues. You can also
use the Find tab to look up Help
topics that have specific words or
phrases.

Getting help in the
ArcMap window

1. Click the What’s This? button.

2. With the Help pointer, click
the item in the ArcMap
window about which you want
more information.

3. Click anywhere on the screen
to close the Help description
box.

Getting help in a dialog
box

1. Click the What’s This? button.

2. With the Help pointer, click
the item in the dialog box
about which you want more
information.

3. Click anywhere on the screen
to close the Help description
box.

Tip

Another way to get help in
a dialog box
Sometimes a dialog box will also
have a Help button on the bottom;
clicking it opens a Help topic with
detailed information about the task
you�re trying to accomplish.

12
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Using the Help Contents
to get help

1. Click the Help menu and click
ArcGIS Help.

2. Click the Contents tab.

3. Double-click a book to see a
list of the topics in that
category.

Double-clicking an open book
closes its list.

4. Click the topic you want to
read.

Searching the Index for
help

1. Click the Help menu and click
ArcGIS Help.

2. Click the Index tab.

3. Type the subject about which
you want information.

4. Double-click the topic you
want to read.

If several topics are related to
your selection, the Topics
Found dialog box appears.
Simply double-click the topic
you want to read.

Tip

Tips for buttons and
menus
When you pause the mouse pointer
over a button, the button�s name
appears in a small box called a
ToolTip. When you position the
mouse pointer over a button or
menu command, a description of
what it does appears in the status
bar.

2

3

4

2

3

4
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Finding Help topics
containing specific words

1. Click the Help menu and click
ArcGIS Help.

2. Click the Search tab.

3. Type the word that should be
contained in the topics you
want to find.

4. Click List Topics.

5. Double-click the topic you
want to see.

2
3
4

5
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Saving a map

1. Click the Save button on the
Standard toolbar.

If you haven’t saved the map
before, you’ll need to provide
a name for it.

Tip

Opening a map will close
the current one
In ArcMap, you work with one map
at a time. If you need to work with
more than one, start another
ArcMap session.

Saving a map and
exiting ArcMap
After you finish working on a
map, you can save it and exit
ArcMap. You save a map as a
document and store it on your
hard disk. If you haven�t saved
the map before, you�ll need to
name it, preferably with one that
adequately describes its contents.
ArcMap automatically appends a
file extension (.mxd) to your map
document name.

The data displayed on a map is
not saved with it. Map layers
reference the data sources in your
GIS database. This helps to keep
map documents relatively small
in size. So if you plan to distrib-
ute your map to others, they�ll
need access to both the map
document and the data your map
references.

In general, it�s a good idea to
save your map periodically while
editing it just in case something
unexpected happens.

1

Saving a map as a new
map

1. Click the File menu and click
Save As.

2. Navigate to the location to
save the map document.

3. Type a file name.

4. Click the Save as type
dropdown arrow and click
ArcMap Documents.

5. Click Save.

1
2
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Exiting ArcMap

1. Click the File menu and click
Exit.

2. Click Yes to save any
changes, No to discard any
changes, or Cancel to
continue working on your
map.

Saving a map as a map
template

1. Click the File menu and click
Save As.

2. Navigate to the location to
save the map template.

3. Type a filename.

4. Click the Save as type
dropdown arrow and click
ArcMap Template.

5. Click Save.

Tip

Differentiating a map
template from a map
document
Map templates have a .mxt file
extension. Map documents have a
.mxd file extension.

1

2

543
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Creating maps 4
• Creating a new map

• Adding layers

• Adding coverages, shapefiles, and
geodatabases

• Adding data from the Internet

• Adding TINs as surfaces

• Adding CAD drawings

• Adding x,y coordinate data

• Adding route events

• About coordinate systems

• Specifying a coordinate system

• Referencing data on the map

Before you sit down to create a map, you need to think about its purpose.
What do you want your map to show? Does the map need to stand on its
own, or will it be part of a larger presentation? Who is the audience for the
map? Answering these and other similar questions will help you determine
how to organize and present the information on your map�for instance,
what level of detail you need to show; what colors and symbols you should
use to draw features; and whether you need to create an interactive map
people use at the computer, or one you simply print out and display on a
wall, or both.

The first step to creating a map is to locate the data you want to put on it.
Finding data may be as simple as using ArcCatalog to browse your
organization�s GIS database or the spatial data distributed with ArcMap. The
Internet is also an excellent resource for finding data�you can add data
directly from the Internet using the Geography NetworkSM Web site at
www.geographynetwork.com. Many government agencies distribute data to
the public at minimal or no cost. Commercial data vendors also package
data for a wide variety of applications, from business to natural resources. If
you have special data requirements, you might create your own data (see
Editing in ArcMap) or contact one of the many service bureaus or GIS
consulting companies that can produce data for you. Even if you don�t think
you have any spatial data, you just might.
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Creating a new
map
No matter what kind of map you
want to make, you begin the
same way�by creating a new
map document. You can either
create an empty map with
nothing on it or use a map
template as a starting point. Map
templates typically contain a
predefined page layout that
arranges map elements such as
North arrows, scale bars, and
logos on the virtual page. This
means you can just add your data
and immediately print the map.
Templates can also contain data
(as layers), special symbols and
styles, custom toolbars, and
macros such as VBA forms and
modules.

ArcMap comes with many
predefined templates to choose
from when making your maps.
Also, any map you make can be
saved as a template. Templates
provide an ideal method for
defining the standard maps your
organization needs.

Creating a new map from
the Startup dialog box

1. Start ArcMap.

2. Click to create a new empty
map, create a map from a
template, or browse for an
existing map.

3. Click OK.

Creating a new empty
map

1. Click the New button on the
Standard toolbar to create a
new empty map.

If you have a map open
already, you’ll be prompted to
save your changes.

3

2

1
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Using a map template

1. Click the File menu and click
New.

2. Click the tab that corresponds
to the type of map you want
to make.

The tabs you see will depend
on how you’ve organized
custom templates.

3. Click the template you want.

Some of the templates
included with ArcMap include
data. You can add your data
right on top.

4. Click Document to create a
new map document.

5. Click OK.

2

3

4 5

Tip

Organizing templates
You can create your own templates
and organize them into folders on
your computer. These folders
appear as tabs on the New dialog
(lower right). Create folders in the
\bin\templates folder where you�ve
installed ArcGIS�.

1
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Adding layers
Geographic data is represented
on a map as a layer. A layer
might represent a particular type
of feature, such as highways,
lakes, or wildlife habitats, or it
might represent a particular type
of data such as a satellite image,
a computer-aided design (CAD)
drawing, or a terrain elevation
surface in a triangulated irregular
network (TIN).

You don�t need to know much
about data to add a layer to a
map. Simply drag one from the
Catalog�or copy and paste one
from another map�onto the map
you�re working on. The layer will
draw as it was previously
symbolized.

A layer doesn�t store geographic
data itself; instead, it references
the data stored in coverages,
shapefiles, rasters, and so on.
Thus a layer always reflects the
most up-to-date information in
your database. If you don�t have
a layer, you can easily create one
as described on the following
pages. For example, you might
create several layers that
highlight different aspects of
your data and distribute them to
others in your organization.

Adding a layer from
ArcCatalog

1. Start ArcCatalog from the
Start menu.

2. Arrange the ArcCatalog and
ArcMap windows so that you
can see both on the screen.

3. Navigate to the layer you
want to add to the map.

4. Click and drag the layer from
ArcCatalog.

5. Drop the layer over the map
display in ArcMap.

The layer is copied to the
map. Any subsequent edits
made to the layer on disk will
not be reflected on this map.

3

4

Adding a layer from the
Add Data button

1. Click the Add Data button on
the Standard toolbar.

2. Click the Look in dropdown
arrow and navigate to the
folder that contains the layer.

3. Click the layer.

4. Click Add.

The new layer appears on
your map.

1

5

2

3

4
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Tip

To see a layer on a map,
you must have access to
its data source
Even though you have access to a
layer on disk, it won�t draw on
your map unless you also have
access to the data source the layer
is based on.

Tip

Adding a layer from the
Catalog
When you add a predefined layer
to your map from the Catalog, a
copy is placed on the current map.
Your current map will not change
if the original layer is modified.

Adding a layer from
another map

1. Open the map that contains
the layer you want to copy.

2. In the table of contents, right-
click the layer and click Save
As Layer File.

3. Click the Look in dropdown
arrow and navigate to the
folder where you want to
save the layer.

4. Type a name for the layer.

5. Click Save.

6. Click the Open button on the
Standard toolbar to open the
map you want to add the
layer to.

7. Click the Add Data button.

8. Click the Look in dropdown
arrow and navigate to the
folder that contains the layer.

9. Click the layer.

10.Click Add.

2

5

4

6

3

7

9

Q

8
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Adding coverages,
shapefiles, and
geodatabases
When you don�t have a pre-
defined layer at your disposal,
you can create one directly from
a data source such as a shapefile.
To create a layer, add the data
source to your map; ArcMap
creates a new layer that refer-
ences the data source.

Once a layer is part of a map, you
can decide whether or not to
display it, the scale at which it
should be visible, what features
or subset of features to display,
and how to draw those features.
You can also join other tabular
information you have about
features to the layer and group
layers so they appear as one layer
on the map.

The data you display on a map
comes in a variety of different
forms�for example, raster,
vector, and tabular�and is stored
in a variety of different formats.
If your data is stored in a format
supported by ArcMap, you can
add it directly to your map as a
layer. If your data isn�t stored in a
supported format, you can use
the data conversion utilities in
ArcToolbox� or other third party
data conversion products to
convert practically any data you
have and display it on a map.

Adding data in ArcMap

1. Click the Add Data button on
the Standard toolbar.

2. Click the Look in dropdown
arrow and navigate to the
folder that contains the data
source.

3. Click the data source.

4. Click Add.

ArcMap creates a new layer
on the map that references
the data source.

Adding data from
ArcCatalog

1. Start ArcCatalog from the
Start menu.

2. Arrange the ArcCatalog and
ArcMap windows so that you
can see both on the screen.

3. Navigate to the data source
you want to add to the map.

4. Click and drag the data
source from ArcCatalog.

5. Drop the data source over the
map display in ArcMap.

ArcMap creates a new layer
on the map that references
the data source.

3

4

5
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Displaying a subset of
the features in a layer
that meet some criteria

1. In the table of contents, right-
click the layer and click
Properties.

2. Click the Definition Query tab.

3. Type an expression or click
Query Builder.

The Query Builder lets you
create an expression to
identify the particular features
in the layer you want to
display. For example, you
might choose to display only
those cities with a population
greater than 1,000,000.

4. Click OK.

See Also

For more information on how to
draw a layer once you�ve added it
to a map, see Chapter 6, �Symbol-
izing your data�.

Tip

Creating a layer in
ArcCatalog
In addition to creating a layer on
the fly in ArcMap, you can create
one in ArcCatalog.

Tip

More than one layer can
reference the same data
source
When you create a layer, you
specify a data source that the layer
references.

1

2

4

3

See Also

For more information on the
syntax for building a Definition
Query expression, see Chapter 13,
�Querying maps�.
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Adding data from
the Internet
The Internet is a vast resource for
geographic data. Now you can
utilize this data directly on your
maps through Geography
Network and other Internet
servers.

Geography Network is a global
community of data providers
committed to making geographic
content available to the public.
Published from sites around the
world, Geography Network gives
you immediate access to the
latest maps, data, and related
services over the Internet. Use
Geography Network to search for
and explore maps and other
geographic content. When you
find what you want, add it
directly to your maps in ArcMap.

Geography Network is built
using ArcIMS�, allowing
member organizations to serve
their data over the Internet. Thus
the data you add to your maps is
accessed directly from the
organization providing the data.
While Geography Network
provides a centralized location
for accessing data, any organiza-
tion can publish their data using
ArcIMS and serve it over the
Internet to ArcMap. You can
connect to an Internet server
through ArcCatalog. u

Adding data through
Geography Network

1. Click the File menu and click
Add Data from Geography
Network.

2. Browse Geography Network
to find the data you want.

Geography Network allows
you to search, for example,
by data provider, data type,
and geographic extent. Once
you find data, you can read a
description of it, view it over
the Internet, and add it to
your map in ArcMap.

1
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Data served over the Internet�
whether through Geography
Network or not�looks like any
other layer on your map. There
are, however, a few differences
depending on how the host
organization decided to serve the
data.

ArcIMS provides two types of
map services, an image map
service and a feature map
service. An image map service
works by taking a snapshot of a
map on a server and delivering it
to you as an image. A feature
map service streams the actual
map features to you, providing
more sophisticated functionality
because the geographic features
are directly accessible by
ArcMap.

When you add an image map
service to ArcMap, you�ll see one
new layer on your map. You can
customize its appearance by
turning on or off the individual
sublayers it contains. Image map
services can serve as background
to your own data.

When you add a feature map
service to ArcMap, you�ll see a
new layer corresponding to each
of the layers in the feature map
service. You work with these
layers in the same way you work
with layers based on other data
sources. For example, you can
change their drawing order and
symbology or perform analysis.

Adding data through an
Internet server

1. Click the Add Data button on
the Standard toolbar.

2. Click the Look in dropdown
arrow and navigate to the
Internet Servers folder.

3. Double-click the server with
data you want to access.

If you don’t see the server
you want, double-click Add
Internet Server. For more
information on connecting to
an Internet server, see Using
ArcCatalog.

4. Click the Details button so
you can see which map
services are image map
services and which are
feature map services.

5. Click the ArcIMS feature class
you want to add.

6. Click Add.

ArcMap creates a new layer
on the map that references
the data source.

1 2
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Adding TINs as
surfaces
Data that varies continuously
across an area�elevation,
rainfall, and temperature�is
often represented on a map as a
surface. Surface data comes from
a variety of sources and in many
formats. Aerial photographs,
radar, sonar, and similar sources
generate information used to
build surfaces. This data is
processed into formats such as
SDTS raster profiles, USGS
DEMs, DTED grids, vector
coverages, and raw text files, all
of which you can convert into
TINs that display as surfaces on
your map.

A TIN is built from a series of
irregularly spaced points with
values that describe the surface at
that point (e.g., an elevation).
From these points, a network of
linked triangles is constructed.
Adjacent triangles, sharing two
nodes and an edge, connect to
form the surface.

A height can be calculated for
any point on the surface by
interpolating a value from the
nodes of nearby triangles.
Additionally, each triangle face
has a specific slope and aspect.
You can display any one of these
surface characteristics�slope,
aspect, and elevation�or the
internal structure of the TIN.

Adding TIN data in
ArcMap

1. Click the Add Data button on
the Standard toolbar.

2. Click the Look in dropdown
arrow and navigate to the
folder that contains the TIN
data source.

3. Click the TIN.

4. Click Add.

ArcMap creates a new layer
on the map that references
the TIN data source.

Adding TIN data from
ArcCatalog

1. Start ArcCatalog from the
Start menu.

2. Arrange the ArcCatalog and
ArcMap windows so that you
can see both on the screen.

3. Navigate to the TIN data
source you want to add to the
map.

4. Click and drag the TIN data
from ArcCatalog.

5. Drop the TIN data over the
map display in ArcMap.

ArcMap creates a new layer
on the map that references
the TIN data source.

3

4
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Adding CAD
drawings
If your organization has existing
CAD drawing files, you can use
these immediately on your maps.
You don�t need to convert the
data, but you do need to decide
how you plan to use the data.

If you simply want to see the
CAD drawing with your other
data, you can add the CAD
drawing as a layer for display
only. The entities will draw as
defined in the CAD drawing file.
Alternatively, if you want to
control how entities draw on the
map or perform geographic
analysis, you need to add the
CAD data as features ArcMap
can work with�specifically,
point, line, or polygon features.
When you browse for a CAD
drawing to add to your map,
you�ll see two representations of
the data: a CAD drawing file and
a CAD dataset. Use the drawing
file for display only and the
dataset for display and geo-
graphic analysis.

CAD drawing files typically store
different types of entities on
different layers in a drawing file.
One layer might contain building
footprints, another streets, a third
well locations, and a fourth
textual annotation. CAD drawing
files, however, do not restrict u

Adding a CAD drawing
from ArcCatalog

1. Start ArcCatalog from the
Start menu.

2. Arrange the ArcCatalog and
ArcMap windows so that you
can see both on the screen.

3. Navigate to the CAD drawing
you want to add to the map.

4. Click and drag the CAD
drawing from ArcCatalog.

5. Drop the CAD drawing over
the map display in ArcMap.

ArcMap creates a new layer
on the map that references
the CAD drawing.

3

4

5

Adding a CAD drawing in
ArcMap

1. Click the Add Data button on
the Standard toolbar.

2. Click the Look in dropdown
arrow and navigate to the
folder that contains the CAD
drawing.

3. Click the CAD drawing.

4. Click Add.

ArcMap creates a new layer
on the map that references
the CAD drawing.

1 2

3

4
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the type of entities you can have
on a drawing layer. Thus building
footprints might be on the same
drawing layer as streets. When
working with a CAD drawing as
features, you�ll likely add several
ArcMap layers from the same
CAD drawing file and adjust
what features display in those
layers.

Adding a CAD dataset for
display and analysis

1. Click the Add Data button on
the Standard toolbar.

2. Click the Look in dropdown
arrow and navigate to the
folder that contains the CAD
dataset.

3. Double-click the CAD dataset
and click the CAD feature you
want to add.

4. Click Add.

Only the subset of features in
the layer will display.

1

2

4
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Adding x,y
coordinate data
You don�t always have to have a
data source, such as a shapefile,
to add data to your map. If you
have some tabular data that
contains geographic locations in
the form of x,y coordinates, you
can add this to a map as well.

X,y coordinates describe discrete
locations on the earth�s surface
such as the location of fire
hydrants in a city or the points
where soil samples were col-
lected. You can easily collect x,y
coordinate data using a global
positioning system (GPS) device.

In order to add a table of x,y
coordinates to your map, the
table must contain two fields,
one for the x-coordinate and one
for the y-coordinate. The values
in the fields may represent any
coordinate system and units such
as latitude and longitude or
meters.

Once you have added the data to
your map, the layer behaves just
like any other feature layer. For
instance, you can decide whether
or not you want to display it,
symbolize it, set the visible scale,
or display a subset of features
that meet some criteria.

1

Adding a table with x,y
coordinates

1. Click the Tools menu on the
Standard toolbar and click
Add XY Data.

2. Click the table dropdown
arrow and click a table that
contains x,y coordinate data.
If the table is not on the map,
click the browse button to
access it from disk.

3. Click the X Field dropdown
arrow and click the field
containing x-coordinate
values.

4. Click the Y Field dropdown
arrow and click the field
containing y-coordinate
values.

5. Click Edit to define the
coordinate system and units
represented in the x and y
fields.

The x,y coordinates will be
automatically transformed to
match the coordinate system
of the data frame.

6. Click OK.

2

3 4
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Adding a route event

1. Click the Tools menu on the
Standard toolbar and click
Add Route Events.

2. Click the table dropdown
arrow and click a table on
your map or click the browse
button to find one on disk.

3. Click the type of route events
the table contains.

4. Click the dropdown arrow and
click the route key field.

5. Click the location field
dropdown arrow and click the
appropriate field.

There are two location fields
with line events.

6. Optionally, click the dropdown
arrow and click a lateral offset
field.

7. Click the layer dropdown
arrow and click the route
feature class or browse for
the route feature classes.

8. Click the dropdown arrow and
click the route key field.

9. Click OK.

Adding route
events
A route event is an attribute that
describes a portion of a route or a
single location on a route. Route
events are organized into tables
based on a common theme. For
example, route event tables for
highways might include speed
limits, year of resurfacing,
present condition, signs, and
accidents. Route events use route
and measure information to
reference the attributes of
particular locations in a route
feature class.

There are two types of route
events: point and line. Point
events occur at precise locations
along on a route. They are
referenced to a location along a
route using a single measure
value. Line events describe
portions of routes. They differ
from point events in that they use
two measure values to describe
the measure location of the event.

A route event table has at least
two fields: an event key and one
or more measure locations. The
event key field identifies the
route an event belongs to. A
measure location is either one or
two values describing the
positions on the route where the
event occurs.

1
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About coordinate systems

The features on a map reference the actual locations of the
objects they represent in the real world. The positions of objects
on the earth�s spherical surface are measured in degrees of
latitude and longitude, also known as geographic coordinates.
While latitude and longitude can locate exact positions on the
surface of the earth, they are not uniform units of measure; only
along the equator does the distance represented by one degree of
longitude approximate the distance represented by one degree of
latitude. To overcome measurement difficulties, data is often
transformed from the three-dimensional geographic coordinate
system to the two-dimensional planar surface in a projected
coordinate system. Projected coordinate systems describe the
distance from an origin (0,0) along two separate axes, a
horizontal x-axis representing east�west, and a vertical y-axis
representing north�south.

Because the earth is round and maps are flat, getting information
from the curved surface to a flat one involves a mathematical
formula called a map projection. A map projection transforms
latitude and longitude to x,y coordinates in a projected coordinate
system.

This process of flattening the earth will cause distortions in one
or more of the following spatial properties: distance, area, shape,
and direction. No projection can preserve all these properties
and, as a result, all flat maps are distorted to some degree.
Fortunately, you can choose from many different map
projections. Each is distinguished by its suitability for
representing a particular portion and amount of the earth�s
surface and by its ability to preserve distance, area, shape, or
direction. Some map projections minimize distortion in one
property at the expense of another, while others strive to balance
the overall distortion. As a mapmaker, you can decide which
properties are most important and choose a projection that suits
your needs.

Locations are expressed as latitude and longitude on a globe and as x,y
coordinates on a map.

Do you need to display your data with a projected
coordinate system?

If your spatial data references locations with latitude and
longitude�for example, decimal degrees�you can still display it
on your map. ArcMap draws the data by simply treating the
latitude/longitude coordinates as planar x,y coordinates. If your
map doesn�t require a high level of locational accuracy�if you
won�t be performing queries based on location and distance or if
you just want to make a quick map�you might decide not to
transform your data to a projected coordinate system. If,
however, you need to make precise measurements on your map,
you should choose a projected coordinate system.

Displaying the world using the sinusoidal projection (left) and the Robinson
projection (right).
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Reasons for using a projected coordinate system

� You want to make accurate measurements from your map and
be sure that spatial analysis options you use in ArcMap
calculate distance correctly. Latitude/Longitude is a good
system for storing spatial data, but not very good for viewing,
querying, or analyzing maps. Degrees of latitude and
longitude are not consistent units of measure for area, shape,
distance, and direction.

� You are making a map in which you want to preserve one or
more of these properties: area, shape, distance, and direction.

� You are making a small-scale map such as a national or world
map. With a small-scale map, your choice of map projection
determines the overall appearance of the map. For example,
with some projections, lines of latitude and longitude will
appear curved; with others they will appear straight.

� Your organization mandates using a particular projected
coordinate system for all maps.

What type of map projection should you choose?

Here are a few things to consider when choosing a projection:

� Which spatial properties do you want to preserve?

� Where is the area you�re mapping? Is your data in a polar
region? An equatorial region?

� What shape is the area you�re mapping? Is it square? Is it
wider in the east�west direction?

� How big is the area you�re mapping? On large-scale maps,
such as street maps, distortion may be negligible because your
map covers only a small part of the earth�s surface. On small-
scale maps, where a small distance on the map represents a
considerable distance on the earth, distortion may have a
bigger impact, especially if you use your map to compare or
measure shape, area, or distance.

Answering these questions will determine what map projection
and thus what projected coordinate system you�ll want to use to
display your data.

Map projections can be generally classified according to what
spatial attribute they preserve.

� Equal Area projections preserve area. Many thematic maps
use an equal area projection. Maps of the United States
commonly use the Albers Equal Area Conic projection.

� Conformal projections preserve shape and are useful for
navigational charts and weather maps. Shape is preserved for
small areas, but the shape of a large area such as a continent
will be significantly distorted. The Lambert Conformal Conic
and Mercator projections are common conformal projections.

� Equidistant projections preserve distances, but no projection
can preserve distances from all points to all other points.
Instead, distance can be held true from one point (or a few
points) to all other points or along all meridians or parallels. If
you will be using your map to find features that are within a
certain distance of other features, you should use an
equidistant map projection.

� Azimuthal projections preserve direction from one point to all
other points. This quality can be combined with equal area,
conformal, and equidistant projections, as in the Lambert
equal area azimuthal and the azimuthal equidistant
projections.

� Other projections minimize overall distortion but don�t
preserve any of the four spatial properties of area, shape,
distance, and direction. The Robinson projection, for
example, is neither equal area nor conformal but is
aesthetically pleasing and useful for general mapping.

For more information on coordinate systems, see Understanding
Map Projections.
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Specifying a
coordinate system
If all the data you want to display
on your map is stored in the same
coordinate system�for example,
you�re using your organization�s
database�you can just add it to a
map and not consider whether
the layers will overlay properly;
they will. If, however, you�ve
collected data from a variety of
sources, you�ll need to know
what coordinate system each
dataset uses to ensure ArcMap
can display them together.

When you add a layer to an
empty data frame, that layer sets
the coordinate system for the data
frame; you can change it later if
necessary. As you add subsequent
layers, they are automatically
transformed to the data frame�s
coordinate system as long as
there�s enough information
associated with the layer�s data
source to determine its current
coordinate system. If there isn�t
enough information, ArcMap will
be unable to align the data and
display it correctly. In this case,
you�ll have to supply the
necessary coordinate system
information yourself.

ArcMap expects coordinate
system information to be stored
with the data source. For a layer
in a geodatabase, this informa-
tion is part of the layer�s u

Finding out what
coordinate system your
data is currently
displayed with

1. Right-click the data frame that
you want to determine the
coordinate system of and
click Properties.

2. Click the Coordinate System
tab.

The details of the current data
frame coordinate system
display in the dialog.

1

2
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Tip

Changing the coordinate
system of a data frame
Changing the coordinate system of
a data frame does not alter the
coordinate system of the source
data contained in it.

See Also

For more information on coordi-
nate systems, see the book
Understanding Map Projections.

metadata. For coverages,
shapefiles, and rasters, it�s stored
on disk in a separate file named
after the data source but with a
.prj file extension (for example,
streets.prj). These files are
optional files; thus you may still
need to define the coordinate
system for one of these data
sources. You can create a .prj file
with ArcCatalog.

If no coordinate system informa-
tion is associated with a data
source, ArcMap will examine the
coordinate values to see if they
fall within the range: -180 to 180
for x-values and -90 to 90 for
y-values. If they do, ArcMap
assumes that these are geo-
graphic coordinates of latitude
and longitude. If the values are
not in this range, ArcMap simply
treats the values as planar x,y
coordinates.

Displaying data with a
predefined coordinate
system

1. Right-click the data frame that
you want to set the coordi-
nate system of and click
Properties.

2. Click the Coordinate System
tab.

3. Double-click Predefined.

4. Navigate through the folders
until you find the coordinate
system you want and click it.

5. Click OK.

All layers in the data frame
will now be displayed with
that coordinate system.

1

2

3

4

5
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Modifying the parameters
of a coordinate system

1. Right-click the data frame
whose coordinate system you
want to modify and click
Properties.

2. Click the Coordinate System
tab.

3. Click Modify.

4. Adjust the coordinate system
properties as appropriate.

5. Click OK.

6. Click OK on the Data Frame
Properties dialog.

1

2

6

4

5

3
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Setting the units for
reporting lengths and
displaying coordinates

1. Right-click the data frame
and click Properties.

2. Click the General tab.

3. Click the Map dropdown
arrow and click the appropri-
ate units.

The map units option is only
available when your data has
no coordinate system
information associated with it.

4. Click the Display dropdown
arrow and click the appropri-
ate units.

5. Click OK.

Tip

Do you want to see meters,
miles, or feet?
When you measure lengths or find
places by their coordinates, you
can choose what units you want to
use. Set the Display Units property
as needed.

1

2

3
4

5

Tip

Why can’t I set the map
units?
Map units are a property of the
coordinate system defined with
your data. You can change the map
units by modifying the coordinate
system. Right-click the data frame
containing your data and click the
Coordinate System tab. Here you
can modify the parameters of the
coordinate system.
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Referencing data
on the map
When you add a layer to your
map, ArcMap references the data
source the layer is based on.
When you save the map, the data
references are stored with it. The
next time you open your map,
ArcMap locates the data based
on the references. If ArcMap
can�t find a data source, you�ll
need to either locate the data
source yourself or ignore the
reference, in which case the layer
won�t be drawn.

If you plan on distributing your
maps to others, they�ll need
access to the data referenced on
it. If they have access to the
data�for example, data stored
on a server�they can simply
update the references to the data
if necessary. If they don�t have
access to the data, you�ll
probably have to distribute the
data with your map.

To help make it easier to
distribute data with your map,
ArcMap allows you to store
relative pathnames to data
sources referenced on a map.
This lets you, for example,
distribute your map and data in
the same directory. The refer-
ences stored in the map would be
correct regardless of where they
were placed on disk.

Storing relative
pathnames to data

1. Click the File menu and click
Map Properties.

2. Click Data Source Options.

3. Click Store relative
pathnames.

4. Click OK.

5. Click OK on the Map Proper-
ties dialog.

3

4

1

2

5
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Updating a link to a data
source

1. In the table of contents, right-
click the layer and click
Properties.

2. Click the Source tab.

3. Click Set Data Source.

4. Click the Look in dropdown
arrow and navigate to the
data source.

5. Click the data source.

6. Click Add.

2

3

4

5

6

1
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Managing layers 5
• Changing a layer’s text

description

• Changing a layer’s drawing order

• Copying layers

• Removing layers from the map

• Grouping layers

• Accessing layer properties

• Displaying a layer at certain
scales

• Changing the appearance of the
table of contents

• Using data frames to organize
layers

• Saving a layer to disk

• Repairing broken data links

You can think of a layer as a convenient way to access geographic data. A
layer defines how to display the geographic data it references and where that
data is located in your database. If you don�t know much about the
geographic data in your organization, you�ll likely just add prebuilt layers to
your maps. If you help maintain the geographic data, you�ll probably create
layers that effectively communicate information about the data for others to
use on their maps.

As you saw in the previous chapter, it�s easy to add layers to a map�you
simply drag them from ArcCatalog to your map. Once they are on your map,
you�ll typically organize them to make your map look the way you want it to.
You organize and manage layers through the table of contents. The table of
contents lets you control when the layer draws, how it draws, and in what
data frame on the map it appears. You can also remove layers, group them,
and save them to disk.

A layer at the top of the table of contents draws on top of those below it.
Thus, you�ll place layers that form the background of your map, such as an
ocean layer, at the bottom of the table of contents.
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Changing a
layer’s text
description
A few pieces of descriptive text
display beside each layer in the
table of contents. One text string
is the layer�s name and the others
describe what the features in the
layer represent, or more specifi-
cally, what the symbols in the
legend mean.

By default, when you add data to
a map, the resulting layer is
named after its data source.
Often, the name of the data
source is an abbreviated name
that doesn�t serve well as the
layer�s name on the map. You can
give a layer a more meaningful
name without changing the name
of the data source. This will
make it easier to understand what
layers are on the map.

When you draw the features of a
layer, you use the attribute values
in a particular field to symbolize
them. These attribute values
appear by default next to the
symbol in the table of contents.
As they don�t usually provide a
good text description of the
features in your layer either,
you�ll likely want to change them
as well.

Changing the name of a
layer

1. In the table of contents, click
the layer to select it.

2. Click again over the name.

This will highlight the name
and allow you to change it.

3. Type the new name and
press enter.

Changing map feature
descriptions

1. In the table of contents, click
the text you want to change.

2. Click again over the text
string.

This will highlight the string
and allow you to change it.

3. Type the new description and
press enter.

1

3

1

3
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Changing a
layer’s drawing
order
The order of layers in the table of
contents determines how layers
are drawn on a map. Within a
data frame, the layers listed at the
top will draw over those listed
below them, and so on down the
list. You can easily move layers
around to adjust their drawing
order or organize them in
separate data frames.

Moving a layer to change
its drawing order

1. In the table of contents, click
and drag the layer up or
down.

A black line indicates where
the layer will be placed.

2. Release the mouse pointer to
drop the layer in its new
position.

2
1
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Copying a layer to
another map

1. Right-click the layer you want
to copy to another data frame
and click Copy.

2. Click the Open button on the
Standard toolbar and open
the map you want to copy the
layer into.

3. Right-click the data frame you
want to copy the layer into
and click Paste Layer(s).

Copying layers
A quick way to build maps that
reference the same data source is
to copy and paste layers within a
map or between maps. For
example, suppose you want to
show the change in population
for an area over time. You can
add a layer to a map and display
it using one population attribute,
then copy the layer to another
map (or another data frame in the
same map) and display it using
the second population attribute.

Copying layers from a map to
disk is a convenient way to let
others access the layers you�ve
created. Once you�ve defined
how to draw a layer, that
information is saved with the
layer. Thus, anyone who adds the
layer to a map will see it exactly
as you created it.

Copying a layer between
data frames

1. Right-click the layer you want
to copy to another data frame
and click Copy.

2. Right-click the data frame you
want to copy the layer into
and click Paste Layer(s).

You can also drag and drop a
layer from one data frame to
another.

1

1

3

2

2

See Also

For information on copying a
layer to disk, see the section
�Saving a layer to disk� at the end
of this chapter.
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Removing a layer

1. In the table of contents, right-
click the layer you want to
remove.

2. Click Remove.

Removing several layers

1. In the table of contents, click
the first layer you want to
remove.

2. Hold down the Shift or Ctrl
key and click to select
additional layers.

3. Right-click the selection and
click Remove.

Removing layers
from the map
When you no longer need a layer
on your map, you can delete it.
Deleting a layer from a map
doesn�t delete the data source
upon which the layer is based.

Tip

Deleting a data source
You can delete a data source, such
as a coverage, in ArcCatalog.

2

1

2

1

3
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Grouping layers
When you want to work with
several layers as one layer, you
gather them together into a group
layer. For example, suppose you
have two layers on a map
representing railroads and
highways. You might choose to
group these layers together and
name the resulting layer �trans-
portation networks�.

A group layer appears and acts
like an individual layer in the
table of contents. Turning off a
group layer turns off all its
component layers. The properties
of the group layer override any
conflicting properties of its
constituent layers. For example, a
visibility scale range set on a
layer will be overridden by a
visibility scale range set on the
group layer. If you need to, you
can even create groups of group
layers.

You can still work with the
individual layers in the group.
For instance, you can change
how an individual layer is drawn,
adjust the scale it is displayed at,
and control whether or not it is
drawn as part of the group. You
can change the drawing order of
the group and add and remove
layers as needed.

Creating a group layer

1. Right-click the data frame you
want to create a group layer
in.

2. Click New Group Layer.

A new group layer appears in
the table of contents.

Adding layers to a group
layer

1. Double-click the group layer
in the table of contents to
display its properties.

2. Click the Group tab.

3. Click Add.

4. Click the Look in dropdown
arrow and navigate to the
data source you want to add
to the group.

5. Click the data source.

6. Click Add.

Tip: If the layer you want to
add to a group is already on
the map, you can drag and
drop it in the group.

2
1

3
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4
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2
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Tip

Changing the drawing
order of layers in a group
The layers listed at the top of a
group layer are drawn over those
beneath it. You can also drag and
drop the layer to a new position to
change the drawing order of the
group.

See Also

For information on how to draw
the individual layers in a group,
see Chapter 6, �Symbolizing your
data�.

Tip

Using ArcCatalog to create
group layers
You can also create your group
layer in ArcCatalog.

Changing the layer order
in a group layer

1. Double-click the group layer
in the table of contents to
display its properties.

2. Click the Group tab.

3. Click the layer you want to
move.

4. Click the appropriate arrow
button to move the layer up
or down.

5. Click OK.

Displaying the properties
of a layer in a group layer

1. Double-click the group layer
in the table of contents to
display its properties.

2. Click the Group tab.

3. Click the layer for which you
want to display properties.

4. Click Properties.

You can now modify the
layer’s properties, for
example, you can change the
drawing properties.

5. Click OK.

4

3

2
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Removing a layer from a
group layer

1. Double-click the group layer
in the table of contents to
display its properties.

2. Click the Group tab.

3. Click the layer that you want
to remove.

4. Click Remove.

5. Click OK.

Tip

Removing several layers
from a group layer
Hold down the Shift or Ctrl key to
select more than one layer in the
group. 4

3

2

5
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Accessing layer
properties
You control all aspects of a layer
through the layer�s properties.
From here, you can define how to
draw the layer, what data source
the layer is based on, whether to
label the layer, and what attribute
fields the layer contains.

Displaying layer
properties

1. In the table of contents, right-
click the layer and click
Properties.

2. Click the tab containing the
properties you want to adjust.

3. When finished, click OK.
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Displaying a layer
at certain scales
As long as a layer is turned on in
the table of contents, ArcMap
draws it, regardless of the map
scale. As you zoom out, it may
become harder to distinguish
features in layers that contain
more detailed information. While
you can turn a layer off, this may
be inconvenient, especially if
your map contains several layers
and you change scale frequently
as you work.

To help you automatically display
layers at the appropriate scale,
you can set a layer�s visible scale
range and define the range of
scales at which ArcMap draws
the layer. Whenever the scale of
the data frame is outside the
layer�s visible scale range, the
layer won�t draw. In this way,
you can control how the map
looks at various scales. For
example, you can hide a detailed
layer that might otherwise clutter
up your map when you zoom out.
Or, you can progressively display
more detailed layers as you zoom
in on an area, that is, as the scale
of the data frame gets larger.
Setting a visible scale range is
especially useful if you are
creating a map for others to use
because it makes browsing the
map easier.

Setting the minimum
visible scale for a layer

1. Right-click the layer in the
table of contents and click
Properties.

2. Click the General tab.

3. Click Don’t show layer when
zoomed.

4. Type a minimum scale for the
layer.

If you zoom out beyond this
scale, the layer will not be
visible.

5. Click OK.

Setting the maximum
visible scale for a layer

1. Right-click the layer in the
table of contents and click
Properties.

2. Click the General tab.

3. Click Don’t show layer when
zoomed.

4. Type a maximum scale for the
layer.

If you zoom in beyond this
scale, the layer will not be
visible.

5. Click OK.

2
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4

5

2

3

4

5

ch5.p65 12/04/2000, 11:10 AM124



MANAGING LAYERS 125

Clearing a layer’s visible
scale

1. Right-click the layer for which
you want to clear a visible
scale range.

2. Point to Visible Scale Range
and click Clear Scale Range.

Setting a visible scale
based on the current
scale

1. Adjust the data frame display
to the appropriate scale.

2. Right-click the layer for which
you want to set a visible
scale.

3. Point to Visible Scale Range
and click Set Maximum Scale
or Set Minimum Scale.

3

2

2

1

1

Tip

How to tell when a layer
has a visible scale range
set
If a layer isn�t drawing because it
has a visible scale range set, you�ll
see a gray scale bar under the
layer�s check box in the table of
contents.
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Setting the text font for
layers

1. Click the Tools menu on the
Standard toolbar and click
Options.

2. Click the TOC tab.

3. Uncheck Use Windows
Desktop Settings.

4. Click the Font dropdown
arrow and click the font you
want to use.

5. Click the Size dropdown
arrow and click the font size.

6. Click OK.

Changing the
appearance of the
table of contents
You can adjust the look of the
table of contents to suit your
needs. For example, you might
change the text size and font so
that it makes a greater visual
impact or is easier to read. Or,
you might want to change the
shape of the lines and patches
that represent the features on a
map.

The table of contents has two
tabs at the bottom, a Display tab
and a Source tab. The Display tab
shows the drawing order of the
layers and allows you to change
the order. The Source tab sorts
layers by where they�re stored on
disk. This is useful during
editing, when you edit all layers
in a given folder or database. If
you�re not planning on using
your map for editing, you can
hide the Source tab. You can�t
change the drawing order of
layers from the Source tab.

Setting the line and patch
for layer symbology

1. Click the Tools menu on the
Standard toolbar and click
Options.

2. Click the TOC tab.

3. Click the Line or Area
dropdown arrow and click the
appropriate shape.

4. Click OK.

3
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Showing the Display and
Source tabs

1. Click the Tools menu on the
Standard toolbar and click
Options.

2. Click the TOC tab.

3. Check the boxes to show the
Display and Source tabs.

4. Click OK.

3

2

4
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Using data frames
to organize layers
A data frame is simply a frame
on your map that displays layers.
When you create a map, it
contains a default data frame
listed in the table of contents as
�Layers�. You can immediately
add layers to this data frame and
give it a more meaningful name.

The layers in a data frame display
in the same coordinate system
and therefore may overlap. When
you want to display layers
separately and not have them
overlap�for example, to
compare layers side by side or
create insets and overviews that
highlight an area�add additional
data frames to your map. When a
map has more than one data
frame, one of them is the active
data frame. The active data frame
is the one you�re currently
working with, for instance,
adding layers to or panning and
zooming. The active data frame
is highlighted on the map in
layout view or is the displayed
data frame in data view. The
name of the active data frame is
also shown in bold text in the
table of contents.

Once on a map, a data frame acts
like any other map element. You
can change its size, move it
around, or delete it.

Adding a data frame

1. Click the Insert menu.

2. Click Data Frame.

The new data frame will
appear in the center of the
layout.

Making a data frame
active

1. Right-click the data frame in
the table of contents.

2. Click Activate.

You can also click the frame
in layout view to activate it.

1

2

2

1
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Removing a data frame

1. Right-click the data frame in
the table of contents that you
want to remove.

2. Click Remove.

In layout view, you can select
the data frame and press the
Delete key on the keyboard.

2

1

Tip

A map always has one data
frame
A map must have at least one data
frame on it. You can�t delete the
last data frame on a map.

Rotating the data in a
data frame

1. Click View on the Standard
toolbar, point to Toolbars, and
click Data Frame Tools.

2. Click the Rotate Data Frame
tool.

3. Click and drag the mouse
over the data frame to rotate
its contents.

Rotating the data in this
manner does not alter the
original source data, just its
display in the data frame.

1

2

Click and drag the mouse
to rotate the data in the
data frame.
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Saving a layer to disk

1. In the table of contents, right-
click the layer and click Save
As Layer File.

2. Click the Look in dropdown
arrow and navigate to the
location where you want to
save the layer.

3. Optionally, change the layer
name.

4. Click Save.

Saving a layer to
disk
One of the main features of a
layer is that it can exist as a file
in your GIS database. This makes
it easy for others to access the
layers you�ve built.

When you save a layer to disk,
you save everything about the
layer. When you add the layer to
another map, it will draw exactly
as it was saved. This is very
convenient when others at your
organization need to make maps
but don�t know how to represent
or access the data in your
database. All they need to do is
add the layer.

2

1

4

3

Tip

Layer filenames
The filename you provide when
you save a layer to disk does not
have to be the same as its name on
the current map. The layer name
on the map, not the layer filename,
will be displayed whenever the
layer is added to another map.
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Repairing broken
data links
When you first open a map,
ArcMap searches for the data
referenced by the layers on the
map. If it can�t find the data�for
example, the data has been
moved�the layer won�t display.
You can immediately tell which
layers on your map have broken
links because you�ll see a red
exclamation mark next to their
name in the table of contents. If
you know the new location of the
data, you can repair the link.

Tip

Storing relative pathnames
to data
If you plan on distributing your
maps to others, you might choose
to reference data using relative
pathnames. See the topic �Refer-
encing data on the map� in
Chapter 4.

Linking a layer to its data
source

1. Locate the layer with the
broken link in the table of
contents. It will have a red
exclamation mark next to it.

2. Right-click the layer, point to
Data, and click Set Data
Source.

3. Click the Look in dropdown
arrow and navigate to the
location of the data source.

4. Click the data source.

5. Click the Add button.

The link to the data source is
now updated.

3

1
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Symbolizing your data 6
• A map gallery

• Drawing all features with one symbol

• Drawing features to show
categories like names or types

• Managing categories

• Ways to map quantitative data

• Standard classification schemes

• Drawing features to show
quantities like counts or amounts

• Setting a classification

• Drawing features to show
multiple attributes

• Drawing features with charts

• Drawing TINs as surfaces

• Drawing CAD layers

• Advanced symbolization

Choosing how to represent your data on a map may be the most important
mapmaking decision you make. How you represent your data determines
what your map communicates.

On some maps, you might simply want to show where things are. The easiest
way to do this is to draw all the features in a layer with the same symbol. On
other maps, you might draw features based on an attribute value or
characteristic that identifies them. For example, you could map roads by type
to get a better sense of traffic patterns or map the wildlife habitat suitability
of a particular bird species, ranked from least to most suitable.

In general, you can draw map features as follows:

� With a single symbol

� To show a category such as a name (unique values maps)

� To represent a quantity such as population (graduated color, graduated
symbol, and dot density maps)

� To show multiple attributes that are related (multivariate and chart maps)

You can also draw these other data types:

� Images and rasters (see Chapter 14, �Working with rasters�)

� TINs representing a three-dimensional surface

� CAD drawing files

Browse the map gallery on the next few pages to see the various ways you
can symbolize your data.
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A map gallery

Single symbol map Unique values map

Drawing your data with just a single symbol gives you a sense of
how features are distributed�whether they�re clustered or
dispersed�and may reveal hidden patterns.

In the map above, you can easily see where people live and
conclude that some areas are more densely populated based on
the number of cities clustered together.

On a unique values map, you draw features based on an attribute
value, or characteristic, that identifies them. In the map above,
each land use type is drawn with a specific color. Typically, each
unique value is symbolized with a different color. Drawing
features based on unique attribute values shows the following:

� How similar features are distributed�whether they�re
grouped or dispersed

� How different feature types are located in relation to each
other

� How much of one category there is compared to other
categories
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Graduated color map Graduated symbol map

When you need to map quantities or amounts of things, you
might choose to use a graduated color map. Graduated color
maps have a series of symbols whose colors change according to
the values of the particular attribute. Graduated color maps are
most useful for showing data that is ranked (for example, 1 to 10,
low to high) or has some kind of numerical progression (for
example, measurements, rates, percentages).

The map above uses different shades of color�in a graduated
color ramp�to represent different amounts of people. Here,
darker shades indicate a greater number of people.

Another way to represent amounts of things is to vary the size of
the symbol a feature is drawn with. The graduated symbol map
above uses a larger symbol to show earthquakes with a larger
magnitude. Like graduated color maps, graduated symbol maps
are most useful for showing rank or progression of values.
However, instead of using color to represent the differences in
values, the size of the symbol varies.

When making a graduated symbol map, it is important to choose
the range of symbol sizes carefully. The largest symbols need to
be small enough that neighboring symbols don�t completely
cover one another. At the same time, the range in size from the
smallest to the largest needs to be great enough that the symbol
for each class is distinct.
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Multivariate map

The maps on the previous pages display one attribute, or
characteristic, of the data�for example, a name or an amount.
Multivariate maps display two or more attributes at the same
time. The map above illustrates the level of human impact on the
natural landscape of Australia. Major habitat types are shown
with unique colors, and the level of disturbance for each habitat
is shown with a graduated symbol. The larger the symbol, the
higher the human impact is on the particular habitat.

Chart map

Chart maps allow you to symbolize multiple attributes on one
map as well as communicate the relationship among different
attributes. Chart maps display charts�bar and pie charts�over
features. The map above shows you the volume and type of
goods distributed by an exporter throughout Asia.

Pie charts show relationships between parts and the whole and
are particularly useful for showing proportions and ratios. Bar
charts compare amounts of related values and are well suited to
showing trends over time. Stacked bar charts can show both the
relative relationship between data as well as allowing for absolute
comparisons.
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Raster map

Much of the most readily available geographic data is in the form
of rasters. A raster can represent almost any geographic features,
though most rasters you�ll work with in ArcMap will probably be
scanned maps or photographs of the earth�s surface. You might
add an aerial photograph to your map to provide a realistic
background to your other data, or you might use satellite imagery
to add up-to-the-minute information about weather conditions or
flood levels. You can even update your other data by using a
raster as a guide for editing.

For more information on displaying raster data, see Chapter 14,
�Working with rasters�.

Density map

Mapping the density of features lets you see the patterns of where
things are concentrated. This helps you find areas that require
action or meet some criteria. For example, the map above shows
where the highest concentration of crimes occurs in a city. Using
this map, the city may choose to increase the number of police
patrols in the areas of high density.

One way to map density is with a dot density map. This type of
map symbolizes features using dots drawn inside polygons to
represent a quantity. Each dot represents a specific value. For
example, on the crime map, each dot might represent five
incidents of crime. When creating a dot density map, you specify
how many features each dot represents and how big the dots are.
You may need to try several combinations of amount and size to
see which one best shows the pattern.
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Color-shaded relief map

One of the ways you can represent a continuous surface, such as
terrain elevation or temperature gradient, is to display the surface
as a color-shaded relief map. This type of map displays elevation
ranges in graduated colors and shades ridges, valleys, and
hillsides using a simulated light source. The shading adds a
realistic effect that makes the surface look as though you are
viewing it from high above. The combined use of color for
elevation and shading for surface morphology results in a highly
informative, yet easy to interpret, view of your surface.

Computer-aided design map

You can integrate CAD drawings onto your maps seamlessly,
without having to convert these files into other GIS formats. This
is particularly useful if your organization has existing CAD data
resources. For example, some departments in your organization
may be using a CAD package to help manage facilities and other
infrastructure. You can let ArcMap draw these layers as they
appear in the CAD package, or you can precisely control how to
draw them.
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Drawing all
features with one
symbol
Often, seeing where something
is�and where it isn�t�can tell
you exactly what you need to
know. Mapping the location of
features reveals patterns and
trends that can help you make
better decisions. For example, a
business owner might map where
his customers live. Seeing where
they live can help him decide
where to target his advertising.

The easiest way to see where
features are is to draw them
using a single symbol. You can
draw any type of data this way.
When you create a new layer,
ArcMap by default draws it with
a single symbol.

Drawing a layer using a
single symbol

1. In the table of contents, right-
click the layer you want to
draw with a single symbol
and click Properties.

2. Click the Symbology tab.

3. Click Features.

Because Single symbol is the
only option, ArcMap automati-
cally selects it.

4. Click the Symbol button to
change the symbol.

5. In the Symbol Selector dialog
box, click a new symbol or
change specific properties of
the symbol.

6. Click OK on the Symbol
Selector dialog box.

7. Type a Label for the feature.

The label appears next to the
symbol in the table of
contents.

8. Click OK.

Tip

Changing the symbol
To quickly change the symbol
features are drawn with, click the
symbol in the table of contents to
display the Symbol Selector.

Tip

Changing the color
To quickly change the color of a
symbol, right-click the symbol in
the table of contents to display the
Color Selector.
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Drawing features
to show categories
like names or types
A category describes a set of
features with the same attribute
value. For example, given parcel
data with an attribute describing
land use�for example, residen-
tial, commercial, and public
areas�you can use a different
symbol to represent each unique
land use type. Drawing features
this way allows you to see where
features are and what category
they belong to. This can be useful
if you�re targeting a specific type
of feature for some action or
policy. For instance, a city
planner might use the land use
map to target areas for redevelop-
ment.

In general, look for these kinds
of attributes when mapping by
category, or unique value:

� Attributes describing the
name, type, or condition of a
feature.

� Attributes containing
measurements or quantities
that are already grouped, for
example, �0�99�, �100�199�.

� Attributes that uniquely
identify features, for example,
a county name attribute could
be used to draw each county
with a unique color. u

Drawing a layer showing
unique values

1. In the table of contents, right-
click the layer you want to
draw showing unique values
and click Properties.

2. Click the Symbology tab.

3. Click Categories.

ArcMap automatically selects
the Unique values option.

4. Click the Value Field
dropdown arrow and click the
field that contains the values
you want to map.

5. Click the Color Scheme
dropdown arrow and click a
color scheme.

6. Click Add All Values.

This adds all unique values to
the list. Alternatively, click the
Add Values button to choose
which unique values to
display.

7. If you want to have more
descriptive labels, click a
label in the Label column and
type a new one.

8. Click OK.

2

3
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6 8 7
Double-click a symbol to
change it.
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Drawing features by
referencing specific
symbols in a style

1. In the table of contents, right-
click the layer you want to
draw showing unique values
and click Properties.

2. Click the Symbology tab.

3. Click Categories.

4. Click Match to symbols in a
style.

5. Click the Value Field
dropdown arrow and click the
field that contains the values
you want to map.

6. Click the Match to symbols in
Style dropdown arrow and
click the style that contains
symbol names that match
attribute values.

If the style is not loaded, click
the Browse button to browse
for it on disk.

7. Click Match Symbols.

This adds all unique values
that have a matching symbol
in the style. Alternatively, click
the Add Values button to
choose which unique values
to display.

8. If you want to have more
descriptive labels, click a
label in the Label column and
type a new one.

9. Click OK.

You can let ArcMap assign a
symbol to each unique value
based on a color scheme you
choose or explicitly assign a
specific symbol to a specific
attribute value.

To draw features with specific
symbols, you need to create a
style beforehand that contains
symbols named after the attribute
value they represent. For
example, if you have a dataset
that categorizes roads as either
major or minor, then you would
need to have line symbols within
that style named �major� and
�minor�. ArcMap will match the
attribute value to the line symbol
name to draw the feature.
Features that don�t have a
matching line symbol won�t be
drawn. This way of drawing
features is especially useful if
you want to draw your data the
same way on different maps.

See Also

For more information on creating
styles, see Chapter 9, �Working
with styles and symbols�.
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Sorting unique values

1. In the table of contents, right-
click the layer whose unique
values you want to sort and
click Properties.

2. Click the Symbology tab.

3. Click the Value column to
show a context menu.

4. Click Reverse Sorting.

5. Click OK.

2 3

5

4

Ordering unique values

1. In the table of contents, right-
click the layer whose unique
values you want to reorder
and click Properties.

2. Click the Symbology tab.

3. Click the value you want to
move up or down in the list.

4. Use the up and down arrows
to either promote or demote
the value in the list.

The arrow buttons only move
values within a heading.

5. Click OK.

5

2

3

4

Tip

Ordering unique value
headings
You can also arrange the headings
for unique values. Just select a
heading and use the arrow keys to
move it.
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Managing
categories
If you�re drawing features by
category, the number of catego-
ries you display will affect what
patterns are revealed on the map.
Most people can easily discern
up to seven categories for a given
layer. The more technical the
audience, the more categories
they will be able to identify and
the more easily they will be able
to interpret complex patterns.
Conversely, a less technical
audience may benefit more from
a map with fewer categories.

When displaying your data, you
can control how you organize
and display categories for a layer.
If you want to display fewer
categories, you can combine
similar categories into one
category�for example, combine
two detailed land use categories
into a more general one. Combin-
ing categories in this manner can
make the patterns more apparent.
However, the trade-off is that
some information may be lost.

Instead of reducing the number
of categories, you might organize
individual categories into groups
that you define. This allows you
to work with and view them as a
group. Additionally, a map reader
will see the groups listed in the
table of contents.

Combining two or more
categories into one

1. In the table of contents, right-
click the layer drawn with
unique values for which you
want to combine categories
and click Properties.

2. Click the Symbology tab.

You should already see
categories in the scrolling list.
If you don’t, follow the steps
for ‘Drawing a layer showing
unique values’ in this chapter.

3. Click the first value you want
to combine. Hold down the
Shift or Ctrl key and click the
additional values that you
want to combine.

4. Right-click over the values
and click Group Values.

The selected values will now
be combined into one
category.

5. Click OK.

Splitting up combined
categories

1. Right-click a combined
category.

2. Click Ungroup Values.
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Organizing categories in
groups

1. In the table of contents, right-
click the layer drawn with
unique values for which you
want to organize categories
and click Properties.

2. Click the Symbology tab.

You should already see
categories in the scrolling list.
If you don’t, follow the steps
for ‘Drawing a layer showing
unique values’ in this chapter.

3. Click the first value you want
to group together. Hold down
the Shift or Ctrl key and click
the additional values that you
want to group.

4. Right-click a selected value,
point to Move to Heading,
and click New Heading.

5. Type a name for the new
heading.

6. Click OK.

7. Click OK on the Layer
Properties dialog box.

Tip

Deleting groups
ArcMap will automatically delete
groups that contain no attribute
values in them.

Tip

Renaming groups
Click the group heading in the
table of contents and type a new
name.
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A new heading now appears
in the table of contents with
values grouped in it.
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Ways to map quantitative data

Quantitative data is data that describes features in terms of a
quantitative value measuring some magnitude of the feature.
Unlike categorical data, where features are described by a unique
attribute value such as a name, quantitative data generally
describes counts or amounts, ratios, or ranked values. For
example, data representing precipitation, population, and habitat
suitability can all be mapped quantitatively.

Which quantitative value should you map?

Knowing what type of data you have and what you want to show
will help you determine what quantitative value to map. In
general, you can follow these guidelines:

� Map counts or amounts if you want to see actual measured
values as well as relative magnitude. Use care when mapping
counts as the values may be influenced by other factors and
could yield a misleading map. For example, when making a
map showing the total sales figures of a product by state, the
total sales figure is likely to reflect the differences in
population among the states.

� Map ratios if you want to minimize differences based on the
size of areas or numbers of features in each area. Ratios are
created by dividing two data values and are also referred to as
normalizing the data. For example, dividing the 18- to 30-
year-old population by the total population yields the
percentage of people aged 18�30. Similarly, dividing a value
by the area of the feature yields a value per unit area, or
density.

� Map ranks if you�re interested in relative measures and actual
values are not important. For example, you may know a
feature with a rank of �3� is higher than one ranked �2� and
lower than a �4�, but you can�t tell how much higher or lower.

Should you map individual values or group them
in classes?

When you map quantitative data, you can either assign each value
its own symbol or group values into classes using a different
symbol for each class.

If you�re only mapping a few values (less than 10), you can
assign a unique symbol to each value. This may present a more
accurate picture of the data, since you�re not predetermining
which features are grouped together. More likely, your data
values will be too numerous to map individually and you�ll want
to group them in classes, or classify the data. A good example of
classified data is a temperature map you might find in a
newspaper. Instead of displaying individual temperatures, these
maps show temperature bands, where each band represents a
given range in temperature.

Ways to classify your data

How you define the class ranges and breaks�the high and low
values that bracket each class�will determine which features fall
into each class and thus what the map will look like. By changing
the classes you can create very different-looking maps. Generally,
the goal is to make sure features with similar values are in the
same class.

Two key factors for classifying your data are the classification
scheme you use and the number of classes you create. If you
know your data well, you can manually define your own classes.
Alternatively, you can let ArcMap classify your data using
standard classification schemes. The four most common schemes
are natural breaks, quantile, equal interval, and standard
deviation. These are described on the following pages.
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Standard classification schemes

Natural breaks (Jenks)

Classes are based on natural groupings of data values. ArcMap identifies break points by looking for groupings and patterns inherent in
the data. The features are divided into classes whose boundaries are set where there are relatively big jumps in the data values.

Quantile

Each class contains an equal number of features. A quantile classification is well suited to linearly distributed data. Because features are
grouped by the number in each class, the resulting map can be misleading. Similar features can be placed in adjacent classes, or features
with widely different values can be put in the same class. You can minimize this distortion by increasing the number of classes.
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Equal interval

This classification scheme divides the range of attribute values into equal-sized subranges. For example, if features have attribute values
ranging from 0 to 300 and you have three classes, each class represents a range of 100 with class ranges of 0�100, 101�200, and 201�
300. This method emphasizes the amount of an attribute value relative to other values, for example, to show that a store is part of the
group of stores that made up the top one-third of all sales. It�s best applied to familiar data ranges such as percentages and temperature.

Standard deviation

This classification scheme shows you the amount a feature�s attribute value varies from the mean. ArcMap calculates the mean value
and then generates class breaks by successively adding to it or subtracting from it the standard deviation. A two-color ramp helps
emphasize values above (shown in blue) and below (shown in red) the mean.
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Drawing features
to show quantities
like counts or
amounts
When you want your map to
communicate how much of
something there is, you need to
draw features using a quantitative
measure. This measure might be
a count; a ratio such as a
percentage; or a rank such as
high, medium, and low.

You can represent quantities on a
map by varying the color or
symbol size you use to draw
features. For example, you might
use increasingly darker shades of
blue to represent increasingly
higher rainfall amounts or larger
circles to represent cities with
larger populations.

Generally, you�ll need to classify
your data when you display it.
Classifying data groups features
with similar values into discrete
classes and displays them with
the same symbol. You can either
manually define classes or apply
one of the standard classification
schemes to do so automatically�
just specify the number of classes
you want to show. Once you�ve
defined the classes, you can add
more classes, delete classes, or
redefine class ranges. u

Representing quantity
with color

1. In the table of contents, right-
click the layer you want to
draw showing a quantitative
value and click Properties.

2. Click the Symbology tab.

3. Click Quantities.

ArcMap automatically selects
Graduated colors.

4. Click the Value dropdown
arrow and click the field that
contains the quantitative
value you want to map.

5. To normalize the data, click
the Normalization dropdown
arrow and click a field.

ArcMap divides this field into
the Value to create a ratio.

6. Click the Color Ramp
dropdown arrow and click a
ramp to display data with.

7. Click the Classes dropdown
arrow and click the number of
classes you want.

8. Click Classify.

9. In the Classification dialog
box, click the Method
dropdown arrow and click the
classification method you
want.

10.Click OK on the Classification
dialog box.

11. Click OK on the Layer
Properties dialog box.

Right-click over a class
to see additional options
such as sorting and
number formatting.
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It�s always a good idea to
examine your data before you
map it. For instance, you may
find that you have a few ex-
tremely high or low values or
null values where no data is
available. These values can skew
a classification and thus the
patterns on the map. Fortunately,
you can choose to exclude these
values before you classify your
data.

You may also want to normalize
your data before you map it.
When you normalize data, you
divide it by another attribute to
come up with a ratio. Often,
ratios are easier to understand
than the raw data values. For
example, dividing total popula-
tion by area yields the number of
people per unit area, or a density.
Dividing a store�s sales figure by
the total sales for all stores yields
a percentage of sales at that store.

Creating your own color
ramp for a layer

1. In the table of contents, right-
click the layer that shows a
quantitative value and click
Properties.

2. Click the Symbology tab.

3. Click Quantities.

4. Double-click the top symbol
in the list and set the start
color for the ramp.

5. Double-click the bottom
symbol and set the end color.

6. Optionally, double-click any
middle symbol to set its color.

This lets you create a
multicolor ramp.

7. Click all the middle symbols
you’ve set the color of.

By selecting one or more
middle symbols, the color of
those symbols is included in
the new ramp. Otherwise,
ArcMap only uses the top and
bottom symbols.

8. Right-click a symbol and click
Ramp Colors.

9. Optionally, right-click the
Color Ramp dropdown and
click Save to save your new
ramp to your default style.

You only need to save the
ramp if you want to use it
again on another layer.

10.Click OK.

9

See Also

For more information on creating
and managing styles, see
Chapter 9, �Working with styles
and symbols�.
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Appearance after the top, middle,
and bottom colors have been set.
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Resulting ramp goes from red to
yellow to green.
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Representing quantity
with graduated symbols

1. In the table of contents, right-
click the layer you want to
draw showing a quantitative
value and click Properties.

2. Click the Symbology tab.

3. Click Quantities and click
Graduated symbols.

4. Click the Value dropdown
arrow and click the field that
contains the quantitative
value you want to map.

5. To normalize the data, click
the Normalization dropdown
arrow and click a field.

ArcMap divides this field into
the Value to create a ratio.

6. Type the minimum and
maximum symbol sizes.

7. Click the Classes dropdown
arrow and click the number of
classes you want.

8. Click Classify.

9. Click the Method dropdown
arrow and click the classifica-
tion method you want.

10.Optionally, click Exclusion to
remove unwanted values
from the classification (e.g.,
null values).

11. Click OK on the Classification
dialog box.

12.Click OK on the Layer
Properties dialog box.

Tip

Why don’t the symbols get
bigger when I zoom in?
As you zoom in on the map, the
graduated symbols will not get
bigger. If you want them to get
bigger, you need to set a reference
scale. Right-click the data frame
and click Set Reference Scale. Now
when you zoom in, all the symbols
in the data frame will become
larger.

Tip

With how many digits do
you want to display your
labels?
You can set the number of
significant digits for labels by
clicking the Label column heading.
This reveals a menu that lets you
format the labels.
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Representing quantity
with proportional
symbols

1. In the table of contents, right-
click the layer you want to
draw showing a quantitative
value and click Properties.

2. Click the Symbology tab.

3. Click Quantities and click
Proportional symbols.

4. Click the Value dropdown
arrow and click the field that
contains the quantitative
value you want to map.

5. To normalize the data, click
the Normalization dropdown
arrow and click a field.

ArcMap divides this field into
the Value to create a ratio.

6. If the Value represents a
measurement on the map—
an area or distance—click the
Unit dropdown arrow and
click a unit. Otherwise, skip to
step 9.

7. Click Square or Circle as the
symbol.

8. Click Radius or Area.

For example, click Radius if
your data represents the
distance an earthquake was
felt from its epicenter. Click
Area if the value represents
an area.

9. Click OK.

Tip

What’s the difference
between graduated
symbols and proportional
symbols?
When you draw features with
graduated symbols, the quantita-
tive values are grouped into
classes. Within a class, all features
are drawn with the same symbol.
Thus, you can�t discern the value
of individual features; you can
only tell that its value is within a
certain range.

Proportional symbols represent
data values more precisely. The
size of a proportional symbol
reflects the actual data value. For
example, you might map earth-
quakes using proportional circles,
where the radius of the circle is
based on the magnitude of the
quake. The difficulty with propor-
tional symbols arises when you
have too many values; the symbols
may become indistinguishable.
Also, the symbols for high values
can become so large as to obscure
each other.

Tip

The maximum value
symbol is too large
If the symbol for the maximum
value fills the space on the dialog
box, it will probably be too big on
the map. Try reducing the symbol
size for the minimum value,
normalizing the data, or excluding
some values. If it�s still too large,
use graduated symbols instead.
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Representing quantity
with a dot density map

1. In the table of contents, right-
click the layer you want to
draw showing a quantitative
value and click Properties.

2. Click the Symbology tab.

3. Click Quantities and click Dot
density.

4. Click one or more fields
under Field Selection that
contain the quantitative
values that you want to map.

5. Click the arrow button to add
fields to the field list.

6. Double-click on a dot symbol
in the field list to change its
properties.

7. Type the dot size or click the
slider to adjust the size.

8. Type the dot value or click the
slider to adjust the value.

9. Check Maintain Density to
preserve the dot density.

When checked, as you zoom
in, the dot size will increase
so that a given area will
visually appear as dense.
Otherwise, the dot size will
remain constant.

10.Optionally, click Properties to
set the dot placement
options.

11. Click OK.

Tip

How big should the dots
be?
When creating a dot density map,
you specify how many features
each dot represents and how big
the dots are. You may need to try
several combinations of amount
and size to see which one best
shows the pattern. In general, you
should select values that ensure the
dots are not so close as to form
solid areas that obscure the
patterns, or so far apart as to
make the variations in density hard
to see.
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Setting a
classification
When you classify your data, you
can either use one of the standard
classification schemes ArcMap
provides or create custom classes
based on class ranges you
specify. If you choose to let
ArcMap classify the data, simply
choose the classification scheme
you want and set the number of
classes. If you want to define
your own classes, you can
manually add class breaks and set
class ranges that are appropriate
for your data. Alternatively, you
can start with one of the standard
classifications and make adjust-
ments as needed.

Why set class ranges manually?
There may already be certain
standards or guidelines for
mapping your data. For example,
temperature maps are often
displayed with 10 degree
temperature bands. Or you might
want to emphasize features with
particular values, for example,
those above or below a threshold
value that determines whether
some action will occur. Whatever
your reason, make sure you
clearly specify what the classes
mean on the map.

Setting a standard
classification method

1. In the table of contents, right-
click the layer that shows a
quantitative value for which
you want to change the
classification.

2. Click the Symbology tab.

3. Click Quantities.

You should see the current
classification.

4. Click Classify.

5. Click the Method dropdown
arrow and click the classifica-
tion method you want.

6. Click the Classes dropdown
arrow and click the number of
classes you want to display.

7. Click OK on the Classification
dialog box.

8. Click OK on the Layer
Properties dialog box.
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Deleting a class break

1. Click Classify from the
Symbology tab of the Layer
Properties dialog.

2. Click on the class break you
want to delete.

The selected break is
highlighted.

3. Right-click over the histogram
and click Delete Break.

Tip

Seeing more data values
plotted on the histogram
Increase the number of columns
shown to see more data values in
the histogram.

Inserting your own class
break and setting a range

1. In the table of contents, right-
click the layer you want to set
class breaks for.

You should see the current
classification.

2. Click the Range you want to
edit.

Make sure to click the Range,
not the Label.

3. Type a new value. This sets
the upper value of the range.

4. Click OK.

2

3

4
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Excluding features from
the classification

1. Click Classify from the
Symbology tab of the Layer
Properties dialog.

2. Click Exclusion.

3. Double-click the field you’re
using to draw the layer.

4. Double-click an operator.

5. Double-click the value you
want to exclude.

If you don’t see the value in
the list, click the Complete
List button.

6. Click OK to execute the
expression and exclude
values.

2

3

4

5

6

See Also

For more information on building
query expressions, see Chapter 13,
�Querying maps�.
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Drawing features
to show multiple
attributes
Geographic data usually has a
number of different attributes
that describe the features it
contains. While you�ll commonly
use one of the attributes to
symbolize the data�for example,
show categories or quantities�
you may sometimes want to use
more than one. For example, you
might display a road network
using two attributes: one
representing the type of road and
the other representing the traffic
volume along it. In this case, you
could use different line colors to
represent the different types of
roads and also vary the line width
to indicate traffic volume along
each road.

When you symbolize your data
using more than one attribute,
you create a multivariate display.
Symbolizing your data this way
can effectively display more
information about the data;
however, it can also make your
map more difficult to interpret.
Sometimes it might be better to
create two separate displays than
to try to display the information
together.

Drawing a layer to show
both categories and
quantities

1. In the table of contents, right-
click the layer you want to
draw showing multiple
attributes and click Proper-
ties.

2. Click the Symbology tab.

3. Click Multiple Attributes.

ArcMap automatically selects
the Quantity by category
option.

4. Click the first Value Fields
dropdown arrow and click the
field that contains the values
you want to map.

5. Click the Color Scheme
dropdown arrow and click a
color scheme.

6. Click Add All Values.

7. Click Symbol Size or Color
Ramp, depending on how you
want to symbolize the
quantitative value. This
example shows Symbol Size.

8. Click the Value dropdown
arrow and click the quantita-
tive value you want to map.

Set other options as de-
scribed in ‘Drawing features
to show quantities like counts
or amounts’.

9. Click OK.

10.Click OK.
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Drawing features
with charts
Pie charts, bar charts, and
stacked bar charts can present
large amounts of quantitative
data in an eye-catching fashion.
For example, if you�re mapping
population by county, you can
use a pie chart to show the
percentage of the population by
ethnic group for each county.

Generally, you�ll draw a layer
with charts when your layer has
a number of related numeric
attributes that you wish to
compare. Use pie charts if you
want to show how much of the
total amount each category takes
up. Use bar charts to show
relative amounts, rather than a
proportion of a total.

Drawing pie charts

1. In the table of contents, right-
click the layer you want to
draw showing quantitative
values and click Properties.

2. Click the Symbology tab.

3. Click Charts and click Pie.

4. Click one or more fields
under Field Selection that
contain the quantitative
values that you want to map.

5. Click the arrow button to add
fields to the field list.

6. Click the Color Scheme
dropdown arrow and click the
colors you want to use.

You can double-click an
individual symbol in the list to
change its properties.

7. Check the box to prevent the
charts from overlapping.

8. Click Size.

9. Click the Variation Type you
want.

You can either draw all pies
the same size or vary the size
based on the sum of the
attributes or a particular
attribute value.

10.Type in a size or click the
arrows to set the size.

11.Click OK.

12.Click OK.

Tip

Charting negative values
Avoid using pie or stacked bar
charts with data containing
negative values.
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Drawing bar and column
charts

1. In the table of contents, right-
click the layer you want to
draw showing quantitative
values and click Properties.

2. Click the Symbology tab.

3. Click Charts and click Bar/
Column.

4. Click one or more fields
under Field Selection that
contain the quantitative
values that you want to map.

5. Click the arrow button to add
fields to the field list.

6. Click the Color Scheme
dropdown arrow and click the
colors you want to use.

You can double-click an
individual symbol in the list to
change its properties.

7. Check the box to prevent the
charts from overlapping.

8. Click Size.

9. Type in a maximum length or
click the arrows to set the
length.

10.Click OK.

11. Click OK.
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Click Properties to
switch between bars
and columns.
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Drawing stacked charts

1. In the table of contents, right-
click the layer you want to
draw showing quantitative
values and click Properties.

2. Click the Symbology tab.

3. Click Charts and click
Stacked.

4. Click one or more fields
under Field Selection that
contain the quantitative
values that you want to map.

5. Click the arrow button to add
fields to the field list.

6. Click the Color Scheme
dropdown arrow and click the
colors you want to use.

You can double-click an
individual symbol in the list to
change its properties.

7. Check the box to prevent the
charts from overlapping.

8. Click Size.

9. Type in a maximum length or
click the arrows to set the
length.

10.Click OK.

11.Click OK.
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Click Properties to
switch between bars
and columns.
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Drawing TINs as
surfaces
TINs represent continuous
surfaces such as terrain elevation
or temperature gradient. Typi-
cally, you display a TIN using
color-shaded relief. This lets you
easily see the ridges, valleys, and
hillsides and their respective
heights. Seeing the data this way
can help explain why other map
features are where they are.

You can display any one of three
surface characteristics�slope,
aspect, and elevation�on your
map and even simulate shaded
relief.

Geographic features that cross
the surface�such as a river,
road, or shoreline�can be
explicitly represented in a TIN
with a breakline. These features
form the edges of triangles and
therefore influence the surface at
their location. Since the underly-
ing triangulation defines the
surface, you might want to take a
closer look at it. You can also
display the internal structure of a
TIN�for example, nodes and
breaklines�independently or on
top of the shaded relief display.

Drawing a color-shaded
relief surface

1. In the table of contents, right-
click the TIN layer that you
want to draw and click
Properties.

2. Click the Symbology tab.

By default, ArcMap displays
the face elevation and
breakline edges of the TIN.

3. Click an entry in the list to see
its symbolization properties.

4. Modify the symbolization
properties as necessary. For
example, set a new color
ramp or change the number
of classes.

5. Click the Add button to draw
additional elements of the
TIN—for example, nodes.

6. Click the renderer that
represents the TIN feature
you want to draw.

7. Click Add.

8. Click Dismiss when you are
finished adding renderers.

The list will update to show
what you want to draw.  u
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9. Click an element in the list.

10.Click the Up or Down arrow
to change its draw order.

The TIN features at the top of
the list will draw on top of
those below them.

11. Click OK.

9

Q

W

Tip

How are slope and aspect
measured?
Slope values range between 0 and
90 degrees, where 0 indicates no
slope. Aspect is also measured in
degrees. North is 0 degrees, east is
90 degrees, south is 180 degrees,
and west is 270 degrees.
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Drawing CAD
layers
You can display CAD drawings
on your map just like other data
types. You can decide which
CAD layers to draw and how to
draw the entities on the layer.

Depending on how you added the
CAD data to your map, you have
two display options:

� If you added the CAD
drawing file for display only,
you can only choose which
CAD layers to show or hide.
ArcMap draws all entities
according to the color
specified in the drawing file.
You can�t override this
drawing behavior.

� If you added the CAD
drawing as features�point,
line, or polygon�because
you are interested in using the
data for geographic analysis,
you have access to all the
symbolization options as
other feature layers. For
example, you can draw the
polygon entities with a single
symbol or classified by a
unique value.

Displaying a CAD
drawing file

1. In the table of contents, right-
click the CAD drawing layer
and click Properties.

2. Click the Display tab.

3. Click and drag the sliders to
adjust the CAD display.

4. Click the Drawing Layers tab.

5. Check the CAD layers that
you want to display.

6. Click OK.
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Drawing CAD features as
points, lines, or polygons

1. In the table of contents, right-
click the CAD dataset and
click Properties.

2. Click the Symbology tab.

The drawing options avail-
able to you are the same as
other feature layers.

3. Modify the drawing properties
as necessary.

See the previous topics in
this chapter for more detailed
instructions.

4. Click the Drawing Layers tab.

5. Check the CAD layers that
you want to display.

6. Click OK.

See Also

For more information on symboliz-
ing the features in a CAD dataset,
see �Drawing features to show
categories like names or types� in
this chapter.
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Tip

Adjusting transparency
You can also use the Effects
toolbar to adjust the transparency
of CAD layers.
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Advanced
symbolization
ArcMap provides a few other
tools that let you control how
layers draw. You can:

� Draw layers transparently.

� Set a reference scale for
symbols so they�ll, for
example, get larger as you
zoom in on the map.

� Order the drawing sequence
of multilevel road networks
with complex symbology.

Transparency is especially useful
for drawing raster layers over
other layers on your map,
allowing you to see the raster
layer while still viewing underly-
ing features.

When you set a reference scale,
symbols and text will appear
larger as you zoom in on your
data frame and smaller as you
zoom out on your data frame. So
for example, text labels will get
larger if you zoom in to a scale
that is larger than the reference
scale.

The current scale of the data
frame is used as the reference
scale to which all symbols and
text in the data frame will be
made relative. Setting a reference
scale is like �freezing� the
symbol and text sizes used in
your data frame so that the way u

Drawing a layer
transparently

1. Click the View menu, point to
Toolbars, and click Effects.

The Effects toolbar appears.

2. Click the Layer dropdown
arrow and click the layer you
want to adjust.

3. Click Adjust Transparency.

4. Drag the slider bar to adjust
the transparency.

2

3

4

Fire station layer before (left) and after adjusting transparency.
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they look at the reference scale is
maintained at all scales.

One reason to set a reference
scale is if you want the detail in
your data frame to look the same
onscreen in Data view as it will
when you print it out. Let�s say
you are creating a map for
publication that will be printed
out at a scale of 1:25,000. If you
set your data frame�s scale to be
1:25,000 and then choose Set
Reference Scale, the symbols and
text sizes in your data frame will
appear on-screen at the same size
in relation to each other that they
will have in your printed map.

When a reference scale is set, all
layers (except for raster layers) in
the current data frame will have
their symbols scaled relative to
the reference scale. However, you
can disable scaling for individual
layers: double-click the layer, go
to the Display tab, and uncheck
�Scale symbols when a reference
scale is set.�

Setting a reference scale
for symbols

1. Set the scale of the data
frame to the scale you want
to use as the reference scale.

2. Right-click the data frame in
the table of contents and click
Set Reference Scale.

With (left) and without (right) a reference scale set.

1

2Clearing a reference
scale

1. Right-click the data frame in
the table of contents and click
Clear Reference Scale.
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Arranging the drawing
order of complex
symbols and features

1. In the table of contents, right-
click a data frame and click
Advanced Drawing Options.

2. Check Draw using advanced
drawing options.

3. Click each symbol and set the
appropriate properties.

Use the pictures to help you
decide how you want the
symbols to interact as they
draw.

4. Click Apply to view your
changes.

5. Click OK.

3
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Tip

Symbolizing your data
Symbolizing by unique values will
help when drawing layers with
complex intersecting features.

Tip

What does Advanced
Drawing Options provide?
Use the Advanced Drawing
Options to order the drawing
sequence of multilevel road
networks with complex symbology.
You can drag and reorder the
drawing sequence, join features
drawn with the same multilayered
symbol, and merge features drawn
with a variety of multilayered
symbols.
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Labeling maps with text and graphics 7
• Drawing points, lines, and circles

• Adding text

• Selecting graphics

• Moving, rotating, and ordering
graphics

• Aligning, distributing, and grouping
graphics

• Joining graphics

• About labeling

• Displaying labels

• Specifying the text of labels

• Prioritizing and positioning labels

• Printing a map with labels

• Feature-linked annotation

• Map tips and hyperlinks

Maps convey information about geographic features. Yet displaying only
features on a map�even those with symbols that describe exactly what they
are�isn�t always enough to make your point. Sometimes you�ll want to add
text and other graphics, such as polygons, circles, and lines, on top of your
data to draw attention to particular features or highlight important areas. For
example, you might want to outline a study area with a polygon, point out
potential locations for new stores, or label city streets with their names. Other
times, you�ll use text and graphics to enhance your map presentation. For
example, you can add titles to your map or draw neatlines around its border.
These sorts of graphics are not associated with any particular map features,
although they are added to the map the same way.

Text that�s associated with a map feature is called a label. You can type in a
label by hand if you know what the feature is, but more likely you�ll let
ArcMap label features automatically based on an attribute of the feature�for
example, a soil type, street name, or land use category. If you�re working with
a geodatabase, you can dynamically link the label to the feature. That way, if
you move the feature, the label will move with it; if you delete the feature, the
label will also be deleted; and if you change the attribute value referenced by
the label, the label will update with the new value.

Another more subtle way to label map features is with map tips and
hyperlinks. Use map tips to display an attribute when you pause the mouse
pointer over a feature. Use hyperlinks to display images, photographs,
documents, drawings, video clips, Web pages, or any other information stored
as a file on your system or on the Internet.
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Drawing points,
lines, and circles
Points, lines, circles, polygons,
and rectangles are among the
graphic shapes you�ll use to
highlight features in your data
and draw cartographic elements,
such as neatlines, on your layout.
Once you�ve added a graphic to
your map, you can move it, resize
it, change its color, or align it
with other graphics.

If you want to add a graphic as
part of the map layout, add it in
layout view. If you want the
graphic to display with your data,
add it in data view. For example,
suppose you want to draw a
circle representing a buffer
around a feature. Instead of
drawing the circle over the data
frame in layout view, draw it
directly over your data in data
view. Then, as you pan and zoom
your data, the circle pans and
zooms with it.

If you want more control over
when graphics in a data frame
draw in relation to other layers or
when you want to draw graphics
only when a particular layer is
visible, you can create annota-
tion. Annotation can be graphics,
such as text, lines, and polygons,
but not map elements such as
scale bars and North arrows. u

Adding a graphic

1. On the Draw toolbar, click the
type of graphic you want to
add. (See the tools in the
table to the right.)

2. Move the mouse pointer over
the display and click to add
the graphic.

Some graphics require more
than one click. For example,
you’ll need to click and drag
the mouse to add a rectangle.

Changing the size of a
graphic

1. Click the Select Graphics
button on the Draw toolbar
and click the graphic you
want to resize.

2. Move the mouse pointer over
one of the blue selection
handles and click and drag
the handle.

Drawing tools

Circle Select Graphics

Curve Edit Vertices

Ellipse Rotate

Freehand Line Fill Color

Line Line Color

Point Point Color

Polygon

Rectangle

Click and drag a selection handle to
resize the graphic. Use the Shift key
to resize as a square or the Ctrl key
to maintain the aspect ratio.

Deleting a graphic

1. Click the Select Graphics
button on the Draw toolbar
and click the graphic you
want to delete.

2. Press the Delete key on the
keyboard.
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See Also

For more information on adding
other elements such as scale bars
and North arrows, see Chapter 8,
�Laying out and printing maps�.

Editing vertices of a
graphic

1. Click the Select Graphics
button on the Draw toolbar
and click the graphic you
want to edit the vertices of.

2. Click the Edit Vertices button
on the Draw toolbar.

If this button is dimmed, you
can’t edit the vertices of the
selected graphic.

3. Right-click over the line and
click Add Vertex to add a
vertex, or right-click over a
vertex and click Delete Vertex
to delete it. Click and drag a
vertex to move it.

Changing the color or
symbol of a graphic

1. Click the Select Graphics
button on the Draw toolbar
and double-click the graphic
to display its properties.

The properties vary depend-
ing on the type of graphic
you’ve selected.

2. To change the fill color, click
the Fill Color dropdown arrow
and click a new color.

3. Click OK.

2

3

3

When you add graphics to a data
frame, you can choose which
annotation target they�re added
to. By default, the annotation
target is your map, so your
graphics will be stored in the
map and will always be drawn.
You can create an annotation
group and make that the target
that graphics will be added to.
Annotation groups are useful for
organizing a large number of
graphics because you can turn
them on and off individually. For
example, you might make one
annotation group and add
graphics to it representing one
planning proposal and another
annotation group representing a
competing proposal. In this way
you can easily hide one of the
annotation groups if you want to
make a map just showing one
proposal.

If you want to use annotation on
different maps, store it in a
geodatabase as an annotation
feature class and make that the
target for graphics you add.
Annotation feature classes that
you create appear in your map as
annotation layers in the table of
contents.

ch7.p65 12/04/2000, 12:57 PM169



170 USING ARCMAP

Setting the annotation
target

1. On the Draw toolbar, click
Drawing and point to Active
Annotation Target.

2. Click the annotation target
you want to add graphics to.

All the annotation targets you
have defined appear in the
list. The default target saves
the graphics into your map
document.

If the annotiation target is
stored in a geodatabase, start
an edit session to add
graphics to it.

Creating an annotation
target

1. On the Draw toolbar, click
Drawing and click New
Annotation Target.

2. Click Save Annotation In the
Map to save the annotation in
the current map or click In a
Database as an annotation
feature class.

3. Click OK.

Tip

Where should you save
annotation?
If you want to display the annota-
tion with a particular map, store it
with the map. If you want to use it
on other maps, store it in a
geodatabase.

Tip

Adding graphics to a data
frame while in layout view
When you add a graphic to a map
while in layout view, ArcMap will,
by default, add it to the layout. To
add the graphic to a data frame,
click the Select Graphics button on
the Draw toolbar and double-click
the data frame. Then click a
drawing tool to add a graphic to
the data frame.

2

3

2
1

Tip

Why is my annotation
target unavailable?
In order to add annotation to a
target stored in a geodatabase, you
must first start an edit session.
Otherwise, the annotation target
will be grayed out in the list of
available targets.
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Converting features into
graphics

1. Right-click the layer in the
table of contents that you
want to convert to graphics
and click Convert Features to
Graphics.

2. Click all to convert all
features or selected to
convert the selected features.

3. Click the Target dropdown
arrow and click the annota-
tion target you want to add
the graphics to.

4. Click OK.

2

3
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Tip

Why convert features to
graphics?
You can convert the features in a
layer to graphics that can be
moved, resized, and edited on the
map. This option is useful if you
want to change the location of
features relative to each other for
cartographic purposes, such as
generalization, but you don�t want
to edit the source data that your
layer represents.

Setting the default
symbol properties

1. On the Draw toolbar, click
Default Symbol Properties.

2. Click the appropriate button
to set the symbol properties
for that type of graphic
element.

3. Click OK.

1
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2
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Adding text
Text serves a variety of purposes
on a map. You can use text to
annotate map features, to present
information about the data on the
map such as its coordinate
system, or to provide a title that
describes the purpose of the map.

You can interactively place text
on a map in several ways. You
can place text along a horizon-
tal line, along a curved line, or
with a callout box behind it that
masks what�s underneath the
text. You can also control the
font, color, style, and size of
text as needed.

Text associated with map
features should be added to the
data frame containing the
features. Text representing an
element on the map layout�
such as a title�should be
added to the layout in layout
view.

Adding text along a
horizontal line

1. Click the Text button on the
Draw toolbar.

2. Click the mouse pointer over
the map display and type the
text string.

Adding text along a
curved line

1. Click the Splined Text button
on the Draw toolbar.

2. Click the mouse pointer over
the map to add vertices along
which the text should be
splined.

3. Double-click to end the line.

4. Type the text string.

Adding text with a callout
box

1. Click the Callout Text button
on the Draw toolbar.

2. Click and drag the mouse
pointer over the map display
to draw the callout line.

3. Type the text string.

Text tools

Text Select Graphics

Splined Text Edit Vertices

Label Tool Rotate

Callout Text

See Also

To dynamically label features
based on an attribute value, see
the section �About labeling� in this
chapter.

2 3

4

3

2

Click the Edit Vertices button on the Draw toolbar to edit the
vertices of the splined text.

You can click and drag the endpoint of the callout to position it
correctly.
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Tip

Adding text to a data frame
while in layout view
When you add text to a map while
in layout view, ArcMap will, by
default, add it to the layout. To add
the text to a data frame, click the
Select Graphics button on the
Draw toolbar and double-click the
data frame. Click the Text tool to
add text to the data frame.

Editing a text string

1. Click the Select Graphics
button on the Draw toolbar
and double-click the text
element you want to edit.

2. Type a new text string.

3. Click OK.

Changing the font, color,
and size of text

1. Click the Select Graphics
button on the Draw toolbar
and click the text elements
you want to edit.

2. Click the appropriate button
on the Draw toolbar to modify
a particular characteristic of
the text.

Change text from the Draw toolbar

Make text bold

Make text italic

Underline text

Change text color

      Change text size

      Change text font

2

3
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Selecting graphics
To work with a graphic, you must
select it first. Once selected, you
can, for example, change its size,
color, or shape. By selecting
more than one graphic, you
define a selected set that you can
work with as a group. For
example, you might align, move,
or delete them.

You select graphics with the
Select Graphics tool. Select an
individual graphic by pointing at
it or select a group by dragging a
rectangle around several graph-
ics. Hold down the Shift key
while selecting to add graphics
to or remove graphics from the
current selection.

You can tell when a graphic is
selected because ArcMap draws
selection handles around it.
When you have selected more
than one graphic, you�ll notice
that one of them has blue
selection handles and the others
have green selection handles.
The blue handles indicate the
dominant graphic, or the one
that ArcMap will use, for
example, to align other graphics
with. To change the dominant
graphic, hold down the Ctrl key
and click on the selected
graphic that you want as the
dominant one.

Selecting graphics one at
a time

1. Click the Select Graphics
button on the Draw toolbar.

2. Move the mouse pointer over
the graphic you want to select
and click the graphic.

ArcMap draws selection
handles around the selected
graphic.

Selecting all graphics

1. Click the Edit menu and click
Select All Elements.

Move the mouse pointer over the graphic and
click it. Hold down the Shift key and click to
add to the current selected graphics.

1
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Moving, rotating,
and ordering
graphics
Much of the work you do while
building your map involves
arranging graphics and other
elements on it. For instance, you
might want to orient labels
around the appropriate features
in a data frame or position map
elements, such as titles, neatlines,
and North arrows, on the layout.

ArcMap provides a number of
tools that let you position and
orient graphics. You can move
graphics by dragging them with
the mouse or, when you need
more precise control, you can
nudge them up, down, left, or
right. You can also position
graphics to a specific coordinate
location you type in. You can
move one graphic on top of
another one, rotate it, and flip it
horizontally or vertically.

Nudging a graphic

1. Click the Select Graphics
button on the Draw toolbar
and click the graphic you
want to move a small amount.

2. On the Draw toolbar, click
Drawing, point to Nudge, and
click the direction you want to
nudge the graphic.

The graphic moves one pixel
in the nudge direction.

Moving a graphic

1. Click the Select Graphics
button on the Draw toolbar
and click the graphic you
want to move.

2. Click and drag the selected
graphic to its new position.

Positioning a graphic to a
specific location

1. Click the Select Graphics
button on the Draw toolbar
and double-click the graphic
you want to position.

2. Click the Size and Position
tab.

3. Type an X and Y position.

4. Click OK.

Tip

Specifying coordinates
In layout view, specify x,y coordi-
nates relative to the lower-left
corner of the layout. In data view,
specify x,y coordinates in the units
your data is stored in.

2

2

3

4

Move the mouse pointer over the
graphic and click and drag it.

ch7.p65 12/04/2000, 12:58 PM175



176 USING ARCMAP

Rotating a graphic

1. Click the Select Graphics
button on the Draw toolbar
and click the graphic you
want to rotate.

2. Click the Rotate button on the
Draw toolbar.

3. Position the mouse pointer
over the “x”, which indicates
the rotation point, and move it
as necessary.

4. Click and drag the mouse to
rotate the graphic.

Ordering a graphic

1. Click the Select Graphics
button on the Draw toolbar
and click the graphic you
want to place in front of or
behind other graphics.

2. On the Draw toolbar, click
Drawing, point to Order, and
click the ordering option.

Tip

Rotating by 90 degrees
To rotate a graphic by 90 degrees
left or right, click Drawing on the
Draw toolbar, point to Rotate or
Flip, and click Rotate Left or
Rotate Right.

2

The “x” indicates the rotation point.

As you drag the mouse to rotate, ArcMap
draws an outline of the graphic.

Tip

Working with a graphic on
a data frame while in
layout view
If you want to work with a graphic
in a data frame while in layout
view, click the Select Graphics
button on the Draw toolbar and
double-click the data frame. Then
click the appropriate tool to modify
the graphic on the data frame.
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Flipping a graphic
horizontally or vertically

1. Click the Select Graphics
button on the Draw toolbar
and click the graphic you
want to flip.

2. On the Draw toolbar, click
Drawing, point to Rotate or
Flip, and click Flip Horizon-
tally or Flip Vertically.

2

Making graphics the
same size

1. Click the Select Graphics
button on the Draw toolbar
and click the graphics you
want to make the same size.

2. Click Drawing on the Draw
toolbar, point to Distribute,
and click Make Same Size. 2

Tip

Displaying the Graphics
toolbar
The Graphics toolbar provides
quick access to frequently used
tools for manipulating graphic
elements. To display it, click the
View menu, point to Toolbars, and
click Graphics.
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Aligning,
distributing, and
grouping
graphics
Most of the time you�ll probably
just drag a graphic where you
want it to be. However, you can
arrange them more precisely
when you need to.

You can align graphics with other
graphics�using the sides,
middles, or top or bottom edges.
You can arrange graphics so that
they are equidistant from each
other�distributing them either
vertically or horizontally. Once
you�ve arranged the graphics,
you may want to group them
together. That way, you can move
them as a group and maintain
their alignment.

Aligning graphics

1. Click the Select Graphics
button on the Draw toolbar
and click the graphics you
want to align.

2. The dominant graphic has
blue selection handles around
it. To change the dominant
graphic, press and hold the
Ctrl key and click the graphic
you want as the dominant
one.

3. Click Drawing on the Draw
toolbar, point to Align, and
click the alignment you want.

Distributing graphics

1. Click the Select Graphics
button on the Draw toolbar
and click the graphics you
want to distribute.

2. Click Drawing on the Draw
toolbar, point to Distribute,
and click the distribution
method you want.

The graphics are distributed
with equal spacing between
the centroid of each graphic.

Tip

What do the blue selection
handles indicate?
When you have more than one
graphic selected, the blue handles
indicate the dominant graphic, or
the one that ArcMap will use, for
example, to align other graphics
with. To change the dominant
graphic, hold down the Ctrl key
and click on the selected graphic
that you want to be the dominant
one.

Before After Align Left

Before

After
Distribute
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Ungrouping graphics

1. Click the Select Graphics
button on the Draw toolbar
and click the graphics you
want to ungroup.

2. Click Drawing on the Draw
toolbar and click Ungroup.

Each graphic formerly in the
group is now independent.

Grouping graphics

1. Click the Select Graphics
button on the Draw toolbar
and click the graphics you
want to group.

2. Click Drawing on the Draw
toolbar and click Group.

The individual graphics now
form a group.

2

2

Tip

Displaying the Graphics
toolbar
The Graphics toolbar provides
quick access to frequently used
tools for manipulating graphic
elements. To display it, click the
View menu, point to Toolbars, and
click Graphics.
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Joining graphics
You can join two or more
polygon graphics you�ve drawn
on your map to form a new
graphic that is a combination of
the input graphics. You can:

� Union�joins all graphics
creating one large graphic.
Where the graphics overlap,
the boundaries are removed.

� Intersect�creates a new
graphic from the shared area
of the input graphics.

� Remove overlap�creates a
new graphic from the
nonoverlapping areas of two
input graphics.

� Subtract�creates a new
graphic by subtracting the
overlapping area of one
graphic from another.

Joining graphics

1. Select the polygon graphics
on the map you want to join.

2. Click Drawing on the Draw
toolbar, point to Graphic
Operations, and click the
method you want to use.

The graphics will be joined.
2

Input Graphics Union Subtract

Intersect Remove Overlap
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About labeling

Labeling is the process of placing a descriptive text string next to
one or more features on your map. Labels help a map reader
interpret a map. How you label your maps depends on the type of
data you�re displaying, what features you want to label, and how
you�ll ultimately use the map.

What do you want to label?

Maps can display large amounts of geographic data in layers that
generally overlap. The way you display your data�for example,
what classification method and symbols you use�can help to
describe and identify map features. Thus, you probably won�t
want to label every feature on your map. You will, however, need
to decide what features do need labels.

If you only want to label a few features, you can simply type in a
text label and place it next to the feature it identifies. If you don�t
know exactly what the feature is beforehand, you can derive its
label from an attribute of the feature. If instead you want to label
all the features in a layer or several layers, you won�t want to
manually place a label for each feature. Instead, ArcMap can
dynamically generate and place the labels for you.

Dynamically displaying labels

To display labels for a layer, you simply specify what attribute of
the features you want to label�for example, a street name or soil
type�and then turn labeling on. ArcMap dynamically places
labels on or near the features they describe. You can also control
the font, size, and color of the text to help differentiate labels for
different types of features. The following map of Europe shows
the various countries and major cities, both labeled with a
different text symbol.

You may have noticed that not every city on the map above has a
label. ArcMap attempts to place as many labels on the map as
possible without overlapping them. Thus, in areas where features
are tightly clustered together, some features may not be labeled.
As you zoom in to an area, more labels dynamically appear.

As you zoom in to the United Kingdom, more
city labels appear.
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Controlling what features are labeled

As you pan and zoom around your map, ArcMap dynamically
adjusts the labels to fit the available space. At smaller scales, you
see fewer labels because ArcMap has less space to place them.
Because fewer features can be labeled, you might want to
prioritize the labeling of some features. For instance, on the map
of Europe, you might want to label a country with its name
instead of labeling a city if ArcMap can�t fit both labels.

For each layer you want to label, you can set its labeling priority.
This means that a feature in a layer with a higher priority will be
labeled over a feature in another layer with a lower priority.
Similarly, within a single layer you can set labeling priorities on
specific groups of features�for example, you might set a high
labeling priority on cities with larger populations and a low
priority on cities with smaller populations.

Still, there�s no guarantee that you�ll get exactly the labels you
want positioned exactly where you want them. Thus, dynamic
labeling is best suited to maps where you don�t need precise
control over what is labeled and where the label is placed. When
you do want precise control over labels, you must manage the
labeling process more closely.

Getting the labels you want, where you want them

When you need more precise control over label placement, you
can convert the dynamic labels to annotation. Converting labels
to annotation allows you to manually control the labeling of
features. The conversion process creates text graphics from the
dynamic labels and displays them on your map. Then you can
work with each label, or text graphic, independently�move it,
change its size or font, and change the text. For example, you
might want to move a few labels to make room for one that
ArcMap was unable to place due to space constraints. ArcMap

also provides you with a list of all the labels that weren�t placed
and lets you interactively place them on your map as needed.

While annotation is typically text, it can also be any graphic
element that annotates your map�such as lines, circles, and
polygons.

Deciding where to store annotation

Suppose you�ve decided to convert your labels to annotation
because you want direct control over what features are labeled
and where. When you convert the labels to annotation, you can
store them with the map as an annotation group, or you can store
them separately in a geodatabase as an annotation feature class
and reference it like other data on your map.

Storing annotation in a geodatabase is similar to storing
geographic features�line, point, and polygon�in a geodatabase.
You can add annotation stored in a geodatabase to any map. It
appears as an annotation layer in the table of contents.

Where should you store your converted labels? The answer to
this question depends on how you plan to use the labels. Here are
some guidelines:

� If you�re creating a map specifically for printing and the
labels you�ve created apply only to this map, store the labels
as an annotation group in the map document. Then, if you
delete the map, the annotation is also deleted because it�s
stored with the map.

� If you want to use the labels you�ve just placed on other
maps�because you�ve invested the time and effort to position
them�store them as an annotation feature class in a
geodatabase. You can add the annotation as a layer to other
maps.
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� If you intend to use the map to browse your data online and
that map has numerous labels�as a general rule, more than
100�store them as an annotation feature class in a
geodatabase for increased drawing performance. ArcMap can
access and display labels stored in an annotation feature class
much more rapidly than labels stored as an annotation group
in the map document.

You can also link annotation in a geodatabase directly to the
feature it annotates, creating feature-linked annotation. Then, if
you move the feature, the annotation (label) moves with it; if you
delete the feature, the annotation is also deleted; and if you
change the attribute of the feature that the annotation is based on,
the text of the annotation changes.

You create feature-linked annotation for a specific layer�rather
than the entire map�and store it in the geodatabase along with
the geographic data (feature class) it�s associated with. You�ll
typically create feature-linked annotation while editing your
geographic data with the Editor. However, you can convert your
dynamic labels into feature-linked annotation.

For more information on working with feature-linked annotation,
see Building a Geodatabase.
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Displaying labels
You can label features on your
map in several ways. You can add
static text, as described earlier in
this chapter, and simply place it
next to the feature you want to
annotate. This assumes that you
know what the feature you want
to label is. If you don�t, you can
use the interactive labeling tool
and label the feature by pointing
at it. These methods work well
when you only want to label a
few features.

When you want to label all the
features in a layer, or in several
layers, turn dynamic labeling on
in ArcMap. With dynamic
labeling, ArcMap automatically
places a label next to each feature
as long as there�s space to display
it without overlapping other
labels. The number of labels you
see increases as you zoom in.

You can also display labels for a
particular subset of features in a
single layer. For example, in a
layer of cities, you might only
want to label those with a
population greater than 100,000.
You can create different subsets
of features by querying the
attribute values of the layer. You
can label features in each subset
with a different text font, size,
and color.

Labeling a feature by
pointing at it

1. In the table of contents, right-
click the layer you want to
label and click Properties.

2. Click the Labels tab.

3. Click the Label Field
dropdown arrow and click the
field you want to use as a
label.

4. Click OK.

5. On the Draw toolbar, click the
Label button.

You may have to click the
dropdown arrow to choose
the Label button.

6. Click Place label at position
clicked.

If you click Automatically find
best placement, ArcMap finds
the best location for the label.

7. Click Choose a style and click
the label style you want.

8. Click the mouse pointer over
the feature you want to label.

ArcMap labels the feature.

2

3

4

5

6

7

8
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Labeling all features in a
layer dynamically

1. In the table of contents, right-
click the layer you want to
label and click Properties.

2. Click the Labels tab.

3. Check Label Features.

4. Click the Label Field
dropdown arrow and click the
field you want to use as a
label.

5. Click OK.

3

5

1

Tip

Making the labels get
bigger when you zoom in
As you zoom in and out on your
map, the size of the labels does not
change. If you want the text to
scale with the map, set a reference
scale. Right-click the data frame
and click Set Reference Scale.

4

Turning dynamic labels
on and off

1. In the table of contents, right-
click the layer and check
Label Features to turn
dynamic labels on.

Uncheck Label Features to
turn them off.

See Also

If you need precise control over
what features are labeled and
where the labels are positioned,
see �Printing a map with labels� in
this chapter.

Tip

Automatically removing
duplicate labels
ArcMap automatically removes
duplicate labels. You might want to
disable this behavior when
labeling features such as soil types
or land use categories where
several features can have the same
attribute value. Click Label
Placement Options on the Labels
tab of the Layer Properties dialog
and click Remove Duplicate
Labels.

2
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W

Labeling a subset of
features in a layer

1. In the table of contents, right-
click the layer you want to
label and click Properties.

2. Click the Labels tab.

3. Click the Method dropdown
arrow and click Define
classes of features and label
each class differently.

4. Click the Label Field
dropdown arrow and click the
field to use as a label.

5. Click SQL Query.

6. Click on the operators to build
an expression that identifies
the subset of features you
want to label.

In this example, cities with a
population greater than
1,000,000 will be labeled.

7. Click OK.

8. Click Label Styles and
choose the style—for ex-
ample, font and size—of the
label you want.

9. If you want to create addi-
tional subsets of features,
click Add and type a new
class name.

10.Repeat steps 5 through 8 to
identify the subset of addi-
tional features you want to
label.

11. Click OK.

Tip

Displaying coverage
annotation
If you have a coverage with
annotation, you can display the
annotation as a layer in the table
of contents. Add the layer as you
would any feature layer.

23

4

5

6

Tip

Using different text
symbols to label features
in a single layer
You can use a different text symbol
to label features in each subset you
create. For example, in a cities
layer, you might want to label
cities with a large population in a
different font than those with a
smaller population.

7

9

8
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Specifying the
text of labels
For each layer on your map that
you want to label, you can
choose one or more attribute
fields to derive the text from. For
example, you might label
features with their name, a code
value, or both.

You can also control how the text
appears on the map. If you�re
labeling features with two
attribute values, you might
display them side by side or
stacked with one on top.

For more advanced labeling
needs, you can programmatically
generate a text label by writing a
script in VBScript or
JavaScript�. Your script can
include any valid statements
those programming languages
support.

Setting an attribute field
for label text

1. In the table of contents, right-
click the layer you want to
label and click Properties.

2. Click the Labels tab.

3. Click the Label Field
dropdown arrow and click the
field you want to use as a
label.

4. Click OK.

2

3

4

Using more than one
attribute field for label
text

1. In the table of contents, right-
click the layer you want to
label and click Properties.

2. Click the Labels tab.

3. Click Expression.

4. Double-click the Label Fields
you want to use as the text of
the label.

You can include other
VBScript or JavaScript
commands in the expression
to modify the text string.

5. Click OK.

5
To create stacked text, use the VBScript constant, vbNewLine,
between the field names—[Name] & vbNewLine& [Abbrevname].

Tip

Changing the case of the
label
To convert your text labels to all
uppercase or lowercase, use the
VBScript functions, UCase and
LCase, as part of your expression.
For example, enter the expression
as LCase ([Name]).

4

ch7.p65 12/04/2000, 1:02 PM187



188 USING ARCMAP

Tip

Rounding numeric values
To round numeric values, use the
VBScript Round function in your
expression. For example,
Round ([Area],2) displays labels
rounded to two decimal places.

Generating label text with
a script

1. In the table of contents, right-
click the layer you want to
label and click Properties.

2. Click the Labels tab.

3. Click Expression.

4. Check Advanced.

5. Type a VBScript or JavaScript
expression.

ArcMap automatically creates
a function called FindLabel.
In your code, FindLabel
should evaluate to a string.

6. Click Verify to make sure
there are no syntax errors.

7. Click OK.

2

3

This VBScript labels features only if
the area is > 100000.

4

5

6

7
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Prioritizing and
positioning labels
ArcMap fits as many labels as
possible�without overlapping
them�within the available
space. Thus, as you pan and
zoom around a map, the labels
dynamically adjust to fit the
space.

When viewing your data at a
small scale, you generally see
fewer labels than at a larger
scale. To increase the chance that
particular features or types of
features are labeled, you can
assign those features a higher
labeling priority. For example,
you�d probably assign a higher
labeling priority to highways and
a lower priority to residential
streets. You control labeling
priority by specifying the order in
which ArcMap should label
layers.

ArcMap also lets you control
how to position a label relative to
its features�for example, above
it, below it, or on top of it. Label
positioning is also dependent on
whether you allow labels to
overlap other labels or features
on the map. When you allow
labels to overlap, you can
generally see more labels because
ArcMap has a bit more room in
which to place them.

Setting a layer’s labeling
priority

1. Right-click the data frame
containing the layers you’re
labeling and click Properties.

2. Click the Labels tab.

3. Click the layer that you want
to change the labeling priority
of.

4. Click the Arrow buttons to
move the layer up to give it a
higher priority or down for a
lower priority.

The layer at the top of the list
will be labeled first, followed
by the next layer in the list,
and so on.

5. Click OK.

2

3
4

5
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Positioning labels

1. In the table of contents, right-
click the layer you want to
label and click Properties.

2. Click the Labels tab.

3. Click Label Placement
Options.

4. Click the placement option
you want.

The options presented will
vary depending on the type of
feature you’re labeling.

5. Click OK.

2

3

4

5
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Allowing label overlap

1. Right-click the data frame
containing the layers you’re
labeling and click Properties.

2. Click the Labels tab.

3. Click Conflict Detection
Rules.

4. Set the weights for the labels
and features.

A feature or label with a lower
weight can be overlapped by
one with a higher weight.

5. Click OK.

Cities Label Weight = High
Cities Feature Weight = None
States Label Weight = High
States Feature Weight = None

High label weights mean the labels will not
overlap. No weights for features mean labels
can overlap features. Notice that no city label
overlaps a state label and that the city labels
do overlap the city features.

Cities Label Weight = High
Cities Feature Weight = High
States Label Weight = Low
States Feature Weight = None

State labels can be overlapped by other
labels because of low weight. A high weight
for City features prevents labels from
overlapping the feature—compare the label
placement around the cluster of cities above
with the figure on the left. Including feature
weights can dramatically slow labeling speed.

Tip

Preventing labels from
overlapping features
Setting a feature weight to high
will prevent ArcMap from placing
a label over the feature. Because
ArcMap will evaluate every feature
before determining a label
position, using feature weights can
dramatically slow labeling speed.

Tip

Avoiding overlapping
labels with annotation
layers
If you�ve added an annotation
layer to your map, set the Feature
Weight for the layer to High. This
will prevent dynamic labels from
overlapping the annotation stored
in the layer.

4

5
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Printing a map
with labels
With dynamic labeling, ArcMap
constantly adjusts labels to show
the most labels within the space
available. As you pan and zoom
your map, you see more or fewer
labels, depending on the current
scale. This behavior extends to
printing maps as well. ArcMap
repositions labels during printing
to fit the most labels in the
available space. As you work with
your layout, there�s no guarantee
that the labels you see online will
be exactly the same as what you
see on the printed map.

For some maps, you don�t need
precise control over labeling. You
can use Print Preview to see what
the printout will look like. If the
labeling is acceptable, go ahead
and print your map. If not, you�ll
probably want to take control of
labeling.

When you want precise control
over what labels appear and where
they�re positioned, you need to
take control of the labeling
process. Use dynamic labeling as a
starting point to generate labels
and then convert the dynamic
labels to annotation. You can then
move the text labels around and
position them exactly where you
want them. You�ll find those
labels that u

Using Print Preview to
evaluate labels

1. Turn on dynamic labeling and
set the labeling properties as
described on the previous
pages.

2. Click the File menu and click
Print Preview.

3. Click Zoom In and evaluate
the labels.

4. If the labeling looks accept-
able, click Print to send the
map to the printer. If not, you
should control the labeling
process yourself as described
below.

34

Controlling the labeling
process for a map

1. Zoom in to a sample area on
your map to generate
dynamic labels.

The area should be a good
representation of the general
density of features you want
to label.

2. In the table of contents right-
click the data frame contain-
ing the layers you want to
label and click Properties.

3. Click the Labels tab.

You’ll see the list of layers in
the data frame. u

2
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ArcMap couldn�t place on the
map listed in the Overflow
Labels window. From this
window, you can choose
individual labels and place them
on your map. Once you�ve placed
and positioned all the labels you
need, you can print your map.
The labels you see online will be
exactly the same as the labels you
get on the printed version.

It takes time and effort to place
and position labels exactly where
you want them. If you�d like to
reuse some of your labeling work
on other maps, save the labels in
an annotation feature class in a
geodatabase instead of as simple
text graphics stored in the map.
You can then load the annotation
into another map. For example,
suppose you labeled cities and
states with their names and
stored the labels as an annotation
feature class in a geodatabase.
You can then load the data and
the labels for display on another
map.

4. Check the layers you want to
label.

5. Click Properties to set
labeling properties for each
layer as described earlier in
this chapter.

6. Once you have your labels
looking close to how you
ultimately want them, convert
them to annotation. Right-
click the data frame and click
Convert Labels to Annotation.

7. Click Create annotation for All
features in the layer.

If you don’t want to label all
features in the layer, choose
one of the other options.

8. Click OK.

If any of your labels overlap,
the Overflow Labels window
appears.

9. In the Overflow Labels
window, right-click the label
you want to place on your
map and click Add Label.

You’ll probably need to move
a few of the other labels
around in order to place a
new label on the map.

10.Repeat step 9 until you’ve
placed all the labels you want
on your map.

11.Print your map. The labels
will be exactly where you’ve
positioned them.

7

9

8
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Feature-linked
annotation
Feature-linked annotation
describes a special type of label
that is directly linked to the
feature it annotates. For example,
if you move the feature, the label
moves with it; if you delete the
feature, the label is also deleted;
if you update the attribute the
label is based on, the text of the
label changes.

Feature-linked annotation is
stored as an annotation feature
class in a geodatabase along with
the geographic data it�s associ-
ated with. You can create an
annotation feature class in
ArcCatalog and establish the link
to a feature class in the
geodatabase. As you edit the
features in your geodatabase with
the Editor, you can also annotate
them one at a time. Alternatively,
you can quickly create annotation
for all features by converting
dynamic labels to feature-linked
annotation.

Converting labels to
feature-linked annotation

1. In the table of contents, right-
click the layers you want to
label and click Label Fea-
tures.

2. Right-click the data frame
containing the labeled layers
and click Convert Labels to
Annotation.

3. Check the layers that you
want to save labels as
annotation for.

4. Click Create annotation for All
features in the layer.

If you don’t want to label all
features in the layer, choose
one of the other options.

5. Click Save annotation for the
selected layer In the same
database as the features and
automatically linked to them.

This option is only available if
the layer on your map
references data stored in a
geodatabase.

6. Type a name for the annota-
tion.

This creates a layer in a
geodatabase. Spaces are not
allowed in the name.

7. For each layer you checked
in step 3, click the layer and
repeat steps 4 through 6.

8. Click OK.

See Also

For more information on creating
and working with feature-linked
annotation, see Building a
Geodatabase.

3

4 5

6

8
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Annotating selected
features

1. Select the features in the
layer you want to create
feature-linked annotation for.

2. Right-click the layer, point to
Selection, and click Annotate
selected features.

You must already have
feature-linked annotation for
the layer; otherwise, the
option will be unavailable.

3. If you have more than one
annotation feature class
displayed for the layer, check
the ones you want to add
annotation to.

4. Click OK.

3

4

Annotating an individual
feature

1. If you haven’t done so
already, add an annotation
feature class to your map
that’s linked to the layer you
want to create feature-linked
annotation for.

2. On the Draw toolbar, click
Drawing, point to Active
Annotation Target, and click
the name of the annotation
feature class.

3. Click the Label button.

4. Point to the feature you want
to label.

2 3

Tip

Creating an annotation
feature class
You can create an annotation
feature class in ArcCatalog or by
converting labels to feature-linked
annotation as described on the
previous page.

Tip

Why is my annotation
target unavailable?
In order to add annotation to a
target stored in a geodatabase, you
must first start an edit session.
Otherwise, the annotation target
will be grayed out in the list of
available targets.
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Map tips and
hyperlinks
Map tips and hyperlinks provide
additional ways to present more
information about map features.

Like Tool Tips for toolbar
buttons, map tips pop up as you
pause the mouse pointer over a
feature. ArcMap lets you choose
which attribute field you want to
display as your map tip.

Through hyperlinks, you can
display documents�such as a
text file or image�or Web pages
accessed over the Internet. You
can dynamically create
hyperlinks as you browse your
map, or alternatively, you can
store hyperlinks with your data in
an attribute field.

Displaying map tips

1. In the table of contents, right-
click the layer that you want
to display map tips for and
click Properties.

2. Click the Display tab.

3. Check Show Map Tips.

4. Click the Fields tab.

5. Click the Primary display field
dropdown arrow and click the
attribute field you want to
display as the map tip.

6. Click OK.

7. Move the mouse pointer over
a feature in the layer and
pause to see the map tip.

2

3

4

5

6
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Creating a hyperlink

1. On the Tools toolbar, click the
Identify button and click on a
feature.

2. In the Identify Results dialog,
right-click the feature you
want to set a hyperlink for
and click Add Hyperlink.

3. To add a hyperlink to a Web
page, click Link to a URL and
type a URL.

To link to a document instead,
click Link to a Document and
type a pathname to the
document on your system.

Using an attribute field as
a hyperlink

1. In the table of contents, right-
click the layer containing a
field with hyperlinks and click
Properties.

2. Click the Display tab.

3. Check Support Hyperlinks
using field. Click the dropdown
arrow and click a field.

4. Click Document or URL.

5. Click OK.

6. On the Tools toolbar, click the
Hyperlink button.

7. Move the mouse pointer over
a feature and click to display
the hyperlink.

2

3

Tip

Displaying hyperlinked
documents
If you specify a Web address as a
hyperlink, ArcMap launches your
default Web browser and displays
the Web page. If you specify a
document as a hyperlink, ArcMap
opens that document in its native
program.

3

5
6

2

4
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Laying out and printing maps 8
• About map templates

• Starting a map from a template

• Saving a map as a template

• Setting up the page

• Customizing data frames

• Using rulers, guides, and grids

• Adding data frames

• Adding map elements related to
data frames

• Adding other map elements

• Aligning and grouping map ele-
ments

• Printing a map

• Changing the layout

• Exporting a map

Before you begin to symbolize data for a map, you�ll need to think about
how you want the map to look when it�s printed or published.

You should consider questions such as:

� Will the map stand alone, or will it be part of a series of maps that share a
similar design?

� What size will the printed version of the map be?

� How will the page be oriented?

� How many data frames will the map have?

� Will the map have other map elements such as a title, a North arrow, and
a legend?

� Will the map contain graphs or reports to complement the geographic
view of the data?

� How will scale be indicated on the map?

� How will the map elements be organized on the page?

If the map is part of a series, you may have a template to work from, or you
may create a new template for the series. Map templates make it easy to
produce maps that conform to a standard, and they save time by letting you
do the layout work for all of the maps in the series at once.

You can also use the map templates that come with ArcMap to quickly make
a variety of styles of maps. You can use these templates to get ideas for your
own maps, and you can modify them to suit your needs.

ch8.p65 12/04/2000, 2:36 PM199



200 USING ARCMAP

The Mexico and New Hampshire maps on this page and the
next illustrate two different map layouts and show some of
the ways you can use map elements to create a map.

Perhaps the most important part of a map is the geographic
data. Geographic data is presented in the layout in a data
frame. Simple maps usually have a single data frame, but
maps can have multiple data frames.

The shape and orientation of the geographic features you�re
depicting may influence the size and shape of the data
frame on the map, as well as the orientation of the map on
the page.

Aesthetic criteria, limitations of the media that you use to
reproduce the map, and the number and size of other
elements that you add to the map will bear upon your
choice of page size and orientation.

Title

Text

Ruler

Guide

Data frame

North arrow

Legend

Legend
border

Legend
background

Scale bar Scale text

Data frame
background color

Data frame
selection handleRuler  units Ruler divisions

Landscape page
orientation

8.5 x 11 in. page
size
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Legend

Legend

Text callout

Title (rotated)

Data frame with
locator map

Data frame

Data frame

Text

Graphic rectangle

Gradient fill background
Text

Graphic image

Portrait page orientation

24 x 36 in. page size

In addition to a data frame, most maps contain one or more
other map elements. These include titles, North arrows,
legends, scale bars, scale text, graphs, reports, text labels,
and graphics.

One challenge of cartography is to arrange the elements of
the map on the page to create a useful, visually pleasing
map. ArcMap includes adjustable rulers, guides, and grids
that can help you position elements precisely where you
want them.
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About map templates

If you are creating a series of maps and it is important that they
have the same look and feel, you can use a map template to
standardize the layout. If the series contains the same background
data, you can include that data in the template. Using a template
can save you time since you don�t have to manually reproduce
the common parts of the maps.

You can also use the map templates that come with ArcMap to
quickly make a map that looks good, with a minimal amount of
layout work on your part. Just choose a template that has the look
you want, add your data, and make whatever changes you want,
and your map is done.

Like maps and layers, templates can be shared within an
organization to increase productivity and standardize the maps
that the organization produces. You can use a template to store
layout, data, and customization of the ArcMap interface that you
want to be able to use over and over again.

You can modify existing maps or templates and save them as new
templates, or you can create new maps from scratch and save
them as templates.

Map templates are ArcMap documents that ArcMap recognizes
as templates. When you start a new map using a template,
ArcMap reproduces the template on a new map document and
keeps the original template document intact. Map templates have
the file extension .mxt to differentiate them from map documents
(.mxd).

Using map templates

If you want to make a map using a template, start a new map,
choose the template that you want to use, then start adding layers
to the map. Later, if you want to change the layout, you can apply
a new template.

The Normal template

ArcMap uses a special template called the Normal template
(Normal.mxt) to store information about the default user
interface, for example, the state�visible or hidden, docked or
free-floating�of each of the ArcMap toolbars. This information
is recorded automatically in the Normal template when you
change it, so when you start ArcMap (whether you saved the map
you were working on or not), the toolbars look the same as they
did when you quit.

When you add custom toolbars or tools to ArcMap, you can save
the changes to the Normal template or to the current map. If you
save changes to the interface in the Normal template, they will be
reflected in all the maps that you open. If you save changes to
another map or template, they will only appear when you open
that map or template.
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Starting a map
from a template
Map templates make it easy to
reuse the same layout or even the
same data on a series of maps.
You can use the templates that
come with ArcMap to make
maps quickly�all you need to
do is add data, a title, and any
other supporting information that
you choose.

When you open a template, you
get a new untitled ArcMap
document plus any layout or data
that�s saved in the template.

Opening a template when
you first start ArcMap

1. Start ArcMap.

2. Click Start using ArcMap with
a template.

3. Click OK.

4. Click a template.

5. Click OK.

New Map File button

Opening a new template
while in ArcMap

1. Click File and click New.

2. Click a template and click
OK.

4

3

2

5Tip

Storing customization in
templates
In addition to layout and data,
map templates (like maps) can
store customization of the ArcMap
user interface such as custom
toolbars and tools.

Tip

Starting a new map using a
shortcut
If you click the New Map File
button on the Standard toolbar,
you can start a new, empty map.
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Saving a map as
a template
If you create a map that you�d
like to use as a template, or if
you modify an existing template
and want to use it again, you can
save it as a template.

You can save a map template
anywhere on your network.
When you want to use the
template, you can open it from
ArcCatalog or ArcMap.

 If you save a template in the
ArcMap Templates folder (by
default in the folder
\bin\Templates where you�ve
installed ArcGIS), it will show
up in the list of templates on the
New map document dialog box.
You can also create subfolders in
this folder, and they�ll show up
as separate tabs on this dialog�
when you click each tab you�ll
see the templates in that folder. If
you work with many different
templates, this is a great way to
organize them.

Saving a template

1. Click File and click Save As.

2. Click the Save as type
dropdown arrow and click
ArcMap Templates.

3. Navigate to the folder where
you want the template saved.

4. Type a name for the new
template.

5. Click Save.

Note: You can only save a
map as a template if your
map was built using
Normal.mxt as the base
template. If it wasn’t, click the
Edit menu and click Select All
Elements while in layout view.
Then copy and paste the
elements into a new empty
map. Then you can save the
new map as a template.

Saving a template so it
will appear in a new tab

1. Click File and click Save As.

2. Click the dropdown arrow and
click ArcMap Templates. u

1

3

5

24

1

2

Tip

Changing a map template
To change an existing template,
open the template (.mxd) file and
make the necessary edits directly
on it.
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3. Navigate to the Templates
folder.

4. Click the New Folder button.

5. Type the name of the new
folder—this name will appear
on the New map document
dialog box as a tab.

6. Double-click the new folder.

7. Type the name of the new
template.

8. Click Save.

Next time you start a map
from a template, you’ll see a
new tab with your template
on the New map document
dialog box.

3 4

5

8

7
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Setting up the
page
When you create a map for
printing or publication, you�ll
work on the virtual page in layout
view.

If you intend to print or export a
graphic of a map, you should plan
the size of the map. Will the map
be printed on a small page or a
large one? What printer will you
use and which print engine will be
most efficient for your map
content? Will it be viewed close
up or at a distance?

ArcMap makes it easy for you to
change the size of the page if
needed, but it is wise to have the
final product in mind when you
begin designing the map.

If the virtual page doesn�t match
the page size and orientation
you�ve planned for your map, you
can change the page setup. By
default, the virtual page size is the
same as your system printer�s
default page size, but you can set
the page to be one of many
standard sizes, or you can define a
custom page size for your map.

You can set the page size, page
orientation, printer, printer engine,
and the visibility of printer
margins in the layout from the
Page Setup dialog box. u

Switching to layout view

1. Click View and click Layout
View.

Setting up the page size
and printer properties

1. Right-click the virtual page
and click Page Setup.

You can also open the Page
Setup dialog box from the
File menu or the Print dialog
box.  u

Right-click outside of selected data
frames to get the Page context menu.

1

1
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2. Click the Name dropdown
arrow and click the printer
you want to use.

3. Click the Printer Page Size
dropdown arrow and click the
page size that’s right for your
map.

4. Click OK.

Because the Same as Printer
box is checked, the map
Width and Height text boxes
are updated with the new
page size, and the Page
Orientation is set accordingly.

Making the map page
size independent of the
system printer

1. Uncheck Same as Printer on
the Page Setup dialog box.

2. Click the Standard Page
Sizes dropdown arrow and
click the page size that’s right
for your map.

3. Optionally, to define a custom
page size, type the page size
for your map in the Width and
Height text boxes.

4. Click OK.

Check to automatically rescale
map elements when you change
the page size.

3

4

2

1

3

4

Tip

Changing the page size
later
While it�s best to set the page size
before you begin creating a map,
you can make changes to the page
size later if necessary. ArcMap will
automatically rescale map
elements to fit the new page size.
You can turn off the rescaling
function by unchecking the box on
the Page Setup dialog if you�d
prefer to adjust the size and shape
of your map elements by hand.

Tip

Why make the map page
independent of the printer?
If you give a map document�that�s
dependent on your printer setup�
to someone who doesn�t have that
printer, they�ll get a warning
message when they open the map.
The map will then rescale to fit
their default printer size and page
orientation�usually 8.5 x 11
inches and portrait orientation in
the United States. The result may
differ considerably from the map
you designed.

You can prevent this by making the
page size independent of the
printer. If you do this, you�ll need
to specify a standard page size.

The page setup is important
because it affects the size of the
features, symbols, labels, and
other text, as well as other map
elements.

2
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Setting the page
orientation

1. Click a page orientation
(Landscape or Portrait) to set
the page orientation.

2. Click OK.

Showing or hiding printer
margins

1. Check Show printer margins
on Layout.

2. Click OK.

Printer margins shown by light gray dotted line

1

1 2

2

Tip

Changing the page
orientation later
While it�s a good idea to set up the
page orientation before you begin
laying out your map, you can
change the page orientation at any
time. If auto-rescaling is turned
on, your map elements will be
adjusted to fit the new orientation.

Tip

Why show printer margins?
It�s useful to show the printer�s
built-in margins on the layout so
you won�t place map elements on a
nonprinting part of the page.

If you�re working on a map where
the virtual page size is not set to be
the same as your printer�s page
size, you�ll be unable to use the
printer�s margins. However, you
can use guides to define the map�s
margins.

See Also

For more information on using
guides, see �Using rulers, guides,
and grids� in this chapter.
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Customizing data
frames
In layout view you see geo-
graphic data in a data frame on
the virtual page. You can use the
data frame to emphasize the
geographic data on the map, for
example, by adding a border, a
background, or a drop shadow.

To help locate geographic
features, you can add grids to
your data frame. Grids subdivide
the data frame by latitude and
longitude, projected linear units,
or a specified number of rows
and columns.

Renaming a data frame

1. Click the data frame in the
table of contents.

2. Wait a moment, then click the
data frame a second time.

3. Type a new name for the data
frame.

Adding a border to a data
frame

1. In the table of contents, right-
click the data frame and click
Properties.

2. Click the Frame tab.

3. Click the Border dropdown
arrow and click a symbol.

4. Click the Color dropdown
arrow and click a color.

5. Type an X and Y gap to offset
the border from the edge of
the data frame.

6. Type a Rounding percentage
to round the corners of the
border.

7. Click OK.

Data frame name

6

2

1

Tip

Why rename a data frame?
When you just have one data
frame, its name isn�t that impor-
tant. However, if you make a map
with multiple data frames, it can
be convenient to name them.

5
4

3

7

Click here to change other
border properties.
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Adding a background to a
data frame

1. In the table of contents, right-
click the data frame and click
Properties.

2. Click the Frame tab.

3. Click the Background
dropdown arrow and click a
background.

4. Click the Color dropdown
arrow and click a color.

5. Type an X and Y gap to offset
the background from the
edge of the data frame.

6. Type a Rounding percentage
to round the corners of the
background.

7. Click OK.

6

2

5
4

3

7

Click here to change other
background properties.
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Adding a drop shadow to
a data frame

1. In the table of contents, right-
click the data frame and click
Properties.

2. Click the Frame tab.

3. Click the Drop Shadow
dropdown arrow and click a
drop shadow.

4. Click the Color dropdown
arrow and click a color.

5. Type an X and Y offset to
shift the drop shadow away
from the border of the data
frame.

6. Type a Rounding percentage
to round the corners of the
drop shadow.

7. Click OK.

6

2

5
4

3

7

Click here to change other
drop shadow properties.
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Rotating the data in a
data frame

1. Click View, point to Toolbars,
and click Data Frame Tools.

2. Click the Rotate Data Frame
tool.

3. Click and drag the mouse
over the data frame to rotate
its contents.

Rotating the data in this
manner does not alter the
original source data, just its
display in the data frame.

1

2

Click and drag the mouse
to rotate the data in the
data frame.

Tip

Rotating using a specific
angle
If you want to rotate your data
frame by a specific angle, you can
type in the angle on the Data
Frame Tools toolbar.

You can also type
in an angle here.
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Adding a graticule

1. In the table of contents,
double-click the data frame
you want to add a graticule
to.

2. Click the Grids tab on the
Data Frame Properties dialog
box.

3. Click New Grid.

The Grids and Graticules
Wizard should appear. If not,
see the tip to the left.

4. Click Graticule.

5. Type a name for the new grid.

6. Click Next.

7. Click an Appearance option.

8. Type the Intervals you want.

9. Click Next. u

Tip

What type of grid should I
display?
If the data you�re mapping covers
a large area of the earth�s surface,
you can show graticules that
represent lines of latitude and
longitude.

If you�re mapping a region, such
as a country, you can show a
measured grid that references a
particular projected coordinate
system.

If you�re mapping a local area,
such as a study area, you can show
a reference grid that divides the
data frame into squares that you
can reference by row and column.

2

3

4

5

6

9

7

8

Tip

Why don’t I see the Grids
and Graticules Wizard?
You need to enable wizards. From
the Tools menu, click Options, then
check Show Wizards when
available.
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Q

W

E

U

R

T

10.Check the Axes you want and
set how they should appear.

11. Click Font to set the text
style.

12.Click Next.

13.Click the Graticule Border you
want.

14.Check Place a border outside
the grid.

15.Click to specify whether the
graticule is static or updates
with changes to the data
frame.

16.Click Finish.

Y
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Adding a measured grid

1. In the table of contents,
double-click the data frame
you want to add a measured
grid to.

2. Click the Grids tab on the
Data Frame Properties dialog
box.

3. Click New Grid.

The Grids and Graticules
Wizard should appear. If not,
see the tip to the left.

4. Click Measured Grid.

5. Type a name for the new grid.

6. Click Next.

7. Click an Appearance option.

8. Click Properties to set a
coordinate system for the grid
that differs from that of the
data frame.

9. Type the Intervals you want.

10.Click Next. u

2

3

4

5

6

Q

7

8

9

Tip

Why don’t I see the Grids
and Graticules Wizard?
You need to enable wizards. From
the Tools menu, click Options, then
check Show Wizards when
available.
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W

E

R

I

T

Y

U

11. Check the Axes you want and
set how they should appear.

12.Click Font to set the text
style.

13.Click Next.

14.Click the Measured Grid
Border you want.

15.Check Place a border outside
the grid.

16.Click to specify whether the
measured grid is static or
updates with changes to the
data frame.

17.Click Finish.
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Adding a reference grid

1. In the table of contents,
double-click the data frame
you want to add a reference
grid to.

2. Click the Grids tab on the
Data Frame Properties dialog
box.

3. Click New Grid.

The Grids and Graticules
Wizard should appear. If not,
see the tip to the left.

4. Click Reference Grid.

5. Type a name for the new grid.

6. Click Next.

7. Click an Appearance option.

8. Type the Intervals you want.

9. Click Next. u

2

3

4

5

6

9

7

8

Tip

Why don’t I see the Grids
and Graticules Wizard?
You need to enable wizards. From
the Tools menu, click Options, then
check Show Wizards when
available.
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Q

W

E

U

R

T

Y

10.Set the Tab Style.

11. Set the Tab Configuration.

12.Click Next.

13.Check Place a border
between grid and axis labels.

14.Check Place a border outside
the grid.

15.Click to specify whether the
graticule is static or updates
with changes to the data
frame.

16.Click Finish.
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Using rulers,
guides, and grids
You can use rulers, guides, and
grids in layout view to align map
elements on the page.

Rulers show the size of the page
and map elements on the final
printed map. Guides are straight
lines that you can use to align
map elements on the page. A grid
is a grid of reference points on
the layout that you can use to
position map elements.

You can use each of these layout
aids as visual indicators of
element size and position. You
can also turn on snapping to
force map elements to snap to the
rulers, guides, or grid. Snapping
makes it easy to align map
elements precisely.

You can use guides in layout
view to align map elements on
the page. u

Turning rulers on and off

1. Right-click the page.

2. Point to Rulers and click
Rulers.

The rulers are on by default.

Ruler

Page positionGeographic position

Snapping to rulers

1. Right-click the page.

2. Point to Rulers and click
Snap to Rulers.

2

Tip

How can I tell exactly
where the pointer is?
You can use the readouts in the
lower-right corner of the ArcMap
window to find the geographic
position and page position of the
pointer.

1

2
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Setting the units and
divisions on rulers

1. Right-click the ruler.

2. Click Options.

3. Click the Units dropdown
arrow and click a unit of
measure.

4. Click the Smallest Division
dropdown arrow and click the
size of the smallest division.

5. Click OK.

Although you can see guides on
the virtual page in layout view,
they will not show up when you
print your map.

You can use a snapping grid in
layout view to align map
elements on the page.

Although you can see the grid on
the virtual page in layout view, it
will not show up when you print
your map.

2

1

4

3

5

Tip

What units can I use to
measure the page?
You can set the units of measure
shown on the rulers to points,
centimeters, or inches. You can
also change the number of
divisions per unit.
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Turning guides on and off

1. Right-click the page.

2. Point to Guides and click
Guides.

Snapping to guides

1. Right-click the page.

2. Point to Guides and click
Snap to Guides.

When you move map
elements to the vicinity of a
guide, the map element will
snap to the guide.

1 2

2
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Adding a guide

1. Click the ruler at the place
where you want a guide.

Moving a guide

1. Point to a guide marker on
the ruler.

2. Click and drag the guide
marker to a new location on
the ruler.

The guide appears with a
dotted line until you release
the mouse button.

Guide marker

Guide

Removing a guide

1. Point to a guide marker on
the ruler.

2. Right-click the guide marker
and click Clear Guide.

1

2

2

1
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Using guides to define a
map’s margins

1. Click the rulers to add guides
where you want the map’s
margins to be.

2. Optionally, move the guides
to fine-tune their position.

Removing all guides from
a ruler

1. Right-click the ruler.

2. Click Clear All Guides.

All of the guides are removed
from the ruler.

1

2

See Also

For more information on margins,
see �Showing or hiding printer
margins� in this chapter.

Tip

Using guides to set
margins on the page
You can use guides to set margins
for a map that is not the same size
as your printer�s page size.

The guides provide a visual
indication of the map�s margins to
help you avoid positioning map
elements in the margins.

Turning on snapping to guides will
provide an additional cue that an
element is near a margin.
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Turning the grid on and
off

1. Right-click the page.

2. Point to Grid and click Grid.

Changing the grid size

1. Click Tools and click Options.

2. Click the Layout View tab on
the Options dialog box.

The Options dialog box
appears.  u

Tip

Snapping to the grid
The snapping grid appears as a
grid of dots on the virtual page.
You can use the grid as a purely
visual reference in placing map
elements, or you can turn on
snapping to grid. If you turn on
snapping, the position of elements
on the page will be constrained by
the vertices of the snapping grid.

Snapping to the grid

1. Right-click the page.

2. Point to Grid and click Snap
to Grid.

1

2

2

1

Tip

Why change the grid size?
You can change the size of the grid
to allow more or less freedom in
positioning map elements when
snapping to grid is enabled.
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3. Click the Horizontal Spacing
dropdown arrow and click a
number of units to specify the
horizontal spacing of the
snapping grid.

4. Click the Vertical Spacing
dropdown arrow and click a
number of units to specify the
vertical spacing of the
snapping grid.

5. Click OK.

Changing the snapping
tolerance

1. Right-click the page.

2. Click Options.

3. Type a number of units for
the snapping tolerance.

4. Click OK.

3

4

4
3

5

Tip

Changing the snapping
order
The order in which guides, grids,
and rulers appear in the Snap
elements to list determines which
one an element will snap to. For
example, in the event that the
element is within the snapping
tolerance of both a guide and a
grid point, it will snap to which-
ever is on top�the guide or the
grid point.

You can use the up and down
arrow keys to change the snapping
order.
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Adding data
frames
A map is composed of one or
more data frames (and data)
arranged on the page, plus one or
more other map elements.

Simple maps usually have only a
single data frame. Sometimes
you want to show more data than
a single frame can conveniently
hold. If that�s the case, you may
decide to add another data frame
to the map.

You can use additional data
frames in different ways, for
example, to show insets and
overviews or to allow map
readers to compare different
representations of the same area.

Adding a new data frame
to a map

1. Click Insert and click Data
Frame.

You can add any data to the
new data frame.

Newly inserted
data frame

Existing data frame

Duplicating a data frame

1. Click the data frame to select
it.

2. Click Edit and click Copy.  u

1

1

2

Tip

Choosing how to add a
data frame
If you want to show two different
layers of data in two data frames,
it may be quicker to add a new
data frame to the map than to copy
an existing data frame.

If your data frames have layers in
common, it may be more conve-
nient to add the common layers to
a single data frame than to
duplicate the data frame.
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3. Click Edit and click Paste.

4. Click the copy, located on top
of the original data frame,
and drag it to a new place on
the page.

Resizing a data frame

1. Click the data frame to select
it.

2. Click a selection handle and
drag it to change the size of
the data frame.

3

4

1

2
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Using one data frame to
show the location of
another

1. Click the overview data frame
to select it.

2. Right-click the overview data
frame and click Properties.

3. Click the Extent Rectangles
tab.

4. Click the detail data frame (in
this case called Layers) in the
Other data frames list and
click the right arrow button to
send it to the Show extent
rectangle for these data
frames list.

5. Click Frame to choose a
border for the extent rect-
angle.  u

Overview data frame

Detail data frame

Tip

Showing a data frame’s
position with an extent
rectangle
You can use a data frame with a
large extent to provide context for
another data frame�for example,
showing the location of a state
within a country. If the area on the
map is familiar to your audience, it
may not be necessary to add any
more information.

Sometimes, the area that you show
in the detail data frame does not
have a commonly recognized
outline. In this case, it may be
useful to show its position with an
extent rectangle.

2

1

54

3
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6. Click the Border dropdown
arrow and click a border.

7. Click OK on the Frame
Properties dialog box.

8. Click OK on the Data Frame
Properties dialog box.

Extent rectangle

Overview data frame

Detail data frame

87

6

Tip

Changing extents after you
add an extent rectangle
You can change the extent of either
data frame when you have an
extent rectangle�the rectangle
will automatically be updated to
reflect the new relationship of the
data frames.

Tip

Showing multiple extents
You can use extent rectangles to
show the positions of several
different data frames on a single
data frame.
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Adding map
elements related
to data frames
Some map elements�such as
North arrows, scale bars, scale
text, and legends�are related to
the data in data frames. North
arrows indicate the orientation of
the map. Scale bars provide a
visual indication of the sizes of
features and distances between
features shown on the map. Scale
text indicates the scale of the
map and features on the map. A
legend tells a map reader what
the symbols used to represent
features on the map mean. u

Adding a North arrow

1. Click Insert and click North
Arrow.

2. Click a North arrow.

3. Click OK.

4. Click and drag the North
arrow into place on your map.

5. Optionally, resize the North
arrow by clicking and drag-
ging a selection handle.

1

2

4

3

Tip

Resizing a map element
Map elements aren�t always the
size you want when they�re added
to a map. You can change the size
of map elements by selecting them
and dragging the selection
handles.

Dragging a handle away from an
element enlarges it. Dragging a
handle toward an element reduces
it.
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Adding a scale bar

1. Click Insert and click Scale
Bar.

2. Click a scale bar.

3. Optionally, click Properties to
modify the scale bar’s
properties.

4. Click OK.

5. Click and drag the scale bar
into place on your map.

6. Optionally, resize the scale
bar by clicking and dragging
a selection handle.

You can use a scale bar to
represent the scale of your map.

A scale bar is a line or bar
divided into parts and labeled
with its ground length, usually in
multiples of map units such as
tens of kilometers or hundreds of
miles.

If the map is enlarged or reduced,
the scale bar remains correct. u

1

2

3

4

5
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Customizing a scale bar’s
scale and units

1. Right-click the scale bar and
click Properties.

2. Click the Scale and Units tab.

3. Click the arrow buttons to set
the number of divisions.

4. Click the arrow buttons to set
the number of subdivisions.

5. Click the When resizing
dropdown arrow and click
how you want the scale bar to
respond when the map scale
changes.

Adjust division value—the
division value will vary with
the map scale. The number of
divisions and the width of the
scale bar remain constant.

Adjust number of divisions—
the number of divisions will
vary with the map scale. The
division value and the width
of the scale bar remain
constant.

Adjust width—the width of the
scale bar will vary with the
map scale. The division value
and number of divisions
remain constant.

6. Choose the units for the scale
bar.

7. Click Symbol and choose a
text style for the scale bar
labels.

8. Click OK.

When you add a scale bar to a
map, the number and size of the
divisions might not be exactly as
you would like them. For
example, you might want to show
four divisions rather than three or
show 100 meters per division
instead of 200.

You might also want to change
the units that the scale bar shows
or adjust how those units are
represented.

You can adjust many characteris-
tics of a scale bar from the Scale
Bar properties dialog box. u

8

2

3

4

5

7

6

Tip

Why can’t I see the Size
and Position tab or the
Frame tab?
You can only change the size and
position and frame of an element
after it has been placed on the
map. If you click Properties while
inserting a map element, you won�t
see these tabs.

Tip

Changing the units label
By default, the units label on a
scale bar is the same as the scale
bar units. Sometimes you might
want to change the label of the
scale bar, for example, from
Kilometers to km. Just type the new
scale bar label in the Label text
box.
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Customizing a scale bar’s
numbers and marks

1. Right-click the scale bar and
click Properties.

2. Click the Numbers and Marks
tab.

3. Click the Numbers Frequency
dropdown arrow to choose
where along the bar to place
the numbers.

4. Click the Numbers Position
dropdown arrow to choose
where to place numbers
relative to the bar.

5. Click the Marks Frequency
dropdown arrow to choose
where along the bar to place
tic marks.

6. Click the Marks Position
dropdown arrow to choose
where to place tic marks
relative to the bar.

7. Click the Division Height
arrow buttons to increase or
decrease the height of
division tic marks.

8. Click the Subdivision Height
arrow buttons to increase or
decrease the height of
subdivision tic marks.

9. Click OK.

When you add a scale bar to a
map, the number labels and tic
marks might not be exactly as
you would like them. For
example, you might want to label
the endpoints of the scale bar but
not the divisions, or you might
want larger tic marks at the major
divisions of the bar than at the
minor ones.

You might also want to change
the size or color of the font that
the numbers are drawn in. u

2

3

4

5

6
7
8

9
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You can also represent the scale
of your map with scale text.

Scale text tells a map reader how
many ground units are repre-
sented by a map unit�for
example, �one centimeter equals
100,000 meters�.

One drawback of scale text is
that if a printed copy of the map
is duplicated at another scale
(enlarged or reduced), the scale
text will be in error. Scale bars
do not suffer this limitation.

Many maps have both scale text
and a scale bar to indicate the
map scale. u

Adding scale text

1. Click Insert and click Scale
Text.

2. Click a sample of the style of
scale text to add to the map.

3. Optionally, click Properties to
customize the scale text.

4. Click OK.

5. Click and drag the scale text
into position on your map.

6. Optionally, resize the scale
text by clicking and dragging
a selection handle.

4

5

2

3

1
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You can use a legend to tell map
readers the meaning of the
symbols you�ve used on the map.

Legends consist of examples of
the symbols on the map with a
label containing some explana-
tory text.

When you use a single symbol for
the features in a layer, the layer is
labeled with the layer�s name in
the legend.

When you use multiple symbols
to represent features in a single
layer, the field you used to
classify the features becomes a
heading in the legend, and each
category is labeled with its value.

Adding a legend

1. Click Insert and click Legend.

The Legend Wizard appears.
If you don’t see it, enable the
Legend Wizard as described
in the tip to the left.

2. By default, all the layers on
the map will appear as
legend items in the legend.
To remove a legend item,
click it, then click the left
arrow button.

3. Use the Up and Down arrow
buttons to order the legend
items.

4. Click Next.  u

1

Tip

Legends on maps with
multiple data frames
When you have more than one data
frame, inserting a legend adds a
legend for the selected data frame.

Each legend corresponds to a
single data frame, although you
can arrange multiple legends
together as a single legend for a
complex map.

Tip

Enable the Legend Wizard
You can insert legends with the
help of the Legend Wizard. To
enable the wizard, click the Tools
menu and click Options. Click the
Application tab and check Show
Wizards when available.

2 2

3

4
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5. Type a title for the legend.

6. Set the text color, size, and
font as desired.

7. Click Next.

8. Click the Border dropdown
arrow and click a border.

9. Click the Background
dropdown arrow and click a
background.

10.Click the Drop Shadow
dropdown arrow and click a
drop shadow.

11. Click Next.  u

Tip

Changing legend labels
You can edit the text of the labels
that appear in the legend by
changing the text in the ArcMap
table of contents or on the
Symbology tab of the Layer
Properties dialog box.

5

6

7

8

9

Q

W
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12.Click a Legend Item in the list
to modify the symbol patch.

13.Set the Patch properties as
desired.

14.Click Next.

15.Set the spacing between
legend elements by typing a
value into the appropriate
box.

16.Click Finish.

E

R

T
Y

U
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Changing the patches in
a legend

1. Double-click the legend on
the map and click Properties.

2. Click the Legend tab.

3. Click the dropdown arrow to
select a new patch shape.

4. Click OK.

Legends have patches that show
examples of the map symbols. By
default, the legend patches are
points, straight lines, or rect-
angles that match the map
symbols. You can customize the
legend patches so areas are
represented with patches of
another shape or so rivers are
drawn with a sinuous rather than
straight line. 1

2

3 4
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Changing the items in a
legend

1. Right-click the legend on the
map and click Properties.

2. Click the Items tab.

3. Click a legend item in the
Legend Items list.

4. Click the up and down arrows
to move the item up or down
in the legend.

5. Optionally, click Style and
change the Item’s style in the
legend.

6. Optionally, check Place in
new column to place the
highlighted item in a new
column.

7. Optionally, change the
number of columns in the
legend for the highlighted
legend item by clicking the up
and down arrow keys.

8. Optionally, remove an item
from the legend by clicking it
and clicking the left arrow
key.

9. Click OK.

Tip

Changing a single layer ’s
legend patch
If you have two layers with the
same geometry in a data frame�
for example, a layer of roads and a
layer of streams�you can set their
legend patches independently, so
roads are shown with a straight
line and rivers with a sinuous line.

In the Legend Items list, click the
Item for the layer you want to
change. Right-click and click
Properties. Click the General tab
and check the Override default
patch box. Click the Patch
dropdown arrow and click a new
patch.

2 8 3

4

5

6
7

9
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Framing a map element

1. Right-click the element on the
map and click Properties.

2. Click the Frame tab.

3. Click the Border dropdown
arrow and click a border.

4. Click the Background
dropdown arrow and click a
background.

5. Click the Drop Shadow
dropdown arrow and click a
drop shadow.

6. Click OK.

Certain map elements�includ-
ing scale bars, scale text, North
arrows, legends, and data
frames�can have frames.

You can use frames to set map
elements apart from other
elements or from the background
of the map.

You can also use frames to
visually link map elements to
other parts of the map by using
similar frames for related
elements.

1

2

6

Tip

Why can’t I see the Frame
tab?
You can only set the frame
properties after an element has
been placed on the map.

Tip

Framing grouped elements
If you group some elements
together, you can right-click the
group and set a frame for the
group.

3

4

5
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Converting map elements
to simple graphics

1. Right-click an element, such
as a legend, and click
Convert To Graphics.

The element is now a
grouped graphic.

2. Right-click the graphic and
click Ungroup.

The individual graphics that
comprise the map element
can now be edited separately.

1

2

After ungrouping, you can edit the individual graphic elements.

Tip

Why convert a map
element to graphics?
You might want to convert a map
element, such as a legend, to
graphics if you want more precise
control over each element that
comprises the element. Once you
convert a map element to graphics,
you can�t reconstruct the map
element from the individual pieces.
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Adding other map
elements
In addition to those elements that
are related to data frames, there
are elements that provide
additional information, frame or
group the elements of the map,
or ornament the map.

Most maps have a title. A title
communicates the topic of the
map to a casual viewer and
provides a way to refer to a map.

Many maps have graphic
elements in addition to the
geographic data on the map.

Graphics can be used to orna-
ment a map, group related parts
of a map together, identify a map
with an organization, or empha-
size a part of the map. You can
use graphic rectangles to frame a
group of other map elements.

If you want to frame an indi-
vidual map element, right-click
it, click properties, and click the
Frame tab�you can use this
method to choose borders and
backgrounds for legends, North
arrows, data frames, scale bars,
scale text, and data frames.

Maps can have pictures or
graphic images in addition to the
geographic data on the
map. u

Adding a title

1. Click Insert and click Title.

2. Type a title for the map.

3. Click and drag the title into
place on your map.

4. Optionally, modify the
appearance of the title text.

Modifying a title

1. With the title selected, click
the Font dropdown arrow and
click a font.

2. Click the font size dropdown
arrow and click a font size.

3. Click Bold, Italic, or Underline
to change the style of the
text.

4. Click the Text Color drop-
down arrow and click a color.

1 2 3 4

1

2

3
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Adding a graphic element

1. Click the graphics dropdown
arrow on the Drawing toolbar.

2. Click the New Rectangle
button.

3. Click on the map and drag a
box where you want the
rectangle.

The graphic element appears
on the map.

3

3

Applying color to a
graphic element

1. Click a graphic element to
select it.

2. Click the Fill Color dropdown
arrow.

3. Click a color.

The fill color is applied to the
graphic element.

3

You might add a graphic image
of your company�s logo to
indicate the source of a map or
add a nation�s flag to a map to
indicate its subject.

You can also ornament a map by
placing representative images of
places, people, or objects found
in an area on a map.

While most of the data on a map
is usually geographic data
presented in data frames, maps
can also contain reports and
graphs that support or comple-
ment the geographic data.
Reports and graphs are two
alternative ways of presenting
complex tabular information;
they can make your map more
informative or persuasive.

1

2

2

Tip

Mixing your own colors
If you don�t find the exact color
you want in the array of colors on
the Fill Color dropdown menu, you
can mix your own. Click the
dropdown arrow and click More
Colors.
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Applying a line color to a
graphic element

1. Click a graphic element to
select it.

2. Click the Line Color drop-
down arrow.

3. Click a color.

The line color is applied to
the graphic element.

Placing a graphic element
behind other elements

1. Click the graphic element to
select it.

2. Right-click on the graphic
element, point to Order, and
click Send to Back.

Graphic rectangle behind
map elements

2

3

2
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Adding a neatline

1. Click the Insert menu and
click Neatline.

2. Click the Placement option
you want.

3. Check Group neatline with
elements if you want to group
the elements with the
neatline.

4. Click the Border dropdown
arrow and click the type of
neatline you want.

5. Click OK.

2

3

4

5

1
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Adding a picture

1. Click Insert and click Picture.

2. Navigate to the folder that
contains the picture.

3. Optionally, select the type of
picture that you want to add.

4. Click the picture that you
want to add.

5. Click Open.

6. Click and drag the picture into
position on your map.

7. Optionally, resize the picture
by clicking a selection handle
and dragging it.

Tip

Stretching picture graphics
ArcMap keeps the same ratio of
width to height (the aspect ratio)
when you resize picture graphics,
so they won�t be distorted when
you change their size. If you want
to make a graphic wider or taller
without changing its other
dimension, right-click the graphic,
click properties, then uncheck
�Maintain aspect ratio� on the
Picture tab. You can then stretch
the graphic.

1

2

4

5

3
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7
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Aligning map elements

1. Click one of the map ele-
ments to select it.

2. Hold the Shift key and click
the other map element.

Now both elements are
selected.

3. Right-click on one of the
selected elements, point to
Align, and click Align Center.

4. Click the aligned map
elements and drag them into
position on your map.

Aligning and
grouping map
elements
Sometimes you�ll have multiple
elements that you want aligned
on the map. For example, you
might want the left edges of two
legends to be aligned. You can
quickly align map elements by
using the Align tools.

If you have multiple elements
that you�ve placed relative to
each other and you want them to
maintain the same relationship
when they�re moved, you can
group them together. The map
elements will be treated as a
single element until you ungroup
them.

4

2

1

3

Tip

Snapping to the map’s
margins when you align
elements
The Align tools can either align
selected map elements with each
other or with the margin of the
map. If you click Align to Margins,
the Align tools will snap selected
elements to the margins of the
map. Click Align to Margins again
to make the Align tools align
selected elements with each other.
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Grouping map elements

1. Click one of the map ele-
ments to select it.

2. Hold the Shift key and click
the other map element.

Now both elements are
selected.

3. Right-click on one of the
selected elements and click
Group.

1

3

2

Tip

Ungrouping map elements
To ungroup map elements, select
the group, right-click it, and click
Ungroup.

Tip

Resizing groups of
elements
If you group some elements, you
can click on the group and drag a
selection handle to resize the
group, just as you would a
graphic.

The font size of text in a group will
be scaled to match the new size of
the group.

See Also

For more information on aligning,
distributing, positioning, and
ordering map elements, see
Chapter 7, �Labeling maps with
text and graphics�.
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Printing a map
Once you�ve created a map,
you�ll probably want to print it.

It�s a good idea to preview your
map before your print it to make
sure that the map page and
printer page sizes are correctly
matched.

If you want to print a map that is
not set to be the same as the
printer page size, there are
several scenarios.

If the map is smaller than your
printer page size, go ahead and
print or choose a smaller page
size on your printer.

If the map is larger than the
printer�s default page size, you
have several options. You can
change the page size of the
printer, change the printer that
you�re using, or change the page
size of the map. u

Previewing and printing a
map

1. Click File and click Print
Preview.

2. Examine the preview. If it
looks right, click Print. u

Tip

Previews of maps with
raster data layers
Large maps with raster layers may
look excessively dark in the small
print preview window. This is
because rasters are not resampled
for the preview. This will not affect
the way your map appears when it
is printed at full scale.

1

2
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3. Verify that you’re printing to
the correct printer with the
printer engine you want.

4. Optionally, click the Setup
button to display the Page
Setup dialog and choose
another printer engine. Click
OK.

5. Click OK.

Tiling a map that’s bigger
than your printer page

1. Click File and click Print
Preview.

If the map page size is larger
than the printer page size,
you will see a portion of the
map in the preview.

2. Click Print. u

If your printer will accommodate
a large page but its default page
size is smaller than your map,
change the Printer Page size on
the Page Setup dialog box.

If your printer cannot accommo-
date a page the size of the map,
you can print the map as tiles on
separate pages, scale the map to
the printer page size, or simply
proceed with printing and clip
the map to the printer�s page
size.

If you have another printer on the
network that will print your large
map on a single page, you can
switch to that printer. Just choose
the new printer and the correct
page size on the Page Setup
dialog.

You can also change the page
size of the map on the Page
Setup dialog box. See �Setting
the page� in this chapter.

5

2

Tip

Set page size the same as
printer
If you have the page size set to be
the same as the printer page,
printing your map will be very
simple�just click File, click Print,
then click OK.

3

4

See Also

For more information on setting
the page size for a map, see
�Setting the page� in this chapter.
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3. Click Tile map to printer
paper.

4. Click OK.

Printing multiple copies

1. Click File and click Print. u

4

3

1

Tip

ArcPress
For large or very complex maps or
maps with rasters or transparent
layers, the Windows® and
PostScript® printer engines may
produce print files that are larger
and more complex than your
printer can handle.

If your printer is unable to print
your map, you should purchase the
ArcPress� printer engine to use
with ArcMap.
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2. Type the number of copies
you want to print.

3. Click OK.

Printing to a file

1. Click File and click Print.

2. Check Print to file.

3. Optionally, click the Setup
button to display the Page
Setup dialog and choose
another printer engine. Click
OK.

4. Click OK. u

3

2

2

3

4

Tip

Page orientation
If you have the page size set to be
the same as the printer page, the
page orientation will match the
best fit for the selected printer and
printer engine.

If you have a custom page size, the
map�s page orientation will be
rotated according to the width and
height of your map page. It�s best
to set the printer page orientation
to match, or your map may be
clipped.
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7

5

6

5. Navigate to where you want
to save the output printer file.

6. Type a name for your print
file.

7. Click Save.

Tip

Print filename extensions
If you choose the Windows printer
engine, you�ll create a Windows
printer file, *.prn. If you choose
the PostScript printer engine,
you�ll create a PostScript file, *.ps.
If you choose the ArcPress printer
engine, you�ll create a raster file
with the extension of the ArcPress
driver you�ve selected.
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Changing the
layout
A quick way to change the way
your map looks is to change the
layout so that it matches the
layout of a template. To change
the layout, use the Change
Layout tool. This tool is ideally
suited for maps that you haven�t
spent much time arranging and
adding map elements to. For
example, suppose you created an
empty map, added a few layers to
it, and symbolized the layers the
way you wanted them to look.
You could then use the Change
Layout tool to arrange the map
elements as defined in a layout.

When you change the layout, the
resulting map will contain only
those map elements that are
defined in the template. For
instance, if your original map has
a legend but the template you
want to use doesn�t, the new
layout will not contain a legend.
Additionally, any map elements
will be formatted as they are
defined on the template, not on
the original map. Thus, if you�ve
spent a long time setting the
properties of the map elements,
you probably won�t want to use
the Change Layout tool as the
settings will not carry over to the
new layout.

Changing the layout

1. Click the Change Layout tool
on the Layout toolbar.

2. Click the tab containing the
template you want to use to
change the layout.

3. Click the template you want
to use.

4. Click Finish if the number of
data frames on the map
matches the number of data
frames in the template.

Click Next if the number of
data frames on the map
doesn’t match the number of
data frames in the template
and proceed to the next step
to arrange the data frames on
the map.

5. Click the data frame you want
to position on the map.

6. Click Move Up or Move Down
to change its position in the
list.

Order the data frames to
position them appropriately
on the layout. If your map has
more data frames than the
template provides space for,
the extra data frames will be
positioned at the lower-left
corner of the map.

7. Click Finish.

1
2

3

4

5

6 7
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Exporting a map
Once you�ve created a map, you
may want to export it from a map
document to another file type.

You can export maps as several
types of image files. These
include EMF, BMP, EPS, PDF,
and JPEG (and several more
types if you have ArcPress).

EMF (Enhanced Windows
Metafiles) are Windows native
vector, or vector and raster,
graphics. They are useful for
embedding in Windows docu-
ments because they can be
resized without distortion.

BMP (Windows Bitmap) files are
simple, native Windows raster
images. They do not scale as well
as EMF files.

EPS (Encapsulated PostScript)
files are primarily used for vector
graphics and printing.

PDF (Portable Document
Format) files are designed to be
consistently viewable across
different platforms. They are
commonly used for distributing
documents on the Web.

JPEG (Joint Photographic
Experts Group) files are com-
pressed image files. They are
commonly used for images on
the Web because they are more
compact than many other file
types.

Exporting a map

1. Click File and click Export
Map.

2. Navigate to where you want
to save the export file.

3. Click the Save as type
dropdown arrow and click the
type of file that you want to
export.

4. Type a name for the export
file.

5. Optionally, click Options and
set parameters for the file
type that you chose.

6. Click Export.

2

34

6

1

5
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Working with styles and symbols 9
• Using styles to create maps

• Finding the styles you need

• Modifying and saving symbols

• Modifying and saving map ele-
ments

• Saving the current styles

• The Style Manager

• Organizing style contents

• Creating new symbols and map
elements

• Creating line symbols

• Creating fill symbols

• Creating marker symbols

• Creating text symbols

• Working with color

Styles provide a complete set of tools to help you create a map. Each style
contains a suite of symbols and map elements that provide information about
symbol properties, label specifications, color schemes, legend and scale bar
characteristics, coordinate reference systems, and much more.

Styles help to describe not only how data is drawn, but also the appearance
and placement of map elements, symbols, and other cartographic additions on
your map. Every time you select and apply a particular map element or
symbol, you are using the contents of a style.

Styles are designed to be used with map templates and feature layers. A style
or group of styles can be referenced with a map template to help you create a
map for a specific purpose or a map series.

Styles can help you maintain standards for symbols, colors, patterns, and
methods of rendering distributions, relationships, and trends. Using familiar
styles lets your map communicate in the most effective way. Styles enable
people to easily explore, understand, and analyze a map. ArcMap comes with
a wide variety of styles to help you create maps that convey the right message
for a specific application and audience.

In the previous chapters, you have learned how to symbolize data and how to
draw map elements and graphics. You are probably already familiar with most
of the symbol and map element dialog boxes.

In this chapter, you will learn how to create the symbols you want and save
them in styles you can reuse to produce maps that meet the needs of your
organization.
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Using styles to create maps

Marker
symbol

Fill symbol Reference system

Color

Scale bar

Legend item

Area patch

Text symbol

Label

North arrow

Color ramp

Scale text

Border
Background

Line patch

Line
symbol
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Finding the styles
you need
By default, ArcMap displays a
robust set of generic symbols and
map elements from the style of
ESRI. It also comes with a wide
range of industry-specific styles.
To create maps for your applica-
tion, you may need to use
components from one or more
styles. When a style is refer-
enced, its map elements and
symbols are available throughout
ArcMap.

As you compose your map, you
will see these symbols through-
out the user interface.

You can add more styles or
remove styles at any time during
an ArcMap session.

1. Click Tools, point to Styles,
and click Style References.

Your personal style and the
ESRI style are referenced by
default.

2. Check the additional styles
you want to use.

3. Click the Add button to load
more styles.

Navigate to and click the
styles you need.

4. Click OK.

4

1

2

3

Tip

Are there other ways to
reference styles?
You can reference styles in the
Style Manager dialog box and in
the Symbol Selector dialog boxes.
However, the Symbol Selector
dialog boxes only list the styles
that contain the same symbols.

Tip

Can I install just the styles
I need?
You can use the custom ArcMap
installation to load only the styles
you want to have accessible in
ArcMap.
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Modifying and saving
symbols used to draw
feature layers

1. In the Table of Contents, click
the symbol you want to
modify.

The Symbol Selector dialog
box is displayed.

2. Double-click on a symbol.

3. If you want to make further
simple modifications, use the
Color and Width Options to
set specific properties.

4. If you want to make further
advanced modifications, click
Properties to access the
Symbol Editor dialog box and
make the changes you want.

5. Click Save.

6. Type a Symbol Name.

Your new symbol is saved in
your personal style and
appears at the top of the
Style contents window.

7. Click OK.

8. Click OK.

4

7

2

3

8

5

6

Modifying and
saving symbols
As you compose your map, you
may want to modify the symbols
you�ve used to draw data and
graphics.

You may also want to open a
saved map document and make
modifications.

When you save your changes
from the Symbol Selector dialog
box, the new symbols are stored
in your personal style. Later, you
can use the Style Manager to
move them into another style.

Tip

Why can’t I modify the
color of a symbol?
Sometimes a symbol layer or
layers are locked. In this case, you
can click Properties and use the
Symbol Editor dialog to modify the
colors you want.

Tip

What’s a symbol category?
When you save a symbol, you can
specify a name and a category for
class distinction. The category can
be  used to differentiate drawing
methods and other criteria. It can
be viewed in the Style Manager
dialog box.
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Modifying symbols used
to draw graphics

1. In layout view, double-click a
graphic element on the map
or click the context menu and
click Properties.

2. Change the Color, Size, and
Angle options as needed or
click Change Symbol and
choose another symbol.

3. If you want to make further
advanced modifications, click
Properties to access the
Symbol Editor dialog box and
make the changes you want.

4. Click OK.

2

3

4

Using the Draw toolbar to
make quick symbol
changes

1. In layout view, click to select
the graphic element you want
to modify.

2. Click the appropriate shortcut
button on the Draw toolbar.

3. Click the new property.

Your changes are immedi-
ately applied.

1

1

3
24

Tip

Can I modify my data with
the Draw toolbar shortcuts?
Only if you have exported your
data to a graphics layer. The Draw
toolbar is only for graphics.

Tip

What’s the difference
between modifying symbols
used to draw data and
symbols used to draw
graphics?
Graphics have an additional
property tab for size and position
in relation to the page.

Tip

Shortcut to the Symbol
Property Editor dialog box
Instead of clicking the Properties
button on the Symbol Selector
dialog box, you can click on the
Preview window.

Tip

What units are used in the
symbol dialog menus?
The Symbol Selector dialog menus
and map element Properties dialog
menus use points. The Symbol
Property Editors can be set to use
points, inches, centimeters, or
millimeters.
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Modifying and
saving map
elements
When you insert a map element
on the map layout, you can
modify its properties. Later, you
may decide to make more
changes and save them to use in
another map.

Most map elements are com-
posed of a mix of symbols and
map elements. For example, the
North arrow�s graphic comes
from a marker that is created
from a font, and its frame comes
from a border and background
that are created from other
symbols.

The graphic example here shows
you how to modify this element.

1. In layout view, double-click on
the element you want to
modify.

2. Click the Color dropdown
arrow and click a new color.

3. Click the Style button.

4. Click Save.

5. Type a name and click OK.

6. Click the Frame tab.

7. Click the Style button to
change the border style.

8. Click Properties.

9. In the Symbol Border dialog
box, click the properties you
want.

10. Click Save.

11. Type a name and click OK.

12.Repeat steps 7 through 11 to
set the background style and
properties.

13.Click OK.Tip

What’s the difference
between modifying symbols
and map elements?
Map elements have an additional
Frame tab for background and
border properties.

Border

Background

1

2

5

6 7

8
R

W

9

3 4

Q
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Saving the
current styles
Saving your current map styles
is an easy way to generate a
style containing all the elements
and symbols used in your map.

You can create and modify map
elements and symbols as you
design your map and then save
everything into a style.

Exporting map styles also allows
you to save map elements and
symbols from many styles into a
single style.

1. Click Tools, point to Styles,
and click Export Map Styles.

2. Navigate to where you want
to save the new style.

By default, the browser is set
to your Styles folder.

3. Type a style name.

4. Click Save.

2

3

1

4

Tip

Can I create a style from
any map without any
referenced styles?
If you need to modify the symbols
in a map and don�t have the
original styles, you can easily
create a style of the existing map
elements and symbols.

Tip

How are symbols stored in
a map document?
When you draw anything in
ArcMap�symbols, map elements,
and graphics�it�s copied into the
map document. Therefore, you
don�t need the original referenced
styles to open and draw the map
again.
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The Style Manager

Style tree.
Open the map element

or symbol folder you
want to view.

Name of the element or symbol. Category of the element or symbol.

Style Contents view modes.

Your personal style
contains all your saved

symbol and map
element modifications.

Referenced
styles.

ESRI style contains a
default set of map

elements and symbols.

Manage elements
and symbols.

Load more
styles.

Create new
styles.

Resize the left and right panels.

Style contents.
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Organizing style
contents
The Style Manager dialog box
lets you organize styles and their
contents�symbols and map
elements. You can cut, copy,
paste, rename, and modify any
style contents. You can also
create new styles, symbols, and
map elements.

You can create a new style and
copy in your personal style
contents as well as symbols and
map elements from other existing
styles.

You may want to customize some
of the ArcMap-provided styles by
deleting the symbols and map
elements you don�t need.

You can easily distinguish which
style folders contain map
elements and symbols, which can
be modified, and which are
empty.

Read/Write
Read only
Empty

Creating a new style

1. Click Tools, point to Styles,
and click Style Manager.

2. Click Styles and click Create
New.

3. Navigate to the Styles folder.

4. Type the name for the new
style you’re creating.

5. Click Save.

2
3

4

5

1
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Tip

Where is the Styles folder
installed?
By default, the Styles folder is
installed \bin\Styles folder where
ArcGIS is installed.

Tip

Where is my personal style
folder installed?
Your personal style folder is
installed under the Windows install
location, for example,
C:\WINNT\Profiles\<user>\Application
Data\Esri\ArcMap.

Copying and pasting
style contents

1. Click Tools, point to Styles,
and click Style Manager.

2. Click the style folder whose
contents you want to view.

3. Click an element and click
Cut or Copy.

4. Click another style folder of
the same kind.

5. Right-click in the contents
window and click Paste.

6. Type a new name for the
style.

You can change the name
later by using Rename on the
context menu.

Deleting style contents

Click on any map element or
symbol and click Delete from
the context menu.

There is no undo for delete,
so you may want to move
something to another folder
for later use rather than
deleting it.

Tip

Using shortcut keys
You can use keyboard shortcuts to
cut, copy, paste, and delete styles.

4 6

3

5

2
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Creating new
symbols and map
elements
When you�re creating symbols
and map elements from scratch,
use the Style Manager dialog
box. You can create new symbols
to add to the style contents, or
you can modify an existing
symbol.

Creating a new symbol in
the Style Manager

1. In the style tree, click the
symbol folder where you want
to create more symbols.

2. Right-click in the open space
in the Symbol contents
window, point to New, and
click Line Symbol.

Use the properties in the
Symbol Property Editor dialog
boxes to create the symbol
you want and click OK.

3. Name the new symbol.

3

4

5

7

8 Q

9

1 2

1 23

6

Tip

Why should I lock or
unlock a symbol layer?
The locking property controls
whether or not the color option
can be modified in the Symbol
Selector dialog box. A locked layer
can�t be modified.

Tip

Why should I turn off
drawing for a symbol
layer?
You might want to modify the
symbol for a particular application
but not want to lose the original
symbol definition.

Using common symbol
properties

1. Set the symbol type.

2. Set the units of measure.

3. Click tabs for applicable
properties.

4. Preview all layers.

5. Preview mode options.

6. Preview each layer.

7. Set layer drawing on or off.

8. Set color locking on or off.

9. Select layer options to add,
delete, move up, move down,
copy, and paste.

10.Click OK.

See Also

To learn how to automate map
production by matching symbol
names to data attributes, see
Chapter 6, �Symbolizing your
data�.
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Creating an encased road

1. In the Line Symbol Property
Editor dialog, click the Type
dropdown arrow and click
Cartographic Line Symbol.

2. Click the Color dropdown
arrow and click black.

3. Set the Width to 3.4 points.

4. Click Butt for Line Caps and
Round for Line Joins.

5. Click the Add a New Layer
button.

Cartographic Line Symbol
should already be selected as
the Type.

6. Click red from the Color
palette.

7. Set the Width to 2.6 points.

8. Click Butt for Line Caps and
Round for Line Joins.

9. Click OK.

1

4

5 9

Creating line
symbols
Line symbols are used to draw
linear data such as transportation
networks, water systems,
boundaries, zonings, and other
connective networks. Lines are
also used to outline other features
such as polygons, points, and
labels. As graphics, lines can be
used as borders, leaders for
arrows and other annotation, and
freehand drawing.

The examples here show you
how to create some common line
symbols: an encased road, a
railroad, a touring route, and
arrowhead leaders.

The four line types are as
follows:

� Simple�fast-drawing, one-
pixel lines with predefined
pattern; or solid, wide lines

� Cartographic�straight line
template patterns and marker
decorations

� Hash�hashures, template
patterns, and marker decora-
tions

� Marker�markers, template
patterns, and other marker
decorations

Any number of layers can be
combined in a single line.

2 3

86 7
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Creating a railroad

1. In the Line Symbol Property
Editor dialog, click the Type
dropdown arrow and click
Cartographic Line Symbol.

2. Click the Color dropdown
arrow and click a gray shade.

3. Adjust the Width to 0.5 points.

4. Click the Add Layer button.

5. Click the Type dropdown
arrow and click Hash Line
Symbol.

6. Click the Hash Line tab and
click Hash Symbol.

7. Click the Color dropdown
arrow and click a gray shade.

8. Adjust the Width to 0.5 points.

9. Click OK.

10.Click the Template tab.

11.Slide the dark gray square to
the 11th position to create a
pattern length of 10 units.

12.Click the 4th position to add
another hash.

13.Click the Cartographic Line
tab.

14.Click the Color dropdown
arrow and click a gray shade.

15.Adjust the Width to 4.

16.Click OK.

Tip

How do I get intersecting
road networks and other
features to draw
realistically?
You can reorder any feature layer
by using the Advanced Drawing
Options menu accessed by right-
clicking on a layer.

For more control, it is also helpful
to symbolize features using the
drawing method to depict unique
values.

Y

U

Tip

How do I modify a hash?
The hash mark uses a line symbol
to set the color, width, caps, and
joins.

Tip

Why shouldn’t I use two
parallel lines for road
encasements?
Using a single wide layer produces
more realistic symbology where
roads intersect and merge.

R
T
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Creating a tour route

1. In the Line Symbol Property
Editor dialog, click the Type
dropdown arrow and click
Cartographic Line Symbol.

2. Click the Color dropdown
arrow and click a color.

3. Click the Template tab.

4. Adjust the Interval to 2 points.

5. Slide the dark gray square to
the 21st position to create a
pattern length of 20 units.

6. Click positions 1–10 to create
a dash.

7. Click the Add Layer button.

8. Click the Type dropdown and
click Marker Line Symbol.

9. Click Marker.

10.Click More Symbols and click
Civic.

11. Click the Car-Generic symbol,
set the Color, set the Size to
30, and click OK.

12.Click the Template tab.

13.Adjust the Interval to 2.

14.Slide the dark gray square to
the 21st position to create a
pattern length of 20 units.

15.Click positions 11–20.

16.Click the Line Properties tab
and set the Offset to 3.

17. Click OK.

1

2

3

5
4

7

W

Tip

How do I align multilayer
symbols using the
Template tab?
The Template tab lets you design a
common template for the symbol
layers that need to be synchro-
nized. You can use the same
template to stack and center line
dashes with markers, or you can
reverse the template pattern to
center the marker in the gap as
shown in the touring route
example.

For hash lines, the template mark
indicates how many dashes will
occur in the pattern segment.

You can create a wide variety of
effects with multiple line layers.
Aligning the layer patterns is
achieved by having a common
denominator for the template and
interval settings.

6

E

R
T

U

I

8
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Creating arrowhead
leaders

1. In the Line Symbol Property
Editor dialog, click the Type
dropdown arrow and click
Cartographic Line Symbol.

2. Click the Line Properties tab.

3. Click the right-facing arrow.

4. Click Properties.

5. Click Rotate symbol to follow
line angle.

6. Click Symbol and click
Properties.

7. Click the Type dropdown
arrow and click Character
Marker Symbol.

8. Click the Font dropdown
arrow and click ESRI Arrow-
head.

9. Click the Character dropdown
arrow and click 37.

10.Click the Color dropdown
arrow and click a green
shade.

11.Set the Size to 18 points and
click OK on all dialog boxes.

12.Click the Cartographic Line
tab.

13.Click the Color dropdown
arrow and click a green
shade.

14.Click Butt for Line Caps and
Miter for Line Joins.

15.Click OK.

1

3

5

6

7

9
8

Y

Tip

Can I create leaders with
markers other than
arrows?
You can use any marker you want
to create start or end decorations.
The default arrow lets you adjust
its length and height. The ESRI
Arrowhead font contains addi-
tional arrow styles, but you can
also use any marker for line
decorations.

Tip

Why do my line arrows
sometimes appear
horizontal to the map?
You can toggle the arrowheads to
follow the line orientation or stay
at a fixed angle to the map. See
step 5 in the task on this page.

2

R
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Creating a solid fill

1. In the Fill Symbol Property
Editor dialog, click the Type
dropdown arrow and click
Simple Fill Symbol.

2. Click the Color dropdown
arrow and click the color you
want.

Or click More Colors and use
the Color Selector dialog box
to mix a new color.

3. Click OK.

12

2

3

1
2

3

Creating fill
symbols
Use fill symbols to draw polygo-
nal features like countries,
provinces, land uses, habitats,
parcels, and footprints. Fills can
be solid, gradients, hatched
overlays, random markers, and
transparent or opaque pictures.
In addition, a polygonal data
layer can be given a percentage
of transparency. Fills are also
used to draw graphic shapes and
backgrounds, data frames, map
elements, graphics, and text.

The five fill types are:

� Simple�fast-drawing solid
fill with optional outline

� Gradient�linear, rectangular,
and circular color ramp fills

� Line�hatched lines at any
angle, separation, or offset

� Marker�marker symbols
drawn randomly or ordered

� Picture�continuous tiling of
a .bmp (Windows bitmap) or
.emf (Windows enhanced
metafile) graphic

Any number of layers can be
combined in a single fill.

Adding a fill outline

1. Click on Outline Color and
click the color you want to
use.

2. Set the Outline Width or click
Outline to choose a pre-
defined line symbol.

Alternatively, use the line
properties menu to create a
new outline.

3. Click OK.

Tip

Creating custom outlines
Click Properties and use the Line
Symbol Editor dialog to design a
custom outline.
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Creating a gradient fill

1. In the Fill Symbol Property
Editor dialog, click the Type
dropdown arrow and click
Gradient Fill Symbol.

2. Click the Style dropdown
arrow and click Linear.

3. Adjust the number of color
Intervals and the color stretch
Percentage from start to end.

4. Click the Color Ramp Style
dropdown arrow and click
another fill.

5. To modify the ramp, right-
click Style and click Proper-
ties.

6. Click Color 1, click the
dropdown arrow, and choose
a new color hue.

7. Click OK.

8. Right-click Style and click
Save.

9. Type the new color ramp
name.

The color ramp is stored in
your personal style.

10.Click OK.

11. Click Outline and set the
Width to 0 for no outline.

12.Click OK.
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2Tip

Do I have to use a
predefined color ramp to
create a gradient fill?
You can modify an existing color
ramp or create a new one as you
create the gradient symbol. See
steps 5 through 9 in the task on
this page.

Tip

Are there different kinds of
color ramps to use with
gradient fills?
There are four types of color
ramps designed to communicate
quantitative data, temperature,
and elevation and to draw
polygonal fills.

The four color ramp types are:

� Algorithmic�linear stretch
between one or two specified
end colors

� Random�alternating bands
of random colors

� Multipart�combines other
color ramp elements in a
continuous band

� Preset�a ramp of individu-
ally specified colors

See also

For more information on color, see
the section �Working with color� in
this chapter.

6

8
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Creating a random dot fill

1. In the Fill Symbol Property
Editor dialog, click the Type
dropdown arrow and click
Marker Fill Symbol.

2. Click Random.

3. Click Marker.

4. Change the Color.

5. Change the Size to 3.

6. Click OK.

7. Click the Fill Properties tab.

8. Adjust the X and Y Separa-
tion to 5, 5 for a denser
distribution.

9. Click OK.

1

3

2

4
5
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Tip

What’s the difference in
using marker fills, line fills,
and picture fills?
Marker and line fills are vector
based. The more dense the fill is,
the more drawing-intensive it is.
Picture fills can be .emf (vector) or
.bmp (images).
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Creating an overlay fill

1. In the Fill Symbol Property
Editor dialog, click the Type
dropdown arrow and click
Line Fill Symbol.

2. Click the Units dropdown
arrow and click Inches.

3. Click Line and click Proper-
ties.

4. Click the Units dropdown
arrow and click Inches.

5. Click the Color dropdown
arrow and click an orange
shade.

6. Set the Width to 0.05.

7. Click OK twice.

8. Adjust the Angle to 45.

9. Set the Separation to 0.1.

10.Click Outline and set it to 0.
Click OK.

11.Click the Add Layer button.

12.Repeat steps 3 through 5.
Set the Width to 0.01. Click
OK twice.

13.Adjust the Angle to 45.

14.Set the Offset to 0.12.

15.Set the Separation to 0.1.

16.Click Outline and set it to 0.
Click OK.

17.Click OK.
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Tip

Is there more than one way
to create a transparent
overlay fill?
You can create a hatched line fill
with alternating opaque and
transparent hatches. You can also
set the entire feature layer to a
percentage of transparency.
Combining these can achieve a
variety of effects.

3

Tip

Can I mix symbols with
different units in the same
style?
You can use any units you prefer.

T
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Creating picture fills

1. In the Fill Symbol Property
Editor dialog, click the Type
dropdown arrow and click
Picture Fill Symbol.

2. Navigate to a .bmp or .emf
file.

3. Click the Foreground and
Background Color dropdown
arrows and set the new
colors.

You can choose “no color” to
create a transparent back-
ground or foreground.

4. Adjust the Scale of the
picture.

5. Click OK.

1

4

Tip

How do I create a
transparent picture fill?
You can set the background or
foreground color to �no color� to
create a transparent picture.

Tip

Why would I want to swap
the foreground and
background color?
Swapping the color properties of a
1-bit .bmp image toggles which
color can be modified with the
Symbol Selector Options. Only the
foreground color can be modified.

Tip

Why does a .bmp look
worse than an .emf when I
scale it?
A .bmp is an image, or a grid of
pixels; therefore, only the indi-
vidual pixels can be scaled. If it is
scaled too large it can look jagged,
rough, or blurry. If it is scaled too
small, it can lose detail.

.emf vectors scale proportionately.

Tip

Is there a significant
difference between a .bmp
and an .emf picture?
A .bmp is a raster image. An .emf
is a vector graphic. You can
modify both foreground and
background colors on 1-bit .bmp
pictures. You can only modify the
background color on multibyte
.bmp and .emf pictures.
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Creating a simple marker
shape

1. In the Marker Symbol
Property Editor dialog, click
the Type dropdown arrow and
click Simple Marker Symbol.

2. Click the Style dropdown
arrow and click Square.

3. Click the Color dropdown
arrow and click a color.

4. Check Use Outline.

5. Click the Outline Color
dropdown arrow and click a
color.

6. Set the Outline Size to 0.5.

7. Click OK.

1

3

5

Creating marker
symbols
Marker symbols are used to
draw point features, labels, and
other map annotations. They
can be used in conjunction with
other symbols to decorate line
symbols and create fill patterns
and  text backgrounds. As
graphics, they can add special
cartographic elements.

The four marker types are:

� Simple�fast-drawing set of
basic glyph patterns with
optional mask

� Character�a glyph from a
TrueType font

� Arrow�a glyph from a
TrueType font

� Picture�a single .bmp
(Windows bitmap) or .emf
(Windows enhanced
metafile) graphic

Any number of layers can be
combined in a single marker.

74

Tip

What’s the difference
between an outline and a
mask?
An outline uses a line symbol to
surround the layer graphic.

A mask uses a fill symbol to draw
a halo around all layers of the
symbol.

2 6

ch9.p65 12/05/2000, 11:42 AM277



278 USING ARCMAP

1

2 3

45

67 8

Creating a marker from a
TrueType font

1. In the Marker Symbol
Property Editor dialog, click
the Type dropdown arrow and
click Character Marker
Symbol.

2. Click the Font dropdown
arrow and click ESRI Default
Marker.

3. Click the Character
dropdown arrow and click the
pushpin button (99).

4. Click the Mask tab.

5. Click Halo.

6. Click Symbol and create a
white fill with a black outline
width of 0.5.

7. Adjust the Size to 2 points.

8. Click OK.

Tip

Can I use any TrueType
font to create symbols?
You can use any text or display font
that�s loaded in your system�s fonts
folder.

ArcMap installs a wide range of
fonts with hundreds of glyphs used
to create the provided styles.

Tip

Can I create my own
TrueType fonts?
You can create your own TrueType®

fonts using third-party font-
creation software and copy them to
your system�s font folder.

Tip

Isn’t a North arrow just a
character marker?
A North arrow is created from a
TrueType font. It also has unique
properties that link it to its source
data frame, and it can have a
background and border.
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Creating an arrow marker

1. In the Marker Symbol
Property Editor dialog, click
the Type dropdown arrow and
click Arrow Marker Symbol.

2. Click the Units dropdown
arrow and click Inches.

3. Click the Color dropdown
arrow and click a red shade.

4. Set the Length to 0.3.

5. Set the Width to 0.125.

6. Click the Copy Layer button.

7. Click the Paste Layer button.

8. Click the Color dropdown
arrow and click black.

9. Set the X Offset to -1.5.

10. Set the Y Offset to -2.0.

11.Click OK.

4
5

7

Tip

Does ArcMap come with
any existing arrowheads?
An ESRI Arrowhead font contains
a variety of arrow shapes. For
more information on how to access
the font, see the section �Creating
a marker from a TrueType font� in
this chapter.
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Creating a marker from a
picture graphic

1. In the Marker Symbol
Property Editor dialog, click
the Type dropdown arrow,
and click Picture Marker
Symbol.

2. Click a .bmp or .emf.

3. Set the Size.

4. Set the Angle.

5. Click OK.

Tip

Does ArcMap come with
any pictures?
The pictures used in the styles that
come with ArcMap are stored in
the \bin\styles\pictures folder
where ArcGIS is installed.

Tip

How can I create my own
pictures?
You can create pictures using any
graphics software package that
supports export to Windows
bitmaps or Windows enhanced
metafiles.

Using a graphics package to
design artwork allows you to
create a single image with several
colors as well as combine graphics
and text.

You can scan graphics and use an
editing package to clean them up
and then save them as a .bmp or
.emf file.

Tip

Is there a difference
between using a .bmp or
an .emf format?
.bmp is a raster format and .emf is
a vector format; therefore, the .emf
format has better clarity and
scaling abilities.
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Creating text
backgrounds

1. In the Text Symbol Property
Editor dialog, click the
General tab.

2. Click the Font dropdown
arrow and choose a Font,
Font style, and Size and click
OK.

3. Set the Vertical and Horizon-
tal Alignment.

4. Click the Advanced Text tab.

5. Check Text Background and
click Properties.

6. Click the rounded style
balloon callout.

7. Set the Right and Left
Margins.

8. Click OK in all dialog boxes.

Creating text
symbols
Text symbols are used to draw
labels and annotation that
identify and add meaning to your
data. Text is also used for titles,
descriptions, callouts, legends,
scale bars, graticule labels,
tables, and other textual and
tabular information conveyed on
your map.

You can create simple text
symbols or add advanced
formatting, backgrounds, fills,
shadows, and halos.

Text symbols consist of a single
layer.

Tip

What’s the difference
between text and labels?
Text describes the font, style,
formatting, and effects. Labels are
drawn with text symbols and have
additional properties for place-
ment and conflict detection.

3

ch9.p65 12/05/2000, 11:43 AM281



282 USING ARCMAP

Creating text callouts

1. In the Text Symbol Property
Editor dialog, click the
Advanced Text tab.

2. Check Text Background and
click Properties.

3. Click the Type dropdown
arrow and click Line Callout.

4. Click the third Style option.

5. Check Border and click
Symbol underneath.

6. Click the Color dropdown
arrow and click the color and
outline you want. Click OK.

7. Click OK.

Creating text inside
markers

1. In the Text Symbol Property
Editor dialog, click the
Advanced Text tab.

2. Check Text Background and
click Properties.

3. Click the Type dropdown
arrow and click Marker Text
Background.

4. Click Symbol.

5. Choose a marker and click
OK.

6. Check Scale marker to fit
text.

7. Click OK.
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Tip

What if I don’t want leaders
and accent bars?
You can use the Line Callout
option to draw text backgrounds
only.

A wide variety of effects can be
achieved with different styles and
by toggling the leaders, accent
bars, and borders.

Tip

What if the background
outline is too close to the
accent bar?
You can enlarge the Gap.

Tip

Crowded text in the
background?
Fix this problem by adjusting the
Margins.
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Creating text with a drop
shadow

1. In the Text Symbol Property
Editor dialog, click the
General tab.

2. Click Font and choose a font.

3. Click the Color dropdown
arrow and choose a color.

4. Set the Vertical and Horizon-
tal Alignment.

5. Click the Advanced Text tab.

6. Click Color and click gray.

7. Set the X Offset to 2 and the
Y Offset to -2.

8. Click OK.

Creating text with a halo

1. In the Text Symbol Property
Editor dialog, click the
General tab.

2. Click Font and choose a font.

3. Click the Color dropdown
arrow and choose a color.

4. Click the Mask tab.

5. Click Halo.

6. Click Symbol and click a fill.
Click OK.

7. Set a Size.

8. Click OK.
8
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Creating filled text

1. In the Text Symbol Property
Editor dialog, click the
General tab.

2. Click Font and choose a font.

3. Set the Vertical and Horizon-
tal Alignment.

4. Click the Formatted Text tab.

5. Set the Character Spacing.

6. Click the Advanced Text tab.

7. Check Text fill pattern and
click Properties.

8. Select a fill.

9. Set the Outline Width and
Color and click OK.

10.Click OK.

1
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Working with
color
Color is one of the fundamental
properties of all symbols and
map elements. The color palette
on each dialog box shows the
color contents of all the refer-
enced styles. Your personal
modifications are also shown at
the top of the palette. You can
use a variety of dialog boxes to
create the colors you want. The
Selector dialog boxes are
accessed from the color palette.
The Property dialog boxes are
accessed from the Selector dialog
boxes and the Style Manager.

Color can be defined in five
ways:

� RGB�red, green, blue

� CMYK�cyan, magenta,
yellow, black

� HLS�hue, lightness,
saturation

� Gray�gray shade ramp

� Names�ArcInfo color
names

Defining the colors you
want to use on your map

1. Click Tools, point to Styles,
and click Style Manager.

2. Click the Color Style folder to
view its contents.

3. Right-click in the Contents
window. Click New and
choose a color model.

4. Click on a color in the Color
window or use the color
model spinners to mix a color.

5. Click OK.

6. Type the name of the new
color in the Contents window.

Defining a null color

1. Right-click in the Contents
window. Click New and click
Gray.

2. Click the Arrow button and
click Advanced Properties.

3. Check Color is Null.

4. Click OK.
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Redefining colors as you
work

1. Click the Color dropdown
arrow on a dialog box or
right-click on a symbol in the
table of contents.

2. Click on a new color or click
More Colors to view addi-
tional colors.

3. Use the Color Selector dialog
box to mix a new color.

You can toggle the color
model with the Arrow button
menu choices or click on the
color preview to display the
Property dialog boxes.

4. Click the Arrow button and
click Save Color.

5. Type a name for the new
color.

The color is saved in your
personal style.

6. Click OK.

Tip

Identifying the colors on
the palette
You can right-click the color to see
its name as a tip.

Defining a null color

1. Click the Color dropdown
arrow on a dialog box.

2. Click More Colors.

3. Click the Properties tab.

4. Check Color is Null.

5. Click OK.

Tip

Does the color palette
come from a style?
Yes, it is a combination of all the
referenced styles. As you create
custom colors, they are displayed
at the top of the palette.
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Tip

Why would I use a null
color?
A null color lets you create
transparent areas in your symbols.
It also lets you turn off outline
drawing.

However, a null color can�t be used
to knock out or block other colors.
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Working with tables 10
• Elements of a table

• Opening a layer’s attribute table

• Loading existing tabular data onto
a map

• Arranging columns

• Controlling a table’s appearance

• Locating and viewing records

• Sorting records

• Selecting records

• Summarizing data

• Adding and deleting fields

• Editing attributes

• Making field calculations

• About joining attribute tables

• Joining attribute tables

A table is a database component that contains a series of rows and columns,
where each row, or record, represents a geographic feature�such as a
parcel, power pole, highway, or lake�and each column, or field, describes a
particular attribute of the feature�such as its length, depth, cost, and so on.
Tables are stored in a database�for example, INFO�, Microsoft® Access,
dBASE®, FoxPro®, Oracle®, and SQL Server�.

You�ll typically use tables in ArcMap to inspect the attributes of geographic
features. From a table, you can identify features with particular attributes
and select them on the map. Over time, you might also update the attributes
to reflect changes to geographic features�for example, a new subdivision
extends your parcel database, or the construction of a dam alters a river
network.

Tables can also store information related to features such as warehouse
inventories, monthly sales figures, and maintenance records. By joining this
information to your spatial data, you can uncover new patterns and
relationships that were not apparent before. For example, you might see
which stores have the top monthly sales figures, what roads require
maintenance in the near future, or where the largest number of endangered
species are located.
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Elements of a table

Move to first record

Rows or
records

Number of records. An *
indicates total not yet
determined.

Previous record

Current record

Move to last record

Next record
Click to find and replace
records, select records by
attributes, add fields, change
the highlight color, add the
table to the layout, export the
table, and open related tables.

Columns or fields
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Opening a layer’s
attribute table
To explore the attributes of a
layer on a map, open its attribute
table. Once open, you can select
features and find features with
particular attributes.

You can open more than one
table at a time. For example, you
can view an attribute table for
administrative boundaries and, at
the same, view the attribute table
for cities.

1. In the table of contents, right-
click the layer for which you
want to display a table.

2. Click Open Attribute Table.

The layer’s attribute table
opens.

Tip

Closing a table
You can close a table by clicking
the Close button in the upper-right
corner of the table window.

1

2
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Loading existing
tabular data onto
a map
Not all the tabular data associ-
ated with a layer has to be stored
in its attribute table. Some data
you may choose to store in
separate tables�for instance,
data that changes frequently such
as monthly sales figures. You can
add this tabular data directly to
your map as a table and use it in
conjunction with the layers on
your map. These tables don�t
display on your map, but they are
listed in the table of contents on
the Source tab. You work with
these tables as you would any
table based on geographic
features. For example, you can
view the table, add new fields,
create graphs, and join the table
to other tables.

1. Click the Add Data button.

2. Navigate to the table you
want to add and click it.

3. Click Add.

4. Click the Source tab at the
bottom of the table of
contents.

5. Right-click the table and click
Open.

See Also

Joining a table to a layer allows
you to visualize the information
contained in a table. For more
information, see �Joining attribute
tables� in this chapter.
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Changing a column’s
width

1. Position the mouse pointer at
the edge of the column you
want to resize.

The pointer’s icon changes.

2. Click and drag the column’s
edge to the desired width.

A black line indicates where
the edge of the column will be
located.

3. Drop the edge of the column.

The column is resized.

Arranging columns
When you open a table, you can
rearrange its appearance. For
example, you may want to widen
or reduce the width of the visible
columns, move a column, hide a
column from being displayed at
all, sort the table based on a
selected field or fields, or freeze
a field so that you always see it
as you scroll across the table.

Freezing a column is helpful
when a table has many columns.
It is often very useful to see how
the values in a certain column
relate to the data in the rest of a
table.

Freezing a column locks a
column as the leftmost column in
the table view. You can then use
the horizontal scroll bar to see
the other columns in the table.
When you scroll, the frozen
column remains in place while all
other columns move. A frozen
column is easily identified
because it has a thick black line
separating it from the other
columns in the table.

1

3
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Rearranging a table’s
columns

1. Click the heading of the
column you want to move.

2. Click and drag the column’s
heading.

A red line indicates where the
column will be positioned.

3. Drop the column.

After you drop it, the column
appears in the new position.

Tip

Changing the selection
color
By default, selected columns are
highlighted in cyan. To change the
selection color, click the Options
button on the table, click Appear-
ance, then click the color you
prefer.

Tip

Deselecting a column
To deselect all columns in the
table, click Options and click
Clear Selection or simply click on
a cell in the table.

2 1

3
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Freezing a column

1. Click the heading of the
column(s) you want to freeze.

2. Right-click the selected
column’s heading and click
Freeze/Unfreeze Column to
freeze the column.

The column is now frozen.

Tip

Unfreezing a column
Right-click the column heading
and click Freeze/Unfreeze Column
to unfreeze the column.

Tip

Hiding a column
Right-click the layer or table in the
table of contents and click
Properties. Click the Fields tab.
Here you can set whether a field is
visible or not.

1

The column has been frozen.
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Setting the text font and
size for a table

1. On the table window, click
Options and click Appear-
ance.

2. Click the Table Font
dropdown arrow and click the
font you want to use.

3. Click the Table Font Size
dropdown arrow and click a
point size.

4. Click OK.

Setting the default text
font and size for all tables

1. Click the Tools menu and
click Options.

2. Click the Tables tab.

3. Click the Table Font
dropdown arrow and click the
font you want to use.

4. Click the Table Font Size
dropdown arrow and click a
point size.

5. Click OK.
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Controlling a
table’s
appearance
You can tailor the look of the
table window to suit your needs.
For example, if you don�t like the
default table font, you can
change it to another one and set
the font size as well. Make
changes for all tables or just
one�each table can have its own
individual settings.

You can also set the selection and
highlight color for records in a
table. Selected records are
displayed with the selection
color; the highlight color
identifies a record when you�re
only viewing the selected records
in the table.

Formatting a field can also
enhance the look of a table. For
example, you might set the
number digits to display to the
right of a decimal point or use
scientific notation.
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Setting the selection and
highlight color for a table

1. On the table window, click
Options and click Appear-
ance.

2. Click the Selection color
dropdown arrow and click the
color you want to use.

3. Click the Highlight color
dropdown arrow and click the
color you want to use.

4. Click OK.

Setting the default
selection and highlight
color for all tables

1. Click the Tools menu and
click Options.

2. Click the Tables tab.

3. Click the Selection color
dropdown arrow and click the
color you want to use.

4. Click the Highlight color
dropdown arrow and click the
color you want to use.

5. Click OK.
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Tip

Selection vs. highlight
color
The selection color shows the
selected records in a table. When
you�re only viewing the selected
records, clicking one highlights the
feature with the highlight color.

ch10.p65 12/05/2000, 12:36 PM297



298 USING ARCMAP

Formatting numeric fields

1. Right-click the layer or table
in the table of contents and
click Properties.

2. Click the Fields tab.

3. Click a numeric field in the
list.

4. Click Format.

5. Set the number of decimal
places, alignment, and so on.

6. Click OK when finished.
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Locating and
viewing records
You can use the navigation
buttons at the bottom of the table
window to quickly move to the
next, previous, first, or last
record in the table. If you know
the specific record number, you
can type that in as well.

When you want to find a record
in a table that matches some
numeric value or text string, you
can search the table for that value
in the selected fields or the entire
table. Depending on the type of
field�text or numeric�you
have three different types of
searches:

� Any part

� Whole field

� Start of field

Numeric fields are always
searched using the whole field. If
you�re searching a text field, you
can search for any part of the text
string or the start of the field that
matches the text you enter into
the Find dialog box. The Find
dialog box also gives you the
option of searching up, down, or
in all directions from the current
position in the table.

Moving to a specific
record number

1. Open the table.

2. Type the number of the
record you want to move to
and press Enter.

The table scrolls to the
record.

Move to first record

Previous record

Move to last record

Next record2

Viewing all or only the
selected records

1. Open the table.

2. Click Show All to view all
records or click Show
Selected to view only the
selected ones.

2
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Finding records with
particular attribute values

1. Click the heading of the
column that contains the text
for which you want to search.

2. Click Options and click Find &
Replace.

3. Type the text you want to find
in the Find what text box.

4. Click the Text Match
dropdown arrow and click the
type of search you want.

5. Click Find Next.

The first record found
containing your text is
selected.

6. If you want to find another
record containing the same
text, click Find Next again.

Tip

Matching the case
To match the capitalization of the
text you type, check Match Case in
the Find dialog box.

1

2

543

Tip

Search the whole table or
just one field
To constrain the search to specific
fields, check the box next to Search
Only Selected Field(s).

Tip

Replacing text you find
In order to replace the text you
find, you must be editing the table.
For more information, see �Editing
attributes� in this chapter.
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Sorting records by one
column

1. Click the heading of the
column whose values you
want to use to sort the
records.

2. Right-click the selected
column’s heading and click
Sort Ascending or Sort
Descending.

The table’s records are
sorted.

Sorting records
Sorting the records or rows in a
table lets you derive information
about its contents. For example,
you could find the city with the
largest population in Southeast
Asia. After you sort a column�s
values in ascending order, the
values appear ordered from A to
Z or from 1 to n, where n is the
largest number. Descending order
arranges a column�s values from
Z to A or from n to 1.

Sometimes it�s helpful to sort a
table�s rows by more than one
column. For example, it might be
more useful to sort the cities by
country and by population�the
effect is similar to producing a
report. To sort by more than one
column, you must first arrange
the columns that you�ll use for
sorting. The sorting columns
must be arranged in order from
left to right, where the values in
the column farthest to the left
will be sorted first and the values
in the column farthest to the right
will be sorted last. The sorting
columns are not required to be
adjacent to each other; however,
if they are the order of the
records is more obvious.

1 2

The records are sorted according
to the selected column’s values.
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Sorting records by more
than one column

1. Rearrange the table’s
columns so the column
whose values will be sorted
first appears to the left of the
column whose values will be
sorted second.

2. Click the heading of the first
column you want to use to
sort the records.

3. Press the Ctrl key on the
keyboard and click the
second column’s heading.

4. Repeat step 3 until you’ve
selected all columns that will
be used to sort the table’s
records.

5. Right-click a selected column
heading and click Sort
Ascending or Sort Descend-
ing.

The table’s records are
sorted.

The records are sorted first by the left column’s
values and then by the right column’s values.

Tip

Selecting adjacent
columns
Hold down the Ctrl key while
selecting columns to select more
than one.

2 3 5
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Selecting records
There are various ways to select
features in ArcMap. One way is
to select features through an
attribute table. From a table, you
can interactively select records
by pointing at them or select
those records that meet some
criteria�for example, find all
cities with a population greater
than one million.

Once you�ve defined a selection,
you�ll see those features high-
lighted on your map. For
example, suppose you wanted to
find the locations of the five
cities with the largest population.
You would sort the records in the
table in descending order based
upon population and then select
the top five records in the table to
see them highlighted on the map.

You can add to your selected set
using any other ArcMap selection
methods.

Interactively selecting
records

1. Open the attribute table for a
layer on your map.

2. Click the leftmost column in
the table adjacent to the
record you want to select.

To select consecutive
records, you can click and
drag the mouse.

3. Press and hold the Ctrl key
while clicking additional
records.

Selected records are highlighted in
the table and on the map.

2

3

See Also

For more information on selecting
map features, see Chapter 13,
�Querying maps�.
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Tip

Saving and reusing
selection expressions
You can save and reload selection
expressions using the Save and
Load buttons at the bottom of the
Select By Attributes dialog box.
This lets you quickly re-create a
selected set of records by loading
in a saved expression.

Selecting records by
attributes

1. Click Options in the table you
want to query and click Select
By Attributes.

2. Click the Method dropdown
arrow and click the selection
procedure you want to use.

3. Double-click the field from
which you want to select.

4. Click the logical operator you
wish to use.

5. Scroll to and double-click the
value in the Unique sample
values list you wish to select.
Alternatively, you can type a
value directly into the text
box.

6. Click Verify to verify your
selection.

7. Click OK.

Your selection is highlighted
in the table.

124

3

5

6 7
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Selecting all records

1. Click Options in the table and
click Select All.

Clearing the selected set

1. Click Options in the table and
click Clear Selection.

Switching the selected
set

1. Click Options in the table and
click Switch Selection.

1

1

1

Tip

Selecting features
The Selection menu on the
Standard toolbar contains
additional tools for selecting
features.
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Summarizing data
Sometimes the attribute informa-
tion you have about map features
is not organized in the way you
want�for instance, you have
population data by county when
you want it by state. By summa-
rizing the data in a table, you can
derive various summary statis-
tics�including the count,
average, minimum, and maxi-
mum value�and get exactly the
information you want. ArcMap
creates a new table containing
the summary statistics. You can
then join this table to the
attribute table of a layer. Doing
so lets you symbolize, label, or
query the layer�s features based
on their values for the summary
statistics.

See Also

For more information on joining
tables, see �Joining attribute
tables� in this chapter.

See Also

If you want to summarize features
by dissolving the boundaries
between similar features, see the
topic on the GeoProcessing Wizard
in Chapter 13, �Querying maps�.

Summarizing data in a
field

1. Right-click the field heading
of the field you want to
summarize and click Summa-
rize.

2. Check the box next to the
summary statistics you want
to include in the output table.

3. Type the name and location
of the output table you want
to create or click the Browse
button and navigate to a
workspace.

4. Click OK.

5. Click Yes when prompted to
add the new table to your
map.

1

2

3

4

The new output table contains one record for each unique land
use value and a field for each summary statistic you selected.
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Adding and
deleting fields
You can easily add or remove
fields from a table in ArcMap as
necessary. Most likely, you�ll add
or remove fields from data that
you personally manage. Large
organizations typically have large
databases with well-defined
database schemas that outline the
contents�including fields�of
the database. Unless you manage
the database, it is unlikely that
you�ll be able to add or remove
fields.

You can add or remove fields
from a table as long as the
following conditions are met:

� You have write access to the
data.

� You�re not currently editing
the data in ArcMap.

� No other users or applications
are accessing the data
including other ArcMap or
ArcCatalog sessions.

Adding a field to a table

1. Click Options in the table you
want to add a field to.

2. Click Add Field.

3. Type the name of the field.

4. Click the Type dropdown
arrow and click the field type.

5. Set any other field properties,
such as a field alias, as
necessary.

6. Click OK.

Tip

Why is Add Field
unavailable?
The Add and Delete Field options
are grayed out when you�re editing
the table.

1

2

3
4

5

6

Deleting a field from a
table

1. In the table window, right-click
over the field header of the
field you want to delete.

2. Click Delete Field.

3. Click Yes to confirm the
deletion.

Deleting a field cannot be
undone.

1

2

3
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Editing attributes
Your database is only as good as
the information it contains. Over
time, you�ll need to edit the
information in your database to
keep it accurate and up-to-date.
ArcMap lets you edit the
attributes of features displayed
on your map and also the
attributes contained in other
database tables (for example, a
table of monthly sales figures)
that are not represented geo-
graphically on the map. You can
edit any of the attribute values
that appear in a table as well as
add new records and delete
records. You can also use the
field calculator to change the
attribute value of a field for
several records at once.

As with editing map features in
ArcMap, editing the attributes of
features takes place within an
edit session. You start an edit
session by clicking Start Editing
from the Editor menu on the
Editor toolbar. Once you begin
an edit session, you�ll notice this
icon  next to the Options
button on the table window,
indicating that the table can be
edited. Additionally, those fields
that you can edit will have a
white background color to the
field heading. u

Editing text in records

1. If you haven’t started an edit
session, click the Editor menu
on the Editor toolbar and click
Start Editing.

2. Open the table you want to
edit.

3. Click the cell containing the
attribute value you want to
change.

4. Type the values and press
Enter.

The table is updated.

3

Adding new records

1. If you haven’t started an edit
session, click the Editor menu
on the Editor toolbar and click
Start Editing.

2. Open the table you want to
edit.

3. Click Move to end of table.

4. Click a cell in the last, empty
record and type in a new
value.

Note: Use these steps to add
new records to tables that
don’t have associated
geographic features. If you
want to add features to your
coverage, shapefile, or
geodatabase, use the Create
New Feature task on the
Editor toolbar.

34
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Tip

Navigating the cells in a
table
You can navigate the cells in a
table by pressing the Tab or arrow
keys on your keyboard.

Now, you can make any of the
attribute changes you need by
clicking on a cell and typing a
new attribute value. If you make
a mistake, you can easily undo
the edit by clicking Undo from
the Edit menu.

Editing attributes through the
table allows you to quickly make
changes to several features
(records) at once. When you�re
editing the attributes of specific
map features, you may find it
more convenient to do so using
the Attribute dialog box,
accessed from the Editor toolbar.
This dialog is tailored to
updating the attributes of specific
map features that you first point
at with the mouse.

When you�ve completed your
edits, you can save them and end
the edit session.

Tip

Adding the Editor toolbar
To display the Editor toolbar, click
Tools, then click Editor Toolbar.

Deleting records

1. If you haven’t started an edit
session, click the Editor menu
on the Editor toolbar and click
Start Editing.

2. Open the table you want to
edit.

3. Select the records you want
to delete. Press and hold the
Ctrl key while clicking to
select more than one record.

4. Press the Delete key on the
keyboard.

Any geographic features
associated with the records
are also deleted.

3

Copying and pasting
records

1. If you haven’t started an edit
session, click the Editor menu
on the Editor toolbar and click
Start Editing.

2. Open the table you want to
edit.

3. Select the records you want
to copy. Press and hold the
Ctrl key while clicking to
select more than one record.

4. Click Copy on the Standard
toolbar.

5. Click Paste on the Standard
toolbar. The new records are
added at the end of the table.

3

4 5

To select a record, click in the first column adjacent to the
record you want to select.
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Making simple field
calculations

1. If you haven’t started an edit
session, click the Editor menu
on the Editor toolbar and click
Start Editing.

2. Open the table you want to
edit.

3. Select the records you want
to update. If you don’t select
any, the calculation will be
applied to all records.

4. Right-click the field heading
for which you want to make a
calculation and click Calcu-
late Values.

5. Use the Fields list and
Functions to build a calcula-
tion expression. You can also
edit the expression in the text
area below. Alternatively, you
can just type in a value to set
the field to. In this example,
the string “Single Family” is
used.

Note: Use single or double
quotes when calculating
strings. Which one you use
will depend on the database
your data is stored in.

6. Click OK.

Making field
calculations
Entering values with the key-
board is not the only way you can
edit tables. In some cases, you
might want to perform a math-
ematical calculation to set a field
value for a single record or even
all records. The ArcMap field
calculator lets you perform
simple as well as advanced
calculations on any selected
record.

The field calculator also lets you
perform advanced calculations
using VBA statements that
process the data before calcula-
tions are made on the selected
field. For example, using
demographic data, you might
want to find out the largest age
group by percentage of the
population for each county in the
United States. You can create a
script that preprocesses your data
using logical constructs such as
If...Then statements and Select
Case blocks. This lets you
perform sophisticated calcula-
tions quickly and easily.

3

4

5 5

5

6

Tip

Calculating fields outside
an edit session
You can�t undo a field calculation
when performed outside of an edit
session.
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Making advanced field
calculations

1. If you haven’t started an edit
session, click the Editor menu
on the Editor toolbar and click
Start Editing.

2. Open the table you want to
edit.

3. Select the records you want
to update. If you don’t select
any, the calculation will be
applied to all records.

4. Right-click the field heading
for which you want to make a
calculation and click Calcu-
late Values.

5. Check Advanced.

6. Type VBA statements in the
first text box.

The VBA statements can
include ArcMap methods. The
VBA code shown in the figure
gets the x-coordinate of the
centroid of each polygon in
the layer and writes it out to a
field called X_FIELD.

7. Type the variable or value
that is to be written to the
selected records.

8. Click OK.

6

8

Tip

Reusing calculation
expressions
After entering VBA statements,
click Save to write them out to a
file. The Load button will prompt
you to find and select an existing
calculation file.

5

7

3

4

See Also

For more information on VBA,
consult any Visual Basic reference.
The Visual Basic Editor�accessed
by clicking the Tools menu,
pointing to Macros, and clicking
Visual Basic Editor�also contains
an online reference to Visual Basic
commands.
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About joining attribute tables

Most database design guidelines promote organizing your
database into multiple tables�each focused on a specific topic�
instead of one large table containing all the necessary fields. This
scheme prevents duplicate information in the database because
you store the information only once in one table. When you need
information that isn�t in the current table, you can link the two
tables together. In ArcMap, you can establish this kind of link by
either joining or relating two tables together.

Joining the attributes from a table

Typically, you�ll join a table of data to a layer�s attribute table,
extending the information you have about your geographic
features. Joins are based on the value of a field that can be found
in both tables. The name of the field does not have to be the
same, but the data type has to be the same; you join numbers to
numbers, strings to strings, and so on.

Suppose you obtain daily weather forecasts by county and
generate weather maps based on this information. As long as the

Shape FID       County

Polygon  1          Atoka

Polygon  2          Kiowa
Polygon  3          Nowata

County  Rain Total

Atoka  1.80 10.16

Kiowa  2.34 13.67
Nowata  1.62 11.90

Symbolizing features based on joined rainfall data.

weather data is stored in a table in your database and shares a
common field with your layer, you can join it to your geographic
features and use any of the additional fields to symbolize, label,
query, or analyze the layer�s features.

When you join tables in ArcMap, you establish a one-to-one or
many-to-one relationship between the layer�s attribute table and
the table containing the information you wish to join. The
example above illustrates a one-to-one relationship between each
county and the weather data. In other words, there�s one record of
weather data for each county.

Here�s an example of a many-to-one relationship. Suppose you
have a layer where each polygon is classified according to its
land use type. The layer�s attribute table only stores a land use
code; a separate table stores the full description of each land use
type. Joining these two tables together establishes a many-to-one
relationship because many records in the layer�s attribute table
join to the same record in the table of land use descriptions. You
might then use the more descriptive text when generating the
legend for your map.

Shape FID       LU_Code
Polygon  1 2

Polygon  2 1
Polygon  3 1

LU-Code    Description
      1     Single Family

      2     Agriculture
      3     Commercial

Many polygons share the same land use description.

Single Family

Commercial

Agriculture

Forest

Low Rainfall

High Rainfall
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Summarizing your data before joining it

Depending on how your data is organized, you may have to start
by summarizing the data in your table before you join it to a
layer. When you summarize a table, ArcMap creates a new table
containing summary statistics derived from your table. You can
create various summary statistics including count, average, sum,
minimum, and maximum.

For example, suppose you want to create weather maps by state
instead of by county, but the weather information you have is
organized by county. You could summarize the county data by
state�for instance, finding the average rainfall for all counties
within a state�and then join the newly created output table to a
state layer to create a weather map of rainfall by state.

When to relate tables instead of joining them

You�ve seen how joining tables establishes a one-to-one or many-
to-one relationship between a layer and a table. However, in
some situations, you may want to establish a one-to-many or a
many-to-many relationship between a layer and a table.

An example of a one-to-many relationship is building occupancy.
One building, such as a shopping center, may be occupied by
many tenants. You may want to join a table of tenants to the
attribute table of a layer representing buildings. However, if you
perform a join, ArcMap will only find the first tenant belonging
to each building, ignoring additional tenants. In this case, you
should relate the tables instead of joining them.

Unlike joining tables, relating tables simply defines a relationship
between two tables. The associated data isn�t appended to the
layer�s attribute table like it is with a join. Instead, you can access
the related data when you work with the layer�s attributes. For
example, if you select a building, you can find all the tenants that
occupy that building. Similarly, if you select a tenant, you can
find what building they reside in (or several buildings, in the case
of a chain of stores in multiple shopping centers�a many-to-
many relationship).

Relates defined in ArcMap are essentially the same as simple
relationship classes defined in a geodatabase, except that they are
saved with the map instead of in a geodatabase. For more
information on creating relationship classes, see Chapter 6,
�Defining relationship classes�, in Building a Geodatabase.

Sometimes it may be necessary to summarize your tabular data so that it
can be joined to your geographic data.

State    County     Rain     Total
Oklahoma    Atoka      1.80      10.16

Oklahoma    Kiowa      2.34      13.67

Oklahoma    Nowata   1.62      11.90

State    Count     Avg_Rain     Max_Rain

Oklahoma       77             2.56             3.86
Ohio               88             3.21             4.50

Oregon           36             5.66             7.92

ch10.p65 12/05/2000, 12:40 PM313



314 USING ARCMAP

Joining data spatially

When the layers on your map don�t share a common attribute
field, you can instead join them using a spatial join. A spatial join
joins the attributes of two layers based on the location of the
features in the layers. With a spatial join, you can:

� Find the closest feature to another feature.

� Find what�s inside a feature.

� Find what intersects a feature.

For example, you might want to tell a customer where they can
find the nearest retail store and how far away it is from them. Or
a biologist might summarize information about endangered
species sightings based on what region in a national park the
observations were made.

For information on how to perform a spatial join, see Chapter 13,
�Querying maps�.

How are joins and relates saved in your map?

When you save a map containing joins and relates, ArcMap saves
the definition of how the two attribute tables are linked rather
than saving the linked data itself. The next time you open your
map, ArcMap reestablishes the relationship (whether a join or
relate) between the tables by reading the tables from the
database. In this way, any changes to the source tables that have
taken place since they were last viewed on the map are
automatically included and reflected on the map.

If you want, you can make a permanent disk copy of a layer with
joined data; simply export the layer. To export the layer, right-
click it in the table of contents, point to Data, and click Export
Data. This creates a new feature class with all of the attributes,
including the joined fields, written out.
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Joining attribute
tables
Data comes from a variety of
sources. Often, the data you want
to display on your map is not
directly stored with your
geographic data. For instance,
you might obtain data from other
departments in your organization,
purchase commercially available
data, or download data from the
Internet. If this information is
stored in a table, such as a
dBASE, INFO, or geodatabase
table, you can associate it with
your geographic features and
display the data on your map.

ArcMap provides two methods to
associate data stored in tables
with geographic features: joins
and relates. When you join two
tables, you append the attributes
from one onto the other, based on
a field common to both tables.
Relating tables defines a
relationship between two u

Joining the attributes in
one table to another

1. Right-click the layer or table
you want to join, point to
Joins and Relates, and click
Join.

2. Click the first dropdown arrow
and click Join attributes from
a table.

3. Click the dropdown arrow and
click the field name in the
layer that the join will be
based on.

4. Click the dropdown to choose
the table to join to the layer. If
the table is not currently part
of the map, click the browse
button to search for it on disk.

5. Click the dropdown arrow and
click the field in the table to
base the join on.

6. Click OK.

The attributes of the table are
appended to the layer’s
attribute table.

See Also

For information on spatial joins,
see Chapter 13, �Querying maps�.

1

2

3

4

5

6

Tip

Joining by relationship
class
You can also join two tables using
a predefined relationship class.
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tables�also based on a common
field�but doesn�t appended the
u attributes of one to the other.
Instead, you can access the
related data when necessary.

You�ll want to join two tables
when the data in the tables has a
one-to-one or a many-to-one
relationship�for example, you
have a layer showing store
locations and you want to join a
table of the latest monthly sales
figures to it.

You�ll want to relate two tables
when the data in the tables has a
one-to-many or many-to-many
relationship�for example, your
map displays a parcel database,
and you have a table of owners.
A parcel may have more than one
owner and an owner may own
more than one parcel.

Joins and relates are reconnected
whenever you open the map. This
way, if the underlying data in
your tables changes, it will be
reflected in the join or relate.

When you�re through using a
join or relate, you can remove it.

Removing a joined table

1. Right-click the layer contain-
ing a join you want to remove
and point to Joins and
Relates.

2. Point to Remove Join(s) and
click the join you want to
remove.

2

Managing joined tables

1. Right-click a layer or table in
the table of contents and click
Properties.

2. Click the Joins & Relates tab.

All the joins for the layer or
table are listed on the left
side of the dialog. You can
add new joins or remove
existing ones.

2

All joins for the layer or table are listed here.

Tip

Creating a new dataset
from joined data
If you want to permanently save
joined data with your geographic
features, export the data to a new
dataset (e.g., shapefile). Right-
click the layer in the table of
contents, point to Data, and click
Export data.
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Relating the attributes in
one table to another

1. Right-click the layer you want
to relate, point to Joins and
Relates, and click Relate.

2. Click the first dropdown arrow
and click the field in the layer
the relate will be based on.

3. Click the second dropdown
arrow and click the table or
layer to relate to, or load the
table from disk.

4. Click the third dropdown
arrow and click the field in the
related table to base the
relate on.

5. Type a name for the relate.
You’ll use this name to
access the related data.

6. Click OK.

The relate is now established
between the two tables. The
next topic discusses how to
access records using the
relate.

1

2

3

4

5

6

Tip

You may not need to relate
feature classes in
geodatabases
If a feature class in a geodatabase
participates in a relationship class,
that relationship class will be
immediately available for use. You
don�t need to relate the tables in
ArcMap.
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Accessing related
records

1. Open the attribute table for
which you’ve set up a relate.

2. Select the records in the table
for which you want to display
related records.

3. Click Options, point to
Related Tables, and click the
name of the relate you want
to access.

The related table displays
with the related records
selected.

See Also

You must set up a relationship
before you can access related
records. For information on
relating tables, see �Relating the
attributes in one table to another�
on the previous page.

All banks in the City of Marietta are selected.

2

3

Tip

Accessing relationship
classes
If your map contains layers from a
geodatabase that participate in
relationship classes, those
relationship classes will be listed
automatically along with any
relates you define.

Tip

Relates work both ways
Once you define a relate, you can
access the related records from
either table participating in the
relationship.
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Removing a related table

1. Right-click the layer contain-
ing a relate you want to
remove and point to Joins
and Relates.

2. Point to Remove Relate(s)
and click the relate you want
to remove. 2

Managing related tables

1. Right-click a layer or table in
the table of contents and click
Properties.

2. Click the Joins & Relates tab.

All the relates for the layer or
table are listed on the right
side of the dialog. You can
add new relates or remove
existing ones.

2

All relates for the layer or table are listed here.
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Looking at data with graphs 11
• Choosing which type of graph to

make

• Creating a graph

• Displaying a graph

• Modifying a graph

• Creating a static copy of a graph

• Managing graphs

• Saving and loading a graph

• Exporting a graph

Graphs present information about map features�and the relationship
between them�in an attractive, easy-to-understand manner. They can show
additional information about the features on the map or show the same
information in a different way. Graphs complement a map because they
convey information that would otherwise take some time to summarize and
understand�for instance, you can quickly compare features to see which
have more or less of a particular attribute.

You can quickly see which countries have a high population density in this column graph.

The information displayed on a graph comes directly from the attribute
information stored with your geographic data. Once created, you can easily
add a graph to your map and print it out.
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Choosing which type of graph to make

You can choose from several different types of graphs�both two- and three-dimensional. Some graphs are better than others at
presenting certain kinds of information. Each graph has display properties that you can adjust to suit your needs. You can experiment
with the various graph types and display properties to see what works best for you.

Area�An area graph consists of one or more
lines drawn on an x,y grid with the area between
the lines and the x-axis shaded. Like line graphs,
area graphs show trends in values, but shading
gives greater emphasis to differences in quantities.
An area graph can be two- or three-dimensional.

Bar and Column�Bar and column graphs
consist of two or more parallel bars, each
representing a particular attribute value. Use
either of these graphs to compare amounts or to
show trends�for example, monthly sales figures.
Bar and column graphs can be two- or three-
dimensional.

Bubble�The bubble graph lets you chart three
variables in two dimensions. It�s a variation of the
scatter graph, where the size of the bubble
represents a particular data value. For example,
the size of the bubble might represent total
population; the position along the y-axis, birth
rate; and the position along the x-axis, death rate.

High�Low�Close�The high�low�close graph
lets you chart a range of values on an x,y grid. The
range is shown as a vertical bar, with a horizontal
crossbar for the high, the low, and a normative
value usually called the close. An alternate
version, the open�high�low�close, adds a fourth
crossbar for another value called the open.

Line�A line graph consists of one or more lines,
or sequences of symbols, drawn on an x,y grid.
Line graphs show trends in value along a
continuous scale. The three-dimensional version
of the line graph is also available.

Pie�The pie chart consists of a circle, or pie,
divided into two or more sections, or slices. Pie
charts show relationships between parts and the
whole and are particularly useful for showing
proportions and ratios. You can highlight a pie
slice by �exploding� it�moving it slightly away
from the center. A pie chart can be two- or three-
dimensional.

Polar�A polar graph is essentially a line graph
drawn on a circular grid. The line relates values
to angles. Polar graphs are useful primarily in
mathematical and statistical applications.

Scatter�A scatter graph plots x,y coordinates
based on attribute values. The pattern may reveal
a relationship between the values plotted on the
grid. A scatter graph may also be three-
dimensional, with data plotted along a z-axis.
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Creating a graph
Before you create a graph, you
should determine what you want
to graph. You can graph all
features or just the selected ones.
Some graphs can effectively
display only a limited amount of
data, so choose your graph type
appropriately. Alternatively, you
might consider making more than
one graph.

Most graphs are drawn on a grid
whose scales are shown by two or
three axes: x, y, and z. A data
point displayed on the graph is
defined by the intersection of
two or more field values�for
instance, birth rate plotted along
the x-axis and death rate plotted
along the y-axis on a scatter
graph. Keep in mind that a data
point doesn�t necessarily appear
as a point (or dot) on a graph.
Depending on the type of graph,
a single data point may be
represented by a dot, a bar, a pie
slice, or some other graphic.

For most graphs, you can choose
more than one field value to plot
along the axes. You can order the
fields as necessary. For example,
you can choose which bar in a
bar graph represents which field.
The order also defines how fields
pair up for plotting data points on
the graph. For example, suppose
you want to graph two attribute
fields for the x-axis and two for u

Creating a graph and
adding it to a layout

1. Click the Tools menu, point to
Graphs, and click Create.

2. Click the Graph type and
subtype you want.

3. Click Next.

4. Click the dropdown arrow and
click the layer or table you
want to graph.

5. Check to graph only the
selected features or records.

6. Check the fields you want to
graph.

7. Click an option to graph data
series using Records or
Fields.

8. Click Next. u

1

2

3

4

5

6

8

7
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the y-axis on a scatter graph. The
first field in the list for the x-axis
pairs up with the first field in the
list for the y-axis, and so on, to
determine the location of the data
points on the graph.

With some graph types, you can
graph data using either records or
fields. For instance, suppose you
have data on birth and death rates
by country. Graphing by record
allows you to easily compare the
birth and death rates for indi-
vidual countries.

9. Type a title for the graph.

10.Check Label X Axis With,
then click the dropdown
arrow and click a field.

11. Check Show Legend.

12.Check Show Graph on
Layout.

You can add the graph to the
layout later if necessary.

13.Click Finish.

Graphing by field plots all birth
and death rates together for all
countries.

In some cases, you can also plot
a secondary graph, called an
overlay graph, over the primary
one. An overlay graph is a line
graph that uses the same x-axis
as the primary graph.

Adding an overlay graph

1. Right-click the title bar of the
graph window and click
Properties.

2. Click the Appearance tab.

3. Click Add Overlay. u

E

Q

9

W

R

12

3
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Tip

Why is the Add Overlay
button unavailable?
You can only add an overlay graph
to column, area, high�low�close,
and scatter graphs.

4. Check Display overlay graph.

5. Click the type of overlay
graph you want to add.

6. Click Next.

7. Click the Y axis field
dropdown arrow and click the
field you want to graph.

8. Click the option to add a
second y-axis if the data
values in the field you chose
are not in the same range as
the primary graph.

9. Click Next.

10.Click the Color dropdown
arrow and set a line color for
the graph.

11.Optionally, you can add
statistical lines to the overlay.
Check those you want to add.

12. Click Finish.

4

5

67

8

9Q

W

E
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Displaying a
graph
While working with the graphs
on your map, you can choose to
view them in separate windows
alongside the ArcMap window,
as map elements on the layout
ready to be printed, or both.

Graphs are dynamic; they can
update automatically as you
change the selected set of
features in a layer. Thus, as you
browse a map selecting new
features, the graph will update to
reflect the new selected features.

Adding a graph to the
layout

1. Right-click the title bar of the
graph window and click Show
on Layout.

If the graph is already on the
layout, this option will be
unavailable.

Tip

Updating a graph on the
layout
Graphs shown on the layout will
automatically update as you
change the selected set of features
the graph is based on. If you want
to create a static copy on the
layout, copy and paste the graph
on the layout.

1

Updating a graph when
the selection changes

1. Right-click the title bar of the
graph window and click
Reload Automatically.

When Reload Automatically is
checked, the graph will
update whenever the
selected set of features
changes. Disabling this
feature creates a static graph.
This option works only when
you create a graph using the
selected features.Tip

You can only display a
graph once on a layout
If you want to show different sets
of data graphed the same way, you
need to create multiple graphs. You
can copy and paste a graph on a
layout to create a static copy.

1
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Modifying a graph
You can control most visual
aspects of a graph to create an
effective display of your data. For
example, you can choose what
type of graph you want to use,
add titles, label axes, and change
the color of graph markers�such
as the bars in a bar graph.

Changing the graph type

1. Right-click the title bar of the
graph window and click
Properties.

2. Click the Type tab.

3. Click the graph type you want
to use.

4. Click the Graph subtype you
want to use.

5. Click OK. 1

3

2 4

5

Tip

Identifying features on a
graph
Clicking on a data point on a
graph�whether a bar on a bar
graph or a point on a line graph�
identifies the associated feature on
the layer.
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Adding a title to a graph

1. Right-click the title bar of the
graph window and click
Properties.

2. Click the Appearance tab.

3. Type a title.

4. Click OK.

Tip

Changing the font and size
of the title
To change the text font or text size
of the graph title, click the
Advanced Options button on the
Appearance tab. Then, click the
Fonts tab on the dialog box that
appears.

Tip

Changing the text color of
the title
To set the text color of the title,
click the Advanced Options button
on the Appearance tab. On the
dialog box that appears, click the
background tab and change the
text color.

1

2 3

4

Click Advanced Options to set the text font, size, and color. Set
the text font and size from the Font tab. Set the text color from
the Background tab.
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Changing graph marker
colors

1. Right-click the title bar of the
graph window and click
Properties.

2. Click the Appearance tab.

3. Click Advanced Options.

4. Click the Markers tab.

5. Click the marker you want to
change.

6. Click the Color dropdown
arrow and click a color.

7. Click OK.

7

5 4

6

Tip

Setting point symbols
For graphs that plot points�for
example, the scatter graph�you
can also choose the symbol to plot
points with. Click the Markers tab
on the Advanced Options dialog
box.

Tip

Why don’t I see the color I
want?
Click the Background tab on the
Advanced Options dialog box and
change the palette.

2

3

1

If you don’t see the colors
you want, click the
Background tab and
change the palette.
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Adding a legend to a
graph

1. Right-click the title bar of the
graph window and click
Properties.

2. Click the Appearance tab.

3. Check Show Legend and
click a legend position.

4. Click OK.

4

Tip

Changing the font of the
legend
To change the text font or text size
of the text in the legend, click the
Fonts tab on the Advanced Options
dialog box.

Tip

Changing the text color of
the legend
The option for setting the text
color of the legend is located on
the Background tab on the
Advanced Options dialog box.

2

3

1

Tip

Placing a border around a
legend
You�ll find the option to add or
remove the border around a legend
on the Background tab on the
Advanced Options dialog box.

Click Advanced Options to set the text size, font, and
color for the legend, as well as to add and remove
borders. The text font and size controls are found on the
Fonts tab. The text color and border controls are found
on the Background tab.
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Controlling the x-, y-, and
z-axes of the graph

1. Right-click the title bar of the
graph window and click
Properties.

2. Click the Appearance tab.

3. Click Advanced Options.

4. Click the Axis tab.

5. Click the axis you want to
modify.

6. Set the position of the axis.
For example, click variable,
left, or right for the y-axis.

7. Set the scale, or numeric
range, for the axis.

Zero Origin: axis coordinates
range from zero to maximum
data value.

Variable Origin: axis coordi-
nates range is set to the
actual data value range.

User-Defined: you specify the
coordinate range for the axis.

8. Optionally, check the boxes to
show Tick Marks and Grids on
your graph.

9. Click OK.

9

5

4

6
7

8

2

3

1

Tip

Setting the text font for
labeling axes
Click the Fonts tab on the
Advanced Options dialog box. In
Apply to, click Labels, then in
Typeface, choose the font you want
your labels displayed with.

Tip

Why don’t I see the color I
want?
Click the Background tab on the
Advanced Options dialog box and
change the palette.
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Drawing trend lines on a
graph

1. Right-click the title bar of the
graph window and click
Properties.

2. Click the Appearance tab.

3. Click Advanced Options.

4. Click the Trends tab.

Not all graph types support
trend lines. If the tab is not
available, the graph type
does not support it.

5. Check All Sets to draw trend
lines for each attribute value
you’re graphing.

For example, if you’re
graphing birth and death
rates, you can draw a mean
line for both values or just
one of them.

6. Check the line types you
want to add to the graph.

7. Type a value to add your own
limit lines (drawn along a
specified y-axis value).

8. Click OK.

Tip

What are trend lines?
Trend lines are additional lines
you can draw on top of your
graph. A trend line can represent a
statistical value, such as the mean
or standard deviation, or it might
be a limit line you define to
highlight data values that fall
outside a prescribed limit.

8

5

4

7

6

2

3

1
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Creating a static
copy of a graph
Graphs shown on a layout update
automatically as you change the
selected features in the layer the
graph is based on. Sometimes
you may want to create a static
version of a graph to show how
different features compare. To do
this, you can copy and paste the
graph on the layout.

Copying a graph on the layout
creates a static version for
display only. Although it looks
just like the original graph, it is
not listed in the Graph Manager
and you can only change certain
appearance properties.

Tip

Copying a graph to the
clipboard
From the graph window, you can
copy a graph to the clipboard. This
creates a bitmap image of the
graph that you can then paste into
other applications.

Copying and pasting a
graph

1. Click the Select Elements tool
on the Tools toolbar.

2. Click the graph on the layout
you want to copy.

3. Click the Edit menu and click
Copy.

4. Click the Edit menu and click
Paste.

The static copy of the graph
appears on the layout.

1

3

4
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Managing graphs
Your maps may contain several
graphs. To help you manage
them, you�ll use the Graph
Manager. From this dialog box,
you can open a graph, add it to
the layout, rename it, and delete
it.

If you remove the layer a graph is
based on, the graph will still
remain on the map. You need to
explicitly remove the graph if you
no longer want it. You can
associate the graph with a new
layer by displaying the Graph
Properties and assigning a new
layer.

Opening a graph

1. Click the Tools menu, point to
Graphs, and click Manage.

2. Click the graph you want to
open.

3. Click Open.

Removing a graph

1. Click the Tools menu, point to
Graphs, and click Manage.

2. Click the graph you want to
remove.

3. Click Remove.

Renaming a graph

1. Click the Tools menu, point to
Graphs, and click Manage.

2. Click the graph you want to
rename.

3. Click again over the name.

This will allow you to type a
new name.

4. Type the new name.

1

Tip

How can I tell if a graph is
on the layout?

If you see this icon  next to the
graph name in the Graph Man-
ager, the graph is on the layout.

2

3

2

3

2 4
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Saving and
loading a graph
If you want to copy a graph that
you�ve made on one map and put
it on another, save it to a file on
disk. That way, you can load the
graph onto another map and
place it as appropriate.

All the properties you�ve set on a
graph are maintained when you
save it to disk, including the type
of graph, data the graph is based
on, whether there�s a selected set,
what fields are being graphed,
and so on. While you can
preview a saved graph in
ArcCatalog, you can only change
the properties in ArcMap.

When you load a graph on a map
that doesn�t contain the layer the
graph is based on, ArcMap will
prompt you to add that layer to
the map. If you choose not to, the
graph will still display, but you
won�t be able to change the
features shown on the graph.

Saving a graph

1. Right-click the title bar of the
graph window and click Save.

2. Click the Save in dropdown
arrow and navigate to the
location you want to save the
graph to.

3. Type a name for the graph.

4. Click Save.

2

3

4

Loading a graph

1. Right-click the title bar of the
graph window and click Load.

2. Click the Look in dropdown
arrow and navigate to the
location where the graph is
stored.

3. Click the graph.

4. Click Open.

3

4

2
Tip

Using a graph in another
application
If you want to include a graph in
another application, you can
export the graph to these formats:
Windows bitmap, JPEG, Windows
metafile, and GIF.

1

1
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Exporting a graph

1. Right-click the title bar of the
graph window and click
Export.

2. Click the Save in dropdown
arrow and navigate to the
location where you want to
save the exported graph.

3. Type a name for the graph.

4. Click the Save as type
dropdown arrow and click the
type of file you want to
export.

5. Click Save.

2

3

4

5

Exporting a graph
When you want to use a graph in
another application, you can
export it to one of these formats:
bitmap (.bmp), JPEG (.jpg), GIF
(.gif), and Windows metafile
(.wmf). For example, you might
want to include a graph in a
document you�re distributing
with your map.

1

Tip

Copying a graph to the
clipboard
You can also copy a graph to the
clipboard and paste it into another
application. The graph is copied
as a bitmap file (.bmp).
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Creating reports 12
• About reports

• Creating a simple report

• Setting the report type and size

• Working with fields

• Organizing report data

• Adding report elements

• Controlling the presentation

• Saving and loading a report

• Using Crystal Reports

Reports present the facts and figures behind your analysis and are invaluable
companions to the maps you�re creating. Reports let you effectively display
attribute information about map features in a tabular format that you control.

The information displayed in a report
comes directly from the attribute
information stored with your
geographic data.

ArcMap provides two methods for
creating reports. Using ArcMap�s
built-in reporting tool, you can create
reports that are stored directly with
your map. Once created, you can add
the report to your map layout and
print it out. ArcMap also integrates
with Seagate�s Crystal Reports� 8.
Crystal Reports lets you quickly
create presentation-quality reports to
include with your map or distribute to
others. The Report Designer provides

a graphical interface for controlling the look of your report. (Note: Crystal
Reports 8 Standard Edition is distributed with ArcMap. In order to access the
reporting tools, you must have installed Crystal Reports.) Which one should
you use? For a simple report, try ArcMap�s built-in reporting tool. When you
need a full-functioned graphical report building tool, try Crystal Reports.

A report created in ArcMap
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About reports

What is a report?

A report presents tabular information about features on the map formatted in an attractive manner. Reports are derived from an attribute
table on your map. You can choose which fields from your table you want to display and how you want to display them. Once you�ve
created a report, you can place it on your map layout next to your geographic data or save it as a file�for example, a PDF file�for
distribution. The figures below show a few examples of the kinds of reports you can create. This report displays records in a tabular
form, where each record is represented by a row in the display. You can include a title, page numbers, the current date, summary
statistics, and images.

Display an image
behind the data.

Display an image such as
a company logo.

Display records in
tabular form.

Put a title on the report.

Display the current date
and page numbers.

Calculate statistics about
attribute values.

Draw borders around
report elements.

Choose the fields to
display.
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Control the font,
size, and color of

text. Shade report elements
with various colors.

The cities are sorted
alphabetically by

name; alternatively,
they could be sorted

by population.

Group values by a
field; here, the cities
are grouped by what

country they’re in. Display records in one
or more columns.

This report organizes the data in a single column, displaying field names and values vertically. The report groups cities by what country
they�re in and displays them alphabetically by name. By controlling the text font, size, and color and shading certain elements, you can
create a report that highlights the information you want to convey.
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Report sections

Reports are divided into a series of sections; each one identifies a particular area on the report. You control how a report looks by
manipulating the contents of a section and by setting properties such as its size and color. For example, the section at the top of the
report typically contains the title and subtitle of the report; however, you don�t have to include either of these report elements if you
don�t need them. The following figure highlights the various sections in a report with different colors.

Top of report—Prints once at the beginning of the report and can
contain the title, subtitle, image, and field names.

Top of page—Prints once at the top of each page. Commonly
contains field names, the current date, and the page number.

Top of group—Prints once at the beginning of each group that
you’ve defined. Typically, the name of the group appears here.
This section appears only when you’ve defined groups.

Records—Prints the data for each record.

Bottom of group—Prints after the records in the group and may
contain group summary statistics. This section appears only when
you’ve defined groups.

Bottom of page—Prints once at the bottom of the page. Typically
contains page summaries, page footnotes, and the page number.

Bottom of report—Prints once at the end of the report. Primarily
used to print a summary of the report, such as grand totals, and
report footnotes.
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Working with sections

ArcMap automatically calculates the height of each section based
on the height of the elements in it. An element can be a title,
subtitle, column header, page number, and so on. For example, if
you use a large point size for the title, ArcMap enlarges the
section at the top of the report to accommodate the text.

If you want to manually control the height of a section, you can
turn off the automatic sizing of the section and set the height
explicitly. You will also need to make sure that the height of
elements, such as the title, within a section are sized accordingly.
Otherwise, they may be truncated.

Using a larger point size increases the height of the title and subsequently
increases the height of the top of the report section.

By turning off the Autosize property, you can explicitly set the height of the
section. Elements in that section, however, can become truncated.

The width is the same for all sections and is determined by the
width you specify for the report.

Working with elements in a section

Within each section, you can control the size and position of an
element within it. As with sections, you can let ArcMap
automatically size elements or size them explicitly yourself. In
the figure below, the title has an explicit height, width, and
position set. It also has a border around it and a background color
that�s different from the background color of the section.

You can set the size, position, and color of an element.

Once the title is the right size, you can position it relative to other
elements such as an image representing a company logo.
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Creating a simple
report
A report lets you organize and
display the tabular data that�s
associated with your geographic
features. Sometimes you�ll want
to print out a report to distribute
with your map or, alternatively,
you might put the report right on
the map.

When you create your report, you
choose what fields to display and
whether you want to generate a
report listing all features in a
layer or only the selected ones.
Once you�ve created your report,
you can put it on the layout next
to your map display or print it
out.

A report has many properties that
you set when you create it. For
example, you can set a property
to define what type of report you
want�tabular or columnar. You
can also set a particular page size
and use a particular text font and
color for the text on your report.

The set of steps to the right show
you how to make a simple tabular
report. Subsequent sections in
this chapter focus on how to set
report properties to achieve a
particular result.

Creating a simple tabular
report

1. Click the Tools menu, point to
Reports, and click Create
Report.

2. On the Fields tab, click the
Layer/Table dropdown arrow
and click the layer or table
you want to base the report
on.

3. In the Available Fields list,
double-click the fields you
want to include in the report.

4. Check Use Selected Set if
you want to create a report
with only the selected
features.

5. Click the arrow buttons to
order the report fields.

6. Click the Sorting tab.

7. Click a field to sort in the Sort
column.

8. Click the Display tab. u

2

3

4

5
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9. Under Settings, click Ele-
ments.

10.Check Title to add a title to
the report.

11. Locate the Text property and
type a title for the report.

12.Click the Font property and
set the font and size of the
title.

13.Click Show Settings to
preview the report.

14.Click Generate Report.

15.At the top of the Report
Viewer, click Add to add the
report to the map layout.

16.Click OK.

The report is added to the
layout as a graphic element.
Each page of the report is
added as a separate graphic
element on the layout.

9

Tip

Adding a report to the map
layout
Once you�ve created a report, you
can display it on your map layout.
By creating a report with a
particular page size, you can
ensure that it fits exactly where you
want it on the layout.

Tip

Adding titles, subtitles,
and page numbers to your
report
You can add additional elements to
your report�such as a title, page
numbers, an image, and foot-
notes�to enhance the display. The
Elements setting on the Display
tab lists all the additional things
you can add.

Tip

Shading records
To make the data in your reports
easier to read, you can shade every
other record with a color. On the
Report Properties dialog, click the
Display tab. Click Report and click
Records. Then set the Shade
Records and Shade Color
properties.
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Setting the report
type and size
You can make two different types
of reports�tabular or columnar.
A tabular report organizes data in
rows and columns, much like a
spreadsheet. Each row represents
one record of data, and each
column represents one field. A
columnar report displays fields
and their values vertically in
columns, much like a newspaper
column layout. With a columnar
report, you can specify the
number of columns you want to
display.

When creating a report, you can
specify the size you want. The
size you choose will depend on
how you plan to use the report. If
you plan to print it out on paper,
you�ll typically use common
paper sizes. If you plan to
incorporate it onto your map
layout, you�ll want to set a page
size that�s as close to the actual
size of the space available on the
layout. That way, the text sizes
you specify in the report will be
the same on the map layout.

The page size you set initially
determines the height and width
of the report. You can, however,
increase the width to accommo-
date the data you want to display.
If the width exceeds the printer
page size, the report will print on
additional pages.

Setting the report type

1. Click the Display tab on the
Report Properties dialog.

2. Click Report.

3. Click the Style property, then
click the dropdown arrow, and
click Tabular or Columnar.

4. Optionally, for a columnar
report, set the Column Count
and Column Style properties.

Setting the report width

1. Click the Display tab on the
Report Properties dialog.

2. Click Report.

3. Double-click the Width
property and type a width in
inches.

1
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Setting the page size,
orientation, and margin

1. Click the Display tab on the
Report Properties dialog.

2. Click Report.

3. Click the Page Setup prop-
erty and click the button to
display the Page Setup
dialog.

4. Click the Paper Size
dropdown arrow and click the
size you want.

If you’re incorporating the
report on a layout, choose a
size that’s close to the
available space on the layout.

5. Click Portrait or Landscape.

6. Type the Left, Right, Top, and
Bottom margins.

7. Click OK.

Tip

Setting the report height
While you can set the report width
independently, the report height is
determined by the paper size.
However, by adjusting the page
margins, you can precisely control
the report size.

Tip

Composing the report for a
layout
Compose your report at the size
you want it to be on your layout.
Choose the paper size so that the
report will fit in the available
space. Then, you can adjust the
margins of the page to get the
exact size you need. This will
ensure that the text on the report is
sized correctly. You can still reduce
or enlarge the report as it appears
on the layout.

1
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3
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Working with
fields
The information displayed on
your report is based on the fields
you choose to include. When you
choose the fields, you can also
set the order that they will appear
in the report. That way, you can
have certain fields appear before
others.

The field name displayed on the
report is the same as its name in
the database. However, as field
names in a database are often
abbreviations or cryptic descrip-
tions of the attribute stored in the
field, you can replace the names
with your own descriptive text to
help clarify their meaning.

ArcMap automatically sets the
display width of a field to
accommodate the width of the
data. However, you can set a
width explicitly. You may also
want to increase the width of the
report to prevent the fields from
wrapping on the page.

Ordering fields

1. Click the Fields tab on the
Report Properties dialog.

2. In the Available Fields list,
double-click the fields you
want to include in the report if
you haven’t done so already.

3. In the Report Fields list, click
the field you want to move.

4. Click the Up or Down Arrow
buttons to move the field.

The report displays the fields
in the order you’ve specified.

Displaying field names

1. Click the Display tab on the
Report Properties dialog.

2. Click Elements.

3. Check Field Names to display
field names on the report.

Field names appear as
column headers in a tabular
report and to the left of
values in a columnar report.

4. Click the Section property
and click the dropdown arrow.
Click Top of Report or Top of
Each Page. Top of Report
displays the names once on
the first page. This property is
for tabular reports only.

4

1

2 3

1

2

3 4

ch12.p65 12/06/2000, 9:25 AM346



CREATING REPORTS 347

Setting a field alias

1. Click the Display tab on the
Report Properties dialog.

2. Click Fields and click the
name field you want to set an
alias for.

3. Double-click the Text property
and type the text you want to
display.

This field alias only displays
on the report.

Setting the display width
of a field

1. Click the Display tab on the
Report Properties dialog.

2. Click Fields and click the
name field you want to set
the width of.

3. Double-click the Width
property and type the width
you want.

1

2

3
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Tip

Setting field aliases
The field aliases you set while
creating a report will only apply to
the report.

Tip

Setting your own field
widths
ArcMap automatically determines
how wide to display a field to
accommodate the data. However,
you can increase or decrease the
width. If the width of all fields
exceeds the width of the report, the
fields will wrap.
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Increasing the space
between columns in the
report

1. Click the Display tab on the
Report Properties dialog.

2. Click Elements.

3. Check Field Names if it isn’t
already checked.

4. Double-click Spacing and
type a horizontal distance in
inches.

The value you type sets the
distance between the fields in
a tabular report or the field
name and its value in a
columnar report.

Increasing the space
between rows in the
report

1. Click the Display tab on the
Report Properties dialog.

2. Click Report.

3. Click Records.

4. Click Autosize, click the
dropdown arrow, and then
click False.

5. Double-click Height and type
a height in inches for the row.

Increasing the height in-
creases the space between
rows in the report.

Tip

When to adjust the column
spacing
Adjust the column spacing when
you want to increase or decrease
the horizontal distance between
fields in a tabular report or
between the field name and its
value in a columnar report.

Tip

When to adjust the row
spacing
Adjust the row spacing when you
want to increase or decrease the
vertical distance between records
in the report.
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1Changing the vertical
spacing between fields in
a columnar report

1. Click the Display tab on the
Report Properties dialog.

2. Click Elements.

3. Check Field Names if it isn’t
already checked.

4. Double-click Vertical Spacing
and type a distance in inches.

Tip

When to adjust the vertical
spacing between fields in a
columnar report
Field names and values stack on
top of each other in a columnar
report. Thus, a given record of
data may occupy several rows in
the report. When you want to
increase or decrease the space
between these fields, adjust the
Vertical Spacing property.

2

3

4
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Organizing report
data
One advantage of displaying
your data in a report is that a
report allows you to organize
your data. For example, you can
sort records based on the values
in one or more fields�given a
list of cities, you could sort them
by total population. You can also
group records together and
calculate summary statistics. For
example, you could group cities
by what country they�re in. This
lets you easily see which city has
the largest population in a given
country. You can further calcu-
late summary statistics�for
example, compute the sum,
average, count, standard devia-
tion, and minimum and maxi-
mum values.

Sorting records

1. Click the Sorting tab on the
Report Properties dialog.

2. Click a field to sort in the Sort
column.

3. Click Ascending, Descending,
or None.

4. If you want to sort other
fields, click them and then
click the sorting method.

ArcMap sorts the fields based
on the sort order. The figure
to the right sorts cities
alphabetically by country and
then by their name.

Grouping records

1. Click the Grouping tab on the
Report Properties dialog.

2. Double-click the field you
want to use to group data.

3. Click Grouping Intervals and
click the method for grouping
data.

4. Click Ascending or Descend-
ing for the sort method.

5. Check Include Group Fields
to repeat the group value in
the report display.

Tip

Sorting records using up
to three fields
You can sort records using up to
three fields in ascending or
descending order.
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Calculating summary
statistics

1. Click the Summary tab on the
Report Properties dialog.

2. Click the Available Sections
dropdown arrow and click the
section you want the statistics
to appear in.

3. For each numeric field, check
the box that corresponds to
the statistic you want to
display.

4. To display statistics in each
available section, repeat
steps 2 and 3 for each
section.

Tip

Where can you display
summary statistics?
You can display summary statistics
for a field at the end of the report,
at the end of each page, and at the
end of each group you�ve defined.

1

2

3

Tip

What summary statistics
are available?
You can compute the average,
count, minimum, maximum,
standard deviation, and sum for
any numeric fields on your report.

Tip

Shading records
To make the data in your reports
easier to read, you can shade every
other record with a color. On the
Display tab, click Report and click
Records. Then set the Shade
Records and Shade Color
properties.
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Q

Adding report
elements
To help you create attractive-
looking reports, you can add
these additional elements to your
reports:

� A title

� A subtitle

� Page numbers

� The current date

� Images (e.g., a company logo)

� Footnotes

Once you�ve added an element,
you can control the way it looks.
For example, you might change
the text font and size of the title
and center it on the page.

This section describes how to add
the particular element you want
to your report while you�re
creating it.

Adding a title

1. Click the Display tab on the
Report Properties dialog.

2. Click Elements.

3. Check Title.

4. Double-click Text and type
the text for the title.

5. Click Font and click the
button to display the Font
dialog.

6. Set the font, size, style, and
color as desired and click OK.

7. Click Back Color and click the
button to display the Color
dialog.

8. Click the color you want.

9. Click Border and click the
button to open the Border
Properties dialog.

10.Click the border style you
want and click OK.

2
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Tip

Borders and shading
Accent report elements with
borders and background colors.
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Tip

Setting the height of an
element
In general, ArcMap automatically
calculates the height of an element.
For example, the height of the title
is based on the font size you
choose. However, you can also set
the height explicitly. This is useful
when you want to add additional
space around the element. To set
the height, set the Autosize
property to False and then set the
Height property to a height in
inches.

Adding a subtitle

1. Click the Display tab on the
Report Properties dialog.

2. Click Elements.

3. Check Subtitle.

4. Double-click Text and type
the text for the subtitle.

Adding page numbers

1. Click the Display tab on the
Report Properties dialog.

2. Click Elements.

3. Check Page Numbering.

4. Click Section, click the
dropdown arrow, and then
click Top of Page or Bottom of
Page.

5. Click Font and click the
button to open the Font
dialog.

6. In the Font dialog, set the
font, size, style, and color as
desired and click OK.

Tip

Why isn’t the element
centered on the page
properly?
Probably because you need to
adjust the width of the element.
The horizontal alignment of an
element is based on its width, not
the width of the report.
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Adding footnotes

1. Click the Display tab on the
Report Properties dialog.

2. Click Elements.

3. Check Page Footnote or
Report Footnote.

4. Double-click Text and type
the text for the footnote.

5. Click Font and click the
button to open the Font
dialog.

6. In the Font dialog, set the
font, size, style, and color as
desired and click OK.

Tip

Positioning an element
Each element has its own height
and width. An element, such as a
title, is located in the section at the
top of the report. You can position
the upper-left corner of an element
by adjusting the Top and Left
properties of the element.

Adding the date

1. Click the Display tab on the
Report Properties dialog.

2. Click Elements.

3. Check Date.

4. Click Section, click the
dropdown arrow, and click
Top of Page or Bottom of
Page.

5. Click Number Format, click
the dropdown arrow, and click
the date format you want.

Dates can be represented as:
• mm/dd/yy 1:00:00 AM
• Monday, July 26, 1999
• mm/dd/yy
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Tip

Adding footnotes
You can add footnotes to the
bottom of each page or once at the
end of the report.
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Adding an image at the
top of the report

1. Click the Display tab on the
Report Properties dialog.

2. Click Elements.

3. Check Image.

4. Click Picture, click the button
to display the Open Image
dialog, and click the image
you want to display.

5. Double-click Height and type
a height in inches.

6. Double-click Width and type a
width in inches.

7. Click Picture Display; click
the dropdown arrow; and
click Fit, Clip, or Stretch.

Adding an image in the
background

1. Click the Display tab on the
Report Properties dialog.

2. Click Background.

3. Check Image.

4. Click Picture, click the button
to display the Open Image
dialog, and click the image
you want to display.

The image will now appear
behind the report data on all
pages.

2

1

3
5
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Tip

Getting an image to fit
Images aren�t always sized exactly
as you�d like them to be. Fortu-
nately, when you add an image to
your report, you can adjust its
appearance to fit the available
space. If it�s too large, you can
shrink it or crop it. If it�s too small,
you might stretch it instead.
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Adding text in the
background

1. Click the Display tab on the
Report Properties dialog.

2. Click Background.

3. Check Text.

4. Double-click the Text property
and type the text string you
want to appear in the back-
ground.

The text displays behind the
report data on all pages.

5. Click Font and click the
button to open the Font
dialog.

6. In the Font dialog, set the
font, size, style, and color as
desired and click OK.

2
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Tip

Positioning the
background text and image
Use the Top and Left properties to
position the upper-left corner of
the background text or image on
the report page.
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Controlling the
presentation
As described earlier in this
chapter, a report is made up of
several sections, each of which
defines a particular area on the
report. For example, the section
at the top of the report contains
the title of the report; another
section displays the records in
the report.

Each section has properties that
you can modify such as its color
and whether or not it is dis-
played. A section also contains
certain elements with their own
properties that you can modify to
change the visual appearance of
the report. For example, you
might choose to shade the
records in your report.

By setting the properties of a
section and the elements within
it, you can create your own
individual look. As you create
your report, you can preview
your settings to see what your
report will look like.

Previewing a report

1. Click the Show Settings on
the Report Properties dialog.

The dialog expands to show
you a preview of the report.

2. As you modify the report
properties, click Update
Settings to see the changes
reflected on the preview.

1

2
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Setting the background
color of a section

1. Click the Display tab on the
Report Properties dialog.

2. Click Report.

3. Click the report section you
want to set a background
color of, for example, Top of
Page.

4. Click Back Color and click the
button to open the Color
dialog.

5. Click the background color
you want.

Hiding a section

1. Click the Display tab on the
Report Properties dialog.

2. Click Report.

3. Click the report section you
want to hide, for example,
Top of Page.

4. Click Visible, click the
dropdown arrow, and click
False.

The report section will not
appear in the report.

Tip

How to display more data
on your report page
If you�re not using a report
section, such as the top or bottom
of the page, you can hide it,
thereby increasing the space
available to display data on the
report page.

Tip

Using background colors
Each report element, such as the
title, has its own background color.
By using background colors, you
can enhance the display of your
report. Additionally, you can apply
a background color to report
sections.
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Shading records in the
report

1. Click the Display tab on the
Report Properties dialog.

2. Click Report.

3. Click Records.

4. Click Shade Records, click
the dropdown arrow, and click
the option you want.

5. Click Shade Color and click
the button to open the Color
dialog.

6. Click the color you want to
shade records with.

2

1
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Tip

Making your data easier to
read
You can enhance the readability of
your report by shading records.
This helps the reader to visually
separate data in adjacent records.
You can choose to alternately
shade every other, every two, or
every three records.

6
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Saving and
loading a report
If you want to copy a report that
you�ve made on one map and put
it on another, save it to a file on
disk. Then you can load the
report in another map and place it
as appropriate. When you save a
report to a file, you�re creating a
static copy that is not linked to
the actual data you created the
report from. Thus, you won�t be
able to modify the report in any
way.

You can also export a report to a
different file type. Export to
Adobe® Portable Document
Format (PDF), Rich Text Format
(RTF), or plain text (TXT).

Saving a report

1. Click Save on the Report
Properties dialog.

2. Click the Save in dropdown
arrow and navigate to the
location where you want to
save the report.

3. Type a name for the report.

4. Click Save.

Loading a report

1. Click Load in the Report
Properties dialog.

2. Click the Look in dropdown
arrow and navigate to the
location where the report is
stored.

3. Click the report.

4. Click Open.
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Exporting a report

1. Click Generate Report on the
Report Properties dialog.

2. Click Export on the Report
Viewer window.

3. Click the Save in dropdown
arrow and navigate to the
location where you want to
save the exported report.

4. Type a name for the report.

5. Click the Save as type
dropdown arrow and click the
type of file you want to
export.

6. Click Save.
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Tip

Export reports to PDF, RTF,
or plain text
Once you create your report, you
can include it on your map and
also export it to several different
file formats. Export to Adobe PDF,
RTF, or plain text.
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Using Crystal
Reports
To help you create the reports
you need, ArcMap has integrated
with industry-leading Seagate
Crystal Reports. When you install
ArcMap, you can optionally
install Crystal Reports. Once
installed, you�ll have access to
the Crystal Reports Wizard that
lets you create and view reports.

The reports you create with
Crystal Reports are managed as
files outside ArcMap. ArcMap
simply passes the tabular
information from the layers on
your map to Crystal Reports.
While you can access the reports
you create from within ArcMap
and display them in a separate
window, you can�t add them to
your map layout. If you need to
do this, use ArcMap�s built-in
reporting tool instead.

Creating a report

1. Click the Tools menu, point to
Reports, and click Crystal
Reports Wizard.

2. Click Create a new report
using these layers or tables.

3. Check the layers and tables
you want to include in the
report.

4. Type the name of the output
geodatabase.

5. Click Next.

This launches the Crystal
Reports Wizard.

6. Double-click the fields you
want to include in the report.

7. Click Finish to create the
report.

Optionally, click Next to set
other report parameters.

8. Type a name for the report.

9. Click Save.
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Viewing an existing
report

1. Click the Tools menu, point to
Reports, and click Crystal
Reports Wizard.

2. Click View an existing report.

3. Click Next.

4. Click the Look in dropdown
arrow and navigate to the
location of the report.

5. Click the Report.

6. Click Open.

The report appears in its own
window.

2
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Tip

Can I add a Crystal Report
to my map layout?
No. Instead, use ArcMap�s built-in
reporting tool to create your report
and add it to the layout.
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Querying maps 13
• Identifying features

• Displaying a Web page or docu-
ment about a feature

• Selecting features interactively

• Selecting features by searching
with a SQL expression

• Selecting features by their location

• Specifying how selected features
highlight

• Displaying information about
selected features

• Exporting selected features

• Creating buffers around features

• Aggregating data with the
GeoProcessing Wizard

• Joining the attributes of features by
their location

Maps convey a great deal of information. You can learn much about an area
just by looking at a map. Yet, sometimes it�s those things that aren�t
immediately apparent by looking at a map that are most interesting and
revealing. You can begin to discover new spatial relationships when you
start asking questions like: Where is...?, Where�s the closest?, What�s
inside?, and What intersects?

ArcMap provides a number of tools to help you find answers to these types
of questions. With ArcMap, you can:

� Find out what a feature is by pointing at it. This may display additional
information such as a picture or Web page.

� Find features with particular attributes such as cities with a population
greater than one million.

� Find features with a particular spatial relationship. For instance, you can
find the wildlife habitats within 50 kilometers of an oil spill or find all
traffic accidents that occurred along a particular stretch of road.

� Aggregate features in a layer (by removing the boundary between similar
features), merge layers together, and clip the boundary of a layer with
another layer such as a study area.

Once you�ve found features, you can display their attributes and statistics,
create reports and graphs, or export them to a new feature class.
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Identifying
features
When you view a map online,
there�s lots of information you
can get directly from it. If you
want to know what a feature is,
just pause your mouse over it to
display a Map Tip. A Map Tip
pops up on the screen providing
a quick description such as a city
name. If you want to know more
about the feature, use the Identify
tool to display all the attributes
of the feature.

Identifying features by
pointing at them

1. Click the Identify button on
the Tools toolbar.

2. Click the mouse pointer over
the map feature you want to
identify.

The features in all visible
layers under the pointer will
be identified.

Displaying Map Tips

1. In the table of contents, right-
click the layer for which you
want to display Map Tips and
click Properties.

2. Click the Display tab and
check Show Map Tips.

3. Click the Fields tab.

4. Click the Primary display field
dropdown arrow and click the
attribute field you want to
display as the Map Tip.

5. Click OK.

6. Move the mouse pointer over
a feature to see the Map Tip.

Tip

I can’t see the Map Tips
If you can�t see Map Tips even
after you�ve enabled them, make
sure that the layer is turned on and
the features in the layer are not
being hidden by features in
overlapping layers.
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Creating and accessing
hyperlinks stored in a
layer file or ArcMap
document

1. Click the Identify Features
button on the Tools toolbar.

2. Click a feature.

3. In the Identify Results
window, right-click the feature
you want to set a hyperlink
for and click Add Hyperlink.

4. To add a hyperlink to a Web
page, click Link to a URL and
type a URL. To link to a
document, click Link to a
Document and type a
pathname to the document.

5. Click the Hyperlink tool on the
Tools toolbar and click a
feature.

Displaying a Web
page or
document about
a feature
You can display a Web page or
text document about a feature by
clicking the feature in the map.
However, before you can do this,
you must create a hyperlink. A
hyperlink is a document path and
name or a Web page address
stored with the feature.

You can create hyperlinks easily
and save them to the current
ArcMap document or write them
to a layer file by clicking features
in the map and typing the
hyperlinks.

If you would like to store the
hyperlinks in the layer�s attribute
table, create a field in the feature
attribute table and enter the
hyperlinks for each feature. You
must then instruct ArcMap to
access the hyperlinks from this
field.
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Accessing hyperlinks
stored in an attribute
table

1. Double-click the layer in the
table of contents you want to
display a Web page or
document for.

2. Click the Display tab.

3. Check Support Hyperlinks
using field, click the
dropdown arrow, and click a
field.

4. Click OK.

5. Click the Hyperlink button and
click a feature. The document
or Web page displays.
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Selecting features
interactively
You can select features with your
mouse by clicking them one at a
time or by dragging a box around
them.

Before you select features with
one of these methods, you can
specify the layers you want to
select from. Do this when the
features you want to select
overlap or are very close to
features from other layers. For
example, if you have a layer of
cities where many of the cities
are on rivers, you can avoid
selecting rivers by specifying
that you want to select from the
cities layer only.

You can also select features in
the map by selecting their records
in the attribute table. When you
select feature records in a table,
the feature highlights on the map.

Selecting a feature by
clicking it in the map

1. Click Selection and click Set
Selectable Layers.

2. Click the layers you want to
select from.

3. Click Selection, point to
Interactive Selection Method,
then click Create New
Selection.

4. Click the Select Features tool.

5. Click the feature you want to
select.

6. To select additional features,
hold down the Shift key while
clicking the features.

To remove a feature from the
selected set, click the
Selection menu, point to
Interactive Selection Method,
and click Remove From
Current Selection. Click a
selected feature and it
deselects.

4

5

2

1

Tip

Setting selectable layers
When you�re setting selectable
layers, you can check or uncheck
all layers by holding down the Ctrl
key while clicking one of the check
boxes.
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Select features by
dragging a box

1. Click Selection and click Set
Selectable Layers.

2. Click the layers you want to
select from.

3. Click Selection, point to
Interactive Selection Method,
then click Create New
Selection.

4. Click Selection and click
Options.

5. Specify how you’d like to
select features with the box
and click OK.

6. Click the Select Features
button.

7. Click and drag a box around
the features you want to
select.

8.  To select additional features,
hold down the Shift key as
you drag the box.

To remove a feature from the
selected set, click the
Selection menu, point to
Interactive Selection Method,
and click Remove From
Current Selection. Drag a box
around the features you want
to deselect.

Tip

Deselecting all features
To deselect all selected features at
once, click the map where there
are no features or click a feature of
a layer that is not selectable. If
you are unable to do this, click the
Selection menu and click Clear
Selected Features.

5

1

6

7
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Selecting a feature by
clicking it in the table

1. Right-click a layer in the table
of contents and click Open
Attribute Table.

2. Select a feature in the table
by clicking to the left of a
record.

3. To select additional features,
hold down the Ctrl key and
click on the features. To
deselect a feature, hold down
the Ctrl key and click the
feature.

2

1

Tip

Selecting consecutive
records in a table
To select consecutive records in a
table, click and drag the mouse up
or down.
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Selecting features
by searching with
an SQL expression
Structured Query Language
(SQL) is a powerful language
you use to define one or more
criteria that can consist of
attributes, operators, and
calculations. For example,
imagine you have a map of
customers and want to find those
who spent more than $50,000
with you last year and whose
business type is �Restaurant�.
You would select the customers
with this expression:
Sales > 50000 AND
Business_type = �Restaurant�.

When you search with SQL
expressions, you can select
features or table records in any
data format supported by
ArcMap. However, you format
expressions differently depend-
ing on the format of the data
you�re querying. The following
pages contain guidelines on how
to build SQL expressions for
different data formats.

1. Click Selections and click
Select By Attributes.

2. Click the Layer dropdown
arrow and click the layer
containing the features you
want to select.

3. Click the Method dropdown
arrow and click a selection
method.

4. Double-click a field to add the
field name to the expression
box.

5. Click an operator to add it to
the expression.

6. If you have a very large
number of values, click the
Complete List button to see
them all.

Double-click a value to add it
to the expression.

7. To see if you’re using proper
syntax or if the criteria you’ve
entered will select any
features, click the Verify
button.

8. Click OK.

The status bar at the bottom
of the ArcMap window tells
you how many features are
selected.

8

2
3

4

5

6

7

1

Tip

Try the Query Wizard
If you�ve never selected features by
their attributes, try clicking the
Query Wizard button to generate
the selection expression.

Need help
creating an
expression?
Try the Query
Wizard.
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When you create an expression in the Select By Attributes dialog
box, you create it in a version of SQL; the one you use depends
on the format of the data you�re querying.

You use ANSI SQL with shared geodatabase data and Jet SQL
with personal geodatabase data. These two versions of SQL are
similar; however, each supports features and functions the other
doesn�t.

When you query coverages, shapefiles, INFO tables, and dBASE
tables, you use a limited version of SQL that doesn�t support
functions or the many features of ANSI and Jet SQL.

The following shows you how to build simple expressions. For
information on how to build more complex expressions, please
consult your SQL reference manual.

Specifying fields

� If you�re querying ArcInfo coverages, shapefiles, INFO
tables, or dBASE tables, enclose fields in double quotes:

�AREA�

� If you�re querying personal geodatabase data, enclose fields
in square brackets:

[AREA]

� If you�re querying shared geodatabase data, don�t enclose
fields:

AREA

Searching for strings

Regardless of the data you�re querying, always enclose strings
such as names in single quotes. For example, this query will
select California in a layer based on personal geodatabase data:

[STATE_NAME] = �California�

Strings are case-sensitive for coverages, shapefiles, INFO tables,
dBASE tables, and shared geodatabases. If you are unsure of
case, use the operator LIKE, not �=�. For example,
�STATE_NAME� = �rhode island� will not find a feature with
�Rhode Island� in its attribute record, but �STATE_NAME�
LIKE �rhode island� will.

Strings are not case-sensitive for personal geodatabases. For
example, [STATE_NAME] = �rhode island� will select a feature
with �Rhode Island� in its attribute record.

If you are uncertain of spelling or just want to use a shorter string
in your expression, use LIKE with wild cards. If you are querying
a coverage, shapefile, INFO table, dBASE table, or a shared
geodatabase:

�_� represents any one character and �%� any group of characters.

If you are querying a personal geodatabase:

�?� represents any one character and �*� any group of characters.

For example, this query will select Mississippi in a shared
geodatabase:

STATE_NAME LIKE �Miss%�

This query will find Catherine Smith and Katherine Smith in a
layer based on personal geodatabase data:

[OWNER_NAME] LIKE �?atherine smith�

If you use a wild card character in a string with the = operator,
the character is considered part of the string, not a wild card.

Searching for values

To search for a specific value, use the = operator. To compare
values use the <, >, <=, >=, and <> operators. For example, this
query will select all houses greater than or equal to 1,500 square
feet in a coverage:

Building an SQL expression
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�AREA� >= 1500

You can include calculations in expressions. Mathematical
operators you can use include +-* and /. For example, to find the
counties with a population density of less than or equal to
25 people per square kilometer, you could use the query:

�POP2000� / Area <= 25

Longer calculations first evaluate * and / operators from left to
right and then the + and - operators. For example, this query
would multiply PRICE by AREA and then add TAX:

�NETVALUE� > �TAX� + �PRICE� * AREA

To control the order calculations evaluate, use parentheses.
Calculations within parentheses evaluate first. For example, to
add TAX to PRICE and then multiply by AREA, use:

�NETVALUE� > (�TAX� + �PRICE�) * �AREA�

Building expressions with more than one criteria

To search for several strings or values in a field, use the IN
operator. For example, this expression will search for four
different state names in a shared geodatabase:

STATE_NAME IN (�Alabama�, �Alaska�, �California�, �Florida�)

To build an expression with more than one criteria when both
criteria must be true, use the AND operator. For example, to find
areas of pine forest larger than 100 square kilometers, use this
expression:

VEGETATION = �Pine Forest� AND AREA > 100

When at least one of the criteria must be true, use the OR
operator. For example, this expression will select any feature with
at least one of the following conditions:

SALES > 20000 OR ORDERS > 20000

To exclude, use the NOT operator. For example, to select all the
Pacific states except California, use:

SUB_REGION = �Pacific� AND NOT STATE_NAME =
�California�
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With the Select By Location dialog box, you can select features
based on their location relative to other features. You can use a
variety of methods to select the point, line, or polygon features in
one layer that are near or overlap the features in the same or
another layer.

Are crossed by the outline of

This method selects the features that are overlapped by the
features of another layer. For example, selecting wilderness areas
crossed by the outline of roads will select any wilderness area
with a road crossing its boundaries.

Intersect

This method is similar to the Are crossed by the outline of
method but also selects any features bordered by the reference
features. For example, selecting wilderness areas intersected by
roads will select any wilderness area with a road running within
its boundaries or alongside it.

Are within a distance of

This method selects features near or adjacent to features in the
same layer or in a different layer. For example, if you have a
layer of clean and polluted wells, you can find all the clean wells
within 500 meters of the polluted ones. Or, you could find the
reservoirs and farms in other layers that are within this distance
of the polluted wells. You can also use this option to find features
adjacent to other features. For example, you may have already
selected land parcels that your company might purchase, and now
you want to get information about adjacent parcels. In this case
you would select the parcels within zero distance of the ones
you�ve already selected.

Have their center in

This method selects the features in one layer that have their
center in the features of another layer.

Are completely within

This method selects features in one layer that fall completely
inside the polygons of another. For example, you can select lakes
completely within a forested area. To select features that are a
distance from the edges of the polygon they fall inside, specify a
buffer distance. For example, you can select lakes that are at least
500 meters within a forested area.

Completely contain

You can select polygons in one layer that completely contain the
features in another layer. For example, select forested areas that
have lakes completely within them. To select polygons that
completely contain features a certain distance within them,
specify a buffer distance. For example, you can select forested
areas with lakes at least 500 meters within them by buffering the
lakes.

Share a line segment with

This method selects features that share line segments, vertices, or
nodes with other features.

Are identical to

This method selects any feature having the same geometry as a
feature of another layer. The feature types must be the same�for
example, you use polygons to select polygons, lines to select
lines, and points to select points.

Ways to find features by their location

ch13.p65 12/06/2000, 11:44 AM375



376 USING ARCMAP

Contain

This method selects features in one layer that contains the
features of another. This method differs from the Completely
contain method in that the boundaries of the features can touch.
For example, with the Contain method, a forest will contain a
lake�and thus be selected�even if the border of the lake
touches the border of the forest. The forest would not be selected
using Completely contain because the borders touch.

Are contained by

This method selects features in one layer that are contained by
the features in another. For example, you can select those cities
that are contained by a county. This method differs from Are
completely within in that the edges of the features can touch.
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1. Click Selection and click
Select By Location.

2. Click the dropdown arrow and
click a selection method.

3. Check the layers whose
features you would like to
select.

4. Click the dropdown arrow and
click a selection method.

5. Click the dropdown arrow and
click the layer you want to
use to search for the features.

6. Check to use only the
selected features.

7. Check Apply a buffer to the
features in <layer> and set
the distance within which to
search for features.

8. Click Apply.

ArcMap selects the features.

Selecting features
by their location
Suppose you want to know how
many homes were affected by a
recent flood. Answering this
question�and others like it�
involves forming a spatial query.
You want to find features based
on where they are in relation to
other features. For instance, if
you mapped the flood boundary,
you could then select all the
homes that are within this area.

By combining queries, you can
perform more complex searches.
For example, suppose you want
to find all the customers who live
within a 20-mile radius of your
store and who made a recent
purchase so you can send them a
promotional mailing. You would
first select the customers within
this radius (select by location)
and then refine the selection by
finding those customers who
have made a purchase within the
last six months according to a
date-of-last-purchase attribute
(select by attribute).

1
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Specifying how
selected features
highlight
You can display selected features
in any color or symbol. You can
control this for all layers at once
or for any specific layer.

Specifying how all layers
highlight

1. Click the Selection menu and
click Options.

2. Click the color box and click
the color you want to use.

For polygons, this is the color
the edges highlight in. For
points and lines, this is the
color the entire feature
highlights in.

3. Click OK.

Specifying how a specific
layer highlights

1. In the table of contents, right-
click a layer and click
Properties.

2. Click the Selection tab.

3. Click the third option and click
the color you want.

4. Click OK.

This setting overrides any
setting you make with the
Selection Options dialog box.

2

3

2
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Zooming to selected
features

1. Right-click the layer in the
table of contents that contains
selected features.

2. Click Selection and click
Zoom To Selected Features.

ArcMap zooms to the
selected features.

Displaying
information about
selected features
Once you�ve selected features,
you can zoom to them or display
their attributes or statistics. You
can also create a report or graph
of them. For information on how
to create reports and graphs, see
Chapter 11, �Looking at data
with graphs�, and Chapter 12,
�Creating reports�.

Displaying the attribute
of selected features

1. In the table of contents, right-
click the layer containing
selected features and click
Open Attribute Table.

2. Click Show Selected records.

Records of the selected
features display.

1

1

2

2

ch13.p65 12/06/2000, 11:45 AM379



380 USING ARCMAP

Displaying statistics

1. Select features using any
selection method discussed
in this chapter.

2. Click Selection and click
Statistics.

3. Click the Layer dropdown
arrow and click the map layer
you want to see statistics
about.

4. Click the Field dropdown
arrow and click the field you
want to see statistics about.

The statistics display.

4
3

2
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Exporting
selected features
Suppose you�ve selected a set of
features that meet some criteria
and you want to work with these
features outside of the current
layer. You can export the selected
features to a new shapefile,
coverage, or geodatabase feature
class. Alternatively, instead of
creating a new data source, you
can simply create a new layer
that only contains the selected
features.

Exporting selected
features to a new data
source

1. Select features using any
selection method discussed
in this chapter.

2. Right-click the layer that
contains the selected fea-
tures, point to Data, and click
Export Data.

3. Click the Export dropdown
arrow and click Selected
features.

4. Click Use the same Coordi-
nate System as this layer’s
source data.

5. Click the Browse button and
navigate to a location to save
the exported data.

6. Type the Name for the output
source data.

7. Click the Save as type
dropdown arrow and choose
the output type.

8. Click Save.

9. Click OK.
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Creating a new layer from
the selected features

1. Select features in a layer
using any selection method
discussed in this chapter.

2. Right-click the layer in the
table of contents, point to
Selection, and click Create
Layer From Selected Fea-
tures.

The new layer is added to the
map.

2
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Creating buffers
around features
Finding what features are within
a set distance identifies an area,
and the features inside that area,
affected by an event or activity.
For example, a forester would
monitor logging to make sure it
doesn�t occur within a 100-meter
buffer along streams.

Distance is one way of defining
and measuring how close
something is. You can also
measure what�s nearby using
cost. Time is one of the most
common costs�it takes longer,
for example, for customers to get
to a store through heavy traffic.
Other costs include money (such
as the operating cost per mile for
a delivery van) and effort
expended (for instance, for a deer
walking through thick under-
brush versus open forest to reach
a stream). These are often
referred to as travel costs.

ArcMap lets you buffer features
in a layer or graphics you draw
on top of your map. You can
buffer features at a specific
distance or use an attribute value
to create variable width buffers.
Use multiple ring buffers to show
features within distinct bands of
distance�for example, 50, 100,
and 150 meters.

Buffering features at a
specified distance

1. Click the Tools menu and
click Buffer Wizard.

2. Click to buffer the features of
a layer.

3. Click the dropdown arrow and
select the layer to buffer.

4. Check Use only the selected
features if needed.

5. Click Next. u

1
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6. Click to create buffers at a
specified distance and type
the distance.

7. Click the Distance units
dropdown arrow and click the
appropriate units.

8. Click Next.

9. Click to Dissolve barriers
between buffers.

10.Click to output the buffer as a
graphic on the map or as a
new layer.

11. Click Finish.

See Also

For more conceptual information
on buffering features, see
Chapter 6, �Finding what�s
nearby�, in The ESRI Guide to GIS
Analysis.

6

7

8

Tip

Using the buffers you
create on different maps
To use the buffers you create on
different maps, save the buffer as a
new data source such as a
shapefile. Then you can easily add
the data to another map.

9

W

Q

The newly created buffer appears on the map.

Tip

What to do with a buffer
layer
Creating a buffer provides a visual
representation on your map of the
area within a certain distance of
one or more features. You can also
use the buffer to select features in
other layers that fall within the
buffered area.
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Aggregating data
with the
GeoProcessing
Wizard
The GeoProcessing Wizard
allows you to combine layers in
different ways based on the
geography of the features in the
layers. The GeoProcessing
Wizard lets you:

� Aggregate features in a single
layer that have the same
attribute value (dissolve).

� Append two or more adjacent
layers into a single layer
(merge).

� Reduce the spatial extent of
one layer based on the extent
of another (clip).

� Find those features falling
within the spatial extent
common to two layers
(intersect).

� Combine two polygon layers
(union).

Here are some examples of when
to use a particular option.

Dissolve�You might dissolve a
detailed land use layer into more
general categories of land use
such as residential, commercial,
and undeveloped. u

Dissolving features
based on an attribute

1. Click the Tools menu and
click GeoProcessing Wizard.

2. Click Dissolve features based
on an attribute.

3. Click Next.

4. Click the input layer
dropdown arrow and click a
layer to dissolve.

5. Click the attribute field
dropdown arrow and click the
attribute on which to dissolve.

6. Type the name of the output
shapefile or feature class.

7. Click Next.

8. Check the boxes to specify
how you want to summarize
the attributes.

Because you’re dissolving the
boundary between adjacent
features, you need to decide
how you want to combine
their attributes.

9. Click Finish.

4
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Merge�You could merge several
tiled county layers containing
census data to make a layer
representing a metropolitan area.

Clip�You might use the
boundary of a study area to clip a
layer of roads or wildlife habitats
that extends over a much larger
area.

Intersect�You could intersect a
flood zone layer with a land
parcel layer to see which parcels
are in the flood zones.

Union�You might union a layer
representing soil type with
another representing slope to
create a new layer of erosion
potential.

Merging layers together

1. Click the Tools menu and
click GeoProcessing Wizard.

2. Click Merge layers together.

3. Click Next.

4. Check two or more adjacent
layers to merge.

The layers must be of the
same type (e.g., polygons).

5. Click the Use fields from
dropdown arrow and click the
layer containing the fields you
want to maintain.

If the layers merged to this
layer have the same fields,
the attributes will be copied to
the new layer. If a merged
layer contains an extra field, it
will be dropped. Also, if a
merged layer is missing a
field, the field value for
features in that layer will be
null.

6. Type the name of the output
shapefile or feature class.

7. Click Finish.

2

3

4

5

6

7

Tip

Can I merge layers that
overlap?
You can merge layers that overlap.
However, the features are not
intersected (that is, two crossing
lines will not be split and joined at
the intersection). Instead, features
and attributes are simply appended
together.
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Clipping one layer based
on another

1. Click the Tools menu and
click GeoProcessing Wizard.

2. Click Clip one layer based on
another.

3. Click Next.

4. Click the input layer
dropdown arrow and click a
layer to clip.

5. Click the polygon clip layer
you want to clip features with.

6. Type the name of the output
shapefile or feature class.

7. Click Finish.
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Tip

Clip using selected
features
Suppose a layer delineates several
study areas, but you only want to
clip using one of them. Select the
study area before starting the
GeoProcessing Wizard, then use
only the selected study area to clip
other layers.

Tip

Why are some
geoprocessing options
unavailable?
Some geoprocessing options may
be grayed out because the active
data frame doesn�t have enough
layers in it. For example, the union
option requires two polygon layers
as input. If the active data frame
doesn�t have two layers in it, the
option is unavailable.
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Intersecting two layers

1. Click the Tools menu and
click GeoProcessing Wizard.

2. Click Intersect two layers.

3. Click Next.

4. Click the input layer
dropdown arrow and click a
layer to intersect.

5. Click the polygon overlay
layer you want to intersect
features with.

6. Type the name of the output
shapefile or feature class.

7. Click Finish.
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Tip

What do you end up with
after intersecting?
Suppose you have a roads layer
and a counties layer and you want
to know what roads are in what
counties. Intersecting the roads
layer with the counties layer
creates a new layer that combines
the attributes of both. The features
in the new layer are roads with the
attributes of the county they�re in.
Where a road crosses a county
boundary, it will be split in two,
with the appropriate county
attributes assigned to each piece.
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Unioning two layers

1. Click the Tools menu and
click GeoProcessing Wizard.

2. Click Union two layers.

3. Click Next.

4. Click the input layer
dropdown arrow and click a
layer to union.

5. Click the polygon overlay
layer you want to union
features with.

6. Type the name of the output
shapefile or feature class.

7. Click Finish.
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Tip

What types of layers can I
union?
You can only union a layer
containing polygons with another
layer containing polygons.
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Finding the nearest
feature

1. Right-click the layer you want
to join attributes to, point to
Joins and Relates, and click
Join.

2. Click the first dropdown arrow
and click Join data from
another layer based on
spatial location.

3. Click the layer dropdown
arrow and click the name of
the layer you want to join the
attributes of. If the layer is not
currently part of the map,
click the browse button to
search for it on disk.

4. Click the option to join the
attributes of the feature
closest to it.

5. Type the name of the output
shapefile or feature class.

6. Click OK.

A new layer is added to the
map.

Joining the
attributes of
features by their
location
Often, what�s most interesting
about a map is not the individual
layers on it, but the relationships
between the features in those
layers.  For example, suppose
you wanted to tell a customer
where they can find the nearest
branch office of your business, or
you want to compare different
wildlife species with information
about the habitats they live in.
These types of queries can be
answered with a spatial join.

A spatial join joins the attributes
of two layers based on the
location of the features in the
layers. With a spatial join, you
can:

� Find the closest features to
another feature.

� Find what�s inside a feature.

� Find what intersects a
feature. u
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Tip

What is the nearest feature?
The nearest feature is defined as
the feature that is geographically
closest to another one. Proximity is
based on a straight line distance
between features.
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Finding what’s inside a
polygon

1. Right-click the layer you want
to join attributes to, point to
Joins and Relates, and click
Join.

2. Click the first dropdown arrow
and click Join data from
another layer based on
spatial location.

3. Click the layer dropdown
arrow and click the name of
the layer you want to join the
attributes of. If the layer is not
currently part of the map,
click the browse button to
search for it on disk.

4. Click the option to join the
attributes of the features that
fall inside the polygon.

5. Check how you want to
summarize attributes.

In this example, the attributes
of a city layer are being
joined to a states layer. As
more than one city will fall in
a state, the attributes of the
cities will be summarized. For
instance, the output will
contain the sum and average
population for all cities that
fall in a given state.

6. Type the name of the output
shapefile or feature class.

7. Click OK.

A new layer is added to the
map.

Like joining two tables by
matching attribute values in a
field, a spatial join appends the
attributes of one layer to another.
You can then use the additional
information to query your data in
new ways.

While you can also select
features in one layer based on
their location relative to another
layer, a spatial join provides a
more permanent association
between the two layers because it
creates a new layer, containing
both set of attributes.

See Also

For more information on joining
attribute tables, see �Joining
attribute tables� in Chapter 10.

See Also

For more information on selecting
features by location, see �Selecting
features by their location� in this
chapter.
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Finding what intersects a
feature

1. Right-click the layer you want
to join attributes to, point to
Joins and Relates, and click
Join.

2. Click the first dropdown arrow
and click Join data from
another layer based on
spatial location.

3. Click the layer dropdown
arrow and click the name of
the layer you want to join the
attributes of. If the layer is not
currently part of the map,
click the browse button to
search for it on disk.

4. Click the option to join the
attributes of the features that
intersect it.

5. Check how you want to
summarize attributes.

In this example, the attributes
of a roads layer are being
joined to a rivers layer. For
each river, you’ll be able to
find out how many roads
cross it and the summary of
the attributes of those roads.

6. Type the name of the output
shapefile or feature class.

7. Click OK.

A new layer is added to the
map.

1
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Vector data�such as coverages and shapefiles�represents geographic
features with lines, points, and polygons. Rasters�such as images and
grids�represent geographic features by dividing the world into discrete
squares called cells. Cells are laid out in a grid, where each cell has a
location relative to an origin and a value describing the feature being
observed�for instance, the cell values in an aerial photograph represent the
amount of light reflecting off the earth�s surface.

A raster can represent thematic data, such as land use and elevation; spectral
data, such as satellite images and aerial photographs; and pictures, such as
scanned maps and building photographs. You�ll generally display thematic
and spectral rasters as a background to other geographic data on your map.
Picture rasters, when displayed alongside geographic data, can convey
additional information about map features.

Some rasters have a single band of data, while others have multiple bands; a
satellite image commonly has multiple bands representing different
wavelengths of energy from the ultraviolet through the visible and infrared
portions of the electromagnetic spectrum.

ch14.p65 12/06/2000, 12:15 PM393



394 USING ARCMAP

Adding a raster to
your map
When you create a layer from a
raster, you can choose to display
a single band of data or form a
color composite from three
bands.

If you have raster data covering
the same geographic area but in
different coordinate systems,
ArcMap uses the coordinate
system of the first dataset added
and transforms any other data on
the fly into this coordinate
system.

In order to transform a raster
dataset, you must have
georeferencing information or a
world file and know its coordi-
nate system. If your raster is in
pixel space with no georeferenc-
ing information, you can
georeference it in ArcMap. See
�Georeferencing a raster� in this
chapter.

In order for ArcMap to recognize
your raster�s coordinate system, it
must be defined. Use ArcCatalog
to attach the coordinate system
information to the raster. See
�Defining a raster�s coordinate
system� in the online Help for
more information.

Adding a single band
raster

1. Click the Add Data button on
the Standard toolbar.

2. Click the Look in dropdown
arrow and navigate to the
folder that contains the raster.

If the single band is part of a
multiband raster dataset,
double-click the dataset to
expose the bands.

3. Click the single band raster.

4. Click Add.

ArcMap creates a new raster
layer on the map that
references the raster data
source.

Adding a multiband
raster

1. Click the Add Data button on
the Standard toolbar.

2. Click the Look in dropdown
arrow and navigate to the
folder that contains the raster.

3. Click the multiband raster.

4. Click Add.

ArcMap creates a new raster
layer on the map that
references the raster data
source.

1 2

3

4

1 2

3

4
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Adding a raster as a
picture

1. Click the Insert menu on the
Standard toolbar and click
Picture.

2. Click the Look in dropdown
arrow and navigate to the
picture you want to add.

3. Click the picture.

4. Click Open.

If you’re in layout view, the
picture is inserted on the
layout. If you’re in data view,
the picture is inserted within
the data frame.

1

2

4

3
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Displaying
rasters
How you display a raster depends
on what type of data it contains
and what you want to show.
Some rasters have a predefined
color scheme that ArcMap
automatically uses to display
them. For those that don�t,
ArcMap chooses an appropriate
display method that you can
adjust as needed.

If you want, you can change
display colors, group data values
into classes, or stretch values to
increase the visual contrast. For
multiband rasters, you can
display three bands together as a
red�green�blue (RGB) compos-
ite. This drawing method often
improves your ability to distin-
guish features in spectral rasters.

The raster resolution is the ratio
of screen pixels to dataset pixels
at the current map scale. Display-
ing the raster resolution allows
you to determine if you are
actually close to the maximum
resolution of the raster.

A ratio of 1:1 means you have
reached the best display, or the
maximum resolution of the raster,
where every screen pixel is
displaying exactly one raster cell.
A ratio of 1:20 means that every
screen pixel has to display u

Drawing thematic rasters
that represent unique
categories such as land
use

1. In the table of contents, right-
click the raster layer that you
want to draw showing unique
categories and click Proper-
ties.

2. Click the Symbology tab.

3. Click Unique Values.

4. Click the Value Field
dropdown arrow and click the
field you want to map.

5. Click the Color Scheme
dropdown arrow and click a
color scheme.

If your raster has a colormap,
click Default Colors to revert
the raster display to the
colors specified in the
colormap.

6. Optionally, click a label and
type in a more descriptive
one.

7. Click OK.
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Drawing thematic rasters
that represent continuous
data such as elevation

1. In the table of contents, right-
click the raster layer that you
want to display by grouping
values into classes and click
Properties.

2. Click the Symbology tab.

3. Click Classified.

4. Click the Value dropdown
arrow and click the field you
want to map.

5. Optionally, click the Normal-
ization dropdown arrow and
click a field to normalize your
data.

6. Click the Classes dropdown
arrow and click the number of
classes you want.

7. Click Classify and choose the
classification method you
want to use.

8. Click the Color Ramp
dropdown arrow and click a
color ramp.

9. Click OK.

2

3

8

7

9

4 5 620 raster cells, so less detail will
be seen in the raster layer. A ratio
of 1:0.02 means that every screen
pixel is displaying only a portion
of a raster cell or that it takes
many screen pixels to display a
single raster cell.

Tip

Displaying pictures
If your raster is just a picture that
doesn�t align to any other geo-
graphic data, you can simply place
it on a layout as a map element.
Alternatively, create a hyperlink
and associate it with a geographic
feature on your map.

Tip

Changing the color from
the table of contents
You can quickly change the colors
applied to a raster by clicking on
the color in the table of contents.
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Drawing a multiband
raster as an RGB
composite

1. In the table of contents, right-
click the raster layer that you
want to draw as an RGB
composite and click Proper-
ties.

2. Click the Symbology tab.

3. Click RGB Composite.

4. Click the Bands dropdown
arrow next to each color and
click the band you want to
display for that color.

5. Optionally, click the Stretch
Type dropdown arrow and
click the stretch you want to
apply.

6. Optionally, click Histograms to
modify the stretch settings.

7. If the raster contains a
background or border around
the data that you want to
hide, check Display Back-
ground Value and set the
color to No Color.

The cells will display trans-
parently.

8. Click OK.

2

3

4

5

6

7

8

Tip

Displaying the RGB value
for a cell
To see the RGB value for a given
cell, turn on Map Tips for the
layer. Right-click the layer in the
table of contents and click
Properties. Check the Show Map
Tips box on the Display tab.

Tip

The raster draws too dark
You can alter the overall bright-
ness and contrast of a raster
through the Effects toolbar.
Alternatively, some raster drawing
methods will allow you to stretch
the data values to take advantage
of the available colors.
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Displaying the raster
resolution in the table of
contents

1. In the table of contents, right-
click the layer and click
Properties.

2. Click the Display tab.

3. Check Display raster resolu-
tion in table of contents.

4. Click OK.

2

3

4

Tip

Drawing a raster
transparently
Use the Effects toolbar to draw
raster layers transparently over
other layers on your map.

Raster resolution
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Ways to improve
raster display
ArcMap provides additional tools
to enhance the display of a raster.
For instance, you can change the
brightness and contrast of your
raster and display the raster
transparently over other layers.

If your raster represents continu-
ous data, you can also apply a
contrast stretch to it. A stretch
increases the visual contrast of
the raster. You might apply a
stretch when your raster appears
dark or has little contrast.
Different stretches will produce
different results in the raster
display. You can experiment to
find the best one for a particular
raster.

Improving the brightness
or contrast of your raster
layer

1. Click the View menu, point to
Toolbars, and click Effects.

2. Click the dropdown arrow and
click the raster layer you want
to change the brightness or
contrast of.

3. Click the brightness or
contrast button.

4. Drag the slider bar to in-
crease or decrease the
brightness or contrast.

Tip

See the results of the
Effects toolbar immediately
When you adjust the brightness,
contrast, and transparency of your
raster, you can immediately see the
results as you drag the slider bar.
To enable this feature, right-click
the raster layer in the table of
contents and click Properties.
Click the Display tab and check
the option to Allow interactive
display for Effects toolbar.

2 3

4

Before (top) and after (bottom) adjusting the contrast and brightness of
the raster.
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Drawing a raster layer
transparently

1. Click the View menu, point to
Toolbars, and click Effects.

2. Click the dropdown arrow and
click the raster layer you want
to draw transparently.

3. Click the Adjust Transparency
button.

4. Drag the slider bar to adjust
the transparency.

2 3

4

Without transparency (top), the hillshade obscures the underlying land
use layer. With transparency (bottom), the underlying symbology
appears through the hillshade, yielding a three-dimensional effect.
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Stretching a raster to
improve the visual
contrast

1. In the table of contents, right-
click the raster layer that you
want to increase the visual
contrast of and click Proper-
ties.

2. Click the Symbology tab.

3. Click Stretched.

4. Click the Color Ramp
dropdown arrow and click a
color ramp.

5. Click the Stretch Type
dropdown arrow and click the
stretch you want to apply.

6. Optionally, click Histogram to
modify the stretch settings.

7. Type in labels that describe
the attributes.

8. If the raster contains a
background or border around
the data that you want to
hide, check Display Back-
ground Value and set the
color to No Color.

The cells will display trans-
parently.

9. Click OK.

Tip

Displaying the attributes of
a cell
Use the Identify tool on the Tools
toolbar and point at the cell you�re
interested in. The attribute
information, including the cell
value, will display.

2
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Faster drawing
with pyramids
You can reduce the time it takes
to display a large raster dataset
by creating pyramids. Pyramids
are reduced resolution layers that
record the original data in
decreasing levels of resolution.
ArcMap uses the coarsest level of
resolution to quickly draw the
entire dataset. As you zoom in,
ArcMap displays layers with
finer resolution. Performance is
maintained because you�re
drawing successively smaller
areas. Without pyramids, ArcMap
queries the entire raster dataset to
determine the subset of cells that
need to be displayed.

When you add a raster without
pyramids to a map, ArcMap
prompts you to create them. The
pyramid file created is a Reduced
Resolution Dataset (RRD) file,
with the same filename as the
dataset. For uncompressed
rasters, the minimum RRD file
size is approximately 8 percent of
the size of the original raster
dataset. In certain situations,
however, the RRD file can be
larger than the original file,
depending on the compression
technique used in the original
raster file.

Changing the default
setting for building
pyramids

1. Click the Tools menu and
click Options.

2. Click the Raster tab.

3. Click the choice that de-
scribes when you want to
create pyramid layers.

4. Click OK.

2

3

4
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About georeferencing

Raster data is commonly obtained by scanning maps or collecting
aerial photographs and satellite images. Scanned maps don�t
usually contain information as to where the area represented on
the map fits on the surface of the earth; the locational information
delivered with aerial photos and satellite imagery is often
inadequate to perform analysis or display in proper alignment
with other data. Thus, in order to use these types of raster data in
conjunction with your other spatial data, you often need to
align�or georeference�it to a map coordinate system.

When you georeference your raster, you define how the data is
situated in map coordinates. This process includes assigning a
coordinate system that associates the data with a specific location
on the earth. Georeferencing raster data allows it to be viewed,
queried, and analyzed with other geographic data.

How to align the raster

Generally, you�ll align your raster to existing spatial data, such as
a coverage, that resides in the desired map coordinate system.
This assumes that there are features in your spatial data (target
data) that are also visible in the raster�for example, streets,
building footprints, and streams. The basic procedure for
georeferencing is to move the raster into the same space as the
target data by identifying a series of ground control points�of
known x,y coordinates�that link locations on the raster with
locations in the target data in map coordinates. A combination of
one control point on the raster and the corresponding control
point on the target data is called a link.

The number of links you need to create depends on the method
you plan to use to transform the raster to map coordinates.
However, adding more links will not necessarily yield a better
registration. If possible, you should spread the links out over the
entire raster rather than concentrating them in one area. Typically,

having at least one link near each corner of the raster and a few
throughout the interior produces the best results. In general, the
greater the overlap between the raster and target data, the better
the alignment results because you�ll have more widely spaced
points with which to georeference the raster. For example, if your
target data only occupies one quarter of the area of your raster,
the points you could use to align the raster would be confined to
that area of overlap. You can only assume that areas outside the
overlap area are properly aligned.

Transforming the raster

When you�ve created enough links, you can transform�or
warp�the raster to map coordinates. Warping uses a
mathematical transformation to determine the correct map
coordinate location for each cell in the raster.

Use a first order�or affine�transformation to shift, scale, and
rotate your raster. Straight lines on the raster are mapped onto
straight lines in the warped raster. Thus squares and rectangles on
the raster are commonly changed into parallelograms of arbitrary
scaling and angle orientation.

A first-order transformation will probably handle most of your
georeferencing requirements. With the minimum of three links,
the mathematical equation used with a first-order transformation
can exactly map each raster point to the target location. Any more
than three links introduces errors, or residuals, that are distributed
throughout all the links. In practice, add more than three links.
Given only three, if one link is positionally wrong, it has a much
greater impact on the transformation. Thus, even though the
mathematical transformation error may increase as you create
more links, the overall accuracy of the transformation will
increase as well.
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The higher the transformation order, the more complex the
distortion that can be corrected. However, in practice,
transformations higher than third order are rarely needed. Higher-
order transformations require more links and thus will involve
progressively more processing time. In general, if your raster
needs to be stretched, scaled, and rotated, use a first-order
transformation. If, however, the raster must be bent or curved,
use a second- or third-order transformation.

Interpreting the root mean square error

The degree to which the transformation can accurately map all
control points can be measured mathematically by comparing the
actual location of the map coordinate to the transformed position
in the raster. The distance between these two points is known as
the residual error. The total error is computed by taking the root
mean square (RMS) sum of all the residuals to compute the RMS
error. This value describes how consistent the transformation is
between the different control points. While the RMS error is a
good assessment of the accuracy of the transformation, don�t
confuse a low RMS error with an accurate registration. The
transformation may still contain significant errors, for example,
due to a poorly entered control point.

What is resampling?

While you might think each cell in a raster is transformed to its
new map coordinate location, in reality the process works in
reverse. During georeferencing, a matrix of �empty� cells is
computed in map coordinates. Then each cell is given a value
based on a process called resampling.

The three most common resampling techniques are nearest
neighbor assignment, bilinear interpolation, and cubic
convolution. These techniques assign a value to each empty cell
by examining the cells in the untransformed raster. Nearest

neighbor assignment takes the value from the cell closest to the
transformed cell as the new value. It�s the fastest resampling
technique and is appropriate for categorical, or thematic, data.
Bilinear interpolation and cubic convolution techniques combine
a greater number of nearby cells (4 and 16, respectively) to
compute the value for the transformed cell. These two techniques
use a weighted averaging method to compute the output
transformed cell value and thus are only appropriate for
continuous data such as elevation, slope, and other continuous
surfaces.

Should you rectify your raster?

You can permanently transform your raster after georeferencing it
by using the Rectify command on the Georeferencing toolbar.
Rectify creates a new raster that is georeferenced to map
coordinates. You can save this in ESRI GRID, TIFF, or ERDAS®

IMAGINE® format.

ArcMap doesn�t require you to rectify your raster to display it
with other spatial data. You might choose to rectify your raster if
you plan to perform analysis with it or want to use it with another
software package that doesn�t recognize the external
georeferencing information created by ArcMap and requires the
raster to be in map coordinates.
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The Georeferencing toolbar

Rotate or shift the raster
before adding links

Set the raster to georeference Add control points

Save transformation
with raster

Correct for common
scanning distortions

Set the transformation order

Create a new,
transformed raster

Adjust display as
you add links

Show Link Table

Shift raster to current
display area
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Georeferencing a
raster
The general steps for
georeferencing a raster are:

1. Add to your map the raster
and the layers (target data)
you want to align it to.

2. Add control points that link
known raster positions to
known target data positions in
map coordinates.

3. When you�re satisfied with
the registration, save the
georeferencing information
with the raster.

For most rasters, the georeferenc-
ing information is stored in a
separate file with the same name
as the raster but with an .aux file
extension. You can permanently
transform the raster by using the
Rectify command on the
Georeferencing toolbar.

The coordinate system assigned
to the raster is the same as the
coordinate system defined on the
data frame the raster is part of.

Georeferencing a raster

1. Add the layers residing in
map coordinates (target data)
and the raster you want to
georeference.

2. In the table of contents, right-
click a target layer and click
Zoom to Layer.

3. From the Georeferencing
toolbar, click the Layer
dropdown arrow and click the
raster layer you want to
georeference.

4. Click Georeferencing and
click Fit To Display.

This will display the raster in
the same area as the target
layers. You can also use the
Shift and Rotate tools to
move the raster as needed.

5. Click the Control Points tool
to add control points.

6. To add a link, click the mouse
pointer over a known location
on the raster, then over a
known location on the target
data.

You may find it useful to use
a Magnification window to
add your links in.

7. Add enough links for the
transformation order. You
need a minimum of three
links for a first-order transfor-
mation, six links for a second
order, and 10 links for a third
order. u

Tip

Displaying the
Georeferencing toolbar
Right-click the Tools menu, point
to Toolbars, and click
Georeferencing.

3 5
4

6

To create a link, click a control point on the raster, then click
the corresponding control point on the target data.

When enabled, the raster
automatically shifts as you
enter each link.
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Tip

Deleting a link while
creating it
Press the Esc key to remove a link
while you�re in the middle of
creating it.

Tip

Deleting a link
You can delete an unwanted link
from the Link Table dialog box.

8. Click View Link Table to
evaluate the transformation.

You can examine the residual
error for each link and the
RMS error. If you’re satisfied
with the registration, you can
stop entering links.

9. Click Georeferencing and
click Update Georeferencing
to save the transformation
information with the raster.

This creates a new file with
the same name as the raster
but with an .aux file exten-
sion.

8
9

Tip

Permanently transform the
raster
You can permanently transform
your raster after georeferencing by
using the Rectify command. Click
Georeferencing and click Rectify.
This creates a new raster dataset
in GRID, TIFF, or ERDAS
IMAGINE format.

After updating georeferencing information, the raster will align to other
spatial data when added to a map.

Evaluate the links.
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Entering explicit x,y map
coordinates

1. Click the Control Points tool
and add links.

2. Click View Link Table on the
Georeferencing toolbar.

3. Click a map coordinate and
type in a new value.

21
3
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� Finding an address

� Geocoding a table of addresses

� Rematching a geocoded feature
class

A feature is an object that has geometry. In most cases, this geometry is
captured by digitizing or scanning paper maps. In many cases, however,
geographic data exists that indirectly captures geometry by describing
locations such as street addresses, city names, or even telephone numbers.
While humans understand what these descriptions mean and how they relate
to locations on the earth�s surface, computers do not. In order to display
these locations on a map and perform analyses with them, a computer must
be given geometric representations (such as point features) of these loca-
tions.

Geocoding (also commonly known as address matching) is the process of
creating geometric representations for descriptions of locations. A geocoding
service defines a process for converting alphanumeric descriptions of
locations into geometric shapes.

You can use geocoding services in ArcMap to find individual addresses and
to geocode tables of addresses. You can also review and rematch the feature
classes and shapefiles that you create by geocoding tables of addresses.

In order to geocode in ArcMap, you must first define geocoding services.
For information on creating geocoding services, see Using ArcCatalog.
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Managing
geocoding
services in
ArcMap
In ArcMap, you can find
addresses or geocode tables of
addresses using geocoding
services. Your ArcMap document
can contain any number of
geocoding services. You can use
the Geocoding Services Manager
to manage the set of geocoding
services contained in an ArcMap
document.

For information on creating
geocoding services, see Using
ArcCatalog.

Adding a geocoding
service to an ArcMap
document

1. Click the Tools menu, point to
Geocoding, then click
Geocoding Services Man-
ager.

2. Click Add.

3. Browse for the geocoding
service that you want to add
to the ArcMap document and
click Add.

4. Click Close.

1

2

4

3
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Removing a geocoding
service from an ArcMap
document

1. Click the Tools menu, point to
Geocoding, then click
Geocoding Services Man-
ager.

2. Click the geocoding service
that you want to remove from
the ArcMap document, then
click Remove.

3. Click Close.

1

2

3
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Controlling the geocoding process

The geocoding process

Once you have added a geocoding service to an ArcMap docu-
ment, you can begin geocoding addresses with it. However,
understanding how a geocoding service matches addresses and
how modifying a geocoding service�s settings affects this process
can help you improve both the performance and accuracy of your
geocoding.

Geocoding services use a specific set of steps to find a match for
an address. First, the geocoding service standardizes the address.
Second, the geocoding service searches the geocoding reference
data to find potential candidates. Next, each potential candidate
is assigned a score based on how closely it matches the address.
Finally, the address is matched to the candidate with the best
score.

When a geocoding service standardizes an address, it dissects the
address into its address components. For example, the address
�4 Dundas St. E.� has four address components: the street
number, �4�; the street name, �Dundas�; the street type, �St.�;
and the street direction, �E.� Each style of geocoding service
standardizes an address into a different set of address compo-
nents.

If your geocoding service uses a place name alias table, it
searches this table for entries that match the address you are
trying to geocode to determine if the address is actually a place

name alias. If one is found, it substitutes the address in the place
name alias table for the place name that you are trying to locate
and standardizes this address.

Once it has standardized the address, the geocoding service
searches the reference data to find features with address compo-
nents that are similar to the components of the standardized
address. Each style of geocoding service bases this search on a
different set of address components. The geocoding service uses
its spelling sensitivity setting for some address components, such
as street name, to determine how closely the address components
of a feature must match the address components of the address
you are geocoding. If the geocoding service uses an alternate
street name table, then it also searches this table to find potential
candidates.

Once the geocoding service has generated a set of potential
candidates, it scores each potential candidate in order to deter-
mine how closely each potential candidate matches the address
that you are geocoding. Each potential candidate is assigned a
score from 0 to 100. Each address component is used to generate
this score. The score for each potential candidate will be lower if
address components are misspelled (for example, the street name
is misspelled), incorrect (for example, the street number of the
address does not fall within the address range for the candidate),
or missing (for example, the street direction is specified in the

A geocoding service standardizes an address into a number of address
components.

4 DUNDAS ST. E.Street number

Street name

Street type

Street direction

The geocoding service searches the reference data for features with
address components that are similar to the components of the
standardized address.
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The geocoding service scores each potential candidate using all of the
address components. A set of match candidates is generated based on
the geocoding service’s minimum candidate score setting.

The Geocoding Options dialog box allows you to modify the settings of a
geocoding service.

address but not in the potential candidate). Once each potential
candidate is scored, the geocoding service generates a set of
match candidates. The geocoding service determines which
potential candidates are match candidates using its minimum
candidate score setting.

Finally, the geocoding service finds the match candidates with the
highest match score. If the score of the match candidate with the
best match score exceeds the geocoding service�s minimum
match score setting, then the geocoding service matches the
address to that match candidate.

Geocoding service settings

Geocoding services have a number of settings that allow you to
control the geocoding process. These settings control how a
geocoding service reads a table of addresses that you want to
geocode, how it matches addresses to features in the reference
data, and what it writes to the geocoded output. Modifying a
geocoding service�s settings will impact how well the geocoding
service will be able to match addresses to the reference data, as
well as what information the geocoding result will contain.

Matching options

Spelling sensitivity

The spelling sensitivity setting controls how much variation the
geocoding service will allow when it searches for likely candi-

dates in the reference data. A low value for spelling sensitivity
will allow �Mane�, �Maine�, and �Man� to be treated as match
candidates for �Main�. A higher value will restrict candidates to
exact matches. The spelling sensitivity does not affect the match
score of each candidate; it only controls how many candidates the
geocoding service considers. The geocoding service then
computes the match score of each candidate and ranks the
candidates by score.

The spelling sensitivity setting for a geocoding service is a value
between 0 and 100. By default, the spelling sensitivity is 80,
which does not allow for much variation in spelling. If you are
sure that your addresses are spelled correctly, you could set a
higher spelling sensitivity. If you think that your addresses may
contain spelling errors, then you should use a lower setting. The
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geocoding process takes longer when you use a lower setting
because the geocoding service has to compute scores for more
candidates.

Minimum candidate score

When a geocoding service searches for likely candidates in the
reference data, it uses this threshold to determine whether a
potential candidate should be considered. Candidates that yield a
match score lower than this threshold will not be considered.

The minimum candidate score for a geocoding service is a value
between 0 and 100. By default, this is set to 30. If the geocoding
service is unable to come up with any likely candidates for an
address that you want to geocode, you could lower this setting so
that candidates with very low scores are considered.

Minimum match score

The minimum match score setting lets you control how well
addresses have to match their most likely candidate in the
reference data in order to be considered matched. A perfect match
yields a score of 100. A match score between 75 and 100 can
generally be considered a good match. An address below the
minimum match score is considered to have no match.

The minimum match score for a geocoding service is a value
between 0 and 100. By default, this setting is 60. If your applica-
tion demands that addresses be located with a high level of
confidence, you should set a higher minimum match score. If you
want to maximize the number of addresses that can be matched
and don�t mind if some addresses are potentially matched
incorrectly, you can use a lower setting.

Intersection connectors

Geocoding services that are based on the US One Range, US
Streets, and StreetMap� geocoding service styles can geocode
street intersections in addition to street addresses. In ArcGIS,

intersections are designated as two streets delimited by an
intersection connector string. Some examples of intersection
descriptions are �Hollywood Blvd. & Vine St.� and �Yonge and
Bloor�.

The intersection connectors setting lets you specify all the strings
that the geocoding service recognizes as intersection connectors.
By default, �&�, �|�, and �@� are recognized as intersection
connectors.

Output options

Side offset

Geocoding services based on the US Streets or StreetMap
geocoding service styles can determine on which side of a street
an address is located. The reference data that you use for each of
these styles of geocoding service contains address range informa-
tion for each side of the street. For cartographic purposes, you
can specify a side offset for geocoded features when using these
styles of geocoding services. When you specify a side offset, the
geocoding service locates geocoded features at the specified
distance from the street centerline on the correct side of the
street.

End offset

Geocoding services based on the US One Range, US Streets, or
StreetMap geocoding service styles can interpolate a position
along reference features for a geocoded address. In order to
prevent features that are located at the end of a reference feature
from falling on top of other features (for example, a cross street),
the geocoding service can apply a �squeeze factor�, or end offset,
to the location of a geocoded address. The end offset setting of a
geocoding service is expressed as a percentage of the length of
the reference feature, between 0 percent and 50 percent. An end
offset setting of 0 percent will not offset features from the end of
the reference feature. An end offset of 50 percent will locate all
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An end offset can be specified that adjusts the location of the address
toward the center of the street feature. Using an end offset will often rectify
the condition shown in the previous diagram. In this example, a squeeze
factor of 10 percent was used to move the address toward the center of
the street feature by a distance equal to 10 percent of the length of the
street feature.

The address, 100 MAIN ST, has been offset from the street feature by the
offset distance of 25 feet. This address falls at the end of the street feature
and is therefore in-line with the end of the street feature.

When streets intersect at odd angles, specifying an offset distance can
have the undesirable effect of placing the address so it appears that the
address does not belong to MAIN ST, but rather to OAK AV.

features at the middle of the reference feature. By default, the end
offset setting for a geocoding service is 3 percent.

Match if candidates tie

If a geocoding service finds two or more reference features that
have the same best match score, you can specify whether or not
to match an address arbitrarily to one of these features. Use this

setting to specify whether to arbitrarily match these addresses or
to leave them unmatched. In either case, you can review ad-
dresses with tied candidates during the interactive review
process, whether or not they are matched.

Output fields

x,y coordinates

Use this setting to specify whether or not to create attributes in
geocoded feature classes that contain the x,y coordinates of the
geocoded features. If you use this setting, then a geocoding
service will create two attributes in the output features classes
that you create with it, one each for the x,y coordinates of the
geocoded features.

Standardized addresses

Use this setting to specify whether or not to create an attribute in
a geocoded feature class that contains the standardized address.
The contents of this field for each address are the address
components used by the geocoding service, separated by the pipe
(�|�) character. This attribute is useful for determining how the
geocoding service standardized the addresses.

Reference data ID

Use this setting to specify whether or not to create an attribute in
a geocoded feature class that contains the ID of the reference
feature to which an address was matched. If an address is not
matched, then the geocoding service writes a value of -1 in this
attribute for the address.

Percent along

Geocoding services based on the US One Range, US Streets, or
StreetMap geocoding services styles can interpolate a position
along reference features for a geocoded address. Use this setting
to specify whether or not to create an attribute in a geocoded
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feature class that contains the position along the reference feature
to which the address was matched. The value of this attribute is a
number between 0 and 100, with 0 indicating the starting node of
the reference feature and 100 indicating the ending node of the
reference feature. If an address is not matched, then the
geocoding service does not write a value in this attribute for the
address.
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Finding an
address
You can use geocoding services
to find addresses in ArcMap. In
order to use a geocoding service
in ArcMap, it must be loaded into
the ArcMap document. You don�t
need to load the reference data
for a geocoding service into the
ArcMap document, but doing so
will help you choose an appropri-
ate candidate for an address.

In ArcMap, you can modify the
geocoding settings that the
geocoding service uses to find
addresses. Modifying the
geocoding settings in ArcMap
does not change the geocoding
service that you are using. Only
the settings that are used to find
addresses in your ArcMap
session are modified.

1. In ArcMap, click the Find tool.

2. Click the Addresses tab.

3. Choose the geocoding
service that you want to use
to find the address from the
list.

If the geocoding service that
you want to use does not
appear in the list, you need to
add it to the ArcMap docu-
ment. Click the Browse
button to browse for
geocoding services to add to
the document.

4. Type the address compo-
nents in the text boxes.

5. Click Find.

6. Click Show all candidates to
see all of the candidates that
the geocoding service
generated.

By default, only the candi-
dates that meet or exceed the
minimum match score are
shown.

7. If you want to modify the
geocoding settings that the
geocoding service uses to
find the address, click
Options.

Otherwise, skip to step 9. u

1

2 3

4

5

6
7
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8. Modify the geocoding
service’s settings and click
OK.

9. If you want to change how the
geocoding service standard-
ized the address, click Show
Standardization.

Otherwise, skip to step 11.

10.Edit the address’s standard-
ization by editing the values
in the fields in the Edit
Standardization dialog box.

When you make edits in the
Edit Standardization dialog
box, the list of candidates is
automatically updated. u

8

Q
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11.Right-click the candidate and
click Flash Candidate
Location(s) to flash the
location of a candidate.

12.Right-click the candidate and
click Zoom to Candidate(s)
and Flash to zoom into a
candidate.

13.Right-click the candidate and
click Add as Graphic(s) to
Map to add a graphic to the
map at a candidate’s location.

14.Right-click the candidate and
click Set Bookmark to set a
spatial bookmark for a
candidate’s location.

15.Click Cancel to close the Find
dialog box.

R
E

Y

W

T
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Geocoding a
table of
addresses
When you geocode a table of
addresses, you use a geocoding
service to create point features
that represent the locations of the
addresses. You can geocode a
table of addresses into any spatial
format supported by ArcGIS
including ArcSDE� feature
classes, personal geodatabase
feature classes, and shapefiles.
ArcView® GIS users cannot
create ArcSDE feature classes.

Before you can geocode a table
of addresses, you must create a
geocoding service and prepare
your table to be geocoded. For
information on preparing your
address tables for geocoding, see
�Preparing address data for
geocoding� in the online Help
system.

1. Click the Tools menu, point to
Geocoding, then click
Geocoding Addresses.

2. Click the geocoding service
that you want to use to
geocode the table of ad-
dresses and click OK.

If the geocoding service that
you want to use does not
appear in the list, click Add to
browse for the geocoding
service. u

1

2
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3. Click the dropdown arrow and
click the table that you want
to geocode.

If the table does not appear
in the dropdown list, click the
Browse button to browse for
the table.

4. Choose the column name
from each dropdown list that
contains the specified
address information.

The names of the required
address attributes are shown
in bold.

5. Click the Browse button and
navigate to the location
where you want to create the
geocoded feature class.

6. Click Save.

7. Click the option to create a
dynamic feature class related
to the table to create a
geocoded feature class that
has a dynamic relationship
with the address table.

8. Click Advanced Geometry
Options to specify the
geometry settings for the
geocoded feature class. u

3

4

5

8

6

Tip

Geocoding dynamic feature
classes related to the
address table
If you want to create a dynamic
feature class related to the address
table, the address table and
geocoded feature class must be in
the same geodatabase. This option
is not available to ArcView GIS
users.
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9. Specify the geometry settings
for the geocoded feature
class and click OK.

10.Click Geocoding Options to
specify the geocoding options
that will be used to geocode
the table of addresses.

11. Specify the geocoding
settings that you want to use
to geocode the table of
addresses and click OK.

12.Click OK on the Geocode
Addresses dialog box to
geocode the table. u

W

Tip

Specifying the geocoding
settings
When you are geocoding a table of
addresses, modifying the
geocoding settings does not
change the geocoding service that
you are using. Only the settings
that are used to geocode this table
are modified. These settings are
stored with the geocoded feature
class. The original geocoding
service is not modified.

For more information on modify-
ing a geocoding service�s settings,
see Using ArcCatalog.

9
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13.Review the results of the
geocoding process.

14.Click Done.

T

R

Tip

Attributes in geocoded
feature classes
When you geocode a table of
addresses, a geocoding service
creates some special attributes in
the output feature class.

The Status attribute indicates
whether or not the address was
matched. This attribute has values
of �M� for matched addresses,
�U� for unmatched addresses, and
�T� (tied) for addresses for which
there were more than one candi-
date with the best match score.

The Score attribute contains the
match score of the candidate to
which the address was matched.

The Side attribute contains the side
of the street to which an address
was matched, if the geocoding
service that was used to match the
table contains address information
for both sides of the street. This
attribute has values of �L� for the
left side of the street, �R� for the
right side of the street, or nothing
if the geocoding service could not
determine the side of the street.
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Rematching a
geocoded feature
class
After you have geocoded a table
of addresses, you may want to
review the results. If you are
unhappy with the results, you
may want to modify the
geocoding service�s settings and
try to geocode the table of
addresses again. This process is
known as rematching.

There are a number of options for
specifying which addresses in a
geocoded feature class you want
to rematch. You can rematch just
the addresses that are unmatched,
all of the addresses with a match
score less than a certain value, all
of the addresses with two or
more candidates with the best
match score, or all of the
addresses. In addition, you can
specify a query to use that
defines the set of addresses to
rematch.

For more information on defining
queries, see Chapter 13, �Query-
ing maps�.

Rematching a geocoded
feature class
automatically

1. Right-click the feature class
that you want to rematch,
click Data, then click Review/
Rematch Addresses.

2. Specify the criteria for the
addresses that you want to
rematch.

3. Click Geocoding Options to
modify the geocoding settings
that you want to use to
rematch the addresses. u

1

2

3
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4. Specify the geocoding
settings that you want to use
to rematch the geocoded
feature class and click OK.

5. Click Match Automatically.

6. Review the results of
rematching the specified
addresses.

7. Click Done.
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Rematching a geocoded
feature class interactively

1. Right-click the feature class
that you want to rematch,
click Data, then click Review/
Rematch Addresses.

2. Specify the criteria for the
addresses that you want to
rematch.

3. Click Match Interactively. u

2

3

1
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4. Click the address in the top
list that you want to rematch.

5. If necessary, edit the input
address.

6. Check the address standard-
ization to ensure that the
geocoding service has
standardized the address
correctly. If not, click Modify
to edit the address standard-
ization.

7. Click Geocoding Options to
modify the geocoding settings
that you want to use to
geocode the addresses and
click OK.

8. Click Search to refresh the
list of candidates.

The candidates are high-
lighted on the map.

9. Click Candidates to zoom to
the set of candidates for the
address.

10.Click the candidate in the
bottom list to which you want
to match the address.

The candidate that you select
in the bottom list is high-
lighted on the map in a
different color.

11.Click Match.

12.Click Close when you are
finished rematching the
addresses.

13.Click Done.

Tip

Unmatching an address
Sometimes you may want to
unmatch an address. For example,
the geocoding service may have
matched an address to a candi-
date, but you may not be happy
with any of the candidates for the
address. Click Unmatch to
unmatch an address.

4

5

Q
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Analyzing utility networks 16
• What is a geometric network?

• What can you do with networks in
ArcMap?

• Opening a geometric network

• Symbolizing network features

• Editing geometric networks

• Loading the Utility Network Ana-
lyst toolbar

• Exploring the Utility Network
Analyst toolbar

• Flow direction

• Displaying flow direction

• Setting flow direction

• Tracing on networks

• Tracing operations

The economic foundation of the modern world is its infrastructure�the
collection of cables, pipelines, and wires that enables the movement of
energy, commodities, and information. This infrastructure can be modeled
as networks. ArcGIS provides a complete model for capturing, storing, and
analyzing networks.

What can you do with networks in ArcMap?

ArcMap provides a rich set of tools that perform many common network
analysis tasks on geometric networks. Some of the common types of
analyses that you can perform on your network using ArcMap are:

� Trouble call analysis: determines the likely cause of a problem based on
the location of customers with service problems.

� Isolation traces: determines which switches have to be opened in order
to cut power to a part of the network.

� Contaminant tracing: determines whether a particular site is a possible
cause of contamination.

Before you can work with geometric networks in ArcMap, you need to
build a geometric network. To learn how to build a geometric network
using ArcCatalog, see Building a Geodatabase.
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Networks consist of two fundamental components: edges and
junctions. The edges and junctions in a network are topologically
connected to each other. An edge is a type of network element
that has a length and through which some commodity flows.
Electrical transmission lines,  pipes, and stream reaches are
examples of edges. A junction occurs at the intersection of two or
more edges and allows the transfer of flow between edges. Fuses,
switches, service taps, and the confluence of stream reaches are
examples of junctions. Edges connect to each other at junctions;
the flow from edges in the network is transferred to other edges
through junctions.

In ArcGIS, feature classes can participate together in a network.
Feature classes representing transmission lines, switches, fuses,
and transformers can all be part of the same network. Because the
features have geometry and can be mapped, the network of
features is called a geometric network. A geometric network
contains the connectivity information between edges and
junctions and defines rules of behavior such as which classes of
edges can connect to a particular class of junction or to which
class of junction two classes of edges must connect.

To create a geometric network, you use a wizard to specify which
feature classes will participate in the network, or you create an
empty network and add feature classes to it later. Once the
network is created, it is maintained throughout the life cycle of
the database. ArcGIS maintains the connectivity information
whenever you edit the participating feature classes, based on the
connectivity rules and relationships that you define in the
geodatabase.

ArcGIS includes a variety of tools for analyzing networks and a
rich set of objects for building custom networks with complex
behavior. For more information on modeling networks in ArcGIS,
see Modeling Our World. To learn how to create geometric
networks and define connectivity rules, and for information on
defining relationships between feature classes, see Building a
Geodatabase.

Geometric networks
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Opening a
geometric
network
Geometric networks are objects
within the geodatabase. Geomet-
ric networks are automatically
maintained by ArcGIS when their
feature classes are edited.

In order to work with a geometric
network in ArcMap, you must
load a minimum of one feature
class that participates in the
network. If you want to work
with only the feature classes that
participate in the network�for
example, if you are performing
some analysis on the network�
then you can load only these
feature classes by loading the
network object.

If you want to load all of the
feature classes in the feature
dataset that contains the net-
work�for example, if you want
to produce a printed map of the
network�you can open the
network by loading the feature
dataset that contains the network.

1. Open the document to which
you want to add the network
data or create a new docu-
ment.

2. Click the Add Data button.

3. Navigate to the feature
dataset in the geodatabase
that contains the network you
want to open.

4. Double-click the feature
dataset to view the feature
classes and geometric
networks that it contains.

5. Click the geometric network
and click Add.

Your geometric network is
added to ArcMap.

See Also

For information on creating
geometric networks, see �Geomet-
ric networks� in Building a
Geodatabase.

1 2
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Opening a feature dataset
containing a geometric
network

1. Open the document to which
you want to add the network
data or create a new docu-
ment.

2. Click the Add Data button.

3. Navigate to the feature
dataset in the geodatabase
that contains the network you
want to open.

4. Click the feature dataset and
click Add.

The feature dataset contain-
ing your geometric network is
added to ArcMap.

4

4

3

21

ch16.p65 12/06/2000, 2:54 PM434



ANALYZING UTILITY NETWORKS 435

1

4

Symbolizing
network features
You can use symbology in
ArcMap to easily identify
enabled or disabled features,
sources, or sinks in your network.

All network features can be
either enabled or disabled.
Enabled features allow flow to
pass through them, while
disabled features do not. The
status of each feature is stored in
the Enabled field of the feature
class�s attribute table. The values
in this field are defined by a
coded value attribute domain and
can only be 0 or 1. Features with
a value of 1 are enabled, and
those with a value of 0 are
disabled. By symbolizing your
features using this attribute, you
can quickly tell which features
are enabled and which are
disabled.

A junction feature can act as a
source or a sink (or neither).
When you build a geometric
network, you specify which
feature classes contain sources or
sinks. Those feature classes have
an attribute named AncillaryRole
that contains this information.
The values in this field are
defined by a coded value
attribute domain. A value of 1
represents a source, and a value
of 2 represents a sink. u

Displaying enabled and
disabled features in a
layer

1. In the table of contents, right-
click the feature layer for
which you want to display
enabled and disabled
features.

2. Click Properties.

3. Click the Symbology tab.

4. Click the Categories item in
the list and click Unique
values in the expanded list of
items.

5. Click the Value Field drop-
down arrow and click En-
abled to use this attribute for
the symbolization.

6. Click Add All Values.

7. To change the symbol for a
particular value, double-click
the symbol.

8. Click OK when you are
finished formatting the
symbols.

2

3 5

7

6 8
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4

Tip

Stopping map redraws
Each change made to the data
view or layout view that affects the
display of the data (such as
docking a toolbar, maximizing the
window, or changing symbology)
causes the map to be redrawn.
When working with large datasets,
redrawing the map can take a
considerable amount of time. If
you are making multiple changes
that will affect the view, you can
stop the map from being redrawn
by pressing the Esc key.

Displaying source and
sink features in a layer

1. In the table of contents, right-
click the feature layer for
which you want to display
source and sink features.

2. Click Properties.

3. Click the Symbology tab.

4. Click the Categories item in
the list and click Unique
values in the expanded list of
items.

5. Click the Value Field drop-
down arrow and click Ancil-
laryRole to use this attribute
for the symbolization.

6. Click Add All Values.

7. To change the symbol for a
particular value, double-click
the symbol.

8. Click OK when you are
finished formatting the
symbols.

A value of 0 means that the
feature is neither a source nor a
sink. By symbolizing features
using this attribute, you can
quickly tell which junctions are
sources and sinks.

For more information on attribute
domains, see Building a
Geodatabase.
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Adding network
features
Adding features to a network is
the same as adding features to
any dataset. However, when
features are added to a network,
they connect topologically to
other features in the network.
These connections are automati-
cally maintained inside the
geodatabase.

In this example, a new service is
added to the network to provide
water to a building. The new
service connects to a water main
on one end and snaps to a
building on the other. In order to
ensure that the new feature in the
services feature class connects to
the water main on one end and
touches the building on the other,
you must use snapping.

1. Click Editor and click Start
Editing.

2. Click Editor and click Snap-
ping.

3. In the Snapping Environment
window, set the appropriate
snapping properties.

4. Close the Snapping Environ-
ment window. u

See Also

For information on snapping, see
Editing in ArcMap.
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Q

5. Click the Task dropdown
arrow and click Create New
Feature.

6. Click the Target dropdown
arrow and click the layer to
which you want to add a
feature.

7. Click the Sketch tool.

8. Point to a position on the
feature where the new feature
is to connect. A target
appears to show that snap-
ping is on. Click to create the
first vertex of the new feature.

9. Create the remaining vertices
of the sketch and double-click
to finish it.

10.Click Editor and click Stop
Editing.

11. Click Yes to save your
changes.

7 5 6

98
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Connecting and
disconnecting
network features
In some cases, you may wish to
disconnect a feature from the
network. Disconnecting a feature
does not delete it from the
database; it removes the topo-
logical connections the feature
has to other features in the
network. Similarly, connecting a
feature to the network creates
topological relationships between
the feature and its neighboring
features.

To disconnect a feature, you must
first add the Disconnect button to
a toolbar from the Commands tab
of the Customize dialog box. The
Disconnect button is available
from the Editor category.

For information on adding a
button to a toolbar, see
Chapter 17, �Customizing
ArcMap�.

Disconnecting network
features

1. Click Editor and click Start
Editing.

2. Click the Edit tool.

3. Select the feature to be
disconnected.

4. Click the Disconnect button.

Tip

Connecting network
features
You can connect a disconnected
feature by following the same
procedure as for disconnecting
features, using the Connect button
instead of the Disconnect button.

2 4

3

1
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Enabling and
disabling features
Any feature in a geometric
network can be enabled or
disabled. An enabled feature
allows flow to pass through it,
while a disabled feature does not.
Disabling features allows you to
treat features as if they were
disconnected from the network,
without actually removing the
topological connections that they
have to other features in the
network. By default, all features
in a geometric network are
enabled when you create the
network.

To enable or disable a feature, its
Enabled attribute must be edited
in the Attributes dialog box.

1. Click Editor and click Start
Editing.

2. Click the Edit tool and click
the feature that you want to
enable or disable.

3. Click the Attributes button.

4. Click in the Value column
next to the Enabled property.

A list box opens showing all
of the valid codes for this
attribute (as defined by the
coded value attribute domain
for the Enabled attribute).

5. Click True to enable the
feature. Click False to disable
the feature.

6. Click Editor and click Stop
Editing.

7. Click Yes to save your
changes.

Tip

Enabling and disabling
features
You can also enable or disable a
feature by changing the value of its
Enabled attribute in the attribute
table. Open the attribute table for
the feature�s feature class, find the
feature in the table, and edit the
value for this attribute. For more
information on working with
attribute tables, see Chapter 10,
�Working with tables�.

2 3

1

5

4
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Adding the Utility
Network Analyst
toolbar
In order to use ArcMap to
analyze your networks, you must
load the Utility Network Analyst
toolbar. This toolbar contains
most of the tools needed to
perform the analysis tasks
presented later in this chapter.

1. Right-click the Main menu.

2. Click Utility Network Analyst.

3. Dock the toolbar to the
ArcMap window.

Now, each time you start
ArcMap the toolbar will be
displayed.

Tip

Adding the toolbar
You can also add the toolbar by
clicking the View menu, pointing to
Toolbars, then clicking Utility
Network Analyst.

2
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Exploring the Utility Network Analyst toolbar

The Network dropdown list contains all of the geometric
networks that are currently loaded in ArcMap. In order to work
with a network in ArcMap�for example, set the flow direction or
perform a trace operation�you must choose the network in this
list.

The Flow menu contains items for displaying the flow direction
of the features in the network. Clicking the Flow menu reveals
three items: Display Arrows For, Display Arrows, and Properties.

The Utility Network Analyst toolbar is divided into two sections.
The left side of the toolbar lets you choose a network with which
to work and to set and display its flow direction. The right side of
the toolbar lets you set up and perform trace operations on the
current network (see �Tracing on networks� in this chapter).

The Set Flow Direction button establishes flow direction in the
network. This button is enabled when your network contains
feature classes that you have designated as containing persistent
sources and sinks.

Clicking Display Arrows For produces a list of the edge feature
classes in your network. By checking items in this list, you can
specify for which layers to display flow direction. The Display
Arrows command is a toggle button that turns on or off the

Network
dropdown list

Flow menu

Set Flow Direction
button

Analysis menu

Flag and Barrier
tool palette

Trace Task
dropdown list

Solve button

display of flow direction arrows for your network. Clicking the
Properties command opens the Flow Display Properties dialog
box. The Arrow Symbol tab lets you specify the symbol, size, and
color of the arrows used to indicate flow direction. The Scale tab
lets you specify the scale range in which the arrows are
displayed.
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The Analysis menu contains commands for setting up your
network to perform trace operations. Clicking the Analysis menu
reveals five commands: Disable Layers, Clear Flags,  Clear
Barriers, Clear Results, and Options.

Clicking Disable Layers displays a list of feature classes
contained in the geometric network. By checking feature classes
in this list, you can disable feature classes in trace operations.
This makes trace operations behave as if all of the features in
those feature classes are disabled. The Clear Flags and Clear
Barriers menu items remove flags and barriers, respectively, from
the network. Clicking Clear Results clears the results of the
previous trace operation.

Clicking Options opens the Analysis Options dialog box. This
dialog box allows you to specify options for subsequent trace
operations.

The General tab of the Analysis Options dialog box lets you
specify on which features trace tasks are performed. You can
perform trace tasks on all of the features in the network, only the
selected features, or only the unselected features. You can specify
whether or not trace tasks that consider flow direction include
edges with indeterminate or unspecified flow direction. You can
also use this tab to specify the snapping tolerance for placing
flags and barriers on the map.

The Weights tab lets you specify which network weights are used
when tracing. For example, the Find Path trace task uses weights
to determine the cost of including a network feature in the result
of the trace task.
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The Trace Task dropdown list contains a list of all of the trace
operations that you can perform using the Utility Network
Analyst toolbar. ArcGIS comes with nine built-in trace
operations.

While the Trace Task dropdown list is used to select the trace
task, the Solve button is used to perform the trace operation once
you have finished configuring your trace operation using the
toolbar. The Solve button performs the trace operation that you
selected in the Trace Task dropdown list; it does this using the
parameters that you specified using the Analysis Options dialog
box and the placement of flags and barriers on the network.

The Weight Filter tab lets you specify which network features can
be traced based on weights assigned to the network features. For
both edges and junctions, you can specify valid ranges of weights
for features that may be traced.

With the Results tab, you can determine in which format you
want to receive the results of trace operations. Results can be
given as drawings overlaid on the map or as a set of selected
features. If you choose to draw the results, you can choose to
render only the parts of complex edges that are actually traced,
rather than the entire complex feature. You can also specify
whether the results will include features that are traced during the
operation or features stopping the trace. Finally, you can specify
whether the results include both edge and junction features.
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Flow direction

In utility network applications, knowing the flow direction along
network edges is essential. Establishing the flow direction in a
geometric network determines the direction in which
commodities flow along each edge. The flow direction in a
network is determined by the topology of the network, the
locations of sources and sinks in the network, and the enabled or
disabled state of features.

Sources and sinks drive flow through a utility network. Sources
are junction features that push flow away from themselves
through the edges of the network. For example, in a water
distribution network, pump stations can be modeled as sources,
since they drive the water through the pipes away from the pump
stations. Sinks are junction features that pull flow toward
themselves from the edges in the network. For example, in a river
network, the mouth of the river can be modeled as a sink, since
gravity drives all water towards it. Flow moves away from
sources or towards sinks. Because flow direction can be
established with either sources or sinks, it usually suffices to
specify only sources or only sinks in a network.

It is important to remember that disabled features are accounted
for when setting flow direction. Disabling a feature makes it act
as if flow cannot pass through it. Thus, disabling a feature means
that the flow direction cannot be set for the disabled features, or
for those features that are connected to the sources or sinks
exclusively through the disabled feature.

After you set the flow direction for your network, an edge has
one of three categories of flow direction: determinate,
indeterminate, or uninitialized.

Determinate flow direction

If the flow direction of an edge can be uniquely determined from
the topology of the network, the locations of sources and sinks,
and the enabled or disabled states of features, the feature is said

to have determinate flow. Determinate flow for an edge is
specified as either with or against the direction in which the
feature was digitized.

Indeterminate flow direction

Indeterminate flow direction in a network occurs when the flow
direction cannot be uniquely determined from the topology of the
network, the locations of sources and sinks, and the enabled or
disabled states of the features. Indeterminate flow commonly
occurs for edges that form part of a loop, or closed circuit. It can
also occur for an edge whose flow is determined by multiple
sources and sinks, where one source or sink is driving the flow in
one direction through the edge, but another source or sink is
driving it in the opposite direction. For example, an edge that has
a source at both of its ends will have indeterminate flow.

Uninitialized flow direction

Uninitialized flow direction in a network occurs in edges that are
isolated from the sources and sinks in the network. This can
happen if the edge is not topologically connected through the
network to the sources and sinks or if the edge is only connected
to sources and sinks through disabled features.

Specifying flow direction

All utility networks that have flow have sources and sinks. In
some cases, you may not know the locations of the sources and
sinks, but you may know the flow direction. If this is the case,
you must choose the junctions in your network to act as sources
and sinks that produce the correct flow direction.

After setting the flow direction for your network, indeterminate
flow may occur, even when you know the direction of flow. This
is because the flow direction is determined by properties of the

ch16.p65 12/06/2000, 3:01 PM445



446 USING ARCMAP

network or the features making up the network in addition to the
topology or locations of sources and sinks. For example, in a
water network, the flow direction in a pipe is determined by the
difference in water pressure between the ends of the pipe. The
pressure at each end of the pipe is affected by such things as the
material out of which the pipe is made, the pipe diameter, the
flow rate through the pipe, the physical configuration of the pipe
(including any bottlenecks, valves, or sharp bends), the
temperature of the water, the elevation of the ends of the pipe,
and the topology of the network. Since ArcGIS deals with general
utility networks (and not with domain-specific types of
networks), this information is not used to set the flow direction.
Thus, the flow direction may be set to indeterminate for some
edges in these networks.

A set of similar variables exists in every domain. Developers can
write custom flow-direction solvers that use these variables to
find determinate flow direction in domain-specific networks.
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Displaying flow
direction
Network flow direction specifies
the direction in which commod-
ity flows through the network.
ArcGIS stores this information
for edge features in a network.

You can display the flow
direction for edges using the
Utility Network Analyst toolbar.
You can display which edges
have determinate flow direction,
indeterminate flow direction, or
uninitialized flow.

1. Click the Flow menu on the
Utility Network Analyst
toolbar.

2. Point to Display Arrows For.

3. Check the layers for which
you want to display flow
direction.

4. Click Properties.

5. Click the Arrow Symbol tab.
Click a flow category in the
list and click the button to
specify the size and color of
the flow direction arrows. u

See Also

For more information on flow
direction, see �Flow direction� in
this chapter.

4

12 3

5
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6. Click the Scale tab and
specify the scales at which
you want to display the flow
direction arrows. To show the
arrows at all scales, click
Show arrows at all scales. To
only show the arrows within a
scale range, click Don’t show
arrows when zoomed and
type the scale range limits in
the text boxes.

7. Click OK.

8. Click Flow and click Display
Arrows.

The arrows symbolizing the
flow direction are displayed.

Tip

Clearing flow direction
arrows
To remove the flow direction
arrows, click Flow and click
Display Arrows. 6

7

8
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Setting flow
direction
You can use ArcMap to maintain
flow direction in your geometric
network. ArcMap uses the
network topology, the enabled or
disabled state of network
features, and the locations of
sources and sinks to establish
flow direction.

You must set flow direction
whenever you:

� Create a new geometric
network

� Add or remove features from
the network

� Reshape features so as to
change the network topology

� Connect or disconnect
features

� Add or remove sources or
sinks

� Enable or disable features

Setting the flow direction
establishes the correct flow
direction for the new network
topology.

In order to set flow direction,
your network must contain at
least one junction feature class
that you specified as containing
sources and/or sinks.

Creating sources and
sinks

1. Click the Editor menu and
click Start Editing.

2. Click the Attributes button.

3. Click the Edit tool and click
the feature that you want to
set as a source or sink. This
feature must belong to one of
the feature classes that you
specified as containing
sources and sinks when you
built your network.

4. In the Attributes window, click
the Value column next to the
AncillaryRole property.

5. Click Source or Sink to
designate this feature as a
source or sink (you can undo
this later by clicking None in
this list).

6. Click Editor and click Stop
Editing.

7. Click Yes to save the edits to
your network.

3 2

1

3

4

5
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Setting flow direction

1. Click the Editor menu and
click Start Editing.

2. Click the Set Flow Direction
button on the Utility Network
Analyst toolbar. This sets the
correct flow direction for your
network.

3. Click Editor and click Stop
Editing.

4. Click Yes to save the edits to
your network.

Tip

Versioning networks
You can use the versioning features
of ArcGIS to create different
versions of your network. Each
version of the database that you
create maintains its own set of
information for your geometric
network including the network
topology, the enabled or disabled
state of features, sources and sinks,
and flow direction. With versions,
for example, you could maintain
one version of the network for use
in trouble call analysis and
maintain another version for
planning maintenance and
upgrades to the network.

For more information on version-
ing, see �Working with a versioned
geodatabase� in Building a
Geodatabase.

2
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Tracing on networks

Network analysis involves tracing. The term tracing is used here
to describe building a set of network elements according to some
procedure. You can think of tracing as placing a transparency on
top of a map of your network and tracing all of the network
elements that you want to include in your result onto the
transparency.

When working with networks, tracing involves connectivity. A
network element can only be included in a trace result if it is in
some way connected to other elements in the trace result. The
trace result is the set of network features that is found by the
trace operation.

For example, suppose you want to find all of the features
upstream of a particular point in a river network. Using a
transparency placed over the map of the river network, you could
trace over all of the branches of the river that were upstream of
that point. What is drawn on the transparency after this would be
your desired result.

Similarly, when you perform a trace operation in ArcMap, your
result is a set of the network elements included in the trace. In
ArcMap, your trace results can either be drawings on top of your
map or a selection.

Flags and barriers

In ArcMap, flags define the starting points for traces. For
example, if you are performing an upstream trace, you use a flag
to specify where the upstream trace will begin. Flags can be
placed anywhere along edges or on junctions. When performing
the trace operation, ArcMap uses the underlying edge or junction
feature as the starting point of the trace operation. Network
elements connected to these edges or junctions are considered for
inclusion in the trace result.

Barriers define places in the network past which traces cannot
continue. If you are only interested in tracing on a particular part

of your network, you can use barriers to isolate that part of the
network. Like flags, barriers can be placed anywhere along edges
or on junctions. When performing trace operations, ArcMap
treats the underlying network features as if they are disabled, thus
preventing the trace from continuing beyond these features.

Disabling features

Disabling features is a more permanent method of creating a
barrier at a particular location. In a municipal water network, for
example, if a water main has been opened and capped due to a
road construction project, water cannot flow through that section
of the water main. Disabling the network feature representing this
water main would stop a trace at this feature.

Disabling feature layers

In some cases, disabling entire layers may be necessary. For
example, by disabling the switches layer in an electrical
distribution network and tracing from some point in the network,
you can find the switches that need to be thrown to isolate this
point from the network; these will be the features at which the
trace operation is stopped.

Weights

Edges and junctions can have any number of weights associated
with them. A weight is a property of a network feature typically
used to represent a cost for traversing across an edge or through a
junction. An example of an edge weight is the length of the edge.
In a shortest path analysis, you would choose this weight if you
wanted the resulting path to be of the shortest length. Another
example is the resistance to traversing an edge in an electrical
network. Using a resistance weight, the shortest path would be
the path of least resistance.
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When you build a network, you specify which attributes of edge
and junction feature classes will become weights. You can use
these weights to specify the cost of including a feature in the
results of a trace operation. Of the trace tasks included with
ArcGIS, only the Find Path, Find Path Upstream, and Find
Upstream Accumulation trace tasks use weights to calculate the
cost of the trace.

In order to find the cost using these trace tasks, you must specify
which weights to use. For junction features, a single weight is
used. For edge features, two weights can be used: one along the
digitized direction of the edge feature (the From-to weight) and
one against the digitized direction of the edge feature (the To-
from weight). The digitized direction of an edge feature refers to
the order in which the shape nodes of the feature are stored in the
geodatabase. You can specify a different weight for each
direction of an edge for cases where tracing an edge in one
direction has a different cost than tracing it in the other direction.

Weight filters

You can use a weight filter to limit the set of network features
that may be traced. A weight filter specifies which network
features can be traced based on their weight values. A weight
filter serves the same purpose as creating a selection of network
elements based on a simple SQL query, except that the
performance of the weight filter is much faster.

Using a weight filter, you specify valid or invalid ranges of
weight values for network features that may be traced. As with
using weights to represent the cost of including a feature in trace
results, a single weight is used for junction features, and two
weights may be used for edge features.

Traced features and features stopping the trace

When tracing using the Find Connected, Trace Downstream, or
Trace Upstream trace tasks, you can return either the features that
are traced or the features that stop the trace. Features that are
traced are those that are actually traced over by the operation.
Features that stop the trace are those features past which the trace
cannot continue. Features that stop the trace include the
following:

� Disabled features

� Features upon which barriers are placed

� Traced features that are only connected to one other feature
(deadends)

� Features that have been filtered out with a weight filter

Using selections to modify trace tasks

When tracing, ArcMap lets you use selections to modify trace
tasks in three main ways.

First, the Analysis Options dialog box lets you specify whether
the trace operation is performed on all features in the network, on
the selected features only, or on the unselected features only.
Tracing on just the selected features means that unselected
features act as barriers, while tracing on just the unselected
features means that selected features act as barriers. By using
selections in this manner, you could, for example, perform a trace
operation to produce a set of barriers for a subsequent operation,
or you could build a selection query to produce a set of network
features upon which to perform a trace operation.
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ArcMap also lets you specify which layers are selected when
performing a trace operation. From the Selection menu in
ArcMap, you can specify which layers can and cannot be
selected. When ArcMap returns the results of a trace operation as
a selection set, the settings you specify in the Selection menu are
used to determine which features should be included in the
selection set returned by the trace.

Finally, you can also use the interactive selection method�set
through the Selection menu�to specify the behavior of the
resulting selection set. You can create a new selection, add the
results of your trace operation to the current selection, select the
results of your trace operation from the current selection, or
remove the results of your trace operation from the current
selection.

By using the power of selections in ArcMap, you can use the
simple trace tasks included with ArcMap to perform compound
and complex trace operations.

Putting it all together

This section introduced some concepts you can use when
constructing traces to perform on your network. You can return
the trace results as a selection set, disable individual features or
entire feature layers, place barriers on edges or junctions, include
the traced features or the features stopping the trace, trace only
on selected or unselected features, specify which layers to
include in the results, and use different selection methods. All of
these concepts can be used simultaneously when creating a trace
result. Combining these concepts in trace operations allows you
to execute very powerful traces on your network.
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Tracing
operations
Using the Utility Network
Analyst toolbar with your
network, you can do the follow-
ing:

� Trace downstream

� Trace upstream

� Find the upstream accumula-
tion

� Find an upstream path to the
source

� Find common ancestors

� Find connected features

� Find disconnected features

� Find a path

� Find loops

You can use these simple tasks to
perform many useful network
analyses. You can also combine
these with other features of
ArcMap to perform complex
network analysis operations.

To find all network elements that
lie downstream of a given point
in your network, use the Trace
Downstream task.

To find all network elements that
lie upstream of a given point in
your network, use the Trace
Upstream task. u

Adding flags and barriers

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow.

2. Click the button representing
the flag or barrier element
that you want to add to the
network.

3. Point to the edge or junction
feature to which you want to
add the flag or barrier.

4. Click to add the flag or
barrier.

1

2

3

1 3 4
Tracing downstream

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click to place flags at each
point from which you want to
trace downstream.

3. Click the Trace Task drop-
down arrow and click Trace
Downstream.

4. Click the Solve button.

All of the features down-
stream of your flags are
displayed.

2
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To find the total cost of all
network elements that lie
upstream of a given point in your
network, use the Find Upstream
Accumulation task.

To find an upstream path from a
point in the network to the
source, use the Find Path
Upstream task.

To find the common features that
are upstream of a set of points in
your network, use the Find
Common Ancestors task.

To find all of the features that are
connected to a given point
through your network, use the
Find Connected task.

To find all of the features that are
not connected to a given point
through your network, use the
Find Disconnected task.

To find a path between two
points in the network, use the
Find Path task. The path found
can be just one of a number of
paths between these two points�
depending on whether or not
your network contains loops.

To find loops in your network,
use the Find Loops task. Loops
can result in multiple paths
between points in a network.

Tracing upstream

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click to place flags at each
point from which you want to
trace upstream.

3. Click the Trace Task drop-
down arrow and click Trace
Upstream.

4. Click the Solve button.

All of the features upstream
of your flags are displayed.

Finding the upstream
accumulation

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click to place flags at each
point from which you want to
find the upstream accumula-
tion.

3. Click Analysis and click
Options. u

1 3 4

13

2

2

2

2
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4. Click the Weights tab. Click
the Junction weights drop-
down arrow and click the
name of the weight you want
to use for junctions.

5. Click the from-to edge weight
dropdown arrow and click the
name of the weight you want
to use for tracing edges along
the digitized direction.

6. Click the to-from edge weight
dropdown arrow and click the
name of the weight you want
to use for tracing edges
against the digitized direction.

7. Click OK.

8. Click the Trace Task drop-
down arrow and click Find
Upstream Accumulation.

9. Click the Solve button.

All of the features upstream
of your flags are displayed
and the total cost of these
features is reported in the
status bar.

4

5

6

7

8

Tip

Finding the upstream
accumulation without
weights
By default, the Find Upstream
Accumulation trace task does not
use weights. If you do not use
weights, the cost reported is the
number of edge elements in the
result.

9
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Finding common
ancestors

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click to place flags at each
point for which you want to
find the common ancestors.

3. Click the Trace Task drop-
down arrow and click Find
Common Ancestors.

4. Click the Solve button.

The features that are up-
stream of all of your flags are
displayed.

1 3 4

2

2

Finding an upstream path
to the source

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click to place flags at each
point for which you want to
find an upstream path to the
source.

3. Click the Trace Task drop-
down arrow and click Find
Path Upstream.

4. Click the Solve button.

For each of your flags, an
upstream path from the flag
to the source is displayed.

1 3 4

2

Tip

Finding an upstream path
with weights
By default, the Find Path Up-
stream trace task does not use
weights. If you use weights, the
upstream path found to the source
is the shortest path based on the
weights you specify. To specify
weights, follow steps 3 through 7
for finding the upstream accumula-
tion.
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Finding connected
features

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click to place flags at each
point for which you want to
find the connected features.

3. Click the Trace Task drop-
down arrow and click Find
Connected.

4. Click the Solve button.

The features that are con-
nected to the features on
which you placed your flags
are displayed.

1 3 4

2

Tip

Using Find Connected or
Find Disconnected
The Find Disconnected trace task
always returns the features that the
Find Connected trace task does
not. The results of one of these
trace tasks are often easier to view
and analyze than the results of the
other. For example, suppose you
have a mostly connected network
and you would like to check to
make sure all of your network
features are connected to each
other. Performing a Find Discon-
nected trace task and checking to
see if no features are returned is
easier than performing a Find
Connected trace task and making
sure all of your features are
returned.

Finding disconnected
features

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click to place flags at each
point for which you want to
find the disconnected
features.

3. Click the Trace Task drop-
down arrow and click Find
Disconnected.

4. Click the Solve button.

The features that are not
connected to the features on
which you placed your flags
are displayed.

1 3 4

2

ch16.p65 12/07/2000, 7:36 AM458



ANALYZING UTILITY NETWORKS 459

Isolating a point on the
network

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click on the map to place a
flag at the point you want to
isolate.

3. Click Analysis and click
Disable Layers. Check the
layer or layers containing the
features that will be used to
isolate this point.

4. Click Analysis and click
Options.

5. Click the Results tab and click
Selection.

6. Click Features stopping the
trace.

7. Click OK. u

2

3

1

5

6

7
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8. Click the Main menu, click
Selection, then click Set
Selectable Layers.

9. Click Clear All to uncheck all
of the layers.

10.Check the layers that contain
the features that will be used
to isolate your point in the
network.

11. Click Close.

12.Click the Trace Task
dropdown arrow and click
Find Connected.

13.Click the Solve button.

The features that are selected
can be used to isolate your
point in the network.

E

8

9

W

Q
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Finding connected
features using weight
filters

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click to place flags at each
point for which you want to
find the connected features.

3. Click Analysis and click
Options.

4. Click the Weight Filter tab.
Click the Junction weight
dropdown arrow and click the
name of the weight you want
to use to filter junctions.

5. In the Weight range text box
for junctions, type the
expression you want to use to
filter junctions.

6. Check the Not check box to
exclude this range.

7. Click Verify to check the
syntax of the junction weight
filter. u

Tip

Weight filter syntax
When you create a range expres-
sion for a weight filter, you must
use correct syntax. You can specify
multiple valid or invalid ranges for
each weight. You must delimit each
range with commas. Each range
can include a single value or a
range of values. To specify a range
of values, type a hyphen between
the lower and upper bounds of the
range (for example, �1-5, 10-22.2,
27�).

1

3

2

6 7
5
4
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8. Click the From-to weight
dropdown arrow and click the
name of the weight you want
to use to filter edges along
their digitized direction.

9. Click the To-from weight
dropdown arrow and click the
name of the weight you want
to use to filter edges against
their digitized direction.

10.In the Weight range text box
for edges, type the expres-
sion you want to use to filter
edges.

11. Check the Not check box to
exclude this range.

12.Click Verify to check the
syntax of the edge weight
filter.

13.Click OK.

14.Click the Trace Task drop-
down arrow and click Find
Connected.

15.Click the Solve button.

The features that are con-
nected to the features on
which you placed your flags,
using the weight filter you
specified, are displayed.

W

R

E
Q
9

8
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Finding a path

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click to place flags on the
features among which you
want to find a path.

3. Click the Trace Task drop-
down arrow and click Find
Path.

4. Click the Solve button.

A path between the features
on which you placed flags is
displayed.

Tip

The Find Path trace task
When you use the Find Path trace
task, the flags you place on the
network must be either all edge
flags or all junction flags. You
cannot find a path among a
mixture of edge and junction flags.

Finding the shortest path

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click to place flags on the
features among which you
want to find a path.

3. Click Analysis and click
Options. u

Tip

Finding paths without
weights
By default, the Find Path trace
task does not use weights. If you
do not use weights, the shortest
path based on the number of edge
elements in the path is found.

1 3 4

2
2

2

2

2

2

2
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4. Click the Weights tab. Click
the Junction weights drop-
down arrow and click the
name of the weight you want
to use for junctions.

5. Click the from-to edge weight
dropdown arrow and click the
name of the weight you want
to use for tracing edges along
the digitized direction.

6. Click the to-from edge weight
dropdown arrow and click the
name of the weight you want
to use for tracing edges
against the digitized direction.

7. Click OK.

8. Click the Trace Task drop-
down arrow and click Find
Path.

9. Click the Solve button.

The shortest path based on
the weights you chose is
displayed. The total cost of
this path is reported in the
status bar.

4

5

6

7

8 9
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Finding an upstream path

1. On the Utility Network Analyst
toolbar, click the tool palette
dropdown arrow and select
the junction flag tool.

2. Click Analysis and click
Options. Click the Results
tab. Click Selection to return
the results of trace tasks as
selections.

3. Uncheck Junctions. This
returns only edges in the
results.

4. Click OK.

5. Click on the map to place a
flag at the destination point.

6. Click the Trace Task drop-
down arrow and click Trace
Upstream.

7. Click the Solve button.

8. Click Analysis and click Clear
Flags. u

Tip

Finding a downstream path
Find a downstream path using a
process similar to finding an
upstream path.

1

5

6

2

3

4

7

8
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T

R

Q

W9. Click the Main menu and click
Selection. Point to Interactive
Selection Method and click
Add to Current Selection.

10.Click on the map to place a
flag at the origin point.

11. Click the Trace Task drop-
down arrow and click Trace
Downstream.

12.Click the Solve button.

13.Click Analysis and click
Options. Click the General
tab and click Unselected
features to treat the current
selection as barriers.

14.Click OK. u

9

E
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I15.Click the Main menu and click
Selection. Point to Interactive
Selection Method and click
Create New Selection.

16.Click on the map to place a
flag at the destination point.

17.Click the Trace Task drop-
down arrow and click Find
Path.

18.Click the Solve button.

If it exists, the result will be
an upstream path from the
origin point to the destination
point.

O

Y

U

Finding loops
1. On the Utility Network Analyst

toolbar, click the tool palette
dropdown arrow and choose
a flag tool.

2. Click to place at least one
flag on each connected
component in which you want
to find the loops.

3. Click the Trace Task drop-
down arrow and click Find
Loops.

4. Click the Solve button.

For each connected compo-
nent on which you placed a
flag, the features that loop
back on themselves (i.e., can
be reached from more than
one direction) are displayed.

1 3 4

2
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Customizing ArcMap 17
• Basic user interface elements

• Hiding and showing toolbars

• Creating custom toolbars

• Changing a toolbar’s contents

• Changing a command’s
appearance

• Creating shortcut keys

• Saving customizations in a
template

• Setting toolbar options

• Creating, editing, and running
macros

• Creating custom commands with
VBA

• Working with UIControls

• Locking documents and templates

• And more

Although ESRI end user applications are designed to be flexible and easy to
use, you may want the ArcMap interface to reflect your own preferences and
the way you work. If you work in a larger organization, others may want you
to develop a customized work environment for them. As a developer, you�ll
be glad to learn that many of the customization tasks you may be asked to
perform can be handled without writing a single line of code; in fact, you
may be able to instruct others on how to use the customization environment
themselves to create the look and feel they want on their own. You can
change or create toolbars, menus, keystrokes, and so on, to help you get
your work done in the most efficient way. Not only can you change the way
the existing work environment is organized, but you�ll also be able to
provide additional functionality by linking code you or others have written
to menu commands or tools. This chapter shows that the customization
environment for ArcMap is rich with possibilities.
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Basic user interface elements

Docking toolbars

Any toolbar can be docked at the top or bottom or to the left or
right of the ArcMap window. Alternatively, toolbars can float on
the desktop while functioning as part of the application. When
you dock a toolbar, it is moved and resized with the application�s
window. To prevent a toolbar from docking, hold down the Ctrl
key while dragging it.

The table of contents in ArcMap is docked on the left by default,
but you can dock it elsewhere in the window, or have it float on
the desktop if you prefer.

Changing the way the application looks

Whether you want to position toolbars in a specific area of the
application, group commands in a way that works best for you,
add new macros or load add-ins that you�ve gotten from another
source, load styles, or always work with the same geographic
data, you�ll find that you can customize ArcMap in numerous

Main Menu

Standard toolbar

Floating toolbar

Docked table of contents

ArcMap has a Main Menu and a Standard toolbar, which appear
by default. Both are referred to as toolbars, although the Main
Menu toolbar contains menus only. Toolbars can contain menus,
buttons, tools, combo boxes, and edit boxes; these are different
types of commands. Whether it�s built into the application or it�s
something you�ve created yourself, code is associated with each
command. All commands execute in generally the same manner,
although you use each type differently when interacting with the
application.

� Menus arrange other commands into a list. A context menu is
a floating menu that pops up at the location of the pointer
when you press the right mouse button.

� Buttons and menu items run a script when you click them.

� Tools require interaction with the display before an action is
performed�that is, before their script is run. The Zoom In
tool is a good example of a tool�you click or drag a
rectangle over a map before seeing the contents of the
rectangle in more detail.

� Combo boxes let you choose an option from a dropdown list.
For example, in ArcMap you can choose the font used for the
text you add to the map.

� Text boxes or edit boxes let you type in text. For example, in
ArcMap you can type the scale at which you want to view the
map.

The tasks in this book apply to all types of commands unless
otherwise noted. Each task�s description will note any exceptions
that apply for specific types of commands.
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ways. One of the principle ways in which to tailor the
applications to suit your needs is to use the Customize dialog box
to change menus and toolbars. You can carry out many of the
tasks described in the rest of this chapter by starting with this
dialog box. The Customize dialog box resembles and has many
of the same properties as the equivalent dialog in Microsoft
Office applications. If you�ve used any of these applications, the
environment will be familiar to you.

When you open the Customize dialog box, you can modify
existing menus, toolbars, and context menus with simple drag-
and-drop techniques. Afterwards, if you prefer, you can return the
menus and toolbars built into ArcMap to their default settings.
You can also create your own menus, toolbars, and context
menus.

The Toolbars tab of the Customize dialog box

Where to save your changes

When you make customization changes to the user interface in
ArcMap, you can save your changes in one of the following three
places:

� The current map document. There is always a map document
open in ArcMap.

� A base template. A kind of map document that provides a
quick way to create a new map. Templates can contain data, a
custom interface, and a predefined layout that arranges map
elements, such as North arrows, scale bars, and logos, on the
virtual page. Map templates have an .mxt file extension. There
may not be a base template loaded in ArcMap.

� The Normal template. A special template that is automatically
loaded in ArcMap. This template stores any personal settings
you have made to the user interface that you want loaded
every time you use ArcMap.

When you first start ArcMap after installing the software, a
Normal template is automatically created and put in your profiles
location, which is one of the following folders depending on your
operating system:

Windows NT ®

C:\WINNT\Profiles\<your username>\Application
Data\ESRI\ArcMap\Templates\

Windows 2000

C:\Documents and Settings\<your username>\Application
Data\ESRI\ArcMap\Templates\
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This is the default out-of-the-box Normal template that contains
all the standard toolbars and commands and places the toolbars
and the table of contents in their default positions. Any
customizations that you save in your Normal template get saved
in this file. If you want to make changes that appear every time
you open ArcMap, save them in the Normal template.

You might want to make changes that only appear when working
with a particular map. For example, you might want your custom
query and analysis toolbar to appear only in specific maps. In this
case you would choose to save your customization in the current
document. By default, all of your changes are saved in the
Normal template. After you save a change in the current
document, however, all subsequent changes will be saved in the
current document by default.

Suppose you�ve created more than just a custom toolbar�you�ve
created an entire environment with custom tools and macros that
are used only when you edit a dataset�s features. You can save
this environment as a customized template. When you create a
new map document, you can choose to base it on the Normal
template or your custom template. For more information on
saving customized templates, see �Saving customizations in a
template� later in this chapter.

Suppose your administrator has custom toolbars or tools that she
would like to make accessible to everyone in your organization.
Your administrator could create a customized Normal template
and allow everyone in your organization to use that Normal
template instead of the default Normal template. To accomplish
this, your administrator would customize her Normal template
and then copy that Normal.mxt file to the \arcexe81\bin\templates
folder. Everyone would then start with this Normal template
instead of the default Normal template. The following is an
explanation of how this works.

If there is no Normal.mxt file in your profiles location when you
start ArcMap, the application will look in the
\arcexe81\bin\Templates folder where ArcMap is installed. If a
Normal.mxt file exists in the \arcexe81\bin\Templates folder, that
file will be copied to your profiles location and is subsequently
treated as your personal Normal template. Therefore, you start off
with a copy of your organization�s customized Normal template,
but from that point on you are able to save your own
customizations to it.

If a Normal.mxt file is not found in your profiles location or in
the \arcexe81\bin\Templates folder, then a new default
Normal.mxt file is created and placed in your profiles location.
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Hiding and
showing toolbars
In addition to the Main Menu and
the Standard toolbar, ArcMap has
other toolbars that contain
commands to help you perform a
group of related tasks. ArcMap
has buttons on the Standard
toolbar for quickly displaying its
most commonly used toolbars.
You can hide or show toolbars
using the Toolbars list on the
View menu or the Customize
dialog box. A check mark next to
a toolbar name indicates that it�s
visible. Note that the Main Menu
appears in the toolbars list but
cannot be hidden. After checking
a toolbar, the application displays
it as a floating toolbar on the
desktop. If the toolbar was
previously turned on, it returns to
its last position. Toolbar position
and visibility are always saved in
the Normal template.

Hiding and showing
toolbars from the View
menu

1. Click View and point to
Toolbars.

2. Check a toolbar to show it.

Uncheck a toolbar to hide it.

Toggling toolbars from
the Customize dialog box

1. Click the Tools menu and
click Customize.

2. Click the Toolbars tab.

3. Check a toolbar to show it.

Uncheck a toolbar to hide it.

4. Click Close.

2

3

Tip

Shortcut to the Toolbars
list
You can access the Toolbars list
without using the View menu.
Simply right-click any toolbar or
the status bar.

Tip

Hiding floating toolbars
To quickly hide a floating toolbar,
click its Close button.
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7

4

4

7

Creating custom
toolbars
Several toolbars are provided
with ArcMap, but you may want
to create a new toolbar with
buttons to run your custom
scripts. You can rename or delete
a toolbar created in ArcMap with
the New button of the Customize
dialog box; on the other hand, if
the toolbar is built into the
application or is part of an
ActiveX® DLL that you added
with the Add from file button, it
cannot be renamed or deleted.

Creating a new toolbar

1. Click the Tools menu and
click Customize.

2. Click the Toolbars tab.

3. Click New.

4. Type in the name of your new
toolbar.

5. Click the dropdown arrow of
the Save in combo box and
choose the template in which
this toolbar will be saved.

6. Click OK.

The new, empty toolbar
appears in the Toolbars list
and is displayed in the
application as a floating
toolbar.

7. Click Close.

Renaming a toolbar

1. Click the Tools menu and
click Customize.

2. Click the Toolbars tab.

3. Click the toolbar you want to
rename.

4. Click Rename.

5. Type the name of your
toolbar.

6. Click OK.

7. Click Close.

3

56

5

6
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Deleting a toolbar

1. Click the Tools menu and
click Customize.

2. Click the Toolbars tab.

3. Click the custom toolbar that
you want to delete.

4. Click Delete.

The toolbar is removed from
the Toolbars list.

5. Click Close.

4

3 5
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Q

Changing a
toolbar’s contents
You can modify the contents of
any toolbar by adding, moving,
and removing commands.
Grouping commands together on
a toolbar can help to visually
separate commands used for
different tasks such as browsing
and querying. After modifying a
built-in toolbar, you can return it
to its original contents; you
might want to do this if you
accidentally remove a command
from the toolbar.

Adding a command to a
toolbar or menu

1. Click the Tools menu and
click Customize.

2. Click the Toolbars tab.

3. Make sure the toolbar you
want to change is checked.

4. Click the Commands tab.

5. In the Save in combo box,
click the dropdown arrow and
choose the template in which
the changes to the toolbar
will be saved.

6. Click the category that
contains the command you
want to add.

7. Click the command you want
to add.

8. Drag the command you want
to add to any location on the
target toolbar.

9. Repeat steps 6 through 8
until all the commands you
want are added.

10.Click Close.

4 6

7

3

5

8

Tip

About the Save in combo
box
The Save in combo box appears on
the Commands tab, in the New
toolbar dialog, in the Reset toolbar
dialog, and in the Customize
Keyboard dialog. Use this setting
to specify whether the change you
are about to make will be saved in
the Normal template, another
template, or the current document.
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9

Adding a new, empty
menu to a toolbar

1. Show the toolbar to which
you want to add a new, empty
menu.

2. Click the Tools menu and
click Customize.

3. Click the Commands tab.

4. Click New Menu in the
Categories list.

5. Click and drag the New Menu
command from the Com-
mands list and drop it on the
toolbar.

An empty menu called “New
Menu” appears in the toolbar.

6. Right-click New Menu in the
toolbar.

7. Type an appropriate caption
for the menu in the text box.

8. Press Enter.

9. Click Close.

54Tip

Creating access keys
All menus on the Main Menu and
their commands have an under-
lined character in their caption
called an access key. It lets you
access the menu from the keyboard
by holding down Alt and then
pressing the underlined letter. To
create an access key, place an
ampersand (&) in front of a letter
in the menu�s (or the command�s)
caption.
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Adding a command to a
context menu

1. Click Tools and then click
Customize.

2. Click the Toolbars tab.

3. Check the Context Menus
toolbar.

4. Click Context Menus on the
Context Menus toolbar.

A list of all the context menus
in the application appears.

5. Click the arrow for the context
menu to which you want to
add a command.

The context menu’s com-
mands are listed.

6. Click the Commands tab in
the Customize dialog box.

7. Click the category that
contains the command you
want to add to the menu.

8. Click and drag the command
from the Commands list and
drop it on the context menu.

The command appears in the
context menu.

9. Click Close in the Customize
dialog box.

5

4

Modifying context
menus
ArcMap contains several context
menus to provide easy access to
commands appropriate to the task
at hand. By clicking the right-
mouse you�ll see the built-in
context menus. You can add a
command to any of the listed
context menus should your work
require it.

3

7

8

9
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Moving a command

1. Show the toolbar with the
command you want to move.

2. If you’re moving the com-
mand to another toolbar,
show the destination toolbar.

3. Click the Tools menu and
click Customize.

4. Drag the command to its new
position and then drop it.

The command appears in the
new position.

5. Click Close in the Customize
dialog box.

Removing a command

1. Show the toolbar containing
the command that you want
to remove.

2. Click the Tools menu and
click Customize.

3. Click and Drag the tool you
want to remove from the
toolbar.

The mouse pointer changes
to a line through a circle.

4. Drop the command.

5. Click Close in the Customize
dialog box.

1

2

4

1

3

Tip

Removing commands
When you remove a command from
a toolbar, you�re not permanently
deleting it�you�re just making it
unavailable on the toolbar. The
command still appears in the
commands list in the Customize
dialog box. Later, you can always
add the command to the same
toolbar or to a different one.
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Grouping commands

1. Show the toolbar containing
the commands that you want
to group together.

2. Click the Tools menu and
click Customize.

3. On the toolbar, right-click the
command located to the right
of where the grouping bar
should be placed.

4. Click Begin a Group.

A grouping bar appears in the
toolbar.

5. Click Close in the Customize
dialog box.

Resetting a built-in
toolbar

1. Click the Tools menu and
click Customize.

2. Click the Toolbars tab.

3. Click the built-in toolbar that
you want to reset.

4. Click Reset.

5. Click the dropdown arrow and
choose the template in which
the changes to the toolbar
settings were made.

6. Click OK.

7. Click Close.

A grouping bar appears in
the toolbar.

4

4

5

3

6

7

3

Tip

Why open the Customize
dialog box?
Even though you don�t make use of
it in an operation such as grouping
commands, you must display the
Customize dialog box to place the
application in a state in which you
can make changes to its user
interface.
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Changing a
command’s
appearance
You can modify the display type,
caption, and image of a menu,
button, or tool without program-
ming. By default, a button or tool
dropped directly onto a toolbar
has the display type Image Only,
while it has the display type
Image and Text when dropped
onto a menu. Menus can only
have the display type Text Only.
The caption is the text that
appears with the appropriate
display types. Menus and their
contents can be accessed from
the keyboard by holding down
Alt and then pressing the
underlined letter. Create one of
these access keys by typing an
ampersand (&) in front of a letter
in the caption.

Other properties, such as ToolTip
and Message, can only be
modified with programming.
When you hold the mouse
pointer over a command, its
ToolTip displays as a short
message in a floating yellow box.
A command�s Message displays
in the status bar.

Changing the display
type

1. Show the toolbar containing
the command whose display
type you want to change.

2. Click the Tools menu and
click Customize.

3. On the toolbar, right-click the
command you want to
change.

4. Check Image Only to display
only the command’s image.

Check Text Only to display
only the command’s caption.

Check Image and Text to
display both.

5. Click Close in the Customize
dialog box.

Changing the caption

1. Show the toolbar containing
the command whose caption
you want to change.

2. Click the Tools menu and click
Customize.

3. In the toolbar, right-click the
command you want to change.

4. Type a new caption in the text
box on the context menu.

5. Press Enter.

The new caption is applied.

6. Click Close in the Customize
dialog box.

4

3

3

4

Image Only display type
for command

New caption for command
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Changing the icon

1. Show the toolbar containing
the command whose image
you want to change.

2. Click the Tools menu and click
Customize.

3. In the toolbar, right-click the
command you want to change.

4. Point to Change Button Image.

5. Click one of the images
displayed. Or click Browse,
navigate to a custom image,
and then click Open.

The new image is applied. It
appears in the toolbar if the
display type is Image Only or
Image and Text.

6. Click Close in the Customize
dialog box.

Resetting a built-in
command

1. Show the toolbar with the
command you want to reset.

2. Click the Tools menu and
click Customize.

3. In the toolbar, right-click the
command you want to
change.

4. Click Reset.

The command returns to its
default settings.

5. Click Close in the Customize
dialog box.

3

3
4

4

5

See Also

To learn how to set the properties
of commands in code, see
the ArcObjects� Developer Help.
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Creating shortcut
keys
When you access a menu from
the keyboard using its access key,
the menu opens and you can see
its contents. In contrast, a
command�s shortcut key executes
the command directly without
having to open and navigate the
menu first. For example, Ctrl+C
is a well-known shortcut for
copying something in Windows.
One command can have many
shortcuts assigned to it, but each
shortcut can only be assigned to
one command. A command�s first
shortcut is displayed to its right
when the command appears in a
menu.

Assigning a shortcut key

1. Click the Tools menu and
click Customize.

2. Click Keyboard.

3. Click the category containing
the command you want to
modify.

4. Click the command to which
you want to add a keyboard
shortcut.

5. Click in the Press new
shortcut key text box and
then press the keys on the
keyboard that you want to
use for a shortcut.

If those keys have been
assigned to another com-
mand, that command’s name
will appear below.

6. Click the dropdown arrow and
choose the template in which
the shortcut key will be
saved.

7. Click Assign if the keys aren’t
currently assigned to another
command.

The new shortcut appears in
the Current Key/s list.

8. Click Close in the Customize
Keyboard dialog box.

9. Click Close in the Customize
dialog box.

3 4 8

5
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Removing a keyboard
shortcut key

1. Click the Tools menu and click
Customize.

2. Click Keyboard.

3. Click the category that
contains the command you
want to modify.

4. Click the command from
which you want to remove a
keyboard shortcut.

5. Click the dropdown arrow in
the Save in combo box and
choose the template from
which to delete the shortcut
key setting.

6. Click the shortcut in the
Current Key/s list that you
want to delete.

7. Click Remove.

8. Click Close in the Customize
Keyboard dialog box.

9. Click Close in the Customize
dialog box.

3 4

6 5

7

8
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Resetting built-in 
shortcut keys

1. Click the Tools menu and
click Customize.

2. Click Keyboard.

3. Click the dropdown arrow in
the Save in combo box and
choose the template whose
shortcut keys will be reset.

4. Click Reset All.

5. Click Yes when asked if you
want to reset your shortcuts.

6. Click Close in the Customize
Keyboard dialog box.

7. Click Close in the Customize
dialog box.

3

6

4
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Saving
customizations in
a template
If you create a map that contains
customizations or code you�d
like to use as the basis for other
maps, or if you modify an
existing template and want to use
it again, you can save it as a
template. The template will
contain all customizations that
were made graphically as well as
any modules created in the Visual
Basic Editor.

You can save a map template
anywhere on your network.
When you want to use the
template, you can open it from
ArcMap.

 If you save a template in the
ArcMap Templates folder, the
\arcexe81\bin\templates folder
where you have installed
ArcMap, it will show up in the
list of templates on the New map
document dialog box. You can
also create subfolders in this
folder, and they�ll show up as
separate tabs on this dialog
box�when you click each tab
you�ll see the templates in that
folder.

Saving a template

1. Click File and click Save As.

2. Click the dropdown arrow and
click ArcMap Templates.

3. Navigate to the folder where
you want the template saved
(for example, the default
templates folder
arcexe81\bin\templates).

4. Type a name for the new
template.

5. Click Save.

Saving a template so it
will appear in a new tab

1. Click File and click Save As. u

24

3

5

1

1
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Tip

Regenerating Normal.mxt
If you save customizations to
ArcMap�s Normal.mxt template,
and later decide that you�d like to
reset the entire template to its
original settings, delete the file.
ArcMap will regenerate Normal on
startup if it is missing.

Tip

Making changes to an
existing template
If you want to open a template as a
document in order to make
changes to it, use Open in the File
menu. If you open the template
using the �Open an existing map�
option on the Startup dialog box or
by double-clicking on the template
filename, you�ll create a new
document based on your template
instead of just opening your
template as a document. This new
document has a reference to your
template. If you were to try to save
this document as your template
again, you�ll get a save error
because essentially you are trying
to create a template that references
itself.

4

5

7 8

3

New tab

New
template

2

2. Click the dropdown arrow and
click ArcMap Templates.

3. Navigate to the Templates
folder.

4. Click the New Folder button.

5. Type the name of the new
folder—this name will appear
on the New map document
dialog box as a tab.

6. Double-click the new folder.

7. Type the name of the new
template.

8. Click Save.

The next time you start a map
from a template, you’ll see a
new tab with your template
on the New map dialog box.
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Changing where
customization
changes are
saved by default
By default, all customization
changes you make to the user
interface get saved to the Normal
template, unless you select either
another template or the current
document in the Save in combo
box before making the change.
You may prefer to save all of
your customizations to the
current document by default.
This means that unless you
specify differently in the Save in
combo box, all of your changes
will get saved in the current
document.

Saving customizations to
the document by default

1. Click the Tools menu and
click Customize.

2. Click the Options tab.

3. Uncheck Save customizations
to Normal template by
default.

Changes are now saved to
the current document by
default.

4. Click Close.
4

3

Tip

Default document or
template
Once you choose the document as
the default for customization
changes, this default setting will be
in effect every time you start
ArcMap�that is, until you check
Save customizations to Normal
template, making the Normal
template the default template
again.
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Setting toolbar
options
The Options tab in the Customize
dialog box lets you specify the
size of icons on commands and
whether ToolTips will appear on
all the toolbars in ArcMap when
you hold the mouse pointer over
a command.

Later, this chapter shows how the
Options tab also provides a
means to lock or unlock the
Customize dialog box, the
Macros dialog box, and the
Visual Basic Editor. In addition,
you can use the Options tab to
change VBA security and update
the status of the Normal
template�s ArcID module.

Displaying toolbars with
large icons

1. Click the Tools menu and
click Customize.

2. Click the Options tab.

3. Check Large icons to display
large icons for a toolbar’s
commands.

4. Click Close.

Showing ToolTips on
toolbars

1. Click the Tools menu and
click Customize.

2. Click the Options tab.

3. Check Show ToolTips on
toolbars to display ToolTips
for the commands on a
toolbar.

4. Click Close.

4

4

3

3
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Creating, editing,
and running
macros
ArcMap comes with Visual Basic
for Applications. VBA is not a
standalone program. It provides
an integrated programming
environment, the Visual Basic
Editor (VBE), that lets you write
a Visual Basic (VB) macro and
then debug it right away in
ArcMap. A macro can integrate
some or all of VB�s functionality
with the extensive object library
available through ArcMap. The
ESRI Object Library is always
available to you in the VBA
environment.

In the VBE in ArcMap, there can
be up to three VBA projects. The
document, the base template, and
the Normal template all have a
VBA project. The VBA project
for the Normal template is called
Normal (Normal.mxt). The VBA
project for the current document
is called Project
(<NameofDoc>.mxd). The VBA
project for the base template is
called TemplateProject
(<NameofTemplate>.mxt).
Macros can be stored in any of
these VBA projects depending on
where you want the code to be
available. u

Creating a macro in the
Visual Basic Editor

1. Click the Tools menu, point to
Macros, then click Macros.

2. Click the dropdown arrow in
the Macros in combo box,
then click the document or
template in which you want to
create this macro.

3. Type the name of the macro
you want to create in the
Macro name text box.

4. Press the Enter key or click
Create.

The stub for a Sub procedure
for the macro appears in the
Code window.

If you don’t specify a module
name, the application stores
the macro in a module named
NewMacros.

5. Type the code for the macro.

6. Click the VBE File menu and
click Save Project.

Preceding the name of a macro with a
module’s name and a dot stores it in the
specified module.

3

4

2
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Running a macro in the
Visual Basic Editor

1. Click the Tools menu, point to
Macros, and click Visual
Basic Editor.

2. In the VBE Project window,
double-click ThisDocument or
the module containing the
macro that you want to run.

The Code window for that
module appears.

3. Position the cursor inside the
appropriate Sub procedure.

4. Click the VBE Run menu and
click Run Sub/UserForm.

When you create a macro, you�re
creating a VB Sub Procedure.
The procedure�s name is the
name you assign to the macro.
You add code to the procedure in
a Code window just as you
would in VB. You can organize
your macros in different mod-
ules; each module has its own
Code window. To add your
macro to a specific module, type
the module name before the
macro�s name, for example,
�Department.WorkMacro�. If the
module doesn�t exist, a new
module with that name is created
for you and added to the VBA
project. Similarly, if you provide
a name for a new macro, but
don�t specify which module to
store it in, a new module
�NewMacros� is created. Using
modules makes it easier to share
your VB code with others. You
can export a module to a .bas file
from, and import a .bas file to,
your VBA project.

Editing a macro in the
Visual Basic Editor

1. Click the Tools menu, point to
Macros, then click Macros.

2. In the list below the Macro
name text box, click the name
of the macro you want to edit.

3. Click Edit.

The code that’s been written
for the macro appears in the
Code window.

4. Edit the code.

5. Click the VBE File menu and
click Save Project.

6. Click Close to close the VBE.

2

3

2

4

3
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Adding a macro to a
toolbar or menu

1. Show the toolbar to which you
want to add a macro.

2. Click the Tools menu and click
Customize.

3. Click the Commands tab.

4. Click Macros in the
Categories list.

5. Click and drag the macro from
the Commands list and drop it
on the toolbar.

6. Click Close.

5

Running a macro in the
Macros dialog box

1. Click the Tools menu, point to
Macros, then click Macros.

2. Click the Macros in dropdown
arrow and select the
document or template
containing the Macro you
want to run.

3. Type the name of the macro
you want to run or select it
from the list that appears.

4. Click Run.

4

2

6

4

3
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Creating custom
commands with
VBA
An extensive object library is
available in VBA in ArcMap. For
example, ArcMap exposes a
Map, a PageLayout, a
LineFillSymbol, and so on. The
ArcObjects Developer Help
describes the classes, interfaces,
properties, methods, and
enumerations that are available in
the development environment
that is built into ArcMap.

Toolbars and commands are
COM objects, too. To be a
command, the object must meet a
basic set of requirements for all
commands. To be a tool, the
object must also satisfy tool
requirements. The customization
environment makes it easy for
you to create custom commands
with VBA. You create a new
button, tool, combo box, or edit
box (collectively called
UIControls) in the Customize
dialog box, then attach code to
that object�s control events. After
you have created it, you can drag
this new control onto a toolbar.

Creating a new command

1. Show the toolbar to which
you want to add a new
command.

2. Click the Tools menu and
click Customize.

3. Click the Commands tab.

4. Click the dropdown arrow on
the Save in combo box and
click the document or
template in which the new
command will be saved.

5. Click UIControls in the
Categories list.

6. Click New UIControl.

7. Click the type of UIControl
you want to create.

8. Click Create to create the
control without attaching code
to it.

The name of the control
appears in the commands
list. You can add code for the
control at another time. If you
want to start adding code to
the control right away, click
Create and Edit and skip to
step 13.

9. Click the newly created
UIControl, click it again to
activate in-place editing, and
type a new name for the
UIControl. u

8

7

4

6

5

9
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10.Click and drag the newly
created UIControl and drop it
on a toolbar or menu.

11. On the toolbar or menu, right-
click the control to set its
image, caption, and other
properties.

12.Right-click the new control
and then click View Source.

The Visual Basic Editor
appears, displaying the
control’s code in the code
window.

13.Click the Procedures\Events
dropdown arrow and click one
of the control’s event proce-
dures.

14.Type code for the event
procedure.

15.Repeat steps 13 and 14 until
all the appropriate event
procedures have been coded.

16.Click Save in the Visual Basic
Editor.

17.Click the Close button in the
Visual Basic Editor.

18.If you clicked Create and Edit
in step 8, open the Customize
dialog box, click the Com-
mands tab, and drag the
newly created UIControl from
the commands list to a
toolbar or menu.

19.Click Close in the Customize
dialog box.

Q

R
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Working with UIControls

If you create a macro and add it to a toolbar, you�ve essentially
customized what happens when you click the button. UIControls,
however, provide a way to enrich an application in addition to
button clicks and menu selections. The event procedures
associated with these controls allow you to respond to user
interaction and update controls based on the state of the
application. If you create a combo box or an edit box, you might
be able to avoid using a dialog box to get information.

The UIButtonControl works similarly to the built-in buttons that
come with the application. Typically, you use a UIButtonControl
to start, end, or interrupt an action or series of actions. You can
write code to set whether it appears enabled or appears as if it is
pressed in. You can also set its ToolTip, provide a message that
will appear in the status bar, and respond to its Click event.

The UIToolControl works similarly to the built-in tools that come
with the application. Typically, you use a UIToolControl to
perform some type of interaction with the display. You can write
code to toggle whether the tool appears as enabled or set its
ToolTip. You can respond to mouse and key events. In addition,
you can have it respond when the user selects the tool, double-
clicks it, or right-clicks it. The UIToolControl can respond when
the map refreshes or when the tool is deactivated.

The UIComboBoxControl works similarly to the combo boxes
that appear as part of the interface. It combines the features of a
text box and a list box. Typically, you use a UIComboBoxControl

to provide a set of choices from which a selection can be made.
You can also type into the edit box portion of the control. The
combo box has methods that allow you to populate its list or
remove individual or all items. Several properties associated with
the combo box let you work with items, return the index of the
selected item, return the text at a specific index, return the text in
the control�s edit box, and determine how many items are in the
control. In addition, you can respond to several events including
when the user makes a change in the edit portion of the control or
when a change to the selection occurs. As with the
UIButtonControl, you can set the control�s ToolTip and provide a
status bar message.

The UIEditBoxControl works similarly to the edit boxes that
appear as part of the interface. Typically, you use a
UIEditBoxControl to display information entered by the user.
The control can also display data derived from an external
source. You can use its Clear method to remove its contents, and
its Text property contains the text that�s displayed. You can
specify whether the control appears as enabled. In addition, you
can respond to when the user makes a change or presses a key. As
with the UIButtonControl, you can set this control�s ToolTip and
provide a status bar message.
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Adding custom
commands
You don�t have to use VBA to
create custom commands. In fact,
in some cases your custom
commands may require you to
use another development
environment. You can create
custom objects in any program-
ming language that supports the
Component Object Model
(COM). Custom commands or
toolbars created outside VBA are
often distributed as ActiveX
dynamic-link libraries (DLLs).
After adding a custom object into
ArcMap, you can use it as you
would any built-in command.

1. Click the Tools menu and
click Customize.

2. Click Add from file.

3. Navigate to the file containing
the custom command.

4. Click the file and click Open.

The Added Objects dialog
box appears, reporting which
new objects have been
registered with ArcMap.

5. Click OK.

6. Click the Toolbars tab.

7. Check the toolbar to which
you want to add the custom
command.

8. Click the Commands tab.

9. Click the custom command’s
category in the Categories
list.

10.Click and drag the command
from the Commands list and
drop it on the toolbar.

11. Click Close.

2

5

4
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Updating the
ArcID module
If you are developing applica-
tions or writing macros that make
use of COM objects that you�ve
added in, you can update the
Normal.ArcID module to include
newly added commands. In this
way, you�ll be able to refer to the
COM objects you�ve added in by
name when using a method such
as CommandBars.Find. Updating
also allows you to keep
Normal.ArcID up to date should
you remove a command.

1. Click the Tools menu and
click Customize.

2. Click the Options tab.

3. Click Update ArcID module.

4. Click Close.

3

4

Using VB’s code completion feature, you can list the
commands that have been added to the ArcID module.

2
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Locking
customization,
documents, and
templates
In order to protect proprietary or
sensitive information or work in
progress or to prevent others
from changing the way you�ve
customized a document or
template, you can use the Lock
Customization facilities provided
in the Options tab of the Custom-
ize dialog box. In addition, Lock
Customization prevents access to
the Macros dialog box and the
Visual Basic Editor. For locking
individual documents or tem-
plates while still allowing access
to the Visual Basic Editor, you
can use the Protection tab of the
VBA Project Properties dialog
box. This dialog lets you
password protect the ArcMap
document or template you�ve
saved.

Locking customization

1. Click the Tools menu and
click Customize.

2. Click the Options tab.

3. Click Lock Customization.

4. In the dialog box that ap-
pears, enter a password that
has at least five alphanumeric
characters and then confirm
it.

To use the Customize dialog
box, the Macros dialog box,
or the Visual Basic Editor with
the document or template
subsequently, the correct
password must be supplied.

5. Click OK in the Lock dialog
box.

6. Click Close.

Unlocking customization

1. Click Tools, then click
Customize.

The Unlock dialog box
appears.

2. Enter the password to unlock
your selection.

3. Click OK.

The Customize dialog box
appears. If you specify an
incorrect password, a
message appears.

3

See Also

You can create your own customi-
zation filter to control what
aspects of the customization
environment other users will have
access to. For an example written
in VB, see the ArcObjects Devel-
oper Help.

54
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Locking documents and
templates

1. Click the Tools menu, point to
Macros, and then click Visual
Basic Editor.

2. In the Project Explorer, right-
click the project or template
you want to lock and then
click Project Properties.

3. Click the Protection tab.

4. Check Lock project for
viewing to lock the project so
that it cannot be viewed or
edited.

5. Type a password and confirm
it.

6. Click OK in the Project
Properties dialog box.

7. Click Save Project.

The next time someone
opens the Project and
attempts to view the Project
Properties, they’ll be
prompted for a password.

5

6

4

3

2
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1. Click the Tools menu and
click Customize.

2. Click the Options tab.

3. Click Change VBA Security.

4. Click the level of security you
want.

5. Click the Trusted Sources tab
to see a list of the names of
organizations or individuals
whose signed macros will be
allowed to run.

When you check the Always
trust macros from this source
check box in the Security
Warning dialog box, which
appears when you open a
document or template with
macros, this digital certificate
is added to the Visual Basic
for Applications Trusted
Sources list.

6. Click OK.

7. Click Close.

4

Changing VBA
security
A macro virus is a type of
computer virus that�s stored in a
macro within a document,
template, or add-in. When you
open such a document or perform
an action that triggers a macro
virus, the macro virus might be
activated, transmitted to your
computer, and stored in your
Normal template. From that point
on, every document you open
could be automatically �infected�
with the macro virus; if others
open these infected documents,
the macro virus is transmitted to
their computers.

ESRI applications offer the levels
of security described in the
Security dialog box to reduce the
chances of macro viruses
infecting your documents,
templates, or add-ins.

See Also

To learn more about using digital
signatures and about how security
levels and digital signatures work
together, see the Microsoft Visual
Basic Help in the VBE.

3

6

7
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12Glossary active data frame
The data frame you�re currently working with, for example, adding layers to. The active data frame
is shown in bold text in the table of contents.

address matching
The process of assigning x,y coordinates to addresses so they can be displayed as points on a map.

alias
Another name for a field in a table.

ArcInfo workspace
See coverage.

attribute
A characteristic of a map feature. Attributes of a river might include its name, length, average
depth, and so on.

attribute table
Information about features on a map, stored in rows and columns. Each row relates to a single
feature; each column contains the values for a single characteristic.

Attributes dialog box
A dialog box that lets you view and edit attributes of features you�ve selected.

band
A measure of some characteristic or quality of the features being observed in a raster. Some rasters
have a single band; others have more than one. For example, satellite imagery commonly has
multiple bands representing different wavelengths of energy from along the electromagnetic
spectrum.

barrier
An object that is placed on a map to specify a place in a network past which a trace cannot
continue.
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CAD
Computer-aided design. An automated system for the design,
drafting, and display of graphically oriented information.

candidates
A record from a geocoding reference data source that is a
potential match for an address.

cell
A discretely uniform unit�such as a square meter or square
mile�that represents a portion of the earth in a raster. A cell has
a value that corresponds to the feature or characteristic at that site
such as a soil type, census tract, or elevation.

chart
A graphic representation of tabular data. Also referred to as a
graph.

class
A group or category of attribute values.

classifying
The process of sorting or arranging attribute values into groups
or categories; all members of a group are represented on the map
by the same symbol.

cluster tolerance
The distance range in which all vertices and boundaries in a
shapefile or feature dataset are considered identical, or
coincident, when you run the Integrate command from the Editor
menu.

For example, if the cluster tolerance is set to 10 map units, after
running Integrate there will be no more than one vertex within
10 map units of another.

coincident
See cluster tolerance.

color ramp
A range of colors used in a map to show ranking or order of
feature attributes.

control points
Points you establish on a paper map to represent known ground
points or specific locations. Control points are used to register a
paper map before you begin digitizing features on it with a
digitizer.

coordinate system
A method for specifying the location of real-world features on the
surface of the earth.

coverage
A vector data storage format for storing the location, shape, and
attributes of geographic features. One of the primary vector data
storage formats for ArcInfo. Coverages are stored in an ArcInfo
workspace.

current task
The setting of the Current Task dropdown list that determines
with which task the sketch construction tools (Sketch, Arc,
Distance�Distance, and Intersection) will work.

The current task is set by clicking a task in the Current Task
dropdown list. All tasks in the Current Task dropdown list work
with a sketch that you create. For example, the Create New
Feature task uses a sketch you create to make a new feature. The
Extend/Trim Feature task uses a sketch you create to determine
where the selected feature will be extended or trimmed. The Cut
Polygon Feature task uses a sketch you create to determine where
the polygon will be cut.
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data
A collection of related facts usually arranged in a particular
format and gathered for a particular purpose.

data frame
A frame on the map that displays layers occupying the same
geographic area. You may have one or more data frames on your
map depending on how you want to organize your data. For
instance, one data frame might highlight a study area, and another
might provide an overview of where the study area is.

data source
Any geographic data such as a coverage, shapefile, raster, or
geodatabase.

data view
An all-purpose view for exploring, displaying, and querying
geographic data. This view hides all map elements such as titles,
North arrows, and scale bars. See also layout view.

database
A collection of related files organized for efficient retrieval of
information.

dataset
Same as data source.

decimal degrees
Degrees of latitude and longitude expressed as a decimal rather
than in degrees, minutes, and seconds.

determinate flow direction
For an edge feature, occurs when the flow direction can be
determined from the topology of the network, the locations of
sources and sinks, and the enabled or disabled states of features.

digitizer
See digitizing.

digitizer puck
See digitizing.

digitizing
The process of converting the features on a paper map into digital
format. When you digitize a map, you use a digitizing tablet, or
digitizer, connected to your computer and trace over features with
a digitizer puck, which is similar to a mouse. The x,y coordinates
of these features are automatically recorded and stored as spatial
data.

digitizing mode
Also called absolute mode, digitizing mode is one of the ways in
which a digitizing tablet operates. In digitizing mode, the location
of the tablet is mapped to a specific location on the screen.
Moving the digitizer puck on the tablet surface causes the screen
pointer to move to precisely the same position. See also mouse
mode.

digitizing tablet
See digitizing.

disabled feature
A network feature that does not allow flow to pass through it.

display units
The units�for example, feet, miles, meters, or kilometers�
ArcMap uses to report measurements, dimensions of shapes, and
distance tolerances and offsets.
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edge
A network feature that has a length and through which
commodity flows.

edit cache
A command in ArcMap Editor that causes the features visible in
the current map extent to be held in memory on your local
machine. Designed to be used when working with large amounts
of data, an edit cache results in faster editing because the Editor
doesn�t have to retrieve the data from the server.

edit session
All editing takes place within an edit session. An edit session
begins when you choose Start Editing from the Editor menu and
ends when you choose Stop Editing.

Editor toolbar
A toolbar that lets you create and modify features and their
attributes in ArcMap.

enabled feature
A network feature that allows flow to pass through it.

feature
A representation of a real-world object in a layer on a map.

feature class
1. A classification describing the format of geographic features
and supporting data in a coverage. Coverage feature classes for
representing geographic features include point, arc, node, route-
system, route, section, polygon, and region. One or more
coverage features are used to model geographic features; for
example, arcs and nodes can be used to model linear features
such as street centerlines. The tic, annotation, link, and boundary
feature classes provide supporting data for coverage data
management and viewing.

2. The conceptual representation of a geographic feature. When
referring to geographic features, feature classes include point,
line, area, and surface. In a geodatabase, an object class that
stores features and has a field of type geometry in a geodatabase.

feature dataset
A collection of feature classes in a geodatabase that share the
same spatial reference. Because the feature classes share the
same spatial reference, they can participate in topological
relationships with each other such as in a geometric network.
Object classes and relationship classes can also be stored in a
feature dataset.

field
A column in a table. Each field contains the values for a single
attribute.

flag
An object that is placed on a map to specify the starting point for
a trace task.

flow direction
The direction in which commodities flow through edge elements
in a network.

geocoding
The process of creating geometric representations for locations
(such as point features) from descriptions of locations (such as
addresses).

geocoding reference data
Data that a geocoding service uses to determine the geometric
representations for locations.
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geocoding service
An object that defines a process for creating geometric
representations for locations (such as point features) from
descriptions of locations (such as addresses).

geodatabase
A geographic database that provides services for managing
geographic data. A geodatabase is hosted inside a relational
database management system. A geodatabase contains feature
datasets.

geographic coordinates
A measurement of a location on the earth�s surface expressed in
degrees of latitude and longitude. See projected coordinates.

geometric network
A set of feature classes that participate together in a network.

georeference
The process of defining how raster data is situated in map
coordinates. Georeferencing raster data allows it to be viewed,
queried, and analyzed with other geographic data.

graticule
A graphic representation on a map of the network of parallels and
meridians (latitude and longitude) that subdivide the earth�s
surface.

grid
A geographic representation of the world as an array of equally
sized square cells arranged in rows and columns. Each grid cell is
referenced by its geographic x,y location. See raster.

ground control point
A location of known x,y coordinates used to georeference a
raster. A ground control point links a location on a raster to a
location in map coordinates.

group layer
Several layers that appear and act like an individual layer in the
table of contents in ArcMap.

hyperlink
Displays data, such as an image or Web page, when you click it.

image
Represents geographic features by dividing the world into
discrete squares called cells. Examples include satellite and aerial
photographs, scanned documents, and building photographs. See
also raster.

indeterminate flow direction
For an edge feature, this occurs when the flow direction cannot
be determined from the topology of the network, the locations of
sources and sinks, and the enabled or disabled states of features.

join
The process of attaching tabular data to a layer. The fields in the
table are appended to the layer using a common field. Join
establishes a one-to-one, one-to-many, or a many-to-many
relationship between map features and table attributes.

junction
A network feature that occurs at the intersection of two or more
edges or at the endpoint of an edge that allows the transfer of
flow between edges.
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layer
A collection of similar geographic features�such as rivers, lakes,
counties, or cities�of a particular area or place for display on a
map. A layer references geographic data stored in a data source,
such as a coverage, and defines how to display it. You can create
and manage layers as you would any other type of data in your
database.

layout
The design or arrangement of elements�such as geographic
data, North arrows, and scale bars�in a digital map display or
printed map.

layout view
The view for laying out your map. Layout view shows the virtual
page upon which you place and arrange geographic data and map
elements�such as titles, legends, and scale bars�for printing.
See also data view.

legend
A list of symbols appearing on the map; includes a sample of
each symbol and text describing what feature each symbol
represents.

map
A graphical presentation of geographic information. It contains
geographic data and other elements such as a title, North arrow,
legend, and scale bar. You can interactively display and query the
geographic data on the map and also prepare a printable map by
arranging the map elements around the data in a visually pleasing
manner.

map display
A graphic representation of the map on the computer screen.

map document
The disk-based representation of a map. Map documents can be
printed or embedded into other documents. Map documents have
an .mxd file extension.

map element
A graphic component, such as a scale bar, North arrow, and title,
that helps describe the geographic data on the map.

map feature
See feature.

map projection
See projection.

map scale
See scale.

map surround
See map element.

map template
A kind of map document that provides a quick way to create a
new map. Templates can contain data, a custom interface, and a
predefined layout that arranges map elements, such as North
arrows, scale bars, and logos, on the virtual page. Map templates
have an .mxt file extension.

map tips
Displays onscreen descriptions of map features when you pause
the mouse pointer over the feature.

map units
The units�for example, feet, miles, meters, or kilometers�in
which the coordinates of spatial data are stored.
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mouse mode
Also known as relative mode, mouse mode is one of the ways in
which a digitizing tablet operates. In mouse mode, the digitizer
puck behaves just like a mouse; there is no correlation between
the position of the screen pointer and the surface of the digitizing
tablet, but you can choose interface elements with the pointer.
See also digitizing mode.

multipart feature
A feature that is composed of more than one physical part but
only references one set of attributes in the database.

For example, in a layer of states, the State of Hawaii could be
considered a multipart feature. Although composed of many
islands, it would be recorded in the database as one feature.

multipoint feature
A feature that consists of more than one point but only references
one set of attributes in the database. For example, a system of oil
wells might be considered a multipoint feature, as there is a
single set of attributes for the main well and multiple well holes.

neatline
A border commonly drawn around geographic features, often to
separate them from other map elements.

network
A set of edges and junctions that are topologically connected to
each other.

network feature
A feature that participates in a geometric network.

nodata
Same as null value but specific to rasters.

normalize
Creating a ratio by dividing two data values. Normalizing data
minimizes differences in values based on the size of areas or
numbers of features in each area. For example, dividing a value
by the area of a feature yields a value per unit area, or density.

North arrow
A map element that shows how the map is oriented.

null value
The absence of a value. A geographic feature for which there is
no associated attribute information.

parametric curve
A curved segment that has only two vertices as endpoints, instead
of being made of numerous vertices. You can create a parametric
curve using the Arc tool or the Tangent Curve command in the
ArcMap Editor. Also known as a true curve.

point mode digitizing
One of two methods of digitizing features digitally using ArcMap
Editor�s Sketch tool or from a paper map using a digitizer. With
point mode digitizing, you can create or edit features by
digitizing a series of precise points, or vertices. Point mode
digitizing is effective when precise digitizing is required�for
example, when digitizing a perfectly straight line. See also stream
mode digitizing.

projected coordinates
A measurement of locations on the earth�s surface expressed in a
two-dimensional system that locates features based on their
distance from an origin (0,0) along two axes, a horizontal x-axis
representing east�west and a vertical y-axis representing north�
south. A map projection transforms latitude and longitude to x,y
coordinates in a projected coordinate system. See also
geographic coordinates.
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projection
A mathematical formula that transforms feature locations from
the earth�s curved surface to a map�s flat surface. A projected
coordinate system employs a projection to transform locations
expressed as latitude and longitude values to x,y coordinates.
Projections cause distortions in one or more of these spatial
properties: distance, area, shape, and direction.

pyramids
Reduced resolution raster layers that record the original raster
data in decreasing levels of resolution. Pyramids help to reduce
the time it takes to display raster data.

query
A question or request used for selecting features. A query often
appears in the form of a statement or logical expression. In
ArcMap, a query contains a field, an operator, and a value.

raster
Represents any data source that uses a grid structure to store
geographic information. See grid and image.

rematching
The process of re-geocoding a subset of features in a geocoded
feature class.

resampling
The process of assigning a value to a cell when transforming a
raster. The three most common resampling techniques are nearest
neighbor assignment, bilinear interpolation, and cubic
convolution.

resolution
1. The accuracy at which a given map scale can depict the
location and shape of geographic features. The larger the map
scale, the higher the possible resolution. As map scale decreases,
resolution diminishes and feature boundaries must be smoothed,
simplified, or not shown at all. For example, small areas may
have to be represented as points.

2. The size of the smallest feature that can be represented in a
surface.

3. The number of points in x and y in a raster.

scale
The relationship between the dimensions of features on a map
and the geographic objects they represent on the earth, commonly
expressed as a fraction or a ratio. A map scale of 1/100,000 or
1:100,000 means that one unit of measure on the map equals
100,000 of the same unit on the earth.

scale bar
A map element that graphically shows a map�s scale.

segment
A line that connects vertices in a sketch. For example, in a sketch
of a building, a segment would represent one wall.

select
To choose from a number or group of features or records; to
create a separate set, or subset.

selected set
A subset of the features in a layer or records in a table. ArcMap
provides several ways to select features and records graphically
or according to their attribute values.
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selection anchor
A small �x� located in the center of selected features. The
selection anchor is used when you move features using snapping.
It is the point on the feature or group of features that will be
snapped to the snapping location. This is also the point around
which your selection will rotate when you use the Rotate tool and
around which your feature will scale when you use the Scale tool.

shapefile
A vector data storage format for storing the location, shape, and
attributes of geographic features. A shapefile is stored in a folder
and contains one feature class.

shared boundary
A segment or boundary common to two features. For example, in
a parcel database, adjacent parcels will share a boundary. Another
example might be a parcel that shares a boundary on one side
with a river. The segment of the river that coincides with the
parcel boundary would share the same coordinates as the parcel
boundary.

shared vertex
A vertex common to multiple features. For example, in a parcel
database, adjacent parcels will share a vertex at the common
corner.

sink
A junction feature at which flow terminates.

sketch
A shape that represents a feature�s geometry. Every existing
feature on a map has an alternate form, a sketch. A sketch lets you
see exactly how a feature is composed with all vertices and
segments of the feature visible. To modify a feature�s geometry,
you must modify its sketch. To create a feature, you must first
create a sketch. You can only create line and polygon sketches, as
points have neither vertices nor segments.

Sketches help complete the current task. For example, the Create
New Feature task uses a sketch you create to make a new feature.
The Extend/Trim Feature task uses a sketch you create to
determine where the selected feature will be extended or
trimmed. The Cut Polygon Feature task uses a sketch you create
to determine where the polygon will be cut into two features.

sketch constraints
The angle or length limitations you can place on segments you�re
creating.

These commands are available on the Sketch tool context menu.
For example, you can set a length constraint that specifies that the
length of the segment you�re creating will be 50 map units. At
whatever angle you create that segment, its length will be
constrained to 50 map units.

Angle constraints work in the same way. For example, you can
set an angle constraint that specifies that the angle of the segment
you�re creating will be 45 degrees measured from another feature
that already exists. At whatever length you create that segment,
its angle will be constrained to 45 degrees.

sketch operations
Editing operations that are performed on an existing sketch.

Examples are Insert Vertex, Delete Vertex, Flip, Trim, Delete
Sketch, Finish Sketch, and Finish Part. All of these operations are
available from the Sketch context menu, which is available when
you right-click on any part of a sketch using any editing tools.
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snapping environment
Settings in the ArcMap Editor�s Snapping Environment window
and Editing Options dialog box that help you establish exact
locations in relation to other features. You determine the
snapping environment by setting a snapping tolerance, snapping
properties, and a snapping priority.

snapping priority
The order in which snapping will occur by layer. You can set the
snapping priority by dragging the layer names in the Snapping
Environment window to new locations.

snapping properties
A combination of a shape to snap to and a method for what part
of the shape you will snap to. You can set your snapping
properties to have a feature snap to a vertex, edge, or endpoint of
features in a specific layer.

For example, a layer snapping property might let you snap to the
vertices of buildings. A more generic, sketch-specific snapping
property might let you snap to the vertices of a sketch you�re
creating.

snapping tolerance
The distance within which the pointer or a feature will snap to
another location.

If the location being snapped to (vertex, boundary, midpoint, or
connection) is within the distance you set, the pointer will
automatically snap. For example, if you want to snap a power line
to a utility pole and the snapping tolerance is set to 25 pixels,
whenever the power line comes within a 25-pixel range of the
pole, it will automatically snap to it. Snapping tolerance can be
measured using either map units or pixels.

source
A junction feature at which flow originates.

spatial analysis
The study of the locations and shapes of geographic features and
the relationships between them.

spatial bookmark
Identifies a particular geographic location that you want to save
and refer to later�for example, a study area.

spatial data
The locations and shapes of geographic features with descriptions
of each.

spatial join
A type of spatial analysis in which the attributes of features in
two different layers are joined together based on the relative
locations of the features.

spatial overlay
The process of superimposing layers of geographic data that
occupy the same space in order to study the relationship between
them.

stream mode digitizing
One of the two methods of digitizing features from a paper map.
Also known as streaming, stream mode digitizing provides an
easy way to capture features when you don�t require much
precision�for example, to digitize rivers, streams, and contour
lines. With stream mode, you create the first vertex of the feature
and trace over the rest of the feature with the digitizer puck. You
can also use digitize in stream mode with the Editor�s Sketch tool
when editing �freehand�. See also point mode digitizing.
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stream tolerance
The interval at which vertices are added along the feature you�re
digitizing in stream mode. When streaming, vertices are
automatically created at a defined interval as you move the
mouse. For example, if the stream tolerance is set to 10 map
units, you must move the pointer at least 10 map units before the
next vertex will be created. If you move the pointer more than
10 map units, there may be more space between vertices, but
there will always be a minimum interval of 10 map units. Stream
tolerance is measured in map units. See also stream mode
digitizing.

stretch
Applied to a raster to increase the visual contrast between its
cells.

style
An organized collection of elements that you use to make your
maps or put on your maps. Styles include elements such as
symbols, scale bars, North arrows, and colors. You might create
different styles that contain the specific elements for the specific
types of maps you make.

Style Manager
The tool that you use to create new styles and edit existing ones.

surface
A geographic phenomenon represented as a set of continuous
data such as elevation or air temperature over an area. A clear or
sharp break in values of the phenomenon (breaklines) indicates a
significant change in the structure of the phenomenon (for
example, a cliff), not a change in geographic feature.

symbol
A graphic representation of an individual feature or class of
features that helps identify it and distinguish it from other
features.

symbology
The criteria used to determine symbols for the features in a layer.
A characteristic of a feature may influence the size, color, and
shape of the symbol used.

table
Information formatted in rows and columns. See attribute table.

table of contents
Lists all the layers on the map and shows what the features in
each layer represent.

tabular data
Descriptive information that is stored in rows and columns and
can be linked to map features.

target layer
The setting of the Target Layer dropdown list that determines to
which layer new features will be added. The target layer is set by
clicking a layer in the Target Layer dropdown list. For instance, if
you set the target layer to Buildings, any features you create will
be part of the Buildings layer. You must set the target layer
whenever you�re creating new features�whether you�re creating
them with the Sketch tool, by copying and pasting, or by
buffering another feature.

template
See map template.
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text label
Text added to a map to help identify features.

TIN
Triangulated irregular network. A data structure that represents a
continuous surface through a series of irregularly spaced points
with values that describe the surface at that point (for example,
an elevation). From these points, a network of linked triangles
forms the surface.

topological association
The spatial relationship between features that share geometry
such as boundaries and vertices. When you edit a boundary or
vertex shared by two or more features using the topology tools in
ArcMap Editor, the shape of each of those features is updated.

tracing
The process of building a set of network features based on some
procedure.

uninitialized flow direction
For an edge feature, this occurs when the edge feature is not
topologically connected through the network to sources and sinks
or if the edge feature is only connected to sources and sinks
through disabled features.

vertex
A point that joins two segments of a feature. For instance, a
square building would have four vertices, one at each corner.

warp
Transforming a raster to map coordinates.

weight
A property of a network feature typically used to represent a cost
for traversing across an edge or through a junction.

weight filter
A specification of which network features can be traced based on
their weight values.
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Accent bars
using with text  282

Access keys
contrasted with shortcut keys  485
creating  479, 483

Active data frame  67
defined  503

ActiveX DLLs
distributing custom commands as  498

Address matching
defined  503

Addresses. See also Geocoding
candidates  414�415, 417, 419, 421, 429
components  414
finding  419�421
geocoding tables of  422�425
standardizing  414, 417, 420, 429

Aerial photographs  393
Alias

defined  503
Align

graphics  178
map elements  247
to margins  247

Alternate street name table  414
AncillaryRole attribute  435, 436, 449. See also

Sinks; Sources
Annotation. See also Labels

converting labels to  182
described  168
feature-linked  183

Annotation feature classes  169, 182
Annotation groups  169, 182
Annotation layers  169, 182
Annotation target

creating  170
described  169
setting  170

ArcCatalog
opening a map from  71
starting ArcMap from  68

ArcID module  499
ArcPress

printer engine  251
printing complex maps  251

Area graph  322
Area patches

example  258
Arrowheads

creating  279
Aspect ratio

stretching graphics  246
Attribute tables

defined  503
hyperlinks  367

Attributes
Attributes dialog box  503
defined  503
viewing

selected features  379
Azimuthal projection  108

B

Backgrounds
adding  210
color of  200
emphasizing a data frame with  209
example  201, 258
modifying  262
using with text  282

Bands
in rasters  393

defined  503
Bar graph  322
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Barriers. See also Network tracing
adding  454
defined  503
described  451
selected features  452

BMP (Windows Bitmap)
exporting to  255
using with fill symbols  276
using with marker symbols  280

Bookmarks. See Spatial bookmarks
Borders

adding  209
emphasizing a data frame with  209
example  200, 258
modifying  262
using with text  282

Bubble graph  322
Buffers

creating  383
Buttons

changing icon  484
creating  495�496
described  472

C

CAD drawings (Computer-aided design)
adding as layer  103
as a dataset  103
described  103
drawing  162

CAD map  138
Candidates

for geocoding
defined  504

Captions
changing  483

Categories
symbol  260

example  262

Cells
in rasters  393

defined  504
Chart map  136

bar  158
column  158
pie  157
stacked  159

Charts. See Graphs
Classification schemes

defining your own  154
equal interval  147
excluding features from  154
natural breaks  146
quantile  146
setting  153
standard deviation  147

Classifying
defined  504

Clip
map to printer page  250
one layer with another  385

Cluster tolerance. See also Cleaning data
defined  504

Color ramps
creating  149, 273
defined  504
described  273
example  258
modifying  273
using with fill symbols  273

Color shaded relief map  138
Colors

changing fill color  243
changing line color  244
described  285
example  258
locking a symbol layer  260, 267
mixing your own  243, 285
models  285

Colors (continued)
modifying  286
naming  286
saving  286
type

CMYK  285
Gray  285
HLS  285
Names  285
RGB  285

Column graph  322
Columns

in a legend  239
in tables. See Tables

Combo boxes
creating  495�496
described  472

Commands  472
adding to toolbar or menu  478
changing appearance  483
changing captions  483
creating  495�496
display types  483
grouping on toolbars  482
moving  481
removing  481
resetting  484
shortcut keys  485

Complex maps
printing with ArcPress  251

Computer-aided design files. See CAD
drawings

Conformal projection  108
Context menus

adding commands to  480
described  472
modifying  480

Contrast stretch
applying to rasters  402
defined  513
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Control points
defined  504

Coordinate systems
defined  504
described  107
modifying parameters of  111
predefined  110
specifying  109

Copying
data frames  226
map elements  266
symbols  266

Coverages
adding as layer  98
defined  504
drawing  133

Crystal Reports  337, 362
Current task  504
Custom commands

adding from file  498
Customization

saving in a template  202
saving in Normal template  202

Customizations
changing default save location  490
locking  500
saving in templates  488
unlocking  500
where to save  473

Customize dialog box  473, 482

D

Data frames
activating  128
active  67, 128
adding  128, 226
coordinate system  109
defined  505
described  67
drop shadow  211

Data frames (continued)
duplicating  226
example  200, 201
graticules  213
maps with several data frames  199
measured grids  215
name of  209
organizing layers in  67, 128
reference grids  217
removing  129
resizing  227
rotating the data in  129
showing position of other data  228
showing the contents of  74
uses of in layouts  200, 226

Data sources
defined  505

Data view
defined  505
described  75
switching to  70, 75

Databases
defined  505

Datasets
defined  505

Decimal degrees
defined  505

Deleting
map elements  266
symbols  266

Density map  137
Determinate flow direction  445

defined  505
Digitizing

defined  505
in digitizing (absolute) mode  505
in mouse (relative) mode  509
in point mode  509
in stream mode  512�513

Display
units

defined  505

Display tab
showing in table of contents  127

Display units  112
Dissolve

boundaries between like features  385
Distance

measuring  85
units  85

Distributing graphics  178
Documents

locking  501
Dot density

described  137
drawing layer as  152

Downstream trace. See Network tracing
Drawing layers  133
Drop shadows

emphasizing a data frame with  211
for map elements  240
properties  211

Dynamic segmentation  106
Dynamic labels  181

E

Edge barriers. See Barriers
Edge flags. See Flags
Edges. See also Network features

defined  432, 506
Edit boxes. See Text boxes
Edit cache

defined  506
Edit session

defined  506
Editing

tables  308
Editor toolbar

defined  506
Elements

adding  242
aligning  247
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Elements (continued)
grouping  247
related to data frames  230

EMF (Enhanced Windows Metafile)
exporting to  255
using with fill symbols  276
using with marker symbols  280

Enabled attribute  435, 440. See also Network
features

Encapsulated Postscript (EPS)
exporting to  255

End offset  416�417
Enhanced Windows Metafile (EMF)

exporting to  255
using with fill symbols  276
using with marker symbols  280

EPS (Encapsulated PostScript)
exporting to  255

Equal area projection  108
Equal interval classification  147
Equidistant projection  108
ESRI style

example  262
Event key  106
Events  106
Export

features  381
options  255
styles

in your current map  263
Extent rectangles

changing extent  229
showing multiple extents  229
showing position of data  228

F

Feature class
defined  506

Feature dataset
defined  506

Feature map service  100
Feature-linked annotation  183, 194
Features

converting to graphics  171
defined  506
displaying documents about  367
displaying Web pages about  367
exporting to geodatabase or shapefile  381
finding on a map  84
highlighting selected  378
hyperlinks  367
identifying  83, 366
searching with an expression  372
selecting by clicking them  369
selecting by dragging a box  370
selecting by location  377
selecting by using an expression  372
selecting in tables  371

Fields
adding  307
alias

defined  503
arranging in tables  294
calculating values in  310
defined  506
deleting  307
formatting  298
freezing  295
primary display field  84
selecting  302
setting width of  293
summarizing values in  306

File extensions
of coordinate systems  110
of map documents  202
of map templates  202

Fill colors
changing  243

Fill symbols
creating  272
described  272

Fill symbols (continued)
example  258

outline  272
overlay  275
picture  276
random dot  274
solid  272

type
gradient  273
line  275
marker  274
picture  276
simple  272

using with text symbols  281, 282, 284
Find tool  84
Finding features on a map

by searching with an expression  372
Flags. See also Network tracing

adding  454
defined  506
described  451

Flow direction  445. See also Sinks; Sources
defined  447, 506
described  445
displaying  447
establishing  445, 449
with disabled features  445

Frame tab
visibility of  232, 240

Frames
for map elements  240
groups of elements  240
uses of  240

G

Geocoding  411. See also Addresses
attributes of geocoded features  425
candidates

defined  504
defined  506
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Geocoding (continued)
described  411
overview  414�415
reference data  414, 417

defined  506
rematching

defined  510
rematching a geocoded feature class  426�

427, 428�429
services

defined  507
tables of addresses  422�425

Geocoding services  411, 419
adding to a document  412
defined  507
removing from a document  413
settings  415�418, 419, 424, 427

intersection connectors  416
matching options  415�416
output fields  417�418
output options  416�417

styles  416
Geocoding Services Manager  412, 413
Geodatabase

adding as layer  98
defined  507

Geographic coordinates
defined  507
described  107

Geographic position
finding  219

Geography Network  100
Geometric networks. See also Network

features; Network weights
defined  432, 507
described  432
opening  433, 434
versioning  450

GeoProcessing Wizard  385
Georeference

defined  507

Georeferencing rasters  404
Gradient fills

example  201
using with fill symbols  273
using with text symbols  284

Graduated color map  135
Graduated symbol map  135
Graphics

adding  168, 243
aligning  178
as annotation  168
changing color of  169, 243
changing line color  244
changing size of  168
convert from map element  241
converting features to  171
default symbol  171
deleting  168
distributing  178
editing vertices of  169
grouping  178
intersecting  180
joining  180
modifying  261
moving  175
ordering  175
rotating  175
selecting  174
sizing  177
subtracting  180
ungrouping  179
unioning  180

Graphs
adding to layout  323, 326
axes  331
changing type  327
color, changing  329
creating  323
deleting  334
described  321
exporting  336

Graphs (continued)
legend, adding  330
loading from file  335
opening  334
overlays  324
refreshing  326
removing  334
renaming  334
saving to file  335
titles, adding  328
trend lines  332
types of  322

Graticules  213. See also Measured grids
defined  507

Grid (snapping)
changing size of  224
showing  224
snapping to  224

Grids. See Rasters
Ground control point

defined  404
Group layers

adding layers to  120
creating  120
defined  507
described  120
ordering layers in  121
properties of  121
removing layers from  122

Groups
of graphic elements  178
of map elements  247
resizing groups of elements  248

Guides
adding  222
example  200
moving  222
removing  222
removing all  223
showing  221
snapping to  221
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H

Halos
using with marker symbols  278
using with text symbols  283

Help  86
contents  87
finding specific words in  88
in dialog boxes  86
index  87
pointer  86

High-low-close graph  322
Highlighting selected features  378
Hyperlinks  196, 367

defined  507

I

Icons
changing on buttons  484

Identify tool  83, 366
Identifying features  83, 366
Image map service  100
Images

adding as layer  394
bands in  393

defined  503
cells

defined  504
defined  507
described  393
drawing  396
stretching  402

Indeterminate flow direction  445
defined  507

Installing
styles  259

Internet
adding data from

Geography Network  100
internet servers  100

Intersect
graphics  180
one layer with another  385

Intersection connectors  416
Isolation tracing. See Network tracing

J

Joining tables  315
by spatial location  390
defined  507
described  312
managing  316
spatially  314

Joint Photographic Experts Group (JPEG)
exporting to  255

JPEG (Joint Photographic Experts Group)
exporting to  255

Junction barriers. See Barriers
Junction flags. See Flags
Junctions. See also Network features

defined  432, 507

K

Keyboard shortcuts
assigning  485
removing  486
resetting  487

L

Labels. See also Annotation
converting to annotation  182
described  181�182
displaying  184, 185
dynamic  181
example  258
overlap, allowing  191
positioning  189
printing a map with  192

Labels (continued)
prioritizing  182, 189
specifying text of  187

Landscape page orientation
example  200

Latitude and longitude
described  107

Layers
adding  66, 96
copying

to data frames  118
to maps  118

creating  98
defined  508
definition query  99
described  66, 115
displaying labels  167, 184
drawing  133

by matching to style  141
density with dots  152
showing categories  140
showing multiple attributes  156
showing quantities  148
with chart symbols  157
with graduated colors  148
with graduated symbols  150
with proportional symbols  151
with single symbol  139

drawing order  66
changing  117

group
adding layers to  120
creating  120
described  120
ordering layers in  121
properties of  121
removing layers from  122

identifying features in  83, 366
joining attributes  390
organizing in data frames  67
properties  123
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Layers (continued)
referencing data  113, 131
removing  119
renaming  116
saving to disk  130
showing the legend of  74
storing relative pathnames to  113
updating data source of  114, 131
viewing attribute table of  84
visible scale range  74

clearing  125
described  124
setting  124

Laying out and printing maps  199
Layout

applying a template  254
tools for positioning elements  201

Layout aids
grids  219
guides  219
rulers  219
snapping to  219

Layout view
defined  508
described  75
switching to  70, 75
virtual page  206

Leaders
creating  271
using with text symbols  282

Legend items
changing defaults  239
example  258

Legends
adding  235
changing items  239
changing labels  236
changing patches  238
defined  508
example  200, 201
number of columns  239

Legends (continued)
patch for a single layer  239
with multiple data frames  235

Line colors
changing  244

Line graph  322
Line patches

example  258
Line symbols

creating  268
described  268
example  258

arrowhead leaders  271
encased road  268
railroad  269
tour route  270

layers
aligning  270

templates  269, 270
type

cartographic  268, 269, 270, 271
hash  269
marker  271
simple  268

using with fill symbols  275
using with text symbols  284

Links
for georeferencing rasters  404
to data  71

repairing  131
updating data  114

Loading
styles  259

Location
showing with a data frame  228
showing with Extent rectangle  228

Locking
customizations  500
documents  501
symbol layer color  260, 267
templates  501

Longitude and latitude
described  107

M

Macro viruses  502
Macros  492

adding to toolbars  494
creating  492
editing  493
running

from Macros dialog box  494
from module  493

Magnifier window  82
Main Menu  472, 475
Many-to-many relationship  313
Many-to-one relationship  312
Map display

defined  508
Map documents  65

defined  508
Map elements

converting to simple graphics  241
copying  266
defined  508
deleting  266
examples  199, 201, 258
modifying  262

backgrounds  262
borders  262

naming, renaming  266
pasting  266
saving  262

Map projections
defined  508
described  107

Map scale
defined  508

Map templates
applying to layout  254
creating maps from  95
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Map templates (continued)
defined  508
discussion of  202
making a map series  199
organizing  95
quickly making a map  199
reusing data  203
reusing layout  203
saving maps as  90
standardizing maps  199

Map tips  83, 196, 366
defined  508

Map units  112
defined  508

Maps
as documents  65
containing graphs  199
containing reports  199
creating  94
defined  508
described  65
opening  71
querying  365
saving  89

as new map  89
as template  90

series  199
size  199
storing relative pathnames  113

Margins
using guides to define  223

Marker symbols
creating  277
described  277
example  258

arrowhead  279
mask, halo  277
outline  277
picture graphic  280
simple shapes  277
TrueType font  278

Marker symbols (continued)
type

arrow  277, 279
character  277, 278
picture  277, 280
simple  277

using with fill symbols  274
using with line symbols  270, 271
using with text  282

Masking
using with marker symbols  278
using with text symbols  283

Matching options  415�416
Measure locations  106
Measured grids  215. See also Graticules
Measurements

setting ruler units  220
Menu items

described  472
Menus

adding commands to  478
adding to toolbars  479
creating  479
described  472

Merge
one layer with another  385

Mexico
sample map  200

Minimum candidate score  415, 416�418
Minimum match score  415, 416
Modifying

color ramps  273
colors  286
map elements  262
symbols

used to draw feature layers  260
used to draw graphics  261
using the drawing toolbar  261

Mouse mode  509
Multipart features

defined  509

Multipoint features
defined  509

Multivariate map  136

N

Natural breaks classification  146
Neatlines

adding  245
defined  509

Network features. See also Edges; Geometric
networks; Junctions

adding  437
connecting  439
defined  509
disabled  435, 445
disabling  440, 445, 451
disconnecting  439
enabled  435
enabling  440
symbolizing  435

Network tracing  451. See also Barriers; Flags
described  451
features stopping traces  452
finding a path  455, 463
finding common ancestors  455, 457
finding connected features  455, 458
finding disconnected features  455, 458
finding downstream path  465
finding loops  455, 467
finding shortest path  463
finding the upstream accumulation  455
finding upstream path  465
finding upstream path to source  455, 457
isolating a point  459
trace results  451
tracing downstream  454
tracing upstream  454, 455
using selections  452
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Network weights  443
defined  451
filter syntax  458, 461
filters  444, 452, 461
from-to  452
to-from  452

Networks. See Geometric networks
Nodata

defined  509
Normal template  473, 490

discussed  202
Normal.mxt

discussed  202
regenerating  489

Normalizing data
defined  509
described  145

North arrows
adding  230
defined  509
example  200, 258
modifying  262

Null value
defined  509

O

Object libraries  492
One-to-many relationship  313
One-to-one relationship  312
Online help

contents  87
finding specific words in  88
in dialog boxes  86
index  87
pointer  86

Opening
a map  71
a template  203

Order
elements on a map  244

Organizing
styles  265

Orientation (of page)
setting  206

Overlay
joining attributes  390

Overview window  82

P

Page orientation
changing  208
example  200, 201
factors influencing  200
setting  206

Page position
finding an element's  219

Page setup
changing page size  250

Page size
changing  207
default  206
example  201
factors influencing  200
setting  206

Panning  76
from overview window  82
with scroll bars  76

Parametric curves
defined  509

Pasting
map elements  266
symbols  266

Pathnames
to layers

relative  113
updating  114

PDF (Portable Document Format)
Exporting to  255

Personal style
contents  260

Personal style (continued)
example  262
locating  266
referencing  259

Photographs. See Rasters
Pictures

adding  246, 395
colors

foreground, background  276
transparent  276

scaling  276
using with fill symbols  276
using with marker symbols  280

Pie graph  322
Place name alias table  414
Polar graph  322
Portable Document Format (PDF)

exporting to  255
Portrait page orientation

example  201
Position

of elements on page  219
of pointer on page  219

PostScript files  253
PostScript printer engine  251
Preview

a map before printing  249
Primary display field  84
Print

a map  249
multiple copies  251
to a file  252

Printer margins
showing in layout  206, 208

Printer page
scale map to  250

Printers
change page size of  249
default page size  206
select a new  250

Printing
a map  249
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PRJ file (projection file)  110
Projected coordinate system. See Coordinate

systems
defined  509

Projection file (PRJ)  110
Projections. See also Coordinate systems

azimuthal  108
conformal  108
defined  510
equal area  108
equidistant  108
Robinson  107, 108
sinusoidal  107

Pyramids
defined  510
raster  403

Q

Quantile classification  146
Query

defined  510
Query Wizard  372
Querying maps  365

R

Raster map  137
Rasters

adding as layer  394
bands in  393

defined  503
cells

defined  504
color composite  394, 396
defined  510
described  393
drawing  396

adjusting contrast  400
transparently  401
with three-dimensional effect  401

georeferencing  404
defined  507

previews of maps with  249
pyramids  403

defined  510
raster resolution

defined  396
displaying  399

rectifying  405
reduced resolution dataset (RRD)  403
resampling  405

defined  510
stretching  402
world files and  394

Records. See Tables
Rectangle graphics

example  201
Reference grids  217. See also Graticules
Reference scale  164
Reference systems

example  258
Referencing

example  262
styles  259

Relating tables  317
described  313
managing  319

Relief map  138
Rematching

during geocoding
defined  510

Renaming
data frames  209
map elements  266
symbols  266

Reports
columnar  339
creating  342
Crystal Reports  337, 362
described  337, 338
exporting  361

Reports (continued)
fields, displaying  346
footnotes  354
images, adding  355
layout, adding to  343
loading from file  360
margins  345
orientation  345
page numbering  353
page size  345
previewing  357
records

grouping  350
shading  359
sorting  350

saving to file  360
sections  340, 341, 358
summary statistics  351
tabular  338
titles  352
type  344
width  344

Resampling
defined  405

Rescale map elements
when changing page size  207

Resize
groups of elements  248

Resolution
defined  510

RMS error
during georeferencing  405

Robinson projection  107, 108
Rotated text

example  201
Route events

adding as layer  106
described  106

Rows. See Tables
Rulers

divisions  200
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Rulers (continued)
example  200
showing  219
snapping to  219
units  200

S

Same as printer
setting page size  207, 250

Sample maps
Mexico  200
New Hampshire  201

Satellite images  393
Saving

a map as a template  204, 488
colors  286
map elements  262
styles

in your current map  263
symbols  260

Scale
defined  510
indicating on map  199
reference  164

Scale bars
adding  231
changing marks  233
changing numbers  233
changing scale  232
changing units  232
changing units label  232
defined  510
example  200, 258

Scale text
adding  234
and changing map size  234
example  200, 258

Scatter graph  322
Security  502
Segate Crystal Reports  337, 362

Segments
defined  510

Selectable Layers list. See also Selecting
features

Selected set
defined  510

Selecting features
by clicking them  369
by dragging a box  370
by location  377
defined  510
in tables  371
setting highlight color  378
using an SQL expression  372

Selecting graphics  174
Selection anchor

defined  511
Selection handles

example  200
Send to Back

changing order of elements  244
Shapefiles

adding as layer  98
defined  511
drawing  133

Shared boundary  511. See also Topology
Shared vertex. See also Topology

defined  511
Sharing maps

page setup tips  207
Shortcut keys

assigning  485
contrasted with access keys  485
creating  485
removing  486
resetting  487

Shortest path. See Network tracing
Side offset  416�418
Single symbol map  134
Sinks  435. See also AncillaryRole

attribute; Flow direction

Sinks (continued)
creating  449
defined  445, 511
symbolizing  436

Sinusoidal projection  107
Size and Position tab

visibility of  232
Sketch

constraints  511
defined  511
operations  511

Snapping environment
defined  512

Snapping order
changing  225

Snapping priority
defined  512

Snapping properties
defined  512

Snapping tolerance
changing  225
defined  512

Source tab
showing in table of contents  127

Sources  435. See also AncillaryRole
attribute; Flow direction

creating  449
defined  445, 512
symbolizing  436

Spatial bookmarks
creating  79, 80
defined  512
removing  81

Spatial data
defined  512

Spatial join  390
defined  512

Spatial joins  314
Spatial overlay

defined  512
Spelling sensitivity  415�418
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Splash screen
turning on and off  69

SQL
building an expression  373
searching for features with  372

Standard deviation classification  147
Standard toolbar  472, 475
Standardized address  414, 417, 420, 429
Startup dialog

opening a map from  72
turning on and off  69

Statistics
displaying for selected features  380

Stream mode digitizing. See Digitizing: in
stream mode

Stream tolerance  513
Stretch

defined  513
Stretching graphics

aspect ratio  246
Style contents

copying  266
creating

symbols  267
deleting  266
example  262
pasting  266

Style Manager
contents  264
defined  513
described  265

Style tree
example  262

Styles
adding  259
creating  265
defined  513
described  257
ESRI  259
example  258
exporting  263

Styles (continued)
installing  259
loading  259
organizing  265
personal  259, 260
referencing  259
saving  263

Styles folder
icons  265
locating  266

Surfaces. See TIN
defined  513

Symbol Property Editors
described  267

Symbolizing data  133
Symbols

category  260
color

locking  267
copying  266
creating  267

fills  272
lines  268
markers  277
text  281

defined  513
deleting  266
example  258
fills

described  272
layers

drawing  267
locking  267

lines
described  268

markers
described  277

modifying  260
feature layers  260
graphics  261
graphics with the drawing toolbar  261

Symbols (continued)
multilevel  166
naming, renaming  266
pasting  266
properties

described  267
saving  260
Symbol Selector dialog box  260
text

described  281
units  267

T

Table of contents
defined  513
described  66
Display and Source tabs  127
displaying layers in  73
line and patch  126
renaming layers in  116
showing and hiding  73
text font  126

Tables
adding as layer  292
closing  291
color

of highlighted records  297
of selected records  297

columns  289
arranging  294
freezing  295
selecting  302
setting width of  293

defined  513
described  289, 290
editing  308
fields

adding  307
arranging  294
calculating values  310
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Tables (continued)
fields (continued)

defined  506
deleting  307
described  289
formatting  298
freezing  295
selecting  302
setting width of  293
summarizing  306

finding values  299, 300
joining  315

defined  507
described  312

opening  291
primary display field  84
records  289

adding  308
copying and pasting  309
deleting  309
editing  308
navigating to  299
selecting  303, 371
sorting  301

relating  313, 317
rows  289
summarizing data in  306
text font  296
text size  296

Tabs in New dialog
creating  488�489

Target layer  513
Taskbar

starting ArcMap from  68
Templates. See Map templates

changing  489
described  473
locking  501
saving  488

Templates folder  204, 473�474, 488

Text
adding

along  curve  172
along  line  172
with callout  172

color, changing  173
described  172
example  200, 201
font, changing  173
point size, changing  173
string  173

Text boxes
creating  495�496
described  472

Text callouts
example  201

Text symbols
creating  281
described  281
example  258

accent bar  282
background  281
balloon callout  281
border  282
callout  282
filled text  284
halo  283
leader  282
marker background  282
mask  283
outline  284
shadow  283

Tile
a large map for printing  250

TIN (triangular irregular network)
adding as layer  102
defined  514
described  102
drawing  160

Titles
adding  242
example  200, 201
modifying  242

Toolbars
adding commands  478
adding macros to  494
adding menus  479
changing  478
Close button  475
creating  476
deleting  477
described  472
docking  472
floating  475
grouping commands  482
hiding  475
moving commands  481
options  491
removing commands  481
renaming  476
resetting  482
setting options  491
showing  475
ToolTips  491
using large icons  491

Toolbars list
right-click as shortcut to  475

Tools
creating  495�496
described  472

Topological association
defined  514

Tracing. See Network tracing
Transparency

drawing layers  164
Triangular irregular network (TIN)

adding as layer  102
defined  514
described  102
drawing  160
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TrueType fonts
using with marker symbols  278
using with text symbols  281

U

UIButtonControls
creating  495�496
described  497

UIComboBoxControls
creating  495�496
described  497

UIControls
creating  495�496
described  497

UIEditBoxControls
creating  495�496
described  497

UIToolControls
creating  495�496
described  497

Ungroup
graphics  179
map elements  248

Uninitialized flow direction  445. See also Flow
direction

defined  514
Union

graphics  180
one layer with another  385

Unique values map  134
Unique values symbolization  140
Units

display  112
defined  505

map  112
defined  508

symbol  267
used in the symbol dialog menus  261

Unlocking
customizations  500

Utility Network Analyst toolbar  442
adding  441

Utility networks. See also Geometric
networks; Network tracing

analyzing  431

V

VBA macros  492
VBA Projects  492
VBA security

changing  502
Vertices

defined  514
Virtual page

layout view  206
Visible scale range  74

clearing  125
described  124
setting  124

Visual Basic Editor  492

W

Web page
displaying for a feature  367

Weight filters. See Network weights
Weights. See Network weights
Windows

magnifier  82
overview  82

Windows Bitmap (BMP)
using with fill symbols  276
using with marker symbols  280

Windows printer engine  251
Windows printer file  253

Wizards
GeoProcessing  385
Query  372

World file  394

X

X,Y coordinates
adding table of as layer  105

Z

Zooming  76, 77
from overview window  82
to a layer  78
to a specific scale  78
to extent of all layers  77
to selected features  379
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